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Это руководство для OpenToonz, полнофункционального программного обеспечения для создания
2D-анимации с открытым исходным кодом.
http://opentoonz.github.io

Примечание: This manual is an ongoing project, which aims to provide the first and most complete
reference for OpenToonz features, and as such there will always be room for improvements and updates.
Collaboration is welcome!

Чтобы внести свой вклад в документацию OpenToonz, пожалуйста, посетите хранилище
документации OpenToonz.
https://github.com/opentoonz/opentoonz_docs

Начало работы: 1

http://opentoonz.github.io
https://github.com/opentoonz/opentoonz_docs
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2 Начало работы:



Глава 1

Установка OpenToonz

1.1 Скачивание OpenToonz

You can download the appropriate version of OpenToonz for your operating system from the Download page
in the official OpenToonz web site. Choose either the Windows or macOS version to start downloading the
installer application.

At the bottom of that same page it’s also possible to find the developer’s «Nightly Builds» (new versions
of the software compiled each night for testing purposes), with which you will be able to try out the latest
features and bug fixes, as they are being included in OpenToonz.

Примечание: WARNING: Use at you own risk! A Nightly Build version could potentially be an unstable
one, so it is not adviced nor supported, for use in production environments.

Примечание: All other builds apart from the ones downloaded from the official web site ARE NOT
officially supported by OpenToonz.

Morevna Project provides builds for Windows 32-bit, Windows 64-bit, macOS, and appimage as well as snap
for Linux.

Finally, there’s also an OpenToonz fork called Tahoma2D avalaible for Windows, macOS and Linux, that
could represent a good alternative for certain use cases, where it could be possible to find slightly different
approaches to some of the core features in the software, as well as its own new solutions and tools.

All in all, the OpenToonz ecosystem is an open, diverse and fluid one, which means that most novel features,
improvements and fixes developed for one of its variants, would most probably end up appearing in the other
ones too, within time.

3

https://opentoonz.github.io/e/download/opentoonz.html
https://github.com/morevnaproject
https://github.com/morevnaproject/opentoonz/releases
https://snapcraft.io/opentoonz-morevna
https://tahoma2d.org
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1.2 Установка на Windows

Запустите файл OpenToonzSetup.exe и выполните следующие действия:

Примечание: Microsoft Defender’s Smart Screen might alert that the installer is not signed. Just click on
the «Run anyway» button (select «More info» to make it visible) to proceed with the installation.

1. Выберите язык для сообщений установщика.

2. Примите условия использования OpenToonz.

4 Глава 1. Установка OpenToonz
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3. Решите, где установить папку OpenToonz stuff и хотите ли вы перезаписать какие-либо настрой-
ки в существующей папке OpenToonz в выбранном месте (кроме личных настроек пользовате

1.2. Установка на Windows 5
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4. Решите, следует ли создавать значок на рабочем столе в процессе установки.
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5. Нажмите кнопку Установить, чтобы начать процесс установки с выбранными настройками.

1.2. Установка на Windows 7
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6. Решите, стоит ли запускать OpenToonz сразу после закрытия установщика.
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1.2.1 Chocolatey

choco install opentoonz

1.3 Установка на OS X

Следуй этим шагам:

1. Щелкните правой кнопкой мыши файл OpenToonz.pkg в Finder и выберите «Открыть».

2. Нажмите кнопку Продолжить.

1.3. Установка на OS X 9
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3. Выберите язык и нажмите кнопку «Продолжить».

4. Нажмите кнопку «Согласен», чтобы принять Условия использования OpenToonz.
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5. Выберите место установки (будет Macintosh HD, если не доступно несколько дисков) и нажмите
кнопку «Продолжить».

6. Нажмите кнопку Установить, чтобы начать процесс установки с выбранными настройками.

1.3. Установка на OS X 11
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7. Нажмите кнопку Закрыть, чтобы выйти из программы установки.
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1.3.1 Homebrew

brew cask install opentoonz

1.4 Установка на Linux

1.4.1 ALT Linux

# apt-get install opentoonz opentoonz-doc

1.4.2 Arch Linux

# pacman -S opentoonz

1.4.3 Debian GNU/Linux

1. Загрузите пакет ключа подписи PGP.

wget http://www.deb-multimedia.org/pool/main/d/deb-multimedia-keyring/
deb-multimedia-keyring_2016.8.1_all.deb

2. Установите пакет PGP.

sudo dpkg -i deb-multimedia-keyring_2016.8.1_all.deb

3. Добавьте адрес хранилища в список источников.

echo "deb http://www.deb-multimedia.org stable main" | sudo tee -a /etc/apt/sources.list
Builds for testing and sid also avalaible.

Примечание: Пакеты Debian доступны только для архитектур amd64, arm64 и i386.

4. Установите OpenToonz.

sudo apt update && apt install opentoonz opentoonz-data

Совет: Для обновления введите ‘‘ sudo apt update && apt upgrade‘‘.

1.4.4 Fedora

# dnf install opentoonz

1.4.5 Gentoo

sudo emerge media-gfx/opentoonz
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1.4.6 NixOS

nix-env -iA nixos.opentoonz

1.4.7 openSUSE

sudo zypper install opentoonz

1.4.8 Solus

sudo eopkg install opentoonz

1.4.9 Void Linux

sudo xbps-install -S opentoonz

1.4.10 Универсальные бинарные файлы

Flatpak

1. Установка.

flatpak install flathub io.github.OpenToonz

2. Беги.

flatpak run io.github.OpenToonz

Snap

sudo snap install opentoonz

1.5 Installing on FreeBSD

# cd /usr/ports/multimedia/opentoonz && make install clean

1.6 Installing on DragonFly BSD

# pkg install opentoonz
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Глава 2

Использование FFmpeg с OpenToonz

2.1 Что такое FFmpeg?

Чтобы визуализировать анимацию в виде mp4 или webm, а также в виде gif на Mac, OpenToonz
требует, чтобы на вашем компьютере была установлена мультимедийная инфраструктура FFmpeg.
Для получения дополнительной информации, пожалуйста, посетите эту страницу: О FFmpeg

2.2 Установка FFmpeg для Windows

2.2.1 Загрузка

Чтобы загрузить FFmpeg, сначала посетите эту страницу: Загрузить FFmpeg
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Выберите значок Windows, а затем выберите ссылку Windows builds:

Вы попадете на страницу FFmpeg Builds с некоторыми опциями для версии FFmpeg, которую вы
хотите загрузить:
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В большинстве случаев, выбор по умолчанию в порядке.
Нажмите на синюю кнопку Download Build, начнется загрузка zip-архива, содержащего FFmpeg.

2.2.2 Установка

Как только вы загрузите zip-архив FFmpeg, откройте его и дважды щелкните первую папку.

В папке bin находятся исполняемые файлы, которые вам понадобятся.

• Создайте новую папку на вашем компьютере, рекомендуемое расположение - C:\.

• Назовите новую папку FFmpeg.

• Перетащите содержимое папки bin из архива во вновь созданную папку.

• Next, start OpenToonz and open the Preferences window with File → Preferences. . .

• Перейдите в категорию Импорт/Экспорт; вверху вы увидите поле с текстом Путь к FFmpeg.

• Вставьте путь к папке FFmpeg, которую вы создали ранее, если вы использовали рекомендуемый
путь, это будет C:\FFmpeg\:

• Перезапустите OpenToonz.

• Open the Output Settings window with Render → Output Settings. . .

В подразделе Настройки файла вы должны увидеть mp4 и webm.

2.2. Установка FFmpeg для Windows 17
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2.3 Установка FFmpeg для Mac

2.3.1 Загрузка

Чтобы загрузить FFmpeg, сначала посетите эту страницу: Загрузить FFmpeg
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Выберите значок Apple и выберите ссылку Static и Shared build.

Вы попадете на страницу FFmpeg Builds с некоторыми опциями для версии FFmpeg, которую вы
хотите загрузить:

2.3. Установка FFmpeg для Mac 19
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Убедитесь, что в столбце Architecture выбрано macOS 64-bit.

Нажмите на синюю кнопку Download Build, начнется загрузка zip-архива, содержащего FFmpeg.

2.3.2 Установка

Как только вы загрузите zip-архив FFmpeg, откройте его и дважды щелкните первую папку.

В папке bin находятся исполняемые файлы, которые вам понадобятся.

• Откройте Finder и создайте новую папку, папка Applications/OpenToonz является рекоменду-
емым местом.

• Назовите новую папку FFmpeg.

• Перетащите содержимое папки bin из архива во вновь созданную папку.

Совет: For macOS 10.15 and later, each executable within the FFmpeg folder needs to be opened before
using OpenToonz (this only needs to be done one time, due to security features). In Finder, right-click on
each executable (ffmpeg, ffprobe, and etc.) and select Open With → Terminal. Once the Terminal windows
have launched successfully, Terminal can be closed.

• Next, start OpenToonz and open the Preferences window with File → Preferences. . .

• Перейдите в категорию Импорт/Экспорт; вверху вы увидите поле с текстом Путь к FFmpeg.

• Вставьте путь к папке FFmpeg, которую вы создали ранее, если вы использовали рекомендуемый
путь, это будет /Applications/OpenToonz/FFmpeg:

• Перезапустите OpenToonz.

• Open the Output Settings window with Render → Output Settings. . .
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В подразделе Настройки файла вы должны увидеть mp4, webm и gif.

2.4 Установка FFmpeg для Linux

To install FFmpeg, enter the following command in the shell depending on your distribution.

Arch Linux: # pacman -S extra/ffmpeg

Debian GNU/Linux: # apt install ffmpeg

Gentoo Linux: # emerge media-video/ffmpeg

Solus: # eopkg install ffmpeg

Если вы используете другой дистрибутив Linux, обратитесь к его документации или посетите сайт
FFmpeg.

Совет: To make it possible to export files in mp4, webm or gif formats, you need to specify the path
to FFmpeg installed on your system, usually it is /usr/bin/ffmpeg. Enter command which ffmpeg in the
shell to find out.

• Start OpenToonz and open the Preferences window with File → Preferences. . .

• Перейдите в категорию Импорт/Экспорт; вверху вы увидите поле с текстом Путь к FFmpeg.
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• Вставьте путь /usr/bin.

• Перезапустите OpenToonz.

• Open the Output Settings window with Render → Output Settings. . .

В подразделе Настройки файла вы должны увидеть mp4, webm и gif.
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Глава 3

What’s New in OpenToonz

In this section you can find a list of Highlights in the latest release of OpenToonz; these may include New
Features, Bug Fixes or Enhancements to already existent features. Here, you can also find links to past
versions“ Release Notes, to keep track of OpenToonz development history throughout time.

3.1 v1.6

3.1.1 Highlights

• Rhubarb integration for automatic lip-syncing [Tahoma2D port, with modifications].

• Xsheet/Timeline: Ability to Shift + drag an exposed cell to move it, while automatically
adjusting neighbouring hold cells.

• Xsheet/Timeline: Restored original Toonz feature for changing parent of a column from
the XSheet header [Tahoma2D port].

• Xsheet/Timeline: Cell Mark feature for identifying desired cells using colored dots.

• UI: Xsheet Minimum Layout for ultra-compact column size.

• UI: Xsheet zoom control.

• UI: Zoom in/out and fit floating panel geometry commands.

• Color Display: 30bit color display feature.

• I/O: Export Xsheet to PDF.

• I/O: Export to TVPaint JSON file format.

• I/O: OpenEXR image format support.
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• I/O: File Path Processing Using Regular Expressions.

• Cleanup: Enabled to Cleanup without Line Processing, allows applying Autocenter,
Rotation, etc. without further processing of the images.

• Rendering: Multi-Thread FFMPEG option for faster rendering.

• Brush and Paint Brush Tools: Lock Alpha setting for Toonz Raster and Raster level types.

• Style Editor: Hex editbox for color values in Style Editor.

• Style Editor: Hex color names editor.

• Effects: Linear color space option for all Layer Blending Ino effects.

• Effects: Conical Transform option for Fractal Noise Iwa effect.

• Effects: Image Size option for the Input Size parameter for Tile Iwa effect.

• Effects: GPU HSL Blend shader effect.

• Effects: Bokeh Advanced Iwa effect.

• Effects: Compass Gadget for Radial and Spin Blur effects.

• Camera Capture: Camera calibration.

• Audio: Improved Audio Recording.

• Xsheet/Timeline: Enhanced Note level column.

• Viewer: Enhanced Flipbook playback.

• Schematic: Allowed Renaming Pass Through Nodes (Tahoma2D port).

• I/O: Enabled to set Raster level frame number format.

• I/O: Enabled to use PNG for new Raster levels.

• I/O: Enhanced FFMPEG GIF export.

• File Browser: Enabled to view palette files from the File Browser.

• Palette: Enabled to paste style’s color into a color field.

• Effects: Fx Intensity parameter for controlling global effect intensity.

• Effects: Redesigned Pass Through effect node.

• Camera Capture: Enabled inputting frame with suffix in Camera Capture.

• Stop-motion: Enhanced Stop motion feature.

• Packaging Opentoonz for Fedora distribution.

• Crash on showing snapshot in flipbook.

• Crash on saving scene containing missing palette level.
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• Crash on undoing tool.

• Crash after starting a pen stroke from inactive window.

• Crash on Stage Schematic Column Right click.

• Crash on rendering ArtContour fx.

• Crash on rendering PaletteFilter Fx (and other fxs) with hyphen.

• Crash on cleaning up zerary column.

• Crash on creating a zerary fx in the camera column.

• Crash on creating Macro Fx from the Fx Browser.

• Crash On Inserting Fx.

• Crash on clicking shortcut tree.

• Crashes when using Type tool.

• Crash on deleting control point while dragging.

• Crash on switching scenes while selecting raster level frame.

• Undo Malfunction.

• File browser assertion failure.

• «Show Folder Contents» command for UNC path.

• Viewer playback.

• Flipbook wobbling when dragging while playing.

• Pressing Shift key loses focus when renaming cell.

• Autorenumber of Raster Level.

• Cell Selection on Click.

• GIF rendering on older versions.

• Saving TLV.

• Output file name for movie format.

• PSD loading and level format preferences.

• Backtab key to work for moving styles shortcut scope.

• FrameIDs Inconsistency in Level Strip Commands.

• Memo Popup Background Color.

• FX gadget picking.

• Margin of Directional Blur Fx Iwa.
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• Zerary Fx bugs.

• Friction parameter behavior of the Particles Fx.

• Rendering Fx After Xsheet Node.

• Channel clamping behavior in Layer Blending Fxs.

• Fx Gadget Offset.

• Bokeh Fxs Artifacts.

• Schematic node placement fix.

• Shortcut loading from file.

• Tool options“ shortcuts to work without opening tool options bar.

• Camera capture’s level control.

• Mesh file naming.

• Wheel scrolling on the output settings popup

• Missing Checkboxes in Menu Item

• Convert to TLV Palette Saving

• Raster Deformation Slowness

. . . and much more!

Please see the v1.6 Release Notes hosted in GitHub, for the full list of new features, enhancements and bug
fixes.

3.2 Previous Versions of OpenToonz

Here you can find links to previous versions“ full Release Notes, hosted in GitHub:

v1.5 Release Notes

v1.4 Release Notes

v1.3 Release Notes

v1.2.1 Release Notes

v1.2 Release Notes

v1.1.3 Release Notes

v1.1.2 Release Notes

v1.1 Release Notes

v1.0.3 Release Notes

v1.0.2 Release Notes

v1.0 Release Notes
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Глава 4

Рабочий процесс производства

4.1 Традиционный рабочий процесс

Ниже приведен пример того, как OpenToonz позволяет управлять традиционным производством ани-
мации.
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4.1.1 Сканирование

Элементы, нарисованные от руки, сначала определяются в Xsheet OpenToonz, а затем регистрируются
с помощью сканера. Эти элементы могут состоять из уровней анимации, то есть последовательностей
рисунков, принадлежащих одной и той же анимации, или фоновых изображений и наложений.

Отсканированные изображения затем проходят процесс очистки и при необходимости автоматически
центрируются, используя их отверстия в виде штифта в качестве ориентира и соответствующие на-
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стройки полевого ориентира. В случае линейных чертежей они дополнительно подготавливаются к
процессу окраски.

См. Сканирование бумажных рисунков.

4.1.2 Безбумажный рисунок

Дополнительные рисунки и уровни анимации можно нарисовать прямо в OpenToonz. Рисунки могут
быть важной частью сцены, такой как фон или опора персонажа, или случайные элементы, необхо-
димые для достижения конкретного результата, например, изображение маски для создания матового
эффекта.

См. Рисование уровней анимации.

4.1.3 Цветовая модель

Цветовые модели создаются для точной цветовой привязки во время производства, при рисовании
персонажей и реквизита. Это могут быть рисунки, сделанные в OpenToonz, отсканированные изобра-
жения, обработанные в OpenToonz, или изображения, полученные из стороннего программного обес-
печения.

В случае рисунков OpenToonz палитра цветовой модели может быть определена путем создания стилей
и цветов, которые будут использоваться для рисования уровней анимации.

См. Управление палитрами и стилями и Использование цветовой модели.

4.1.4 Чернила и живопись

Уровни анимации, отсканированные и очищенные в OpenToonz, и уровни, созданные непосредственно
в OpenToonz, окрашиваются с использованием стилей, хранящихся в палитре, и набора инструментов.

Стили палитры интерактивно «связаны» с нарисованными линиями и заполненными областями с по-
мощью индексов. Основным преимуществом этого метода является то, что если вы редактируете стиль
палитры, все линии и заполненные области, использующие этот стиль, будут автоматически обновлять-
ся. Это позволяет изменять или калибровать цвета также после завершения процесса рисования, не
корректируя стиль строка за строкой или область за областью.

См. Управление палитрами и стилями и Уровни рисования анимации.

4.1.5 Композитинг

Все нарисованные уровни OpenToonz и изображения отображаются в таблице Xsheet, где можно кон-
тролировать синхронизацию всех элементов сцены. Также можно загружать изображения, анимацию
и клипы из стороннего программного обеспечения.

После добавления и упорядочения необходимых элементов в Xsheet в виде многослойных столбцов они
затем анимируются с использованием интерполированных ключей, помещенных в необходимые пара-
метры. Элементы, которые можно анимировать таким образом, включают камеру, столбцы, pegbars и
таблицу.

Специальные эффекты, такие как размытие, освещение, ключи, маски, деформации, градиенты и т.д.
, могут быть применены к содержимому столбцов таблицы Xsheet, а также могут быть анимированы
путем установки значения ключа для параметров.
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Объектные и специальные преобразования эффектов отображаются в окне редактора функций, где
заданные значения ключей и соответствующие интерполяции можно контролировать и изменять с
помощью функциональных кривых или числовых столбцов.

См. Работа в Xsheet , Создание движений, Использование спецэффектов и Редактирование с исполь-
зованием электронной таблицы и кривых .

4.1.6 Рендер Ферма

Сцена визуализируется для того, чтобы составить все преобразования и применить специальные эф-
фекты в последовательности кадров в формате и разрешении, которые вы предпочитаете.

Ферма рендеринга OpenToonz позволяет выполнять пакетную рендеринг сцен OpenToonz с использо-
ванием нескольких компьютеров, подключенных к одной сети с использованием TCP/IP.

Смотрите Рендеринг анимации и Использование фермы Toonz .

4.2 Безбумажный рабочий процесс

Ниже приведен пример того, как OpenToonz позволяет управлять производством безбумажной анима-
ции.
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4.2.1 Подготовка производства: концепция

Даже если безбумажный проект может быть запущен независимо от сценария, концепция формата с
несколькими настройками и стабильным набором символов облегчит организацию библиотек, которые
должны быть подготовлены до фактического производства эпизода.

4.2. Безбумажный рабочий процесс 31



OpenToonz Documentation, Выпуск 1.7.1

4.2.2 Подготовка производства: графический дизайн

Графический дизайн персонажей, реквизита и локаций одинаково важен, чтобы найти стиль, который
будет хорошо сочетаться как с возможностями рисования программного обеспечения, так и с техникой
анимации вырезов.

В частности, при проектировании моделей персонажей и реквизита, для которых вы могли бы раз-
работать определенный стиль линий для применения к векторам или использовать очень аккуратные
линии, типичные для векторной анимации, вы должны рассмотреть проект, в котором точки поворота
анимации модели можно легко замаскировать под чертежами. особенности (например, точка поворота
хвоста, связанная с головой персонажа, может быть замаскирована под ленту)

4.2.3 Подготовка производства: раскадровка

В то время как обычно раскадровка используется режиссером для управления ритмом действия, в
случае безбумажного производства она также идентифицирует все элементы, необходимые для произ-
водства каждой сцены, перечисляя все анимации и позы персонажей, и идентифицируя все реквизита
и фона, которые необходимы для реализации истории.

4.2.4 Аниматик

Анимация создается, начиная с отсканированных рисунков раскадровки. В OpenToonz или в сторон-
нем программном обеспечении импортируются рисунки раскадровки, настраивается время и задаются
движения камеры. Аудио файлы тоже могут быть импортированы для справки.

В случае, если анимация создается в OpenToonz, ее также можно разделить, чтобы каждый фрагмент
можно было использовать в качестве отправной точки для окончательной композиции каждой сцены.

4.2.5 Библиотеки

Библиотеки готовятся путем рисования непосредственно в OpenToonz всех элементов, составляющих
сцены, таких как локации, персонажи, реквизиты и т.д.

Что касается персонажей, они будут разложены на несколько уровней (то есть голова, туловище, руки
и т.д.), используемые в качестве компонентов скелета, объединенных в иерархию, которая в конце
концов сделает модели доступными для аниматоров.

В соответствии с анализом раскадровки подготовлены чертежи, необходимые как для канонической
модели разворота (то есть коллекции моделей с разных точек зрения: вид спереди, сзади, сбоку и три
четверти), так и для дополнительных движений. Начиная с этих эталонных анимаций, таких как циклы
бега или ходьбы, прыжки, также могут быть сохранены для повторного использования в производстве
сцены.

Реквизит и фон также могут быть созданы с помощью стороннего программного обеспечения, в том
числе визуализированных изображений из программного обеспечения 3D.

См. Уровни рисования анимации и Создание перекладной анимации.

4.2.6 Раскадровка

На этапе раскадровки все элементы, необходимые для сцены (фоны, реквизиты, персонажи, ссылочные
анимации) загружаются из библиотеки в Xsheet, обычно в виде вспомогательных Xsheet. Они ставятся
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на место согласно аниматику. Базовая анимация достигается путем установки ключевых позиций для
анимированных персонажей или импорта эталонных анимаций.

Движения камеры и время анимации, ранее установленные в анимации, корректируются.

См. Работа в Xsheet и Использование Sub-Xsheets.

4.2.7 Анимирование

Анимация для сцены, определенной в макете, улучшается путем добавления ключевой позиции к дви-
жениям персонажа. Позы персонажей добавляются путем настройки модели для достижения более
плавной анимации.

Правильная скорость для всех движений устанавливается путем управления режимом интерполяции
в редакторе функций.

См. Анимация объектов и Использование редактора функций.

4.2.8 Эффекты

Специальные эффекты, такие как размытие, свечение, коррекция цвета, частицы, применяются к эле-
ментам сцены.

Дополнительные элементы анимации, связанные со специальными эффектами, например маски или
изображения для эффекта частиц, рисуются непосредственно в сцене или импортируются из внешних
файлов.

См. Применение спецэффектов.

4.2.9 Рендер

Сцена должна быть отрисована, чтобы составить все преобразования и применить специальные эф-
фекты в последовательности кадров в формате и разрешении, которые вы предпочитаете.

Ферма рендеринга OpenToonz позволяет выполнять пакетную рендеринг сцен OpenToonz с использо-
ванием нескольких компьютеров, подключенных к одной сети с использованием TCP/IP.

Смотрите Рендеринг анимации и Использование фермы Toonz .
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Глава 5

Обзор интерфейса

Интерфейс OpenToonz организован в комнаты, также известные как рабочие пространства: каждая
комната представляет собой различную коллекцию окон, которые расположены в определенных местах
на экране.

5.1 Использование комнат
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Доступные комнаты перечислены в дальнем правом углу строки меню. Каждая из них всегда отобра-
жает содержимое текущей сцены.

Комнаты могут быть названы и их порядок может быть изменен. Новые комнаты могут быть до-
бавлены, а существующие комнаты могут быть удалены. Когда комната добавлена, она пуста; для её
настройки можно добавлять панели по одной (см. ниже).

Совет: Чтобы войти в комнату:

Нажмите на соответствующую вкладку в правой части строки меню.

Совет: Чтобы назвать комнату:

Дважды щелкните вкладку и введите имя, которое вы хотите присвоить комнате.

Совет: Чтобы заказать номерные вкладки:

Нажмите и перетащите вкладку на новую позицию.

Совет: Чтобы добавить новую комнату:

Щелкните правой кнопкой мыши в области вкладок комнаты и выберите «Новая комната» в открыв-
шемся меню.

Совет: Чтобы удалить комнату:

Щелкните правой кнопкой мыши вкладку комнаты и выберите Удалить комнату «<Имя>» в открыв-
шемся меню. Текущая комната не может быть удалена.

Совет: To return to the set of rooms provided with OpenToonz:

Choose Windows → Workspace → Reset to Default Rooms.

5.1.1 Настройка комнат

Комнаты можно изменить, установив разные размеры для разных панелей и добавив или удалив пане-
ли. Чтобы предотвратить случайное добавление или удаление панелей, конфигурация комнат может
быть заблокирована.

Большинство панелей можно развернуть, чтобы заполнить весь интерфейс, и их можно добавить в
виде плавающих окон с помощью меню Окна.

Совет: Чтобы изменить размер панели в комнате:

Щелкните любой вертикальный или горизонтальный разделитель и перетащите его в новое положение.
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Примечание: Некоторые панели, такие как панель инструментов и полоса уровня, имеют фиксиро-
ванный размер, поэтому их нельзя изменить.

Совет: Чтобы открыть панель как плавающее окно:

Выберите в меню Окна панель, которую вы хотите открыть.

Совет: Чтобы изменить размер плавающего окна:

Нажмите и перетащите границу или угол окна.

Совет: Чтобы закрыть плавающее окно или диалог:

Нажмите кнопку закрытия справа от строки заголовка.

Совет: Чтобы добавить панель в комнату:

1. Используйте меню Окна, чтобы открыть панель как плавающее окно.

2. Нажмите и перетащите строку заголовка, чтобы переместить ее и отпустите, чтобы закрепить ее
в соответствии с выделенной точкой вставки.

Примечание: Попытка пристыковать панель к крайней левой / правой части интерфейса может
завершиться неудачей, если в этот момент главное окно OpenToonz развернуто. Чтобы преодолеть
это, вы можете восстановить размер основного окна, закрепить нужную панель, а затем развернуть ее
обратно.

Совет: Чтобы удалить панель из комнаты:

1. Нажмите и перетащите строку заголовка панели, которую хотите удалить, чтобы отсоединить ее
от комнаты.

2. Закройте плавающее окно.

Совет: Чтобы развернуть или свернуть развернутую панель:

Дважды щелкните строку заголовка.

Примечание: Некоторые панели, такие как панель инструментов и полоса уровня, имеют фиксиро-
ванный размер, поэтому их нельзя развернуть.

Совет: Для блокировки/разблокировки конфигурации комнат:
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Activate/deactivate the Windows → Workspace → Lock Room Panes option.

5.2 Панели комнаты

Ниже приведен список панелей (в том же порядке, в котором они появляются в меню Окна), которые
можно использовать для создания комнат и которые можно открывать как плавающие окна.
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5.2.1 Пакетные серверы

Окно «Пакетные серверы» позволяет обрабатывать пакетный список с помощью рендер-фермы и со-
держит информацию о списке узлов сервера (рендеринга), определенных для фермы.

См. Мониторинг серверных узлов.
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5.2.2 Настройки очистки
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Панель «Настройки очистки» позволяет вам определить параметры процесса очистки отсканирован-
ных растровых изображений, чтобы преобразовать их в растровые изображения Toonz, готовые для
рисования в OpenToonz.

См. Очистка отсканированных чертежей.

5.2.3 Цветовая модель

Средство просмотра цветовой модели отображает изображение или уровень анимации, которые вы
загрузили в качестве эталона для рисования текущего уровня анимации.

См. Использование цветовой модели.
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5.2.4 Браузер файлов

Браузер файлов позволяет загружать и сохранять файлы и получать доступ к проектам.

Слева находится дерево файлов с некоторыми основными папками, содержащими материалы, храня-
щиеся на вашем компьютере: My Computer, Network, My Documents, History, Library and Projects. Вы
можете открывать папки и подпапки для получения файлов, которые отображаются в области справа.

См. Управление проектами и Использование браузера файлов.
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5.2.5 Flipbook

Flipbook может отображать уровни анимации, клипы или последовательности изображений. Его можно
использовать для проверки уровней, например, перед их загрузкой, или для управления визуализиро-
ванной последовательностью.

См. Использование Flipbook .
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5.2.6 Редактор функций

Редактор функций сопоставляет объекты и преобразования FX со значениями ключа и соответствую-
щими интерполяциями с использованием электронной таблицы или графического редактора. Он разде-
лен на два раздела: слева есть область, где отображается электронная таблица или редактор графиков,
справа вверху - область, где отображается интерполяция текущего сегмента преобразования, а справа
внизу - объекты / FX дерево.

См. Использование редактора функций.
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5.2.7 Level Strip

Level strip отображает последовательность рисунков, принадлежащих уровню, выбранному в настоя-
щий момент в таблице Xsheet.

Это помогает вам редактировать последовательность рисунков и видеть все рисунки текущего уровня,
даже если эти рисунки не отображаются в Xsheet.

См. Редактирование уровней анимации.
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5.2.8 Палитра

Она отображает стили, определенные для текущего уровня, или, если он неактивен, стили, определен-
ные для ранее выбранного уровня.

См. Окно Палитры.

5.2.9 Состав сцены

Состав сцены позволяет вам управлять файлами, загруженными в сцену, сохранять их и загружать
новые. Это может быть организовано в папках и подпапках.

См. Использование Состава сцены.
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5.2.10 Схема

Схема может альтернативно отображать информацию о стадии или специальном использовании FX.

Схема сцены отображает в виде узлов все объекты, определенные в сцене, то есть столбцы, вешалки,
камеры, таблицы и траектории движения, и позволяет вам управлять способом, которым они связаны
друг с другом.

Схема FX позволяет применять FX к содержимому столбцов Xsheet и управлять их применением. Все
столбцы и FX отображаются как узлы, которые можно подключить, чтобы установить, как FX влияет
на содержимое сцены.

См. Использование схемы и Использование схемы FX .

5.2.11 Палитра Studio
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Палитра Studio позволяет хранить неограниченное количество палитр уровней. Отсюда любая палитра
может быть извлечена и назначена текущему уровню для его рисования, без необходимости определять
одни и те же стили снова и снова. Он также включает в себя средство просмотра, отображающее стили
текущей выбранной палитры.

См. Использование Палитры Studio .

5.2.12 Редактор стилей

Редактор стилей позволяет изменять стили палитры. Вы можете выбрать тип стиля: цвет, текстура,
вектор и растр. Также есть вкладка настроек, где вы можете выбрать некоторые параметры для стиля.

См. Редактирование стилей.
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5.2.13 Задания

Окно Задания содержит дерево задач со всеми задачами, отправленными на пакетную обработку, и
сведения о задаче, выбранной в данный момент в дереве. Из дерева задач вы можете запустить или
остановить выполнение задачи или удалить ее.

См. Управление и выполнение задач рендеринга.

5.2.14 Центр сообщений

The message center displays in a list the messages OpenToonz is sending to the user. You can set filters on
the messages showed in the window using the appropriate radio buttons, or you can clear the list completely
by pressing the Clear button.

5.2.15 Панель инструментов

Панель инструментов содержит инструменты для рисования, выбора и редактирования рисунков, а
также для анимации таких объектов, как камера, столбцы и вешалки. Инструменты на панели ин-
струментов могут использоваться только в главном окне просмотра.
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Примечание: сли панель инструментов слишком короткая для отображения всех инструментов, ее
можно прокручивать с помощью кнопок со стрелками, имеющихся на ее концах.

Инструмент анимирования изменяет положение, вращение и размер текущих объектов (см.
Анимирование объектов).

Инструмент выделения выполняет выделение и преобразует его (см. Использование инстру-
мента выделения).

Кисть рисует в рабочей области в режиме рукописного ввода (см. Рисование с помощью инстру-
мента Кисть).

Геометрический инструмент рисует геометрические фигуры (см. Рисование с помощью гео-
метрического инструмента).

Инструмент шрифта добавляет текст, устанавливая шрифт и размер (см. Добавление текста).

Заливка заполняет области рисования текущим стилем (см. Покраска областей).

Инструмент покраски рисует линии и области в растровых рисунках Toonz в режиме рукопис-
ного ввода. (см. Покраска областей).

Ластик удаляет векторы на векторных рисунках, а также закрашенные области и линии на раст-
ровых рисунках (см. Инструменты рисования).

Скотч объединяет два открытых конца одного или двух векторов в векторных рисунках или
закрывает пропуски в растровых рисунках (см. Соединение и разделение).

Пипетка выбирает стиль из текущего чертежа, который становится текущим стилем в палитре и
в редакторе стилей.

Инструмент RGB пипетка выбирает красные, зеленые и синие значения из содержимого сред-
ства просмотра и применяет их к текущему стилю (см. Простые цвета).

Редактор контрольных точек изменяет векторную форму, редактируя ее контрольные точки
(см. Редактирование векторных контрольных точек).

Щипок изменяет векторную форму, щелкая и перетаскивая в любом месте вектора (см. Изменение
изгиба векторов).

Насос локально изменяет толщину вектора, нажимая на участок, на который вы хотите повлиять,
а затем перетаскивая его вверх или вниз (см. Использование других инструментов модификатора).

Магнит деформирует несколько векторов одновременно, щелкая область, на которую вы хотите
повлиять, и перетаскивая ее (см. Использование других инструментов модификатора).

Клещи изгибает векторы в векторных рисунках (см. Использование других инструментов моди-
фикатора).

Утюг удаляет складки из векторов, перемещая курсор на вектор, который вы хотите сгладить
(см. Использование других инструментов модификатора).
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Нож разбивает вектор на две части при нажатии на него (см. Соединение и разделение).

Скелет определяет модели персонажей и анимирует их, как в анимации вырезов (см. Использо-
вание инструмента Скелет).

Крюк определяет контрольные точки, которые будут использоваться в схеме этапа для переме-
щения объекта или связывания одного объекта с другим (см. Использование крюков).

Трекер отслеживает определенные области в последовательности изображений (см. Трекинг-
точки).

Plastic tool создает сетку, которая позволяет деформировать и анимировать персонажа или его
часть (см. Использование Plastic tool).

Лупа увеличивает и уменьшает содержание зрителя; после щелчка можно перетащить вверх,
чтобы увеличить рабочую область, или перетащить, чтобы уменьшить масштаб.

Рука панорамирует контент зрителя; если активирован 3D-вид, инструмент «Рука» также позво-
ляет перемещаться по 3D-виду.

Поворот вращает содержимое просмотра; Если 3D-вид активирован, инструмент Повернуть поз-
воляет изменить точку обзора.

5.2.16 Панель параметров инструмента

Панель параметров инструмента отображает настройки для текущего инструмента, если он есть.

Например, он позволяет установить толщину и другие свойства инструмента «Кисть».

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

5.2.17 Панель команд

Панель команд - это место, где пользователь может отображать любимые инструменты и команды
OpenToonz, чтобы они были легко доступны.

Панель командной панели может быть закреплена в любой части интерфейса OpenToonz.

Примечание: Если панель команд слишком короткая для отображения всех командных кнопок,
справа от нее появится символ двойной стрелки, позволяющий отобразить раскрывающееся меню с
остальными.
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Совет: Для отображения панели команд:

• Choose Windows → Command Bar.

Совет: Чтобы настроить кнопки панели команд:

1. Choose Windows → Command Bar to open the Command Bar.

2. Щелкните правой кнопкой мыши по нему и выберите Настройка панели команд в открыв-
шемся меню. Откроется окно «Настройка панели команд».

3. Чтобы добавить команду: найдите команду в списке Элементы панели инструментов (спра-
ва) и перетащите ее в список Панель команд (слева).

4. Чтобы добавить разделитель: в конце списка Элементы панели инструментов (справа) пе-
ретащите элемент —-Разделитель—- в список Панель команд (слева).

5. Чтобы удалить команду: найдите команду в списке Панель команд (слева), щелкните ее правой
кнопкой мыши и выберите Удалить в открывшемся меню.

6. Нажмите OK, чтобы принять изменения или Отмена, чтобы отменить их.

5.2. Панели комнаты 53



OpenToonz Documentation, Выпуск 1.7.1

5.2.18 Просмотрщик

Просмотрщик - это рабочая область, в которой вы можете рисовать изображения и одновременно
видеть результат композитинга. Это бесконечно, и вы можете прокручивать, увеличивать, уменьшать
и поворачивать его так, как вы предпочитаете.

Он имеет различные режимы визуализации, среди которых вы можете выбрать наиболее подходящий
для выполняемой вами операции.

См. Использование Просмотрщика и Предварительный просмотр анимации.

54 Глава 5. Обзор интерфейса



OpenToonz Documentation, Выпуск 1.7.1

5.2.19 ComboViewer

Comboviewer объединяет в одной панели средство просмотра, горизонтальную панель инструментов
и панель параметров инструмента.Это и альтернативная рабочая область, где вы можете рисовать
изображения и одновременно видеть результат вашего композитинга. Это бесконечно, и вы можете
прокручивать, увеличивать, уменьшать и по

Он имеет различные режимы визуализации, среди которых вы можете выбрать наиболее подходящий
для выполняемой вами операции.

См. Использование Просмотрщика и Предварительный просмотр анимации.
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5.2.20 Xsheet

Xsheet позволяет вам управлять содержимым сцены так же, как и временной шкалой. Он организован
в столбцы, а столбцы разделены на ячейки, представляющие содержимое этого столбца в данном
конкретном кадре. В столбцы можно загружать уровни анимации, клипы, изображения, аудиофайлы
или другие таблицы Xsheets.

Каждый столбец имеет свой собственный заголовок, содержащий информацию о его содержании. В
крайнем левом столбце отображается номер кадра с курсором на текущем кадре. Область заголовков
и столбец фрейма всегда видны даже при прокрутке области Xsheet; таким образом легче понять, как
строится сцена.

Кадры отображаются с чтением изображений слева направо в каждой строке ячейки.

См. Работа в Xsheet .

5.2.21 Таймлайн

Таймлайн позволяет вам управлять содержимым сцены так же, как Xsheet. Он организован в горизон-
тальных слоях, и слои разделены на ячейки, представляющие содержимое этого слоя в этом конкретном
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кадре. В слоях вы можете загружать уровни анимации, клипы, изображения, аудиофайлы или другие
временные шкалы.

В самой левой части каждый слой имеет свой собственный заголовок, содержащий информацию о
его содержимом. В верхней части временной шкалы есть линейка времени, которая отображает номер
кадра с курсором на текущем кадре. Область заголовков и линейка времени всегда видны, даже при
прокрутке области шкалы времени; таким образом легче понять, как строится сцена.

Кадры отображаются с чтением изображений снизу вверх в каждом столбце ячейки.

См. Работа в Xsheet .

5.2.22 История

Панель истории, позволяет проверять и отменять/повторять историю последних действий, выполнен-
ных в текущей сцене OpenToonz.

См. Назначение памяти для операции отмены.
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5.2.23 Запись аудио

Окно записи аудио, позволяет записывать источник звука в реальном времени, прослушивать его и
вставлять в новый аудио-столбец таблицы Xsheet.Точка вставки будет расположена справа от выбран-
ного столбца ячейки и начинается с выбранного кадра ячейки.

Примечание: В настоящее время это окно нельзя закрепить, чтобы образовать часть комнаты, как
и другие в меню Окна. Вместо этого оно должно быть открыто как плавающее окно, когда это необ-
ходимо.

5.3 Настройка внешнего вида интерфейса

Внешний вид интерфейса OpenToonz можно настроить в соответствии с любой производственной по-
требностью, выбрав требуемый язык и тему интерфейса.

OpenToonz позволяет пользователям выбирать определенный язык для интерфейса программного
обеспечения, включая меню, команды, всплывающие подсказки и сообщения на экране. В настоя-
щее время доступны следующие языки: английский, немецкий, испанский, французский, итальянский,
русский, японский и китайский.

There are also several included themes to choose from: Default, Blue, Dark, Light and Neutral.

Темы интерфейса определяются с помощью файла QSS, концепции, терминология и синтаксис кото-
рого основаны на файлах CSS (HTML Cascading Style Sheets). Файлы QSS также относятся к набору
изображений PNG, которые используются для создания виджетов интерфейса.

Эти файлы хранятся в папке, называемой файлом QSS, и находятся в папке C:\OpenToonz
stuff\config\qss для Windows и OpenToonz stuff\config\qss для macOS.

Примечание: Файл QSS для Macintosh назван с суффиксом _mac.
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Рис. 1: The OpenToonz interface theme set to Default and to Light.

Файл QSS можно редактировать с помощью любого программного обеспечения для текстового ре-
дактора, например, Блокнот или TextEdit; PNG изображения с любым программным обеспечением
для редактирования изображений. Редактирование файла QSS требует определенных навыков в язы-
ке CSS, но некоторые изменения, такие как цвета элементов панели, можно легко сделать, выразив их
в красных, зеленых и синих значениях.

Примечание: Файлы QSS, определяющие цвета и изображения, используемые в интерфейсе
OpenToonz, должны быть записаны в соответствии с определенным синтаксисом, иначе интерфейс
OpenToonz не будет отображаться должным образом. Если вы решите отредактировать файл QSS,
сначала сделайте резервную копию на тот случай, если вам потребуется вернуть файл к исходной
версии.

Совет: Чтобы выбрать язык интерфейса:

1. Choose File → Preferences. . . → Interface.

2. В меню опций Language* выберите язык, который вы хотите использовать в интерфейсе.

3. Перезапустите OpenToonz, чтобы открыть интерфейс на выбранном языке.

Совет: Для выбора темы интерфейса:

1. Choose File → Preferences. . . → Interface.

2. В меню параметров темы выберите стиль, который будет применяться к интерфейсу.

Совет: Для создания новой темы:

1. Перейдите в папку C:\OpenToonz stuff\config\qss для Windows или OpenToonz
stuff\config\qss для macOS.

2. Дублируйте одну из уже существующих папок стилей.

3. Переименуйте папку и файлы QSS внутри нее, указав имя, которое вы хотите присвоить теме.

4. Отредактируйте файл QSS и изображения PNG, содержащиеся в новой папке.
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Примечание: Новый стиль будет доступен в диалоге настроек при следующем запуске OpenToonz.

Совет: Для редактирования файла стиля QSS:

Откройте и отредактируйте с помощью программного обеспечения текстового редактора (например,
«Блокнот» или «TextEdit») файлы QSS, доступные в папке стилей.

Совет: Чтобы редактировать изображения в стиле:

Откройте и отредактируйте с помощью программного обеспечения для редактирования изображений
файлы PNG, доступные в папке стилей.
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Глава 6

Управление проектами

Проекты - это простой способ управления сценами и файлами, которые в них используются. Они
позволяют вам организовать ваш производственный материал не только путем определения настроек
по умолчанию, используемых в производственном процессе, но также и папок по умолчанию, в которые
будут автоматически сохраняться файлы и откуда они будут извлекаться при необходимости. Это
означает, что, например, как только вы отсканируете рисунки, они будут автоматически сохранены во
входных папках по умолчанию, которые вы указали для своего проекта.

Основным преимуществом управления производством с помощью проектов является то, что можно
достичь согласованности производственных параметров и производственных материалов.

Согласованность производственных параметров достигается благодаря тому, что все сцены проекта,
как только они создаются, наследуют все параметры из проекта (см. Настройка сцены ).

Правильное использование производственного материала достигается благодаря тому, что после опре-
деления производственной структуры с помощью проектов все сцены могут сохранять и извлекать
файлы с использованием папок проекта по умолчанию.

6.1 Настройка Projectroot

Projectroot - это папка, в которой хранится информация о проекте и база данных; он отображается в
браузере OpenToonz как одна из основных папок с соответствующим путем в скобках.

Значением по умолчанию является C:\OpenToonz stuff\projects в Windows и /Applications/
OpenToonz/OpenToonz stuff/projects в Macintosh.

Примечание: Если вашим производством нужно управлять более чем на одном компьютере в сети,
вы можете совместно использовать одну и ту же базу данных проекта на всех компьютерах, которые
вы хотите, определив один и тот же корень проекта на каждом компьютере.

При необходимости также можно определить более одного rootproject: в этом случае папки rootproject
будут видны в браузере OpenToonz, каждый из которых имеет связанный путь в скобках.
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Корневая информация проекта может быть изменена в любой момент, например, если вам нужно
переместить файлы базы данных проекта с одного компьютера на другой

Совет: Чтобы установить rootproject в Windows:

1. Откройте диалоговое окно «Выполнить приложение», выбрав в меню «Пуск» пункт «Выполнить».

2. Введите regedit в текстовое поле и нажмите ОК. Откроется приложение редактора реестра.

3. Перейдите к HKEY_LOCAL_MACHINE\SOFTWARE\OpenToonz\OpenToonz и дважды щелкните
TOONZPROJECTS в правой части окна: откроется диалоговое окно «Редактировать стро-
ку».

4. Введите новый путь для rootproject.

5. Нажмите OK и выйдите из приложения редактора реестра.

6. Нажмите OK и выйдите из приложения редактора реестра.

Совет: Чтобы добавить projectroot в Windows:

1. Откройте редактор реестра, чтобы отредактировать реестр TOONZPROJECTS, как описано вы-
ше.

2. Введите путь для нового корня проекта, разделенный точкой с запятой (например,
C:\production01;D:\production02).

3. Нажмите OK и выйдите из приложения редактора реестра.

4. Нажмите OK и выйдите из приложения редактора реестра.

Совет: Чтобы установить projectroot на Macintosh

1. Щелкните правой кнопкой мыши по значку OpenToonz в папке Applications/OpenToonz и вы-
берите «Показать содержимое пакета» в открывшемся меню.

2. В открывшейся папке перейдите в папку Contents/Resources и откройте файл SystemVar.ini с
помощью приложения для текстового редактора, такого как TextEdit.

3. Look for the following line where the projectroot is defined: TOONZPROJECTS=”/Applications/OpenToonz/
OpenToonz stuff/projects”

4. Измените путь в кавычках, введя новый.
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5. Сохраните файл SystemVar.ini.

Совет: Чтобы добавить projectroot в Macintosh:

1. Откройте файл конфигурации, чтобы изменить переменную TOONZPROJECTS, как описано
выше.

2. Измените путь в кавычках, добавив новый путь для нового корня проекта, разделенного
точкой с запятой (например, /Applications/OpenToonz/OpenToonz stuff/production01 ; /
Applications/OpenToonz/OpenToonz stuff/production02).

3. Сохраните файл SystemVar.ini.

4. Нажмите OK и выйдите из приложения редактора реестра.
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6.2 Настройка проектов

Когда вы определяете новый проект, вы можете указать его папки по умолчанию, тогда как его на-
стройки по умолчанию будут унаследованы от текущего проекта. Папки и настройки по умолчанию
могут быть изменены в любое время для удовлетворения новых производственных потребностей.

Информация о проекте хранится в файле XML, названном как проект с суффиксом _otprj, в папке с
именем проекта, расположенной в projectroot (см. Настройка Projectroot).
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Проекты могут быть организованы в папки и могут содержать подпроекты, которые можно просмат-
ривать в файловом браузере OpenToonz. Это позволяет вам настраивать структуры проекта в соответ-
ствии с вашими производственными потребностями, например, создавать папку для каждого эпизода,
а затем проект для каждой сцены, принадлежащей этому эпизоду. Поскольку браузер проекта отоб-
ражает дерево проекта и все папки, содержащиеся в корне проекта, вы также можете организовать
структуру папок в корне проекта с помощью файловой системы ОС.

В браузере проекта всегда выбран один текущий проект: когда вы начинаете работать над сценой, он
автоматически принадлежит текущему проекту, наследуя его настройки и папки по умолчанию.

Если вы хотите, чтобы новая сцена была частью нового проекта, сначала вы должны определить
новый проект. Если вы хотите, чтобы он был частью ранее созданного проекта, сначала вы должны
установить этот проект в качестве текущего.

Примечание: Если вы хотите использовать ферму для рендера сцен, все серверные (рендер) узлы
фермы должны совместно использовать один и тот же projectroot (см. Установка фермы Toonz на
Windows) и все диски, содержащие базу данных проектов, должны быть доступны в сети.

Совет: Для создания нового проекта:

1. Choose File → Project Management → New Project. . .

2. Выберите projectroot или репозиторий (см. Настройка контроля версий в OpenToonz ) и проект
или папку, в которой вы хотите создать новый проект.

3. Введите имя проекта и укажите путь к папкам, которые вы хотите использовать по умолчанию.

4. Click the OK button.

Совет: Чтобы изменить текущий проект:

Нажмите маленькую круглую кнопку слева от имени проекта в дереве проекта, доступном в браузере
файлов OpenToonz. Становится красным при выборе.

Совет: Чтобы добавить сцену в проект:

1. Установите проект как текущий.

2. Choose File → New Scene.

Совет: Чтобы изменить папки проекта по умолчанию:

Select File → Project Management → Project Settings. . . and change default folders paths.

Примечание: При изменении папок по умолчанию сцены, ранее созданные в том же проекте, могут
не получить нужные файлы.
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6.3 Папки проекта по умолчанию

Проекты имеют папки по умолчанию, в которые автоматически сохраняются отсканированные рисун-
ки, нарисованные рисунки, сцены, визуализированные кадры и палитры. Эти папки являются общими
для всех сцен, созданных для этого конкретного проекта, и помечаются следующим образом:

• +input - папка, в которой сохранены все отсканированные рисунки (в виде файлов TIF).

• +drawings - это папка, в которую OpenToonz помещает очищенные рисунки, рисунки, сделанные
непосредственно в OpenToonz, и импортированные рисунки OpenToonz (файлы TLV и PLI).

• +сцены - это папка, в которую сохраняются сцены OpenToonz (файлы TNZ).

• +extras - это папка, в которой сохранены все импортированные не-OpenToonz уровни, изобра-
жения и аудиофайлы.

• +outputs - это папка, в которой сохраняются отрендеренные изображения.

• +palettes - это папка, в которой сохраняются палитры проекта палитры Studio и где хранится
палитра растровых рисунков, общая для всех растровых уровней.

Для каждой из этих папок вы можете указать различные местоположения в вашей компьютерной сети
в зависимости от того, как вы настроили хранилище вашего производственного материала.

Абсолютные или относительные пути могут быть указаны для определения папок по умолчанию.

Если вы укажете абсолютный путь, папки будут создаваться при необходимости там, где это указано.
Например, вы можете установить +drawings в C:\production\drawing01 в Windows или /Volume/
Macintosh HD/production/drawing01 в Macintosh: это означает, что OpenToonz нарисовал и очищен-
ные уровни будут автоматически сохраняться в C:\production\drawing01 в Windows или в /Volume/
Macintosh HD/production/drawing01 в Macintosh.

Если вы укажете относительный путь, все папки, которые вы укажете в пути, будут созданы, ко-
гда это необходимо, в папке проекта в выбранном корне или репозитории проекта (см. Настройка
контроля версий в OpenToonz ). Например, для проекта myproject вы можете установить +drawing
как sequence01\mydrawings: это означает, что нарисованные и очищенные уровни OpenToonz будут
автоматически сохраняться в myproject\sequence01\mydrawings папке, находящейся в выбранном
projectroot или репозитории.

Переменная $scenepath также может использоваться для автоматического создания определенных па-
пок в соответствии со сценой, над которой вы работаете. Переменная может быть либо добавлена к
указанным путям, либо использована в определении пути.

Метки папок по умолчанию, которые вы можете найти в настройках проекта (то есть +drawings,
+extras и т. д.), могут использоваться в качестве псевдонимов в OpenToonz. Например, если какой-
либо материал извлекается из дополнительной папки по умолчанию, путь ее загрузки будет содержать
псевдоним +extras. Их также можно использовать, когда необходимо указать путь сохранения, на-
пример, в поле «Путь» диалогового окна «Новый уровень».

Когда в сцене вы загружаете материал, не находящийся в папках текущего проекта, вы можете вы-
брать, следует ли импортировать файлы, то есть копировать их в соответствующие папки проекта,
или создать ссылку с внешним файлом. Ссылка определяется абсолютным путем.

Примечание: Файлы, загруженные в сцену без импорта, могут быть импортированы позже сразу же
с помощью функции «Сбор активов» (см. Сбор активов).

Примечание: Все общие диски, участвующие в определениях папок, то есть диски, на которых
производственный материал должен быть записан и прочитан, должны быть общими, предоставляя
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полные права любому пользователю, иначе обмен файлами не будет успешным. Для Windows диски
должны иметь разрешение общего доступа, установленное на полный доступ для всех; для Macintosh
настройки общего доступа должны позволять любому пользователю выполнять чтение и запись на
диски.

Примечание: Когда проект не определен, проект OpenToonz stuff/sandbox используется по умол-
чанию.

Совет: Чтобы установить папки по умолчанию для нового проекта:

Выполните одно из следующих действий:

• Введите путь к папке, которую вы хотите использовать по умолчанию.

• Используйте кнопку браузера справа от каждого текстового поля, чтобы установить папку, ко-
торую вы хотите использовать по умолчанию.

6.3.1 Добавление пользовательских папок по умолчанию

Besides the basic default folders you can also add your own default folders, and use the related aliases, by
defining a TXT file named project_folders.txt in the OpenToonz stuff\profiles folder. In this file you
can also change the order of the folders already available to change the way they are listed in the project
settings dialog.

The following is an example of a projectfolders.txt file:

inputs
drawings
backgrounds
scenes
extras
outputs
palettes
3D

где псевдонимы +backgrounds и +3D были добавлены к псевдонимам по умолчанию.

Совет: Чтобы добавить больше папок по умолчанию в проекты:

1. Откройте файл OpenToonz stuff\profile\project_folders.txt.

2. Перечислите папки по умолчанию, которые вы хотите определить, по одной на строку, и сохра-
ните файл.
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6.3.2 Использование переменной $scenepath в определении папки

Переменная $scenepath может также использоваться в определении псевдонимов +input, +drawing
и +extras при вводе пути к папке по умолчанию. В этом случае путь, по которому вы сохраняете
текущую сцену, заменит переменную $scenepath в определении пути, при этом необходимые папки
автоматически создаются в процессе сохранения.

Например, если +drawing равно $scenepath\mydrawings, ``, и вы сохраняете сцену scene01 в
``+scenes\seq01, уровни рисования или очистки OpenToonz для этой сцены будут сохраняться в
seq01\scene01\mydrawings; когда вы сохраняете сцену scene02, в seq01\scene02\mydrawings; и так
далее.

Таким образом, необходимые папки по умолчанию создаются автоматически с тем же именем
(mydrawings), по одной для каждой сцены, в соответствии с путем, использованным при сохранении
сцены. Как следствие, если переменная используется таким образом для всех псевдонимов, все файлы,
относящиеся к сцене, будут храниться в папке с именем сцены.

Второй пример: если +drawing равно mydrawings\$ scenepath, при сохранении сцены scene01
в +scenes\seq01, уровни рисования или очистки OpenToonz для этой сцены будут сохранены в
mydrawings\seq01\scene01; когда вы сохраняете сцену scene02, в mydrawings\seq01\scene02; и так
далее.

В этом случае необходимые папки по умолчанию создаются автоматически с именем и путем к пап-
кам, используемым при сохранении сцены, внутри указанного пути (mydrawings). Как следствие, если
переменная используется таким образом для всех псевдонимов, все файлы, используемые в проекте,
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будут храниться в главной папке для каждого псевдонима, содержимое которого разделено на папки,
называемые сценами.

Примечание: Определение псевдонима +palettes не может включать $scenepath, поскольку палитры
относятся ко всему проекту, а не к конкретным сценам.

Примечание: Невозможно одновременно использовать для псевдонима переменную $scenepath в
определении папки и параметр Append $scenepath.

6.3.3 Использование опции Append $scenepath

Параметр Append $scenepath доступен для псевдонимов +input **, **+drawing ** и **+extra.
Если вы активируете опцию Append $scenepath для псевдонима, путь, по которому вы сохраняете
текущую сцену, будет добавлен к пути псевдонима, при этом необходимые папки автоматически со-
здаются в процессе сохранения.

Например, если +drawing равно mydrawings , и вы сохраняете сцену scene01 в +scenes\seq01, уровни
рисования или очистки OpenToonz для этой сцены будут сохраняться в mydrawings\seq01\scene01 ;
если вы сохраните сцену scene02 в +scenes\seq01, нарисованные или очищенные уровни OpenToonz
для этой сцены будут сохранены в mydrawings\seq01\scene02 ; и так далее.
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Это позволяет OpenToonz автоматически создавать папки, связанные со сценой, при сохранении фай-
лов OpenToonz или импорте внешних файлов, а также позволяет использовать общие псевдонимы
+drawings, +inputs и +extras, независимо от того, где уровни загружаются из текущего проекта.

Примечание: Когда сцена сохраняется в папке +scenes, значение для $scenepath является именем
сцены; например, если вы сохраните сцену scene02 в +scenes, $scenepath будет scene02.

Примечание: Невозможно использовать для псевдонима опцию Append $scenepath и в то же время
переменную $scenepath при определении связанной папки.

6.4 Использование браузера проекта

Браузер проекта доступен в конце дерева браузера файлов. В нем перечислены все созданные проекты,
чье фактическое местоположение находится в корне проекта, который был определен при первоначаль-
ной установке OpenToonz. Значение Projectroot отображается в скобках.

Название папок, на которые указывают псевдонимы, отображается синим цветом.

Примечание: В случае, если определено более одного projectroot, каждый из них будет указан со
связанным значением projectroot в скобках (см. Настройка Projectroot).

6.4.1 Папки по умолчанию с относительными путями

Если папки по умолчанию определены с использованием относительного пути, в браузере проекта вы
увидите все папки, указанные в пути под корневым каталогом проекта, и дерево папок проекта будет
таким же, как и дерево файловой системы. Папки, являющиеся целью путей, отображаются синим
цветом.

Например, для проекта Project01 с +drawings, то есть section01\ prod drawing, браузер проекта
отобразит следующее:

Projects

Project01

section01 prod drawings

Если включена опция Append $scenepath, и вы сохраняете сцену scene01 в +scenes\seq01, браузер
проекта отобразит следующее:

Projects

Project01

section01

prod drawings

seq01 scene01

Если в определении папки используется $scenepath с +drawings, которые являются $scenepath\prod
drawing, и вы сохраняете сцену scene01 в +scenes\seq01, браузер проекта отобразит следующее:
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Projects

Project01

seq01

scene01 prod drawings

Если в определении папки используется $scenepath с +drawings, которые являются mydrawings\$
scenepath, и вы сохраняете сцену scene01 в + scenes\seq01, браузер проекта отобразит следующее:

Projects

Project01

prod drawings

seq01 scene01

6.4.2 Папки по умолчанию с абсолютными путями

Когда папки по умолчанию определены с использованием абсолютного пути, в браузере проекта вы
увидите только связанные псевдонимы, независимо от их расположения в сети. Таким образом, вы
можете быстро получить доступ к производственным материалам, не просматривая компьютер или
сеть. Псевдонимы отображаются синим цветом, поскольку они являются местоположением, на которое
указывают пути к папкам по умолчанию.

Например, для проекта Project01 с +drawings, то есть C:\production\prod drawing в Windows, или
/Volume/Macintosh HD/production/prod drawing в Macintosh, браузер проекта будет отображать сле-
дующее:

Projects

Project01 +drawings

где +drawing - это псевдоним C:\production\prod drawing в Windows или /Volume/Macintosh HD/
production/prod drawing в Macintosh.

Если включена опция Append $scenepath, и вы сохраняете сцену scene01 в +scenes\seq01, браузер
проекта отобразит следующее:

Projects

Project01

+drawings

seq01 scene01

If the $scenepath is used in the folder definition, with +drawings that is C:\$scenepath\prod drawings
on Windows, or /Volume/Macintosh HD/$scenepath/prod drawings on Macintosh, and you save the scene
scene01 in +scenes\seq01 , the project browser will display the following:

Projects

Project01

+scenes

scene01.tnz +drawings

с drawings, то есть C:\seq01\scene01\prod drawings в Windows, или /Volume/Macintosh HD/seq01/
scene01/prod drawings в Macintosh и находится под связанный файл сцены (формат TNZ).
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Если в определении папки используется $scenepath, с +drawing, то есть C:\prod drawing\$scenepath
в Windows, или /Volume/Macintosh HD/prod drawing/$scenepath на Macintosh, и вы сохраняете сцену
scene01 в +scenes\seq01 , браузер проекта будет отображать то же, что и выше, но на этот раз +
drawing C:prod drawingsseq01scene01‘‘ на Windows или /Volume/Macintosh HD/prod drawings/seq01/
scene01 на Macintosh.
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Глава 7

Настройка сцены

7.1 Настройки сцены и настройки проекта по умолчанию

Когда вы начинаете работать над сценой, она автоматически будет принадлежать текущему проекту,
наследуя ее настройки и папки по умолчанию. Таким образом, все сцены, принадлежащие проекту, со-
здаются с одинаковыми настройками, что обеспечивает согласованность производства (см. Управление
проектами).

Настройки касаются различных задач, которые вы можете выполнять в OpenToonz, таких как скани-
рование или очистка, размер и разрешение камеры, частота кадров, параметры вывода и т.д. Доступ
к ним можно получить в диалоговых окнах, которые можно открыть с помощью команд, доступных
в соответствующей меню; например, команды настроек сканирования и очистки доступны в меню
«Сканирование и очистка».

Настройки для определенной сцены всегда можно изменить независимо от других, и они будут авто-
матически сохранены при сохранении сцены.

Если вы хотите изменить значения по умолчанию, вы можете сохранить текущие настройки сцены по
умолчанию, чтобы все новые сцены, созданные для этого проекта, имели эти значения.

Совет: Чтобы сохранить текущие настройки сцены как настройки проекта по умолчанию:

Select File → Project Management → Save Default Settings: all the settings from the current scene will
become the project default.

7.2 Выбор рабочей единицы

Позиции, расстояния и размеры могут быть выражены в нескольких единицах измерения: дюймах,
миллиметрах, сантиметрах, полях и пикселах.

Единица поля равна половине дюйма по горизонтальном измерении, и это зависит от A/R, установлен-
ного в справочной информации о полях в диалоговом окне «Настройки сцены . . . » для вертикального
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размера (см. Использование просмотрщика). Например, если значение A/R равно 1,77778, два гори-
зонтальных поля равны дюйму, а одно вертикальное поле равно дюйму, деленному на 1,77778.

In the Files → Preferences. . . → Interface dialog you can set the following default units:

• The Unit is used to display all measures in text fields, and applied when moving or changing the size
of stage objects.

• The Camera Unit is used to display and define the camera size in the Xsheet → Camera Settings. . .
dialog (see Defining Camera Settings ).

Вы также можете выразить значения в единицах, отличных от единицы по умолчанию, введя любую из
следующих единиц и сокращений: in, inch, «, „“ (два апострофа), cm, mm, fld, field и px после входного
значения сама. Как только значение введено, оно преобразуется в единицу измерения по умолчанию.

Если используется значение без определенной единицы, оно должно быть выражено в единице по
умолчанию.

Совет: Чтобы установить рабочие единицы по умолчанию:

1. Choose File → Preferences. . . → Interface.

2. Выполните одно из следующих действий:

• In the Unit option menu choose the unit you want to use as default.

• In the Camera Unit option menu choose the unit you want to use to express the camera size.

7.3 Установка частоты кадров

Частота кадров - это количество кадров в секунду анимации, которое должно быть установлено в
соответствии с типом вывода, который вы хотите воспроизвести, например, оно обычно должно быть
24 для кинематографического производства, 25 для вывода PAL или 30 для NTSC.
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Текущую частоту кадров сцены можно установить в диалоговом окне «Настройки сцены . . . », и она
отображается в нижней панели любой панели просмотра. В случае, если воспроизведение активирова-
но, фактическая частота кадров отображается слева.

Помимо влияния на скорость воспроизведения при предварительном просмотре или рендере сцены, ча-
стота кадров также определяет количество кадров аудиофайла при его импорте в Xsheet (см. Создание
звуковой дорожки).

Even if a scene has been composited with a specific frame rate for a certain output, it is possible to render it
out at a different frame rate by using the Stretch from FPS: To: option in the Output Settings. . . → More
Settings dialog section (see Choosing the Output Settings ).

Совет: Чтобы установить частоту кадров:

1. Choose Xsheet → Scene Settings. . . → More.

2. В текстовом поле Частота кадров установите значение частоты кадров.

7.4 Определение настроек камеры

Диалоговое окно Настройка камеры. . . , которое можно открыть из меню Xsheet, содержит параметры
для определения текущего размера и разрешения камеры.

Для каждой сцены можно определить более одной камеры, чтобы иметь разные выходные разрешения
или для съемки только определенной области сцены (см. Использование схемы сцены).
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The camera frame size can be expressed in any unit, but will be visualized in the default one chosen in the
Preferences. . . → Interface dialog (see Choosing the Working Unit ).

В OpenToonz Камера определяется различными параметрами:

• Размер камеры X (ширина) и Y (высота), выраженный в Единицах камеры по умолчанию (обычно
в дюймах).

• A/R is the aspect ratio value resulting by dividing Width/Height.

• X and Y resolution Pixels of the resulting image frame seen by the camera.

• X and Y DPI values, calculated using the standard formulas: XDpi=XPx/Width, and
YDpi=YPx/Height. This two fields can be forced to have the same value, by activating the equal-
sign button between them.

При вставке значения в одно поле остальные изменяются соответственно по мере необходимости для
согласованной камеры. Вы можете решить, какой набор значений должен считаться фиксированным
OpenToonz. Кнопки в форме замка и переключатели в крайнем левом столбце параметров камеры
позволяют выбрать, какой столбец и ряд значений должны быть сохранены OpenToonz, при этом
изменяя другие при необходимости.

Кнопка «Использовать настройки текущего уровня» позволяет настроить камеру для точного кад-
рирования содержимого выбранного уровня. Просто нажмите эту кнопку, и OpenToonz рассчитает
соответствующие значения для камеры.

Разрешения камеры также могут быть выбраны из списка предустановленных настроек камеры. Вы
можете добавить любую предустановку камеры, которую вы определили, в список, а также удалить
любую предопределенную камеру из него.

Примечание: Предопределенный список камер сохраняется в файле reslist.txt, хранящемся в
projectroot (см. Настройка Projectroot).

Совет: Чтобы добавить предустановку разрешения камеры:

1. Установите разрешение и A/R для камеры, которую вы хотите сохранить.

2. Нажмите кнопку «Добавить» справа от списка предустановленных камер.

3. Присвойте имя разрешению камеры и нажмите кнопку ОК.

Совет: Чтобы удалить предустановленное разрешение камеры:

1. Выберите разрешение камеры, которое вы хотите удалить, в списке предустановленных камер.

2. Нажмите кнопку «Удалить» справа от списка предустановленных камер.
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7.5 Color Calibration using Look-up Tables

OpenToonz can manage the previsualization of color through the use of 3D Look-up Tables. By applying
a 3D LUT file, properly configured for the current display monitor, it will be possible to work on different
color spaces, such as Rec. 709, DCI-P3 or Rec. 2020.

Once a 3DLUT is active, all colors displayed on Viewer, Combo Viewer, Flipbook, Color Model, Palette,
and Style Editor will be corrected.

Примечание: Currently, only the .3dl file format is supported. It must follow specification written here.

Примечание: Currently, only the Windows version of OpenToonz can detect the currently connected
monitor. For other platforms only one 3D LUT file can be applied for any type of monitors. (Even on
Windows, connecting multiple different monitors at the same time is not supported for now. It will only
identify the first registered monitor).

Примечание: PLEASE NOTE: At the moment, using Plastic deformation together with this feature
causes a display issue such that the deformed image is not shown in Camera Stand mode of the Viewer.

Совет: To apply a 3DLUT file for previsualizing color:

1. Choose File → Preferences. . . → Interface.

2. Activate the Color Calibration using 3D Look-up Table option.

3. In the 3DLUT File for [monitor]: option, press the file browser button to navigate and select the
desired .3DL file.

4. Restart OpenToonz for the changes to take effect.
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7.6 Назначение памяти для операций отмены

All the operations performed in the software can be undone by using the Edit → Undo command, even to
go back for several steps.

Операции отмены требуют компьютерной памяти для выполнения, и некоторые из них могут требовать
больше памяти, чем другие, в зависимости от их сложности.

To prevent most of the computer memory to be used by undo operations while you work, a situation that
slows down the software performance, it is possible to set a limit for it by specifying the Undo Memory Size
(MB) in the Files → Preferences. . . → General dialog.

Как только предел достигнут, самые старые операции отмены будут отброшены, чтобы освободить
место для новых.

7.7 Оптимизация использования памяти

При работе с растровыми изображениями, которые в основном представляют собой уровни анима-
ции, сканируемые с помощью OpenToonz или GTS, может потребоваться интенсивное использование
компьютерной памяти во время процессов очистки, рисования и рендера.

After a certain amount of time the computer performance may worsen, as the memory gets fragmented
because of the several writing and reading accesses. To prevent this behavior, the Minimize Raster Memory
Fragmentation* option can be activated in the Files → Preferences. . . → General dialog. When activated, a
section of computer memory is reserved and used only for operations concerning Raster images.

Если вы работаете в основном с векторными изображениями, которые были нарисованы внутри
OpenToonz, этот параметр должен быть деактивирован, так как в противном случае раздел заре-
зервированной памяти не будет использоваться компьютером.

Примечание: Набор изменений для этой опции действителен только после перезапуска OpenToonz.
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Глава 8

Сканирование бумажных рисунков

Примечание: Currently OpenToonz DOES NOT SUPPORT the native scanning functionality, as
described in this page. Instead you can use the provided GTS scanning and cleaning software, please follow
this link to download GTS .

Примечание: Эта страница руководства сохраняется в первоначальном виде на случай, если код
сканирования OpenToonz будет активирован в следующей версии.

In order to be managed by OpenToonz, paper drawings have to be scanned into OpenToonz. Paper drawings
can be both animation levels, consisting of a large number of sequenced drawings, and other elements such
as backgrounds and overlays.

The scan process can be done in different modes, and in case autocenter is needed it has to follow specific
guidelines.

Animation levels have to be defined first and then scanned according to a defined set of parameters.

8.1 Supported Scanners

OpenToonz supports directly, by using internal drivers, some specific scanners via a USB connection; all the
other scanners are supported via any type of connection by using TWAIN drivers.

81

https://opentoonz.github.io/e/download/gts.html


OpenToonz Documentation, Выпуск 1.7.1

Примечание: For an updated list of directly supported scanners, please visit the OpenToonz Web site .

If your scanner is supported via internal drivers, the scanning process is managed completely by OpenToonz
and the Scan Settings dialog; if it is not, the scanning process is managed by the TWAIN interface.

On Windows, the TWAIN drivers provided with the scanner need to be installed. Note that if you decide
to use internal drivers, you have to disable the Windows Image Acquisition (WIA) service on your
computer; if you want to use TWAIN drivers, you have to enable it.

On macOS, you need to install the TWAIN drivers only if you are going to use them. Note that if you decide
to use internal drivers, any TWAIN driver referring to that scanner has to be removed.

The driver you want to use must be selected according to your scanner before starting the scanning process.
You can choose whether to use the internal or TWAIN drivers; in the latter case, you have to select which
driver to use from a list based on the TWAIN drivers installed on your computer.

Примечание: When using TWAIN drivers you need to specify the driver every time you restart
OpenToonz: the dialog box is automatically displayed when you select any Scan related command.

Совет: To install TWAIN drivers:

Refer to the scanner documentation for more details.

Совет: Windows only - To disable or enable the Windows Image Acquisition (WIA) service:

1. Open the Control Panel → Administrative Tools → Services dialog.

2. Right-click the Windows Image Acquisition (WIA) service and choose Properties from the menu
that opens.

3. In the Properties dialog do one of the following:

• Set the Startup Type option to Disabled to use internal drivers.

• Set the Startup Type option to Automatic to use TWAIN drivers.

4. Restart the computer.

Совет: Macintosh only - To remove the scanner TWAIN drivers:
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Refer to the scanner documentation for more details.

Совет: To define the scanner:

1. Choose Scan & Cleanup → Define Scanner. . . .

2. Do one of the following:

• If your scanner is directly supported, choose Scanner Driver → Internal, and click the OK button.

• If your scanner is not directly supported, be sure that TWAIN drivers are installed, and choose Scanner
Driver → TWAIN, and click the OK button: in the dialog that opens, select the TWAIN driver related
to your scanner.

8.2 Scanning Modes

Drawings can be scanned mainly in three different modes: black and white, greyscale and color.

The first two modes can be used to acquire standard lineart drawings whose outline is usually made in a
single color, that during the scanning is acquired as black or dark grey. Even if the outline color is lost during
the scanning, later on you can assign one or more colors to it during the painting process.

Black and white scanning gives you the most immediate results, and fewer parameters need to be set.
Once a Threshold: value is set, pixels of the scanned image are considered as either black or white. Due
to the simplicity of this concept, less time is required to scan the image, and scanned files are lighter to
manage. Even if images show hard edges, the proper antialiasing will be added during the cleanup process.

Greyscale scanning, being based on a range of grey values, requires a longer scanning time. Determining
Brightness: and Contrast: parameters depends considerably on the individual animated sequence and on
what you want to achieve. The greyscale mode also offers Autoadjust options during the cleanup process,
useful to even the differences between drawings made by key animators and those made by in-betweeners.
See Autoadjusting Greyscale Lineart Drawings .

Color scanning is for scanning colored lineart and other colored images as backgrounds and overlays. Using
colors in lineart allows you to draw different lines with different colors, for example a character outline
in black and its body shadow in red or in blue. As colored lines can be identified later during the cleanup
process, scanning colored artwork in colors allows you to preserve different line colors with no need of intensive
painting work. See Processing Colored Lineart Drawings .

8.3 Scanning Guidelines for Autocentering

To autocenter scanned drawings during the cleanup process, the pegbar holes need to be detected on the
images (see Autocentering ). For this reason they have to be scanned in black, by properly preparing the
scanner and performing the scanning process according to the following guidelines.

8.3.1 Preparing Scanners

• If you use the scanner automatic paper feeder, you should stick a piece of thin black tape in the feeder
on the opposite side of the scanner lamp. Be sure to stick the black tape in a position to face the peg
holes when the paper is fed into the scanner.
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• If you use the scanner bed, you should place a black sheet of paper under the scanner cover, so that
when a drawing is scanned facing down the glass of the scanner bed, the black paper will be behind it.
The black paper must be larger than your animation paper, but it does not have to cover the entire
scanner bed.

8.3.2 Scanning Artwork

• It is better to use quite thick animation paper for your artwork: very thin paper may jam the scanner,
and the scanner light may pass through picking up some grey from the black paper or tape placed
behind it. When this happens, the process will take longer to perform and will produce a poor quality
result.

• Avoid using black or colored paper reinforcements around the pegbar holes in your drawing sheets. The
scanner has to read the exact shape of the hole punches, and colored reinforcements may cause holes to
be scanned larger than their actual size. If you do use white reinforcements, make sure they are aligned
directly over the peg holes: if the holes are slightly covered by the reinforcement, the registration may
fail.

• Do not draw too close to the pegbar holes. Avoid drawing anything with the same shape or area of the
pegbar hole in the pegbar holes area; leave at least 1 cm (~1/2”) of clear space between the pegbar
holes and the rest of your drawings. Lines drawn near the pegbar holes may cause the registration to
fail.

8.4 Defining Animation Levels to Scan

To scan an animation level, first you have to define its name, the number of frames it is made of, and the
way its drawings are numbered. Its size and resolution will be set during the scanning session.

The definition can be made drawing by drawing directly in the Xsheet/Timeline, or at once by using the
New Level dialog. You can assign it the name and the numbering order you prefer.

In case you use the New Level dialog you can set the number of drawings the level is made of, the animation
step to expose the level repeating its frames, and the increment, that sets the way the level drawings are
numbered. For example a Step: value 2 repeats each drawing twice in the Xsheet column (or Timeline layer),
while an Increment: value 2 numbers the drawings 1, 3, 5, etc.
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By default scanned drawings are saved in the +inputs directory of the current project; if the +inputs
definition uses the $scenepath variable, they are saved only if the scene is saved (see Project Default Folders
).

You can change the location by using either the Path: field in the New Level dialog, or the Level Settings
window in case you define a level directly in Xsheet/Timeline.

Settings such as the length of the level and the numbering order can be edited later, as you are free to
arrange the images composing your animation level the way you prefer (see Editing Animation Levels ).

When an animation level is defined, the name and numbers for the drawings of the level are displayed in red
as no level actually exists yet; the column/layer cells where the level is exposed are colored in light blue, the
color denoting full-color images (see Working with Columns/Layers ).

Совет: To define an animation level directly in Xsheet:

1. Double-click a cell, then type a name and a number; the name and the number must be separated by
a space.

2. Press Enter to add a new drawing, and type a different number that will be assigned to the new
drawing.

3. Go on adding all the drawings you need.

4. Click a different cell to end the process.

Совет: To define an animation level with the New Level dialog:

1. Do one of the following:

8.4. Defining Animation Levels to Scan 85



OpenToonz Documentation, Выпуск 1.7.1

• Select a cell in the Xsheet/Timeline where you want to place your animation level to scan and choose
Level → New → New Level. . .

• Right-click the cell in the Xsheet/Timeline where you want to place your animation level to scan and
choose New Level from the menu that opens.

Примечание: If any level is already exposed in the cell column/layer, it will shift down/right from the
cell you selected on.

2. In the New Level dialog choose Scan Level from the Type: option menu and define its settings, then
click the OK button.

Совет: To define the saving location for the level to be scanned:

Do one of the following:

• If you are using the New Level dialog, type in the Path: field, or use the browser button, to set the
path for the saving location.

• If you are defining the level directly in Xsheet/Timeline, right-click the level cells and select Level
Settings from the menu that opens. In the Level Settings window, type in the Path: field, or use the
browser button, to set the path for the saving location.

Примечание: If in the browser you choose any project default folder, in the Path: field the full path will
be replace by the related default folder alias (see Project Default Folders ).

8.5 Scanning Drawings

According to the driver you are using, internal or TWAIN, the scanning process will be controlled either by
the Scan Settings dialog or the TWAIN interface.

The Scan Settings dialog allows you to define the following:

• Paper Format sets the size for the drawings to be scanned. The option menu contains a list of already
defined formats.
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• Reverse Order makes the scanning process in a reverse order, starting from the last selected frame
to the first one.

• Paper Feeder lets the scanner use the automatic document feeder, in case the scanner has one, to
scan all the selected drawings without having to insert one image at a time into the scanner.

• Mode is for setting the scanning mode among: Black and White, Greyscale and Color.

The TWAIN interface is related to the scanner you are using and will be available only when the TWAIN
drivers, provided with the scanner, are installed on your computer. Refer to the scanner documentation for
more details.

Примечание: The Scan Settings dialog can be used in combination with the TWAIN interface settings to
set the Reverse Order option.

The settings, either defined in the Scan Settings dialog or in the TWAIN interface, will be used to scan
the drawings selected in the Xsheet/Timeline. In case you select several drawings, and you are using the
scanner paper feeder, all the drawings to be scanned will be taken from the feeder; if you are not using the
paper feeder, you will be prompted to replace the drawing on the scanner bed, before scanning the following
drawing.

You can also select non-consecutive drawings and drawings from different animation levels. Levels will be
scanned starting from the first selected column/layer. Only exposed drawings will be scanned according the
level numbering order, regardless of the way the animation level is exposed in one or several Xsheet columns
(or Timeline layers). The opposite order will be followed if the Reverse Order option is on.

As soon as a drawing is scanned, it is saved and its name and number displayed in the Xsheet/Timeline turn
black, as the level now has physical drawings saved on disk.

Images are saved as compressed TIF files with a progressive four-digits number written between the file
name and the file extension, e.g. animation.0001.tif , animation.0002.tif , etc. They are displayed in
the OpenToonz browser with a double dot before the file extension, e.g. animation..tif .

If you need to scan again an animation level, or a part of it, select the relevant drawings and scan them
again. Drawings can be also inserted by editing the level sequence (see Renumbering and Adding Frames in
a Level ).

Совет: To scan an animation level:

1. In the Xsheet/Timeline, select the drawings you want to scan.

2. Choose Scan & Cleanup → Scan Settings. . . and use the dialog to control scan options.

3. Do one of the following:

• If you are using the internal drivers, choose Scan & Cleanup → Scan: the selected drawings will be
scanned and automatically saved.

• If you are using the TWAIN drivers, choose Scan & Cleanup → Scan, and guide the scanning process
by using the TWAIN interface that opens: the selected drawings will be scanned and automatically
saved.

4. In case you selected several drawings, do one of the following:

• If you are using the scanner paper feeder, wait for all of the drawings to be scanned.

• If you are not using the paper feeder, you will be prompted to replace the drawing on the scanner bed,
before scanning the following drawing.
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Примечание: After a drawing is scanned, or several drawings are scanned at once by using the paper feeder,
in some TWAIN interfaces you may need to use a specific command (such as Back to Application) to
return to OpenToonz before proceeding with the next scanning session. Refer to the scanner documentation
for more details.

8.5.1 Setting the Cropbox

When using directly supported scanners it is possible to define a cropbox smaller than the paper format
to optimize the scanning process. When the cropbox is set the final scanned image will be the size of the
selected paper format, but only the area defined by the cropbox is actually scanned, thus speeding up the
scanning operations.

Once defined the cropbox will be used for any scanning performed for the scene.

Примечание: The cropbox size information is not saved along with the scene file; it is also automatically
reset when working on a new scene.

Совет: To define the scanning cropbox:

1. Choose Scan & Cleanup → Set Cropbox: the drawing currently placed in the scanner is scanned and
the cropbox is displayed in red.

2. Use the handles along the cropbox to set its size, and click and drag anywhere to change its position.

Примечание: The cropbox default size is the same as the size of the scanned image.

Примечание: The cropbox cannot be moved outside the area of the scanned image.

Совет: To use the defined cropbox when scanning:

Scan drawings after defining the cropbox size (see above ).

Совет: To dismiss the scanning cropbox visualization:

Choose Scan & Cleanup → Set Cropbox.

Совет: To reset the scanning cropbox:

Choose Scan & Cleanup → Reset Cropbox.

88 Глава 8. Сканирование бумажных рисунков



Глава 9

Очистка отсканированных рисунков

Чтобы быть нарисованными и отредактированными с помощью OpenToonz, отсканированные рисун-
ки должны пройти процесс очистки. Процесс включает в себя автоматическое выравнивание, чтобы
выровнять каждый рисунок в соответствии с отверстиями pegbar; обработка строк, распознавание
контура рисунка; обрезка и изменение размера изображения, чтобы рисунки подходили камере.

В процессе создается уровень растра Toonz (формат TLV) и соответствующая палитра по умолчанию
(формат TPL), где будут храниться стили, используемые для рисования уровня.

Примечание: If the computer performance slows down during the cleanup process of very high resolution
images, try activating the Minimize Raster Memory Fragmentation option in the Files → Preferences. . .
→ General dialog (see Optimizing the Memory Usage ).
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9.1 Настройки очистки
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Процесс очистки можно контролировать с помощью параметров очистки, которые включают настрой-
ки очистки, обработки и камеры.

Обычно настройки определяются и проверяются для одного из рисунков уровня, а затем применяют-
ся ко всему уровню анимации. Если все рисунки в сцене имеют одинаковые характеристики, весьма
вероятно, что для каждого рисунка могут использоваться одни и те же настройки на всех уровнях
анимации.

Совет: Чтобы определить настройки очистки:

Choose Scan & Cleanup → Cleanup Settings. . . and use the dialog to control the cleanup process
parameters and options.

9.1.1 Определение настроек очистки

Настройки очистки устанавливают информацию автоматическое выравнивание и некоторые геометри-
ческие преобразования.

Автоматическое выравнивание

The Autocenter option aligns lineart drawings and full-color images according to the shape and position of
the pegbar holes, in order to set the correct registration for them, once they are used in an animation scene.

Отверстия штифтов должны быть правильно включены во время процесса сканирования, чтобы их
можно было распознать во время процесса (см. Руководство по сканированию для автоматического
выравнивания).

В случае сбоя автоматического выравнивания из-за невозможности правильно распознать отверстия
штифтов отображается сообщение об ошибке; все же рисунки и изображения обрабатываются в соот-
ветствии с другими заданными параметрами.

Настройки автоматического выравнивания следующие:

• Autocenter, when activated, triggers the autocenter process.

• Pegbar Holes, sets the side of the drawing along which holes should be detected.

• Field Guide, specifies the size of the reference field guide that has to be used to set the center of the
processed drawings and images, and the type of pegbar holes that have to be detected (such as Acme
or Oxbry).

Совет: Чтобы проверить автоматическое выравнивание на выбранном рисунке:

1. Activate the Autocenter option.

2. Set the side where Pegbar Holes have to be detected.
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3. Set the Field Guide to be used as reference to set the center in the correct place, and to match the
shape of the pegbar holes.

4. Choose Scan & Cleanup → Preview Cleanup to preview the process in the Viewer.

Другие параметры очистки

Панель «Очистка» содержит также другие параметры, которые можно активировать независимо от
автоцентра, поскольку они влияют на обработанные изображения, даже если параметр Автоцентр не
активирован. Параметры следующие:

• Rotate, rotates the image by 90° steps clockwise. It can be used to set the right orientation for images
scanned with a different direction in order to fit the scanner bed.

• Flip, mirrors the image horizontally, vertically or both, according to the activated options. It can be
used, for example, when processing a shadow level drawn on the other side of the paper where the
character level is drawn, in order to match the two animation levels later.

• Save In, lets you define the folder where the cleaned up drawings are saved. By default it is set to the
+drawings default folder of the current project (see Project Default Folders ).

9.1.2 Определение настроек линий обработки

The Processing parameters set the line processing options in order to prepare drawings for the painting
process, recognizing black lines (in black and white or grayscale lineart drawings), or colored lines (in colored
lineart drawings).

Совет: Чтобы установить тип обработки линий:

Set the Line Processing option to None, if no line processing is required, Greyscale, if lines have to be
recognized as black, or Color, if lines have to be recognized as colored ones.
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Обработка черно-белых или рисунков в оттенках серого

Для черно-белых или в оттенках серого линейных рисунков доступен набор настроек для калибровки
процесса распознавания черной линии.

Результат процесса можно предварительно просмотреть в главном просмотрщике OpenToonz (см. Пред-
варительный просмотр процесса очистки).

Параметры следующие:

• Antialias:, can be set to Standard, None or Morphological. Use Standard to keep the antialias
resulting from current camera and defined settings. Use None to eliminate the antialiasing from the
processed line, so that the resulting line will be fully solid with no semi-transparent pixels that smooths
its edges. Use Morphological to replace the standard antialias with one obtained by analyzing the
image edges.

• Autoadjust, corrects the levels of grey in the drawings in order to avoid darker and lighter drawings
in a sequence (see Autoadjusting Greyscale Lineart Drawings ). (NOTE: This feature is currently not
available in OpenToonz).

• Sharpness:, defines how sharp the processed lines will be. Higher values produce sharper, harder lines,
and lower values create smoother lines.

• Despeckling:, removes small spots or marks from the processed images. Its value expresses the size
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in pixels of the side of the maximum area that has to be removed. The spots and marks removed by
this option can also be checked by activating the Opacity Check (see Using the Opacity Check ).

• MLAA Intensity:, sets the intensity of the morphological antialias. The higher the value the more
blurred the line. (It is available only when Morphological is selected).

• Brightness:, controls the thickness of the recognized line: the lower the value, the thicker the line.

• Contrast:, controls the antialiasing of the recognized line: a higher value produces more solid pixels,
a lower value lines with more antialiased pixels. The amount of antialiasing can also be checked by
activating the Opacity Check (see Using the Opacity Check ).

Примечание: If the Antialias is set on None or Morphological, the Contrast: parameter will
become deactivated.

Совет: Чтобы настроить линии обработки для черно-белых или в оттенках серого рисун-
ков:

1. Activate the Line Processing → Greyscale option.

2. Задайте параметры в соответствии с вашими потребностями.

3. Предварительный просмотр результатов процесса очистки (см. Предварительный просмотр про-
цесса очистки).

Автоматическая настройка рисунков в оттенках серого

Примечание: The Autoadjust clean-up options explained here are currently unavailable in OpenToonz.
There is no certainty about its reinclusion at a later version or not. If you judge them to be useful for
your workflow, you could file an Issue about that in the OpenToonz“ GitHub repository or in the various
OpenToonz forums.

The Autoadjust option available among the Cleanup parameters allows you to even the differences between
drawings made by key animators and those made by in-betweeners by adjusting the line darkness of all of
the level drawings.

Примечание: The Autoadjust option has effect only on drawings scanned in greyscale mode, while it
has no effect on drawings scanned in black and white.

Доступны три различных алгоритма автоматической настройки:

• Black Eq, computes the average of the darkest grey tone found in drawing lines below a certain
threshold and sets this value to the conventional black level, so that grey levels of each image are
automatically adjusted.

• Histogram, makes a histogram of the grey levels of the first image and equalizes the histograms of
the following images according to it. It works well when the content of the images (apart from line
darkness) does not vary too much across the level.

• Histo-L, takes into account the number of lines in each image to normalize the histogram of grey levels,
before the histogram equalization is performed. This is useful for example when a character becomes
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bigger or smaller in an animated level, or when parts of the character are animated independently in
some frames.

Примечание: The advantage of the Histo-L mode over the others is that it adjusts the grey levels of
each image independently, while the other algorithms equalize each image to make it look like the first one
of the level.

Only the effects of the Black Eq process can be checked using the Scan & Cleanup → Cleanup Preview
command; the effects of Histogram and Histo-L are only visible selecting a sequence of at least two
frames (i.e. one as reference frame and the others to be auto-adjusted) and processing them using the Scan
& Cleanup → Cleanup command. You may need to make a few trials using different algorithms before
obtaining the desired results.

Примечание: Эти алгоритмы работают с областью рисунка, указанной в текстовых полях поля, за
исключением края границы 5 мм. Таким образом, можно провести любую линию, чтобы ограничить
камеру, снятую на бумаге, и отверстия штифтов не влияют на результат.
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Обработка цветных линейных чертежей
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Для цветных линейных рисунков доступен набор параметров для калибровки процесса распознавания
линий и для определения того, какие и как цвета должны обнаруживаться на чертежах (см. Опреде-
ление цветов для обработки цветных линий).

Для всех очищаемых цветов вы можете определить цвет, который будет автоматически назначаться
линиям после обработки, без необходимости рисовать их. Два цвета, один из которых используется
для распознавания, а другой назначается распознанным линиям, доступны в нижней части панели
Редактора стилей.

Различные параметры доступны для черного цвета, который обычно определяет основной контур на
линейных чертежах, и для дополнительных цветов, которые обычно определяют специальные контуры
для таких областей, как тени и блики.

Результат процесса можно предварительно просмотреть в главном просмотрщике OpenToonz (см. Пред-
варительный просмотр процесса очистки).

Общие параметры следующие:

• Antialias:, can be set to Standard, None or Morphological. Use Standard to keep the antialias
resulting from current camera and defined settings. Use None to remove the antialiasing from the
processed line, so that the resulting line will be fully solid with no semi-transparent pixels smoothing
its edges. Use Morphological to replace the standard antialias with the one obtained by analyzing
the image edges.

Примечание: If the Antialias is set to None or Morphological, the Contrast parameter will
become desactivated.

• Sharpness:, defines how sharp the processed lines will be. Higher values produce sharper, harder lines,
and lower values create smoother lines.

• Despeckling:, removes small spots or marks from the processed images. Its value expresses the size
in pixels of the side of the maximum area that has to be removed. The spots and marks removed by
this option can also be checked by activating the Opacity Check (see Using the Opacity Check ).

• MLAA Intensity:, sets the intensity of the morphological antialias. The higher the value the more
blurred the line. (It is available only when Morphological is selected).

В списке цветов параметры для черного цвета следующие:

98 Глава 9. Очистка отсканированных рисунков



OpenToonz Documentation, Выпуск 1.7.1

• Brightness:, controls the thickness of the recognized line: the lower the value, the thicker the line.

• Contrast:, controls the antialiasing of the recognized line: a higher value produces more solid pixels,
a lower value lines with more antialiased pixels. The amount of antialiasing can also be checked by
activating the Opacity Check (see Using the Opacity Check ).

• Color Threshold:, sets pixels that have to be considered as black and those that have to be considered
as colors: the higher the value, the higher the number of pixels that will be considered as colored.

• White Threshold:, sets pixels that have to be considered as white, for example to eliminate the paper
color: the higher the value, the higher the number of pixels that will be considered as white.

В списке цветов параметры для других цветов следующие:

• Brightness:, controls the thickness of the recognized colored line: the lower the value, the thicker the
line.

• Contrast:, controls the antialiasing of the recognized colored line: a higher value produces more solid
pixels, a lower value lines with more antialiased pixels. The amount of antialiasing can also be checked
by activating the Opacity Check (see Using the Opacity Check ).

• H Range:, sets the range of the hue for color recognition: the higher the value, the higher the number
of differently colored pixels that will be associated to the defined color.

• Line Width:, sets the width of the recognized colored line: the higher the value, the higher the number
of desaturated pixels that will be associated to the defined color, thus increasing the line thickness.

Совет: Чтобы настроить обработку линий для цветных чертежей:

1. Activate the Line Processing → Color option.

2. Определите общие параметры в соответствии с вашими потребностями.

3. Определите цвета, которые вы хотите обнаружить на рисунках (см. Определение цветов для
цветовой линии обработки).

4. Определите параметры цвета в соответствии с вашими потребностями.

5. Предварительный просмотр результатов процесса очистки (см. Предварительный просмотр про-
цесса очистки).

Определение цветов для цветной обработки линии

The colors used to recognize and process drawing lines when doing color line processing can be defined by
using the style editor or picking color values directly from the drawing you want to process.

It is possible to add colors to the list, or remove them if they are not needed anymore. The maximum number
of color you can define is 7 (black included).

Примечание: Первый цвет списка, то есть черный цвет, не может быть отредактирован или удален.

Совет: Чтобы определить цвета:

1. Выберите цвет, который вы хотите определить, в списке, доступном в параметрах обработки.

2. Определите цвет, выполнив одно из следующих действий:

• Use the Style Editor (see Editing Styles ).
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• Use the RGB Picker tool ( ) to pick the value of the line color from the drawings visible in the
Viewer (see Plain Colors ).

Совет: Чтобы определить цвета, которые будут назначены линиям после очистки:

1. Выберите цвет, для которого вы хотите определить цвет постобработки.

2. В нижней части редактора стилей выберите квадрат справа от текущего цвета: это цвет, который
будет назначен после завершения обработки.

3. Отредактируйте цвет в редакторе стилей.

Совет: Чтобы добавить цвет в список цветов:

Click the + button available under the color list.

Совет: Чтобы удалить цвет из списка цветов:

1. Выберите цвет, который вы хотите удалить из списка.

2. Click the - button available under the color list.

9.1.3 Определение камеры

Настройки камеры определяют размер и разрешение камеры, которая используется для обрезки и
изменения размера рисунков в процессе очистки, чтобы подготовить и оптимизировать их для сцены.
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For example if the cleanup camera is 1920x1080 pixels (HD 1080) with a 16 field size, the cleaned up drawings
will be cropped according to the 16 field size and will have the resolution of 1920x1080 pixels.

Определение камеры очистки аналогично определению камеры сцены (см. Определение настроек ка-
меры). Обычно две камеры имеют одинаковые настройки, но иногда вам может потребоваться опре-
делить камеру очистки, которая больше, чем сценическая камера, особенно если вы хотите, чтобы
область границы рисунков выходила за пределы кадра.

Вы также можете установить другие параметры и опции:

• The Closest Field parameter (NOT AVAILABLE in OpenToonz) defines the smallest field size you
will zoom into the drawing, with the camera when compositing the scene. This value is meaningful if
it is smaller than the camera field size, as it increases the final image resolution, preventing zoomed-in
images from appearing jagged. For example if the cleanup camera is 1920x1080 pixels (HD 1080) with
a 16 field size and the Closest Field is set to 8, the cleaned up drawings will have to be of twice the
camera resolution, that is 3840 by 2160 pixels, so that when the camera closes up, the original image
pixel resolution is preserved.

• The X and Y offset parameters shift the camera position, in case you want to define for the drawings
a center different from the one automatically set by the reference field guide when the Autocenter is
on, or different from the actual center of the image if the Autocenter is off ; after the cleanup, the
camera center will be the new center for the processed drawings.

The cleanup camera size, resolution and offset can also be graphically controlled in OpenToonz’s main Viewer
when checking the cleanup process with the Camera Test mode (see Using the Camera Test ).

9.1.4 Сохранение и загрузка настроек очистки

Cleanup settings can be saved as CLN files in order to be loaded back and used in a different scene.

Они также могут быть связаны конкретно с уровнем анимации, сохраняя их в том же месте и с тем
же именем уровня: таким образом, настройки будут автоматически отображаться при выборе уровня
и использоваться каждый раз при очистке уровня.

Загруженные параметры очистки также могут стать настройками по умолчанию для сцены или про-
екта (см. Настройки сцены и Настройки проекта по умолчанию).

Совет: Чтобы сохранить настройки очистки:

1. Select an empty cell in the Xsheet/Timeline.

2. Click the Save Settings button in the bottom bar of the Cleanup Settings window.

3. In the browser that opens choose for the CLN file a location and name, and click the Save button.

Совет: Чтобы загрузить сохраненные настройки очистки:

1. Select an empty cell in the Xsheet/Timeline.

2. Click the Load Settings button in the bottom bar of the Cleanup Settings window.

3. In the browser that opens retrieve the CLN file you want to load, and click the Load button.
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Совет: Чтобы сохранить текущие настройки очистки для определенного уровня:

1. Select any cell where the level is exposed in the Xsheet/Timeline.

2. Click the Save Settings button in the bottom bar of the Cleanup Settings window.

3. In the browser that opens save the CLN file in the same location and with the same name as the level,
and click the Save button.

Совет: Чтобы загрузить настройки очистки для определенного уровня:

1. Select any cell where the level is exposed in the Xsheet/Timeline.

2. Click the Load Settings button in the bottom bar of the Cleanup Settings window.

3. In the browser that opens retrieve the CLN file you want to load, and click the Load button.

4. Click the Save Settings button and in the browser that opens save the CLN file in the same location
and with the same name as the level, and click the Save button.

Совет: Чтобы восстановить настройки очистки по умолчанию для сцены:

Click the Reset Settings button in the bottom bar of the Cleanup Settings window.

9.2 Проверка процесса очистки

При определении параметров очистки можно предварительно просмотреть процесс полной очистки
или выполнить только тест камеры, чтобы проверить результат перед выполнением окончательной
очистки.

9.2.1 Предварительный просмотр процесса очистки

The full cleanup process can be checked in the main Viewer.

Предварительный просмотр процесса очистки в главном окне просмотра

A cleanup preview can be activated in the main viewer to display the drawing selected in the Xsheet/Timeline
as it will be after the real cleanup process according to the defined cleanup settings, displaying at the same
time all the other drawings and images exposed in the Xsheet/Timeline at that frame.

Если вы измените какой-либо параметр в настройках очистки, предварительный просмотр автомати-
чески обновится, чтобы показать, как изменения влияют на процесс

Примечание: The Opacity Check when activated, affects also the cleanup preview in the main Viewer
(see below ).
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Примечание: The Preview Cleanup and the Camera Test checks cannot be activated at the same
time: when one is activated the other one is automatically deactivated.

Совет: To activate the cleanup preview in the main Viewer:

In the Xsheet/Timeline select the scanned drawing you want to preview, and choose Scan & Cleanup →
Preview Cleanup.

Совет: To deactivate the cleanup preview in the main Viewer:

Choose Scan & Cleanup → Preview Cleanup.

Совет: Для предварительного просмотра другого рисунка:

Select it in the Xsheet/Timeline.

Совет: Чтобы выйти из режима очистки предварительного просмотра:

Choose Scan & Cleanup → Preview Cleanup to deactivate it.

Использование Opacity Check

When calibrating the line processing it is important to check the amount of antialiasing along the drawing
outline to understand how smooth the result will be, and to check the small spots and marks that are
removed from the drawing because of the Despeckling: function (see Defining Line Processing Parameters
).

The Opacity check, when activated, displays fully solid pixels in black, and semi-transparent pixels
belonging to the line antialiasing in red ; moreover pixels that will be removed because of the Despeckling:
function are displayed in green.

The check is visible both in the preview area (NOT AVAILABLE in OpenToonz) of the Cleanup Settings
pane, and with the Preview Cleanup mode, in the main Viewer.

Совет: Чтобы активировать и деактивировать Opacity check:

Choose Scan & Cleanup → Opacity Check or press its default shortcut Alt + 1.

9.2.2 Использование тестирования камеры

The Camera Test can be used to check the cleanup process as concerning the Cleanup and the Camera
parameters. It displays the drawing selected in the Xsheet/Timeline directly in the Viewer without line
processing but with the position modified according to the Cleanup parameters (Autocenter, Rotate and
Flip), and the size modified according to the Camera parameters. In particular a red box displays how the
cleanup camera will crop the drawing, and a blue box displays the camera Closest Field.
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It is possible to modify the camera box directly in the Viewer thus updating the cleanup camera information
visible in the Cleanup Settings dialog (see Defining Camera ).

Если вы измените какой-либо из настроек очистки или камеры, тест камеры автоматически обновится,
чтобы показать, как изменения влияют на процесс.

Примечание: The Preview Cleanup and the Camera Test checks cannot be activated at the same
time: when one is activated the other one is automatically deactivated.

Совет: Чтобы активировать тестирование камеры:

In the Xsheet/Timeline select the drawing you want to preview, and choose Scan & Cleanup → Camera
Test.

Совет: Чтобы отключить тестирование камеры:

Choose Scan & Cleanup → Camera Test.

Совет: To modify the cleanup camera directly in the Viewer:

Выполните любое из следующих действий:

• Operate the handles on the top and right edges to scale the camera size horizontally or vertically, thus
changing the camera A/R as well.

• Используйте ручку в верхнем правом углу, чтобы масштабировать размер камеры, сохраняя при
этом A/R.

• Activate the DPI Lock in the cleanup camera parameters, and operate the handles to scale also the
camera resolution (NOT AVAILABLE in OpenToonz).

• Move the camera box to modify the cleanup camera X and Y offset.

Совет: Чтобы выполнить тест камеры на другом рисунке:

Select it in the Xsheet/Timeline.

Совет: Чтобы выйти из режима тестирования камеры:

Choose Scan & Cleanup → Camera Test to deactivate it.

9.3 Очистка рисунков

Как только настройки очистки определены и процесс проверен, можно очистить все чертежи сцены
или их выбор.

Рисунки могут быть обработаны непосредственно внутри сцены после выполнения выбора, или они
могут быть обработаны автоматически в пакетном режиме.
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В обоих случаях они будут очищены в соответствии с настройками очистки, определенными для сцены,
если только не был сохранен конкретный файл CLN для любого из уровней анимации в сцене.

By default cleaned up drawings are saved in the +drawings directory of the current project (see Project
Default Folders ), but you can change the location by using the Save In option available in the cleanup
settings dialog.

Очищенные уровни анимации сохраняются в виде файлов TLV; соответствующие палитры сохраняются
в том же месте и с тем же именем уровней анимации, что и файлы TPL.

It is also possible to automatically create a backup copy of the cleaned up drawings that will be stored in a
subfolder named nopaint inside the same location where the cleaned up drawings are saved. In this way it
will be possible to retrieve the original drawing in case some mistakes (e.g. a deletion of a drawing section)
are made during the painting process.

Совет: Для автоматического создания резервной копии очищенных рисунков:

1. Choose File → Preferences. . . → Drawing.

2. Activate the Keep Original Cleaned Up Drawings As Backup option.

Совет: Чтобы вернуться к исходным вычищенным рисункам:

1. In the Level Strip select the drawings you want to revert (see Using the Level Strip ).

2. Выполните одно из следующих действий:

• Choose Level → Revert to Cleaned Up.

• Right click the selection and choose Replace level → Revert to Cleaned Up from the menu that
opens.
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9.3.1 Очистка рисунков непосредственно в сцене

При очистке рисунков непосредственно в сцене можно выполнить выборку рисунков и обработать их
с текущими настройками очистки. В этом случае вы также можете управлять процессом покадрово,
так как вам предлагается выбрать действие для каждого чертежа выбора.

You can also select non-consecutive drawings and drawings from different animation levels. Levels will be
processed starting from the first selected column/layer, considering only exposed drawings according to their
numbering order.

When a drawing is cleaned up, its cell color turns from light blue to green, the color denoting Toonz raster
levels (see Working with Xsheet Columns ). If you cleanup partially an animation level, the remaining cells
where the level is exposed will have a double color (green and blue), to stress the fact that the level is partially
processed.

Когда рисунки, принадлежащие к частично обработанным уровням, выбраны для очистки, вам будет
предложено очистить выбранные рисунки, перезаписав предыдущую очищенную версию, или добавить
неочищенные кадры к существующему уровню, или удалить существующий уровень и создать новый
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уровень только с выбранными рисунками.

При желании вы также можете вернуться к отсканированной версии очищенного вами уровня с помо-
щью диалогового окна «Настройки уровня» (см. Редактирование настроек уровня).

Примечание: Если вы хотите создать новый уровень TLV из уже очищенного уровня, вы можете вы-
брать его и снова запустить очистку. Появится всплывающее окно с вопросами, в котором вы сможете
задать другое имя для нового уровня TLV, добавив суффикс.

Совет: Для обработки выбора в соответствии с выбранными настройками:

1. In the Xsheet/Timeline select the drawings you want to process.

2. Choose Scan & Cleanup → Cleanup.

3. В диалоговом окне «Очистка» для каждого чертежа выберите один из следующих вариантов:

• Cleanup: the current drawing will be cleaned up.

• Skip: the current drawing will not be cleanup up and the dialog displays the next drawing.

• Cleanup All: all the selected drawings will be cleaned up without further prompts.

• Cancel: the cleanup process will be interrupted.

Совет: Чтобы вернуться к отсканированной версии очищенного уровня:

1. Выберите любой рисунок очищенного уровня.

2. Choose Level → Level Settings. . .

3. Copy the Scan Path: information, and paste it in the Path: text field.

9.3.2 Очистка рисунков в пакетном режиме

Очистка рисунков, представленных в сцене, может быть добавлена в список задач и выполнена в
пакетном режиме, чтобы запускать ее в фоновом режиме, пока вы выполняете другую работу на
своем компьютере.

Cleanup tasks can be submitted from the OpenToonz browser and can be managed and executed in the
Tasks pane, together with render tasks (see for Rendering Scenes in Batch Mode).
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The Tasks pane is divided into two sections: on the left there is the task tree where all of the cleanup tasks
are displayed with a brush icon and all of the render tasks with a clapboard icon; on the right there is
information about the task selected in the tree.

The Task list can be saved as TNZBAT files and loaded back later in case you want to manage it through
different working sessions.

Совет: Чтобы сохранить список задач:

1. Выполните одно из следующих действий:

• Click the Save Task List ( ) or the Save Task List As button ( ) in the bottom bar of the Tasks
pane.

• Right-click the Tasks item at the top of the list and choose Save Task List or the Save Task List
As from the menu that opens.

2. Используйте браузер, который открывается, чтобы сохранить список.
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Совет: Чтобы загрузить список задач:

1. Выполните одно из следующих действий:

• Click the Load Task List button ( ) in the bottom bar of the Tasks pane.

• Right-click the Tasks item at the top of the list and choose Load Task List from the menu that
opens.

2. Используйте браузер, который открывается, чтобы получить и загрузить ранее сохраненный спи-
сок.

Совет: Чтобы изменить размеры разделов панели задач:

Выполните любое из следующих действий:

• Нажмите и перетащите разделитель, чтобы изменить размеры разделов.

• Щелкните и перетащите разделитель к границе окна, чтобы скрыть раздел.

• Щелкните и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить скрытый раздел.

9.3.3 Управление и выполнение задач очистки

When a cleanup task is selected in the tree, in the section on the right of the Tasks pane task-related
properties are displayed, some of which can be edited to configure the task. Properties are the following:

• Name:, displays the tasks name; it can be edited to better identify the task.

• Status:, displays if the task is waiting, running, completed or failed.

• Command Line:, displays the command line related to the task execution with arguments and
qualifiers.

• Server:, displays the computer that is running, or will run, the task.

• Submitted By:, displays the user that submitted the task.

• Submitted On:, displays the computer from where the task was submitted.

• Submission Date:, displays when the task was submitted.

• Start Date:, displays when the execution of the task started.

• Completion Date:, displays when the execution of the task was completed.

• Duration:, displays how long the execution lasted.

• Step Count:, displays the number of frames rendered.

• Failed Steps:, displays the number of frames that failed to be rendered.

• Successful Steps:, displays the number of frames successfully rendered.

• Priority:, sets the importance or urgency of the task: tasks with a higher priority will be executed
first. This can be edited to change the priority of a task.
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• Visible Only, when activated, limits the cleanup process only to columns whose camera stand toggle

( ) is on, that is to say whose content is visible (see Working with Xsheet Columns).

• Overwrite, when activated, processes levels even if they are already available in the destination folder,
overwriting them.

• Dependencies:, lets you set which of the other submitted tasks have to be successfully completed
before starting the current task execution: these tasks can be added from the box on the right where
all submitted tasks are displayed.

Выполнение задачи можно запустить и остановить из списка задач. Если вы используете ферму рен-
дера OpenToonz, задачи и подзадачи рендера будут распределены в ферме, по одной для каждого
компьютера, чтобы одновременно можно было выполнить несколько задач (см. Использование фермы
OpenToonz).

Когда задачи выполняются, цвет значка сообщает о состоянии задачи в соответствии со следующим
цветовым кодом:

• Grey, when the task is waiting or is not executed yet.

• Yellow, when the task is being executed.

• Green, when the task was successfully executed.

• Orange, when the task was executed with some errors.

• Red, when the task execution has failed.

Совет: Чтобы добавить сцены для очистки в список задач:

Выполните одно из следующих действий:

• Click the Add Cleanup Task button ( ) in the bottom bar of the Tasks pane and use the browser
to select a scene file.

• Select the scenes in the OpenToonz Browser, then right-click any of them and choose Add As Cleanup
Task from the menu that opens.

Совет: Чтобы настроить задачу очистки в списке задач:

1. Выберите задачу очистки в списке задач.

2. Настройте его с помощью параметров, доступных в правой части списка.

Совет: Чтобы выбрать задачи в списке задач:

Выполните любое из следующих действий:

• Нажмите на задачу, чтобы выбрать ее.

• Удерживая клавишу Shift, щелкните задачу, чтобы расширить выбор до этой задачи.

• Ctrl-клик (ПК) или Cmd-клик (Mac) задача, чтобы добавить ее или удалить из выбора.

Совет: Для выполнения выбранных задач:

Выполните одно из следующих действий:
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• Click the Start button ( ) in the bottom bar of the pane.

• Right-click any selected task icons and choose Start from the menu that opens.

Совет: Чтобы остановить выполнение выбранных задач:

Выполните одно из следующих действий:

• Click the Stop button ( ) in the bottom bar of the pane.

• Right-click any selected task icon and choose Stop from the menu that opens.

Совет: Чтобы удалить выбранные задачи из списка:

Выполните одно из следующих действий:

• Click the Remove button ( ) in the bottom bar of the Tasks pane.

• Right-click any selected task in the list and choose Remove from the menu that opens.

Совет: Чтобы добавить задачи в список зависимостей:

• Select a task in the list on the right and click the << Add button.

Совет: Чтобы удалить задачи из списка зависимостей:

• Select a task in the list on the left and click the Remove >> button.
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Глава 10

Рисование уровней анимации

В OpenToonz можно создавать и рисовать векторные уровни Toonz (формат PLI), растровые
уровни Toonz (формат TLV) и стандартные растровые уровни (формат TIF) непосредственно в
средстве просмотра. Инструменты рисования также можно использовать для подправки очищенных
чертежей и загруженных растровых изображений.

10.1 Рисование в OpenToonz

Чтобы нарисовать уровень анимации, сначала вы должны определиться с его типом: Toonz векторный,
Toonz растровый или обыкновенный растровый; и его настройки, такие как имя, количество кадров и
способ нумерации рисунков.

Векторные уровни Toonz определяются рисованием векторных штрихов; штрихи и области, опреде-
ленные штрихами, могут быть нарисованы с использованием стилей, доступных в палитре уровней.
Векторные уровни Toonz имеют неограниченный размер и разрешение, поскольку они основаны на
векторах. Они сохраняются в виде файлов PLI.

Уровни Toonz Raster определяются путем рисования растровых линий; линии и области, определен-
ные линиями, могут быть нарисованы с использованием стилей, доступных в палитре уровней. Уровни
Toonz Raster имеют определенный размер и разрешение, определяемые при их создании. Они сохра-
няются в виде файлов TLV.

Растровые уровни определяются путем рисования растровых линий с использованием стилей, доступ-
ных в Палитре растровых рисунков, которая используется всеми растровыми уровнями одного и
того же проекта (см. Папки проекта по умолчанию). Растровые уровни имеют определенный размер
и разрешение, определяемые при их создании. Они сохраняются как последовательности отдельных
файлов TIF, по одному на каждый уровень кадра.

Когда уровень анимации определен, вы можете выбрать любой из его кадров на Xsheet/Timeline или в
Level Strip и начать рисование в средстве просмотра. Вы можете сделать это и тогда, когда вы хотите
создать рисунок с нуля, и когда вы хотите редактировать ранее сделанный рисунок.

При выборе на Xsheet / Timeline программа просмотра отображает всё содержание сцены в текущем
кадре; при выборе в полосе уровня зритель отображает только выбранный кадр текущего уровня
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анимации, чтобы вам было легче работать с ним.

10.1.1 Установка типа уровня по умолчанию для рисования

Можно определить тип уровня по умолчанию, который будет создан, когда Вы рисуете внутри
OpenToonz.

По умолчанию уровни Toonz Vector и Toonz Raster сохраняются в папке +drawing текущего проекта
при сохранении сцены, в то время как Уровни Raster сохраняются в папке +extras (см. Папки проекта
по умолчанию).

Совет: Задать тип уровня по умолчанию для рисования:

1. Open File → Preferences. . . → Drawing.

2. Выберите тип уровня, который вы хотите использовать по умолчанию, в меню параметров Тип
уровня по умолчанию:. Поля Ширина, Высота и DPI доступны для параметров Растровый
уровень Toonz и Растровый уровень.

Примечание: The Width, Height and DPI values set in the File → Preferences. . . → Drawing section
will also be used as default for the New Level dialog.

10.1.2 Рисование уровней анимации

Уровни анимации могут быть созданы следующими способами:

• Использование диалогового окна Новый уровень.

• Для параметра «Автосоздание» установлено значение «Включено».

• Установка параметра «Автосоздание» на Использовать Xsheet как лист анимации.

Использование диалога нового уровня

Новые уровни анимации можно определить с помощью диалогового окна, в котором можно указать ко-
личество рисунков, из которых сделан уровень, шаг анимации, используемый для отображения кадров
в Xsheet/Timeline, и приращение, которое задает способ отображения чертежей уровней. пронумерова-
ны. Например, Шаг 2 повторяет каждый рисунок дважды в столбце Xsheet или на временной шкале, в
то время как Прирост 2 будет нумеровать его рисунки как 1, 3, 5 и т. Д. В этом диалоговом окне также
можно выбрать папка назначения, отличная от папки по умолчанию, с помощью поля Сохранить в.

Если вы определяете Растровый уровень Toonz или Растровый уровень , вы можете установить его
значения Ширина, Высота и DPI в соответствии с тем, как вы хотите использовать его в сцене.

Такие настройки, как длина уровня и порядок нумерации, могут быть отредактированы позже, так как
вы можете упорядочивать изображения, составляющие уровень анимации, так, как вы предпочитаете
(см. Редактирование уровней анимации).

Когда новый уровень создается в пустом столбце, цвет заголовка этого столбца и ячеек, в которых
отображается новый уровень, окрашиваются, обозначая тип уровня: светло-желтый для векторных
уровней Toonz, светло-зеленый для растровых уровней Toonz и светло-синий для растровых уров-
ней (см. Работа со столбцами Xsheet).
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Примечание: The New Level dialog inherits the Default Level Type settings defined in Preferences. . .
→ Drawing.

Совет: Чтобы создать новый уровень анимации для рисования:

1. Выполните одно из следующих действий:

• Select a cell in the Xsheet/Timeline where you want to place your animation level and choose Level
→ New → New Level. . .

• Щелкните правой кнопкой мыши ячейку на Xsheet/Timeline, где вы хотите разместить уровень
анимации, и выберите Новый уровень. . . в открывшемся меню.

• (Если видна панель инструментов Xsheet/Timeline) Нажмите любую из трех кнопок Новый
уровень в самой левой части.

2. Выберите тип уровня: Векторный уровень Toonz, Растровый уровень Toonz или Растровый уро-
вень, в меню параметров Тип: и определите его настройки, затем нажмите кнопку OK.

Примечание: При использовании кнопок панели инструментов Xsheet/Timeline для создания нового
уровня соответствующий тип уровня уже предварительно выбран в раскрывающемся меню диалога.

Примечание: Если уровень уже представлен в столбце ячейки, новый уровень будет создан в пустом
столбце.

Совет: Чтобы определить место сохранения для уровня, который вы хотите нарисовать:

В диалоговом окне Новый уровень введите в поле Сохранить в: или используйте кнопку Browser
button, чтобы указать путь для места сохранения.

Примечание: Если в браузере вы выбираете какую-либо папку проекта, в поле пути полный путь
будет заменен соответствующим псевдонимом папки (см. Папки проекта по умолчанию).

Использование опции автосоздания

Если в меню «Настройки программы» → «Рисунок» для параметра «Автосоздание:» установле-
но значение «Включено», можно автоматически создавать новые рисунки с помощью инструментов
рисования в средстве просмотра. Если текущая выбранная ячейка пуста, новый уровень будет автома-
тически создан и назван с первой доступной буквой алфавита; если текущая выбранная ячейка - это
ячейка сразу после, содержащая рисунок уровня (либо на Xsheet/Timeline, либо на полосе уровня),
к этому рисунку будет добавлен новый рисунок.

Примечание: The level type will be the one defined in Preferences. . . → Drawing as Default Level
Type.
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Использование Xsheet в качестве анимационного листа

When in Preferences. . . → Drawing the Autocreation: option is set to Use the Xsheet as Animation
Sheet, it’s possible to create new drawings automatically by using drawing tools in the viewer. If the currently
selected cell is empty and belongs to an empty column, a new level will be automatically created and named
with the first available letter of the alphabet; if the currently selected cell is anywhere after one containing
a level drawing, a new drawing will be added to that level. In both cases the drawings will take its number
from the scene current frame ; if that drawing number already existed in the level, a letter will be added to
its number (e.g. A.0001a.ext).

Этот метод работы позволяет вам работать как традиционный аниматор: вы можете начать создавать
ключевые рисунки, а затем добавлять разбивочные рисунки, а затем между рисунками. Вы можете
быстро проверить свою анимацию, пролистывая ее в средстве просмотра.

Когда вы добавляете новый рисунок, он будет повторяться как удержанный вдоль столбца / слоя до
следующего.

Также возможно создать новый рисунок в ячейке, которая содержит hold : новый рисунок заменит
удержание до следующего рисунка. Рисунки также можно дублировать, создав копию с другим номе-
ром.

После завершения анимации вы можете изменить нумерацию всей последовательности в соответствии
с нумерацией кадров Xsheet / Timeline.

Примечание: The level type will be the one defined in Preferences. . . → Drawing as Default Level
Type.

Совет: Для создания нового уровня анимации

Щелкните пустую ячейку на Xsheet/Timeline и начните рисовать, используя инструмент рисования в
окне просмотра.

Совет: Чтобы добавить рисунок существующему уровню

Щелкните пустую ячейку в столбце/слое, содержащем существующий уровень, и начните рисовать,
используя инструмент рисования в средстве просмотра.

Совет: Для автоматической нумерации рисунков

1. Выберите ячейки с рисунками, которые вы хотите перенумеровать.

2. Выберите команду Ячейки → Автопересчет.

Примечание: Команда Автопересчет также доступна в меню, которое открывается при
щелчке правой кнопкой мыши в ячейке.

10.1.3 Использование окна просмотра

В средстве просмотра можно использовать инструменты, доступные на панели инструментов, для ри-
сования, рисования, редактирования и моделирования чертежей. Рабочая область зрителя бесконечна,
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и вы можете прокручивать, увеличивать, уменьшать и поворачивать ее.

В строке заголовка вы можете найти информацию о том, что в данный момент отображается и вы-
бирается, процент увеличения и набор кнопок, которые позволяют вам установить режим просмотра
(см. Использование окна просмотра).

В нижней части окна просмотра доступен другой настраиваемый набор кнопок.

Панель кадров и кнопки воспроизведения позволяют установить текущий кадр и перемещаться по
кадрам анимации. Заданная частота кадров визуализируется, и, если воспроизведение активировано,
фактическая частота кадров отображается слева.

Другие кнопки актуальны только при использовании Инструмента анимирования ( ) для анимации
объектов и при предварительном просмотре анимации в окне просмотра (см. Анимация объектов и
Предварительный просмотр анимации).

Примечание: Если нижняя панель слишком короткая, чтобы отобразить все параметры, ее можно
прокрутить с помощью кнопок со стрелками на ее концах.

Примечание: Если диапазон кадров определяется маркерами воспроизведения, кнопки воспроизве-
дения работают только с определенным диапазоном (см. Использование маркеров воспроизведения).

Совет: Для навигации по рабочей области:

Выполните одно из следующих действий:

• Используйте инструмент Лупа ( ): для увеличения нажмите и перетащите вверх; чтобы умень-
шить масштаб, нажмите и перетащите вниз. Точка, в которой вы щелкаете, является центром
действия масштабирования.

• Используйте горячие клавиши масштабирования (по умолчанию клавиши + и -), чтобы увели-
чивать и уменьшать масштаб при определенных шагах (например, 50%, 100%, 200% и т.д.).

• Используйте колесико мыши для увеличения и уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите или используйте инструмент Рука ( ) для
прокрутки в любом направлении.

• Используйте инструмент Поворот ( ), чтобы вращать в окне просмотра: отображается линия
горизонта, чтобы вы могли понять величину вращения; центр вращения является абсолютным
центром рабочей зоны.

• Используйте горячую клавишу сброса просмотра (по умолчанию клавиша Alt + 0) или щелкните
правой кнопкой мыши в окне просмотра и выберите Вид по умолчанию в открывшемся меню,
чтобы отобразить окно просмотра в его реальном размере с центром в абсолютном центре без
вращения.

• Щелкните правой кнопкой мыши и выберите По размеру окна, чтобы автоматически увеличить
масштаб просмотра, чтобы он уместился в поле камеры.

Совет: Для воспроизведения содержимого сцены назад:

Выполните одно из следующих действий:
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• Нажмите кнопку Воспроизведение.

• Перетащите курсор рамки кадра.

Совет: Чтобы установить текущий кадр:

Выполните одно из следующих действий:

• Используйте кнопки воспроизведения.

• Перетащите курсор рамки кадра.

• Введите в поле Текущий кадр номер кадра, который вы хотите просмотреть.

Совет: Чтобы установить частоту кадров воспроизведения:

Выполните одно из следующих действий:

• Введите значение в поле FPS.

• Используйте ползунок частоты кадров.

Настройка визуализации окна просмотра

Способ, которым окно просмотра визуализирует содержание сцены, может быть скорректирован в
соответствии с задачей, которую необходимо выполнить.

Полноэкранный режим можно ввести, чтобы максимально развернуть зрителя до экрана монитора,
скрывая любую границу окна интерфейса. Это доступно только на платформе Windows.

Векторные рисунки, которые могут замедлить производительность визуализации при использовании
в большом количестве в сцене, можно визуализировать как растровые рисунки, быстрее визуализи-
ровать, сохраняя при этом их векторную природу, используя параметр Отображать вектор как
растр.

Примечание: Если текущий уровень основан на векторах, он все равно будет отображаться как
вектор, чтобы разрешить любую операцию рисования/редактирования, которую вы можете выполнить.

Растровые рисунки и изображения, которые обычно отображаются в средстве просмотра в соответ-
ствии с их значением DPI, могут отображаться с их фактическим размером в пикселях, то есть один
пиксель изображения отображается как один пиксель экрана монитора, чтобы лучше их изучить.

Примечание: Визуализация изображения с его фактическим размером в пикселях отличается от
увеличения, поскольку при масштабировании всегда учитывается информация о DPI изображения.

Совет: Только для Windows - Для входа в полноэкранный режим просмотра:

Щелкните правой кнопкой мыши в окне просмотра и выберите Полноэкранный режим в открыв-
шемся меню.
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Совет: Только для Windows - Для выхода из полноэкранного режима просмотра:

Щелкните правой кнопкой мыши на средстве просмотра и выберите Выход из полноэкранного
режима в открывшемся меню.

Совет: Чтобы активировать или деактивировать растровую визуализацию для векторных
рисунков:

Активируйте или деактивируйте опцию Вид → Отображать вектор как растр.

Совет: Для отображения растровых рисунков и изображений с их фактическим размером
пиксела:

1. В Xsheet/Timeline выберите уровень, к которому относится чертеж или изображение, чтобы он
стал текущим уровнем.

2. Выберите рисунок или изображение на полосе уровня, чтобы отобразить его отдельно.

3. Используйте горячую клавишу «Фактический пиксельный размер» (по умолчанию клавиша N)
или щелкните правой кнопкой мыши в средстве просмотра и выберите Фактический пиксель-
ный размер в открывшемся меню.

Настройка окна просмотра

Окно просмотра может быть настроено в соответствии с вашими потребностями: цвета фона, видимые
в просмотрщике и внутри камеры, могут быть изменены; направляющая сетка и безопасная зона могут
быть отображены для справки; стол и камера могут быть скрыты; пользовательские направляющие
могут быть добавлены, чтобы помочь вам выровнять объекты или составить элементы сцены для опре-
деленного кадра. Проверка «Вид» → Только линии позволяет скрыть окрашенные области уровней,
облегчая процесс рисования.

Набор кнопок и информации, доступных в нижней панели средства просмотра, также можно настроить
так, чтобы были видны только те элементы, которые вам нужны.

Совет: Чтобы изменить цвет фона просмотрщика:

1. Open the File → Preferences. . . → Colors dialog.

2. Определите Цвет фона просмотра, выполнив одно из следующих действий:

• Установите значения красного, зеленого и синего.

• Нажмите на миниатюру цвета и используйте Редактор стилей, чтобы отредактировать
его (см. Простые цвета).

Совет: Чтобы изменить цвет фона камеры:

1. Откройте диалоговое окно Xsheet → Настройки сцены. . . .

2. Определите Цвет фона камеры:, выполнив одно из следующих действий:

• Установите значения красного, зеленого, синего и альфа.
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• Нажмите на миниатюру цвета и используйте Редактор стилей, чтобы отредактировать
его (см. Простые цвета).

Совет: Чтобы показать или скрыть таблицу:

Выберите Вид → Таблица, чтобы показать или скрыть таблицу.

Совет: Чтобы показать или скрыть рамку камеры:

Выберите Вид → Граница камеры, чтобы показать или скрыть границу камеры.

Совет: Чтобы показать или скрыть цвет фона камеры:

Выберите Вид → Цвет фона камеры, чтобы показать или скрыть цвет фона камеры.

Совет: Чтобы определить отображаемую направляющую сетку:

Выберите Вид → Направляющая сетка, чтобы показать или скрыть направляющую сетку.

Совет: Чтобы определить отображаемую направляющую сетку:

1. Откройте диалоговое окно Xsheet → Настройки сцены. . . .

2. Определите Размер направляющей сетки: и A/R:. Размер - это число полей ширины направ-
ляющей поля (1 поле равно 1 дюйму), а A/R - это соотношение между шириной направляющей
поля и высотой.

Совет: Чтобы показать или скрыть безопасную зону:

Выберите Вид → Безопасная зона, чтобы показать или скрыть безопасную зону.

Совет: Чтобы добавить пользовательскую сетку:

Нажмите на линейку: щелчок в горизонтальной линейке создаст вертикальную направляющую, щелчок
в вертикальной линейке создаст горизонтальную направляющую.

Совет: Чтобы переместить пользовательскую сетку:

Перетащите маркер пользовательской направляющей сетки по линейке.

Совет: Чтобы удалить пользовательскую сетку:

Выполните одно из следующих действий:

• Щелкните правой кнопкой мыши по направляющему маркеру в линейке.
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• Перетащите маркер за пределы окна просмотра в направлении, противоположном самой направ-
ляющей.

Совет: Чтобы показать или скрыть пользовательские направляющие:

Выберите Вид → Руководства, чтобы показать или скрыть направляющие.

Совет: Чтобы показать или скрыть пользовательские линейки, на которых расположены
маркеры:

Выберите Вид → Линейка, чтобы показать или скрыть линейки.

Примечание: Когда рабочая область окна просмотра поворачивается, направляющие также пово-
рачиваются, но линейки и направляющие маркеры сохраняют свое положение и ориентацию. Однако
положение сетки все еще может контролироваться маркерами, даже если визуально они больше не
совпадают.

Совет: Чтобы настроить набор кнопок в нижней панели окна просмотра:

Нажмите кнопку опции ( ) в крайнем левом углу нижней области и выберите отображаемые элементы
или отмените выбор элементов, которые нужно скрыть, в открывшемся меню.

10.1.4 Инструменты рисования

Вы можете рисовать с помощью инструментов Кисть ( ) и Геометрический ( ). Для обоих
инструментов вы можете установить толщину линии, которую вы собираетесь нарисовать: значения
варьируются от 0 до 100 для уровней векторного Toonz и от 1 до 100 для уровней растрового и раст-
рового Toonz .

Примечание: Для уровней растрового Toonz и растрового можно установить размер инструмента
Кисть больше 100, введя его в поле Размер.

Примечание: Минимальный и Максимальный Размер/Толщина можно изменить одним из
следующих способов:

• Нажатие Ctrl + Alt и перемещение мыши. Перемещение по горизонтали изменяет значение
Максимальный, тогда как перемещение по вертикали изменяет значение Минимальный.

• Использование определенных сочетаний клавиш. U и I для соответственно уменьшения и уве-
личения значения Максимальный или H и J для соответственно уменьшения и увеличения
значения Минимальный.

С помощью инструмента Кисть ( ) вы можете в полной мере воспользоваться чувствительностью
к давлению, если вы используете чувствительный к давлению планшет. Чем больше вы нажимаете на
планшет, тем толще линия, которую вы рисуете.
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С помощью инструмента Геометрический ( ) значение толщины постоянно применяется ко всей
нарисованной фигуре.

При создании векторных рисунков размер/толщину также можно установить на 0 (ноль): в этом слу-
чае векторные штрихи будут существовать только в виде каркаса, даже если вы увеличиваете или
уменьшаете масштаб, и они не будут видны при визуализации анимации.

Примечание: Для векторных рисунков толщину линий можно изменить и настроить позже, исполь-
зуя другие инструменты (см. Редактирование рисунков).

Рисование с помощью инструмента Кисть

Инструмент Кисть ( ) позволяет рисовать линии от руки с текущим стилем.

При использовании планшета, чувствительного к давлению, и при включенной опции Нажим измене-
ние давления пера на планшете позволит вам создавать линии переменной толщины, которые сделают
ваши рисунки более выразительными.

При использовании инструмента Кисть ( ) на рисунках Toonz растровый и растровый курсор отоб-
ражает точную область пикселов, на которую будет воздействовать кисть: внутренний зубчатый круг,
представляющий минимальный размер, и внешний максимальный размер кисти.

На панели параметров инструмента вы можете установить следующее:

• Размер Мин и Макс устанавливает размер кисти; размер будет варьироваться между двумя
значениями, если вы используете чувствительный к давлению планшет. Если два значения оди-
наковы, ваши линии будут иметь постоянную толщину. При использовании мыши для рисования
будет использоваться значение толщины Макс.

• Точность устанавливает, насколько точно сгенерированная линия сравнивается с тем, что вы
рисуете с помощью мыши или планшета: высокое значение будет генерировать линии, кото-
рые полностью сохраняют выполняемое вами движение (даже дрожащую руку); низкое значение
упростит линию. Это доступно только для векторных рисунков Toonz.

• Плавно обеспечивает стабилизацию хода при рисовании. Это доступно только для рисунков
Toonz Vector и Toonz Raster.

• Жесткость устанавливает количество сглаживания вдоль границы линии. Это доступно только
для растровых рисунков и растровых рисунков Toonz.

• Непрозрачность Мин и Maкс устанавливает непрозрачность кисти; Непрозрачность будет
варьироваться между двумя значениями, если вы используете чувствительный к давлению план-
шет. Перекрывающиеся области не учитываются при рисовании одной линии, но только когда
перекрываются разные линии. Это доступно только для растровых рисунков.

• Разрыв автоматически разбивает нарисованный штрих на сечения, если нарисованы очень ост-
рые углы: таким образом, нарисованные фигуры могут быть проще и проще для заполнения. Это
доступно только для векторных рисунков Toonz.

• Порядок рисовки позволяет выбрать порядок упорядочения новых рисунков относительно уже
нарисованных линий. Возможны следующие варианты: Над всеми, Под всеми и Порядок па-
литры. При использовании Порядок палитры новые линии будут нарисованы выше или ниже
уже существующих, используя относительные индексы стилей палитры как фактор сортировки.
Это доступно только для рисунков Toonz Raster.
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• Режим Карандаш рисует линии без сглаживания, то есть с неровными краями. Это доступно
только для растровых рисунков Toonz.

• Нажим определяет, если вы используете графический планшет, давление пера на планшет, что
позволяет создавать линии переменной толщины.

• Диапазон позволяет автоматически создавать серию промежуточных линий, рисуя только край-
ности анимации на последующих кадрах уровня, в Level Strip или последующих открытых ячей-
ках уровня в Xsheet/Timeline. Зажав клавишу Ctrl, вы можете нарисовать промежуточные ли-
нии, чтобы сформировать более сложную последовательность анимации. Этот метод аналогичен
методу, используемому командой Фазовка (см. Использование фазовки с векторными рисунка-
ми). Это доступно только для векторных рисунков Toonz.

• Привязка позволяет привязывать курсор к другим уже нарисованным линиям того же уровня,
одновременно рисуя новую линию. Она имеет три уровня чувствительности: Низкая, Средняя
и Высокая. Это доступно только для векторных рисунков Toonz.

• Предустановка: позволяет выбрать предустановку кисти в меню параметров справа. Вы можете
добавить или удалить предустановку, нажимая кнопки + и -. Список предустановок создается
для каждого типа уровня, и каждая добавленная предустановка будет доступна для следующего
использования.

• Конец опция устанавливает форму концов штриха, который вы собираетесь нарисовать. Вариан-
ты: Обрубок для квадратов, Закругленный для полукруглых концов и Плоский колпачок
для квадратов, выходящих за конец линии, в соответствии с толщиной вектора. Это доступно
только для векторных рисунков Toonz.

• Параметр Изгиб устанавливает форму прямых углов вдоль обводки, которую вы собираетесь
нарисовать. Варианты: Острый изгиб для острых углов, Закругленный изгиб для закруг-
ленных углов, Скошенный изгиб для квадрата. Это доступно только для векторных рисунков
Toonz.

• Скос: устанавливает максимальную длину соединения под углом, которое вычисляется умноже-
нием значения угла под углом на толщину хода. Если длина превышает максимальное значение,
соединение Скос превращается в соединение Скошенный. Это доступно только для векторных
рисунков Toonz, и только если для параметра Изгиб установлено значение Скос.

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

Совет: Чтобы добавить новую предустановку кисти:

1. Нажмите кнопку + справа от списка предустановок.

Совет: Чтобы удалить новую предустановку кисти:

1. Нажмите кнопку - справа от списка предустановок.

Рисование с помощью геометрического инструмента

Геометрический ( ) инструмент позволяет рисовать прямоугольники, круги, эллипсы, правильные
многоугольники, полилинии и дуги.
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На панели параметров инструмента вы можете установить следующее:

• Толщина определяет размер кисти, используемой для рисования геометрических фигур.

• Жесткость устанавливает количество сглаживания вдоль границы фигуры. Это доступно толь-
ко для растровых рисунков и растровых рисунков Toonz.

• Непрозрачность устанавливает непрозрачность границы фигуры. Перекрывающиеся области
не учитываются при рисовании поверх одной и той же фигуры, но только когда перекрываются
разные фигуры. Это доступно только для растровых рисунков.

• Фигура: устанавливает тип фигуры, которую вы хотите нарисовать. Доступны следующие ва-
рианты: прямоугольник, круг, эллипс, линия, полилиния, дуга и многоугольник. Если вы хотите
нарисовать Многоугольник, параметр Сторон многоугольника: позволяет вам установить
количество сторон.

• Автогруппировать автоматически определяет любую нарисованную замкнутую форму (т.е.
прямоугольники, круги, эллипсы, многоугольники и замкнутые полилинии) как группу, создавая
тем самым новый слой, который помещается перед остальными векторами рисования, не пе-
ресекая их (см. Группировка и разгруппировка векторов). Это доступно только для векторных
рисунков Toonz.

• Автозаливка автоматически окрашивает область, определяемую любой нарисованной замкну-
той формой (то есть прямоугольниками, кругами, эллипсами, многоугольниками и замкнутыми
полилиниями) в том же стиле, который использовался для рисования. Это доступно только для
векторных рисунков Toonz.

• Привязка позволяет привязывать курсор к другим уже нарисованным линиям того же уровня,
одновременно рисуя новую фигуру. Она имеет три уровня чувствительности: Низкая, Средняя
и Высокая. Это доступно только для векторных рисунков Toonz.

• Избирательно позволяет операциям рисования не влиять на уже нарисованные линии. Это
доступно только для растровых рисунков Toonz.

• Режим Карандаш рисует геометрические фигуры без сглаживания, то есть с неровными краями.
Это доступно только для растровых рисунков Toonz.

• Конец опция устанавливает форму концов штриха, который вы собираетесь нарисовать. Вариан-
ты: Обрубок для квадратов, Закругленный для полукруглых концов и Плоский колпачок
для квадратов, выходящих за конец линии, в соответствии с толщиной вектора. Это доступно
только для векторных рисунков Toonz.

• Параметр Изгиб устанавливает форму прямых углов вдоль обводки, которую вы собираетесь
нарисовать. Варианты: Острый изгиб для острых углов, Закругленный изгиб для закруг-
ленных углов, Скошенный изгиб для квадрата. Это доступно только для векторных рисунков
Toonz.

• Скос: устанавливает максимальную длину соединения под углом, которое вычисляется умноже-
нием значения угла под углом на толщину хода. Если длина превышает максимальное значение,
соединение Скос превращается в соединение Скошенный. Это доступно только для векторных
рисунков Toonz, и только если для параметра Изгиб установлено значение Скос.

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

В то время как Прямоугольник и Эллипс определяется (ограничивающим) полем, Круг и Много-
угольник определяется центром и радиусом; Полилиния можно использовать для создания откры-
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тых или закрытых фигур путем определения ряда линий; Дуга позволяет установить конечные точки
кривой, а затем изгиб.

Совет: Чтобы нарисовать прямоугольник или эллипс:

Нажмите, чтобы определить верхний левый угол, перетащите и отпустите, чтобы определить нижний
правый угол. Если вы зажмете клавишу Shift во время перетаскивания, форма будет правильной,
то есть квадрат или круг; Если вы нажмете клавишу Alt, фигуры начнут рисоваться, начиная с их
центра. Можно нажать обе клавиши одновременно.

Совет: Чтобы нарисовать круг:

Нажмите, чтобы определить центр, перетащите и отпустите, чтобы определить радиус.

Совет: Чтобы нарисовать многоугольник:

1. Установите количество сторон в поле Сторон многоугольника:.

2. Нажмите, чтобы определить центр, перетащите и отпустите, чтобы определить радиус окружно-
сти, ограничивающей многоугольник.

Совет: Чтобы нарисовать полилинию:

1. Выполните одно из следующих действий:

• Нажмите, чтобы определить первую точку в качестве угловой точки.

• Нажмите и перетащите, чтобы определить первую точку в качестве контрольной точки; во
время перетаскивания вы можете установить маркеры контрольной точки.

2. Выполните одно из следующих действий:

• Нажмите, чтобы определить конечную точку линии как угловую точку. Если вы зажмете кла-
вишу Shift, вы нарисуете вертикальную, горизонтальную или 45° линию.

• Нажмите и перетащите, чтобы определить конечную точку линии в качестве контрольной
точки; во время перетаскивания вы можете установить маркеры контрольной точки.

3. Выполните одно из следующих действий:

• Нажмите или нажмите и перетащите еще раз, чтобы определить конечную точку другой
линии, соединенной с конечной точкой предыдущей линии.

• Дважды щелкните, чтобы определить последнюю точку открытой фигуры.

• Нажмите или щелкните и снова перетащите на первую заданную вами точку, чтобы нари-
совать замкнутую фигуру.

Примечание: Нажмите клавишу Ctrl, чтобы добавить линейную точку после нелинейной.

Примечание: Нажмите клавишу Esc, чтобы отменить создание полилинии.
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Совет: Чтобы нарисовать дугу:

1. Нажмите, чтобы определить первую конечную точку.

2. Нажмите, чтобы определить вторую конечную точку.

3. Перетащите, чтобы установить изгиб, и нажмите, чтобы нарисовать дугу.

Добавление текста

Текст может быть добавлен с помощью инструмента Шрифта ( ).

Примечание: В OpenToonz также можно работать с редактируемым и анимируемым текстом с
помощью эффекта Text Iwa. Для получения дополнительной информации, см. Text Iwa.

На панели параметров инструмента вы можете установить следующее:

• Шрифт: для использования, взятый из списка, основанного на папке шрифтов опера-
ционной системы по умолчанию.

• Начертание: выбранного шрифта.

• Размер:, для выбранного шрифта.

Примечание: Размер уже написанного текста можно изменить с помощью ин-

струмента Выделения ( ) (см. Редактирование рисунков).

• Вертикальная ориентация, позволяет размещать текст вертикально, одну букву под
другой, а не по горизонтали.

Стиль текущей палитры применяется к вводимому вами тексту. Стиль палитры может быть изменен
при наборе текста, поэтому вы можете иметь символы с разными стилями в одном сеансе редактиро-
вания текста (см. Редактирование стилей).

Примечание: Для векторных уровней, как только текст фиксируется, он преобразуется в векторные
контуры и больше не может редактироваться как текст.

Совет: Добавить текст:

1. Выберите инструмент Шрифта ( ) и щелкните по месту в окне просмотра, с которого вы
хотите начать печатать.

2. Выберите параметры Шрифт, Начертание, Размер и Вертикальная ориентация. Эти па-
раметры могут быть изменены, пока вы находитесь в режиме редактирования текста.

3. Измените текущий цветовой стиль в палитре, если вы хотите использовать более одного стиля в
одном сеансе редактирования текста.

4. Щелкните внутри области редактирования текста, чтобы изменить точку вставки текста.
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5. Щелкните за пределами области редактирования текста или выберите другой инструмент для
фиксации текста.

Использование Ластика

Инструмент Ластик ( ) позволяет частично удалять линии, как на векторных, так и на растровых
рисунках.

На панели параметров инструмента вы можете установить следующее:

• Размер устанавливает размер ластика.

• Жесткость устанавливает величину сглаживания вдоль границы ластика. Это доступно только
для рисунков Toonz Raster и Raster.

• Непрозрачность установить непрозрачность ластика; Двойное прохождение по области не учи-
тывается при выполнении одной операции стирания, а только при выполнении различных опера-
ций стирания. Это доступно только для растровых рисунков.

• Тип: имеет параметры Обычный, чтобы использовать стандартный ластик; Прямоугольный,
чтобы выполнить удаление внутри поля, которое вы определяете; От руки, чтобы стереть внутри
области, которую вы наметили, нажав и перетащив; и Полилиния, чтобы выполнить стирание
внутри области, которую вы наметили, определив серию линий. На векторных рисунках обводка
удаляется, только если она полностью включена в определяемую вами область.

• Режим: имеет опции Области, чтобы удалить только области, Линии, чтобы удалить только
контур чертежа, и Линии и области, чтобы выполнить обе операции. Это доступно только для
растровых рисунков.

• Избирательно позволяет стирать только линии или области, созданные в текущем стиле. Это
доступно только для рисунков Toonz Vector и Toonz Raster.

• Инвертировать выполняет удаление за пределами области, определенной с помощью режимов
Прямоугольный, От руки или Полилинии. На векторных рисунках обводка удаляется только в
том случае, если она полностью находится за пределами определяемой вами области.

• Диапазон кадров позволяет вам выполнять стирание Прямоугольника, От руки и Полилинии
для диапазона кадров, определяя область в первом, а затем в последнем кадре диапазона.

• Режим Карандаш стирает линии без сглаживания, то есть с неровными краями. Это доступно
только для рисунков Toonz Raster.

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

Примечание: Инструмент Ластик ( ) можно автоматически выбрать с помощью ластика пера
планшета*.
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10.1.5 Преобразование растровых рисунков в векторы

Отсканированные и растровые рисунки, то есть рисунки, не основанные на векторах, могут быть пре-
образованы в векторные уровни Toonz.

Доступны два основных режима преобразования: Сплошная линия и Контурная обводка. Выбор
между двумя режимами зависит от того, какое преобразование наилучшим образом соответствует
вашим потребностям.

В режиме Сплошная линия для каждой линии на чертеже создается одиночный векторный штрих с
переменной толщиной. Это означает, что преобразованный чертеж можно редактировать как вектор-
ные рисунки, сделанные непосредственно в OpenToonz, например, вы можете изменить изгиб штриха

с помощью инструментов Щипок ( ) или Редактор контрольных точек и толщину с помощью

инструмента Насос ( ).

В режиме Контурная обводка два векторных штриха создаются для определения каждой линии
на чертеже, а области, заполненные разными цветами, разделяются штрихом. Это означает, что, на-
пример, чтобы изменить изгиб линии, вы должны изменить изгиб двух штрихов, определяющих ее, и
изменить толщину, которую вы должны смоделировать одним или обоими штрихами, определяющими
его. * Толщина всех штрихов установлена на 0, чтобы они не были видны в финальном рендере*.

Примечание: Параметры, которые пользователь не считает необходимыми, можно скрыть с помо-
щью кнопки Опции ( ) в правом нижнем углу всплывающего окна Конвертировать в вектор.

В режиме Контурная обводка доступны следующие настройки:

• Точность устанавливает, насколько векторные штрихи будут повторять форму исходных линий
рисования. Высокие значения создают более точные штрихи, но делают их более сложными.

• Удаление соринок удаляет небольшие пятна или отметки на преобразованных изображениях.
Его значение выражает размер в пикселах максимальной области, которая должна быть удалена.

• Сохранять окрашенные области, когда активировано, включает в себя все цвета в преобра-
зованном уровне.

• Смачивание устанавливает, насколько гладкие изгибы изгибаются к полным углам.

• Угол устанавливает угловой порог, ниже которого в изображение вставляются полные углы

• Радиус кривой устанавливает меру радиуса кривой, ниже которой он заменяется гладким углом

• Макс. цвета определяет максимальное количество цветов, которые рассматриваются в раст-
ровом изображении и используются в векторном. Значение должно быть установлено с учетом
реального количества цветов, используемых в растровом изображении. Высокие значения увели-
чивают время, необходимое для преобразования. Это относится только к растровым уровням.

• Прозрачный цвет определяет цвет, который должен быть установлен как прозрачный фон
результирующего векторного уровня. Это относится только к растровым уровням.

• Порог тона устанавливает значение самых темных пикселов, которые необходимо учитывать
для обнаружения линий, которые необходимо преобразовать в вектор; для низких значений учи-
тываются только самые темные пикселы, что приводит к получению более тонких линий; для
высоких значений также учитываются более светлые пикселы, что приводит к более толстым
линиям. Это применимо только к уровням Toonz Raster.

В режиме Сплошная линия доступны следующие настройки:

128 Глава 10. Рисование уровней анимации



OpenToonz Documentation, Выпуск 1.7.1

• Предел устанавливает значение самых темных пикселов, которые необходимо учитывать при
обнаружении линий, которые необходимо преобразовать в векторные штрихи; для низких зна-
чений учитываются только самые темные пикселы, что приводит к более тонким штрихам; для
высоких значений также учитываются более светлые пикселы, что приводит к более толстым
штрихам. Для уровней Toonz Raster (файлы TLV) процесс проверяет только пикселы, принадле-
жащие линиям; для растровых уровней он проверяет пикселы всего изображения.

• Точность устанавливает, насколько векторная черта будет повторять форму исходных линий
рисования. Высокие значения создают более точные штрихи, но делают их более сложными.

• Удаление соринок игнорирует при преобразовании небольшие участки, создаваемые шумом
изображения; чем выше значение, тем больше игнорируемых областей.

• Максимальная толщина устанавливает максимальную толщину векторного хода; если это зна-
чение низкое, очень толстые линии будут преобразованы в два штриха по центральной линии,
определяющих контур линии; если это значение высокое, они будут преобразованы в один штрих
по центральной линии.

• Калибровка толщины: Начало и Конец: калибрует толщину векторного хода, определенную
в соответствии со значением Предел; низкое значение уменьшит толщину хода, сохраняя его це-
лостность. Другое значение, вставленное в поле Начало/Конец, определяет анимацию толщины
по длине уровня.

• Сохранять окрашенные области, при активации сохраняет все закрашенные области на уров-
нях Toonz Raster (файлы TLV) и все области, закрашенные цветами, отличными от цвета линий
на уровнях растра.

• Добавить кайму добавляет векторную обводку вдоль границы изображения, чтобы обнаружить
также области, кровоточащие у края изображения.

• Улучшенное распознавание контура, когда активировано, позволяет векторизовать растро-
вые изображения (такие как TGA, TIF, PNG и т.д.) Без сглаживания вдоль линий. Эвристика
используется для распознавания линий и окрашенных областей, создающих уровень PLI, где
линии видны как чернила, а окрашенные области - как краска.

Можно выбрать изображения или рамки уровня, которые необходимо преобразовать непосредственно
в Xsheet / Timeline.

Когда преобразование выполнено, новый уровень создается в соответствии с выбранным вами выбором
и отображается в Xsheet / Timeline в следующем столбце / слое для уровня, содержащего исходный
уровень. Новый файл будет иметь то же имя, что и начальный, но с расширением PLI и суффиксом
«v», и будет сохранен в папке по умолчанию +drawings.

Примечание: Если уровень PLI с таким именем уже существует, за именем нового файла будет
следовать прогрессивный номер.

Совет: Если уровень PLI с таким именем уже существует, за именем нового файла будет
следовать прогрессивный номер:

1. Выберите кадры уровня для преобразования в Xsheet/Timeline.

2. Choose Level → Convert → Convert to Vectors. . .

3. В диалоговом окне задайте параметры для конвертации.

4. Нажмите кнопку Конвертировать.
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Проверка процесса преобразования в вектор

В нижней части окна Параметры преобразования в вектор доступна область предварительного
просмотра для отображения рисунка, выбранного на Xsheet/Timeline, как это будет после преобразо-
вания в соответствии с заданными настройками. В то же время он позволяет сравнивать конечный
результат с исходным растровым рисунком, отображаемым слева, и выделять структуру векторных
штрихов, нажав кнопку Проверка сплошной линии ( ).

Вы можете активировать или деактивировать его, изменить его размер или перемещаться по его со-
держимому.

Если вы измените какой-либо параметр в Настройках конвертации в вектор, предварительно про-
сматриваемый рисунок автоматически обновится, чтобы показать, как изменения влияют на результат.

Совет: Чтобы активировать область предварительного просмотра:

1. В Xsheet/Timeline выберите рисунок, который вы хотите просмотреть.

2. Нажмите кнопку Переключить просмотр образцов ( ) в нижней панели окна «Настройки
конвертации в вектор».

Совет: Чтобы отключить область предварительного просмотра:

Нажмите кнопку Переключить просмотр образцов ( ) в нижней панели окна «Настройки кон-
вертации в вектор».

Совет: Чтобы изменить размер области предварительного просмотра:

Выполните любое из следующих действий:

• Нажмите и перетащите горизонтальный разделитель.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть область предварительного
просмотра.

• Нажмите и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить область предварительного просмотра.

Совет: Для навигации по области предварительного просмотра:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте горячую клавишу сброса (по умолчанию клавиша 0), чтобы отобразить предвари-
тельный просмотр в его реальном размере

Совет: Чтобы активировать и деактивировать Проверку сплошной линии:
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Нажмите кнопку Переключить проверку сплошной линии ( ) в нижней части окна «Настройки
конвертации в вектор».

Сохранение и загрузка настроек конвертации в вектор

Настройки конвертации в вектор могут быть сохранены в виде tnzsettings файлов, чтобы иметь разные
настройки для каждого уровня и быть загруженными обратно и использоваться в другой сцене.

Загруженные настройки конвертации в вектор также можно назначить настройками по умолчанию
для сцены или проекта (см. Настройки сцены и Настройки проекта по умолчанию).

Совет: Чтобы сохранить настройки конвертации в вектор:

1. Нажмите кнопку Сохранить настройки ( ) в нижней части окна «Настройки конвертации в
вектор».

2. В открывшемся браузере выберите для файла tnzsettings местоположение и имя и нажмите кноп-
ку Сохранить.

Совет: Для загрузки сохраненных настроек конвертации в вектор:

1. Нажмите кнопку Загрузить изменения ( ) в нижней панели окна «Настройки конвертации
в вектор».

2. В открывшемся браузере найдите файл tnzsettings, который вы хотите загрузить, и нажмите
кнопку Загрузить.

Совет: Для сброса настроек конвертации в вектор по умолчанию в сцене:

Нажмите кнопку Сбросить настройки ( ) в нижней части окна Конвертации в вектор.

10.2 Изменение размера холста

Можно изменить размер уровней Toonz Raster и Raster, чтобы увеличить или уменьшить область
вокруг изображений уровня.
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Новый размер может быть установлен в любой единице, поддерживаемой OpenToonz, используя аб-
солютные или относительные значения. Если холст увеличивается, добавляется некоторая белая про-
зрачная область; если холст уменьшен, некоторая обрезка применяется к изображениям уровня.

Совет: Чтобы изменить размер холста:

1. Выберите уровень Toonz Raster или Raster, который вы хотите изменить, в Xsheet / Timeline.

2. Выберите Уровень → Размер холста. . . , откроется диалоговое окно Размер холста.

3. В диалоговом окне установите Ед. изм, чтобы выразить новый размер холста, и установите
Ширина и Высота нового холста; активируйте параметр Относительный, чтобы определить
новый размер, указав только размер, который холст должен увеличивать или уменьшать.

4. Используйте диаграмму Анкер, чтобы определить положение текущего холста на новом: стрелки
представляют собой ссылку, чтобы увидеть, как новый размер увеличит или уменьшит текущий
размер холста.

5. Нажмите кнопку Изменить размер.
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Примечание: Если новый размер холста меньше текущего, откроется диалоговое окно подтвержде-
ния с вопросом, хотите ли вы обрезать холст.

10.3 Редактирование рисунка

Уровнями Toonz Vector, Toonz Raster и Raster можно манипулировать в OpenToonz.

Чтобы отредактировать рисунок, например скопировать его часть, сначала выделите в Xsheet/Timeline
или в Level Strip. При выделении в Xsheet/Timeline, вьювер отображает все содержимое сцены в теку-
щем кадре, при выделении Level Strip, вьювер отображает только выбранный кадр текущего уровня
анимации, чтобы позволить вам работать болееe удобно.

Рисунки также могут быть выбраны непосредственно в программе просмотра: это позволяет вам ра-
ботать над различными рисунками, видимыми в определенном кадре без необходимости извлекать их
в Xsheet/Timeline или Level Strip.

Примечание: Все ваше редактирование рисунка не сохраняется пока вы не сохраните соответству-
ющий уровень, или не используете команду Сохранить все (см. Сохранение уровней ).

Совет: Чтобы выбрать рисунок для редактирования:

Выполните одно из следующих действий:

• Выберите его в Xsheet / Timeline или Level Strip.

• Щелкните правой кнопкой мыши во вьювере рисунок, который вы хотите редактировать, и в
открывшемся меню, выберите команду Select, относящуюся к столбцу, содержащему рисунок
который вы хотите редактировать.

Примечание: Меню правого клика сначала перечисляет все столбцы, содержащие перекрывающиеся
рисунки, а затем столбцы и объекты, которые иерархически связаны с выбранным.

10.3.1 Использование Инструмента выделения

Инструмент Выделения ( ) позволяет редактировать, перемещать, вращать,масштабировать и на-
клонять выделение на рисунке.

На панели параметров инструмента вы можете установить следующее:

• Тип: имеет параметры Прямоугольный, чтобы выбрать область поля, которую вы определя-
ете, щелкая и перетаскивая; От руки, чтобы выбрать область, которую вы обводите, нажав и
перетащив; и Полилиния, чтобы выбрать область, которую вы очерчиваете, определяя ряд ли-
ний. На векторных рисунках векторный штрих выбирается, только если он полностью включен
в определяемую вами область.

• Режим: имеет параметры Стандарт, для выбора векторов; Выбранные Кадры, для редакти-
рования всех строк выбранных кадров одновременно; Уровень целиком, чтобы преобразовать
все рисунки текущего уровня анимации; Того же стиля, чтобы выбрать сразу все векторы,
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окрашенные в тот же стиль в текущем чертеже; Того же стиля на выбранных кадрах, что-
бы выбрать сразу все векторные штрихи, окрашенные одинаковым стилем в выбранных кадрах
текущего уровня анимации; Того же стиля во всем уровне , чтобы выбрать сразу все вектор-
ные штрихи, нарисованные одним и тем же стилем на всех чертежах текущего уровня анимации;
Отделяющие линии, чтобы выбрать все граничные штрихи текущего чертежа; Отделяющие
линии на выбранных кадрах, чтобы выбрать все штрихи границы выбранных кадров; От-
деляющие линии на всём уровне, чтобы выбрать все штрихи границы всего уровня. Это
доступно только для векторных рисунков Toonz.

• Сохранять толщину сохранит первоначальную толщину векторов чертежа при выполнении
операций изменения размера. Это доступно только для векторных рисунков Toonz.

• Масштаб H и V устанавливает горизонтальное и вертикальное масштабирование текущего вы-
бора.

• Связать сохранит пропорцию выделения при перетаскивании по любой из букв Масштаб H или
V на панели параметров инструмента.

• Вращение устанавливает поворот текущего выделения.

• Position X and Y set a vertical and horizontal offset for the selection.

• Толщина устанавливает толщину выделенных векторных штрихов. В случае, если выбранные
штрихи имеют переменную толщину или разные значения толщины, отображается самое высокое
значение, и любое изменение соответственно повлияет на другие значения. Это доступно только
для векторных рисунков Toonz.

• Конец: устанавливает форму концов выбранных векторных штрихов. Возможные варианты:
Обрубок для квадратов, Закругленный для полукруглых концов и Плоский для квадратов,
выходящих за конец линии, в зависимости от толщины обводки. Это доступно только для век-
торных рисунков Toonz.

Рис. 1: Простой, закругленный и плоский кончик.

• Изгиб: устанавливает форму прямых углов вдоль выбранных векторных штрихов. Варианты:
Острый изгиб для острых углов, Закругленный изгиб для закругленных углов, Скошенный
изгиб для квадрата. Это доступно только для векторных рисунков Toonz.

• Острый: устанавливает максимальную длину соединения Острый изгиб, которое вычисляется
умножением значения Острый на толщину хода. Если длина превышает максимальное значение,
соединение Острый превращается в соединение Закругленный. Это доступно только для вектор-
ных рисунков Toonz, и только если опция Изгиб: установлена на Острый.

• Флажок Изменить Savebox позволяет изменить размер Savebox рисунка. Часть рисунка, кото-
рая из-за редактирования выпадает за пределы окна сохранения, будет удалена. Это доступно
только для рисунков Toonz Raster.

Примечание: Размер Savebox можно автоматически установить на минимальный размер, акти-
вировав параметр «Настройки программы» → «Рисунок» → Минимизировать Savebox после
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Рис. 2: Острый, закругленный и скошенный изгиб.

правки.

• Без сглаживания, когда активирован, сглаживание не применяется, когда выделение дефор-
мировано или повернуто. Это доступно только для рисунков Toonz Raster и Raster.

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

Когда выбор сделан, он отображается с ограничительной рамкой с ручками, которые позволяют вам
выполнять следующие преобразования:

• Перемещать, щелкните и перетащите внутреннюю часть выделенного растра или лю-
бой выбранный вектор выделенного вектора, чтобы переместить его; при нажатии кла-
виши Shift во время перетаскивания движение будет ограничено в горизонтальном или
вертикальном направлении.

Примечание: Клавиши со стрелками на клавиатуре также можно использовать
для перемещения выделения на один пиксель в любом направлении; если они ис-
пользуются при нажатии клавиши Shift, движение будет с шагом 10 пикселей.

• Вращать, щелкните и перетащите за любую угловую ручку, чтобы повернуть выде-
ление.

• Масштабировать, щелкните и перетащите любой угловой маркер, чтобы свободно
масштабировать выделение; при нажатии клавиши Shift при перетаскивании масшта-
бирование будет равномерным; при нажатии клавиши Alt масштабирование будет при-
менено от центра.

• Масштабировать в одном направлении, щелкните и перетащите любую боковую
ручку, чтобы масштабировать выделение в одном направлении; при нажатии клавиши
Alt масштабирование будет применено симметрично от центра.

• Центрировать, щелкните и перетащите центральную ручку, чтобы изменить центр
вращения, а также центр, используемый при Alt-масштабировании.

• Наклонять, Ctrl-клик (ПК) или Cmd-клик (Mac) любой угловой маркер, чтобы ис-
казить выделение, или любой боковой маркер, чтобы срезать его.
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Примечание: Ctrl-щелчок (PC) или Cmd-щелчок (Mac) не применимы в режи-
мах Уровень целиком (см. выше).

• Толщина, щелкните двойную стрелку в правом нижнем углу выделения и перетащите
вверх, чтобы увеличить толщину выделенных линий, вниз, чтобы уменьшить ее. Эта
опция доступна только для векторных рисунков Toonz.

Чтобы применить преобразования, вы можете нажать за пределами выделения.

Примечание: При наведении курсора на курсор курсор меняет форму, чтобы указать операции,
которые вы можете выполнить.

Выделенноетакже может быть вырезано, скопировано, вставлено и удалено с помощью соответствую-
щего пункта в меню «Правка». Вырезать или копировать и вставлять также работать с одного рисунка
на другой, или на новый. Это позволяет копировать или перемещать часть рисунка на другой рисунок
или разбивать рисунок на несколько.

Когда рисунок на уровне Toonz или его часть вставляется в другой, стили вставленного рисунка до-
бавляются в палитру целевого уровня, если в палитре уже не доступны те же стили.

Примечание: Выделение также можно использовать для изменения стиля векторных штрихов, вы-
брав его в палитре или создав новый стиль при выделении. См. Редактирование стилей.

Совет: Для редактирования окна сохранения рисунка:

1. Активируйте опцию Изменить Savebox, чтобы визуализовать окно сохранения вокруг рисунка.

2. Используйте ручки, чтобы изменить его размер.

3. Отключите параметр Изменить Savebox, чтобы подтвердить изменения.

Совет: Чтобы выбрать и преобразовать область на уровне Toonz Raster или Raster:

1. Выберите область, выполнив одно из следующих действий:

• Установите режим на Прямоугольный, нажмите и перетащите, чтобы определить поле, область
которого вы хотите выбрать.

• Установите тип От руки, нажмите и перетащите, чтобы выделить область, которую вы хотите
выбрать.

• Установите тип Полилиния и щелкните, чтобы выделить область, которую вы хотите выделить,
определив серию линий.

2. Выполните одно из следующих действий для геометрических преобразований:

• Используйте ручки, доступные вдоль ограничительной рамки.

• Отредактируйте значения масштаба, поворота и положения, доступные на панели параметров
инструмента.

Совет: Чтобы выбрать и преобразовать векторы на уровне Toonz Vector:
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Рис. 3: Сначала определите область, которую вы хотите выбрать, затем используйте ограничивающий
прямоугольник для геометрических преобразований.

1. Выберите векторы, выполнив одно из следующих действий:

• Кликните по линии, чтобы выбрать ее.

• Удерживая нажатой клавишу «Shift», можно добавить или удалить выбранные линии из текущего
выделения.

• Установите режим Прямоугольный и щелкните и перетащите вправо, чтобы определить
поле и выбрать все линии, которые полностью включены в поле; щелкните и перетащите
влево, чтобы выбрать все линии, которые частично включены в поле.

• Установите режим От руки, нажмите и перетащите, чтобы обвести область и выбрать все линии,
которые полностью включены в область.

• Установите режим Полилиния и щелкните, чтобы обвести область, определив серию линий, и
выберите все линии, которые полностью включены в область.

• Установите режим на Того же стиля и нажмите, чтобы автоматически выбрать все векторы, на-
рисованные в том же стиле, который использовался для вектора, выбранного в текущем рисунке,
или щелкните, удерживая клавишу «Shift», чтобы добавить их или удалить из выделения.

Примечание: При нажатии на линию, принадлежащую группе, выделятеся вся группа
(см. Группировка и разгруппировка векторов).

2. Выполните одно из следующих действий для геометрических преобразований:

• Используйте ручки, доступные вдоль ограничительной рамки.

• Измените значения масштаба, поворота, положения и толщины, доступные на панели параметров
инструмента.

Совет: Чтобы выбрать и преобразовать все рисунки уровня Toonz Vector:
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Рис. 4: Сначала выберите векторные линии, которые вы хотите преобразовать, затем используйте
ограничивающий прямоугольник для геометрических преобразований.

1. Выполните одно из следующих действий:

• Установите режим Уровень целиком, чтобы автоматически выбирать все линии на всех рисун-
ках текущего уровня анимации.

• Установите режим Того же стиля во всем уровне и щелкните, чтобы выбрать сразу все линии,
нарисованные в том же стиле, который использовался для штриха, выбранного на всех рисунках
текущего уровня анимации, или кликните по ним, зажав клавишу Shift, чтобы добавить их или
удалить из выбора.

2. Выполните одно из следующих действий, чтобы выполнить геометрические преобразования, вли-
яющие на все чертежи уровней:

• Используйте ручки, доступные вдоль ограничительной рамки.

• Измените значения масштаба, поворота, положения и толщины, доступные на панели параметров
инструмента.

Примечание: При работе на уровне целиком ограничивающая рамка, отображаемая на рисунке
текущего уровня, имеет двойные линии.

Совет: Чтобы вставить выделение в другой существующий рисунок:

1. Выделите требуемое в текущем рисунке.

2. Скопируйте или вырежьте его.

3. Выберите другой рисунок на Level Strip или на Xsheet/Timeline.

4. Вставьте скопированный/вырезанный фрагмент.

Примечание: Выделенные фрагменты из уровней Toonz Raster и Toonz Vector могут быть вставлены
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в любой другой тип рисунков, автоматически преобразуются вставленный выбор в соответствующий
тип; выделенное из стандартных растровых уровней могут быть вставлены только в другие растровые
рисунки.

Совет: Чтобы вставить выделение в новый рисунок:

1. Выделите требуемое в текущем рисунке.

2. Скопируйте или вырежьте его.

3. Выберите пустой кадр в Level Strip или пустую ячейку в Xsheet.

4. Вставьте скопированный/вырезанный фрагмент.

Совет: Чтобы объединить несколько рисунков в один рисунок:

1. Выберите область, которую хотите объединить, и скопируйте/вырежьте ее.

2. Выберите рисунок, в который вы хотите вставить выделение.

3. Вставьте скопированный/вырезанный фрагмент.

Примечание: Несколько уровней растровой анимации также можно объединить одновременно с
помощью соответствующей команды (см. Объединение уровней анимации).

Совет: Чтобы разбить рисунок на несколько рисунков:

1. Выберите область, которую вы хотите использовать в качестве нового рисунка, и скопируй-
те/обрежьте его.

2. Выберите пустую ячейку в Xsheet.

3. Вставьте скопированный/вырезанный фрагмент: автоматически будет создан новый рисунок.

10.3.2 Группировка и разгруппировка векторов

Все векторные линии рисунка лежат в одной плоскости, поэтому области рисования очерчены отрез-
ками, определенными пересечениями штрихов. Это означает, что если вы рисуете два пересекающихся
квадрата, автоматически определяются три области: одна принадлежит только первому квадрату, вто-
рая - второму, а другая определяется пересечением.

Для организации линий вы можете использовать функции группировки, которые создают новую груп-
повую сущность, содержащую только выбранные вами линии.

В случае двух пересекающихся квадратов, если вы хотите, чтобы два квадрата перекрывались, а не
пересекались, вы можете создать группу, содержащую линии первого квадрата и еще линии второго
квадрата, таким образом определяя две группы, порядок которых может быть организован.

Можно создать столько групп, сколько вы хотите; группы могут быть сделаны только из одной линии,
например, из круга или линии.
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Рис. 5: Рисование рисунка, который содержит пересекающиеся векторные линии и фигуры, может
быть проблемой, потому что все они лежат на одном слое.

Рис. 6: Сначала определите группы, затем установите правильный порядок наложения для решения
проблем пересечения.

140 Глава 10. Рисование уровней анимации



OpenToonz Documentation, Выпуск 1.7.1

При рисовании с помощью Геометрического ( ) инструмента замкнутые фигуры (например, пря-
моугольники, круги, эллипсы, многоугольники и замкнутые полилинии) можно автоматически опреде-
лить как группу, активировав опцию Автогруппировать (см. Рисование с помощью геометрического
инструмента).

Когда вами выделено одна или несколько групп, новая группа также будет включать их, сохраняя их
и их исходное положение порядка сортировки на случай, если группа будет освобождена.

Примечание: Невозможно определить группу, если выбор включает только несколько штрихов,
принадлежащих группе.

Когда группа освобождается, если никакая другая группа не определена на том же рисунке, все линии
будут лежать в одной плоскости; если определены другие группы, линии освобожденной группы будут
лежать на плоскости позади, перед или между другими группами в соответствии с исходной позицией
порядка сортировки группы.

Можно вводить группы, чтобы визуально изолировать их от остальной части рисунка и лучше понять,
какие линии находятся внутри, а какие - вне группы. Таким образом, над рисунком также легче
работать, например, чтобы заполнить область или изменить цвет некоторых линий.

Так как инструмент Выделения ( ) рассматривает группу в целом, если вы хотите выбрать линию,
принадлежащую группе, сначала необходимо ввести группу, а затем выбрать линию.

Примечание: Поскольку группы определяют, какие линии принадлежат определенной плоскости,

при использовании инструмента Заливка ( ) могут быть заполнены только области, определенные
линиями в одной и той же группе.

Совет: Чтобы определить группу:

1. Используйте инструмент Выделение ( ), чтобы выбрать линии, которые вы хотите включить
в группу.

2. Выполните одно из следующих действий:

• Choose Edit → Group → Group.

• Щелкните правой кнопкой мыши по выделенному и выберите Сгруппировать в открывшемся
меню.

Совет: Чтобы распустить группу:

1. Выберите группу, которую вы хотите распустить.

2. Выполните одно из следующих действий:

• Choose Edit → Group → Ungroup.

• Щелкните правой кнопкой мыши на выделении и выберите Разгруппировать в открывшемся
меню.

Совет: Для входа в группу:
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Выполните одно из следующих действий:

• Select the group, then choose Edit → Group → Enter Group.

• Щелкните правой кнопкой мыши группу и выберите Войти в группу в открывшемся меню.

• Дважды щелкните по группе.

Совет: Для выхода из группы:

Выполните одно из следующих действий:

• Choose Edit → Group → Exit Group.

• Щелкните правой кнопкой мыши группу и выберите Выход из группы в открывшемся меню.

• Дважды щелкните за пределами группы.

Совет: Чтобы выбрать группу:

Выберите инструмент Выделения ( ) и выполните одно из следующих действий:

• Щелкните по любой линии, принадлежащей группе.

• Нажмите и перетащите, чтобы выбрать хотя бы одну линию, принадлежащую группе.

• Установите режим Прямоугольный, щелкните и перетащите, чтобы определить поле и выберите
хотя бы одну линию, принадлежащую группе.

• Установите режим От руки, щелкните и перетащите, чтобы обвести область и выберите хотя бы
одну линию, принадлежащую группе.

• Установите режим Полилиния и щелкните, чтобы обвести область, определив серию линий, и
выберите хотя бы одну линию, принадлежащую группе.

Совет: Чтобы выбрать линию в группе:

1. Войдите в группу.

2. Щелкните по линии, чтобы выбрать ее.

10.3.3 Установка линии и порядка сортировки группы

Для каждого векторного рисунка порядок сортировки линий и групп можно изменить, установив, что
должно находиться впереди, а что позади.

Совет: Чтобы вывести выделение на передний план:

Выполните одно из следующих действий:

• Choose Edit → Arrange → Bring to Front.

• Щелкните правой кнопкой мыши на выделении и выберите На передний план в открывшемся
меню.
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Рис. 7: Выберите векторные линии, создайте группы и установите их порядок наложения, чтобы лучше
управлять рисунком.

Совет: Чтобы перенести выделение на один уровень вперед:

Выполните одно из следующих действий:

• Choose Edit → Arrange → Bring Forward.

• Щелкните правой кнопкой мыши по выделению и выберите На порядок выше в открывшемся
меню.

Совет: Чтобы отправить выделение назад:

Выполните одно из следующих действий:

• Choose Edit → Arrange → Send Back.

• Щелкните правой кнопкой мыши по выделению и выберите На порядок ниже в открывшемся
меню.

Совет: Чтобы отправить выделение на один уровень назад:

Выполните одно из следующих действий:

• Choose Edit → Arrange → Send Backward.

• Щелкните правой кнопкой мыши по выделению и выберите Отправить на задний план в
открывшемся меню.
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10.3.4 Редактирование векторных рисунков

Векторные рисунки могут быть отредактированы некоторыми дополнительными способами, используя
набор инструментов. Это позволяет вам, например, лучше откалибровать изгиб вектора или изменить
его толщину.

Все эти преобразования также могут быть достигнуты на уже покрашенных рисунках, потому что
стили заливки, используемые для рисования, будут автоматически следовать форме областей, которые
вы изменяете, работая как «жидкая» краска, заполняя область, определенную контуром.

Редактирование векторных контрольных точек

Чтобы изменить вектор путем редактирования его контрольных точек, вы можете использовать ин-

струмент Редактор контрольных точек ( ).

Контрольные точки имеют ручки, длина и направление которых определяют изгиб вектора. С помо-
щью этого инструмента вы можете выбрать вектор и изменить маркеры контрольной точки или изгиб
кривой, определенной контрольными точками, а также перемещать, добавлять или удалять контроль-
ные точки.

Дескрипторы контрольных точек могут быть связаны, то есть они имеют одинаковое направление, или
нет, создавая излом в векторе; они также могут быть свернуты в контрольной точке, чтобы повернуть
ее в угловой точке. В случае, если свернута только одна ручка, точка будет угловой с одной стороны
и гладкой с другой. Когда сечение вектора определяется двумя угловыми точками, это будет прямая
линия.

Опция Автовыбор рисунка доступна для автоматического выделения любого вектора любого рисунка,
видимого в окне просмотра.

Рис. 8: Нажмите, чтобы выбрать векторную линию и отредактировать его контрольные точки; Alt-
клик, чтобы отсоединить маркеры контрольной точки; Ctrl (PC) или Cmd (Mac)-клик, чтобы выбрать
контрольную точку.

Совет: Чтобы выбрать вектор:

Щелкните по нему.

Совет: Чтобы редактировать изгиб вектора:

Выполните любое из следующих действий:

• Нажмите и перетащите концы маркеров контрольной точки.
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• Нажмите и перетащите кривую, определенную контрольными точками, чтобы отредактировать
ее.

• Удерживая нажатой клавишу Shift, перетащите кривую, заданную контрольной точкой, чтобы
отредактировать ее, сохранив положение контрольных точек.

Совет: Чтобы отсоединить маркеры контрольной точки:

Удерживая клавишу Alt, щелкните один из концов ручки и перетащите.

Совет: Чтобы связать ручки контрольной точки:

Удерживая клавишу Alt, щелкните один из концов маркера и перетащите его: другой маркер привя-
зывается к направлению перетаскивания.

Совет: Чтобы добавить контрольную точку:

Ctrl-клик (PС) или Cmd-клик (Mac) вектор, где вы хотите добавить контрольную точку.

Совет: Чтобы выбрать контрольные точки:

Выполните одно из следующих действий:

• Нажмите контрольную точку, чтобы выбрать ее.

• Ctrl-клик (Pc) или Cmd-клик (Mac) контрольной точки, чтобы добавить ее в выделение.

• Нажмите и потяните, чтобы выбрать все контрольные точки, которые включены в область вы-
бора.

Совет: Чтобы переместить выделение:

Выполните одно из следующих действий:

• Нажмите любую выбранную контрольную точку и потяните.

• Используйте клавиши со стрелками, чтобы переместить выделение на один пиксель вправо, влево,
вверх или вниз.

Совет: Чтобы удалить выделение:

Выберите пункт меню Правка → Удалить.

Совет: Чтобы превратить контрольную точку в угловую точку:

Выполните одно из следующих действий:

• Щелкните с нажатой кнопкой Alt по контрольной точке.

• Переместите концы ручки к контрольной точке, чтобы свернуть их.
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• Right-click the control point and choose Set Linear Control Point from the menu that opens.

Совет: Чтобы получить ручки из угловой точки:

Выполните одно из следующих действий:

• Alt-щелкните по угловой точке.

• Right-click the control point and choose Set Nonlinear Control Point from the menu that opens.

Изменение изгиба векторных линий

Чтобы изменить изгиб векторной линии более интуитивно понятным способом, вы можете использовать

инструмент Щипок ( ). Вы можете использовать его в любом месте на ходу, чтобы изменить изгиб
в любом направлении.

Когда инструмент выбран, отрезок центральной линии ближайшей линии подсвечивается: сегмент
показывает длину линии, на которую будет влиять растягивание.

Длина сегмента зависит от угловых точек, которые инструмент автоматически определяет вдоль хо-
да, в соответствии со значением Угол. Его также можно установить вручную, активировав опцию
Вручную и, таким образом, используя значение Размер, чтобы установить соответствующую длину.

Когда активирован режим Вручную, вдоль выделенной линии отображается ручка для интерактив-
ного управления длиной сегмента, на который воздействует инструмент. Ручка имеет двойной круг и
квадрат на концах, что позволяет выполнять следующие действия:

• Двойной круг позволяет перемещать ручку вдоль сегмента.

• Квадрат позволяет увеличить длину сегмента, на который воздействует инструмент, кликая и
перетаскивая вправо, или уменьшая ее кликая и перетаскивая влево.

Как в автоматическом, так и в ручном режимах, при щелчке и перемещении курсора могут выпол-
няться различные типы редактирования:

• Щелкните и потяните, чтобы изменить изгиб выделенного сегмента.

• Щелкните, удерживая клавишу Shift, и перетащите, чтобы отредактировать выделенный
сегмент, добавив кончики.

• Ctrl-клик (PC) или Cmd-клик (Mac) и перетащите, чтобы редактировать выделенный сегмент,
добавив угол.

Совет: Чтобы изменить изгиб линии:

1. Измените длину сегмента, на который воздействует инструмент, установив значение Угол на
панели параметров инструмента.

2. Щелкните, щелкните с нажатой клавишей Shift или щелкните, удерживая клавишу Ctrl (PС) или
Cmd (Mac), и перетащите, чтобы изменить изгиб выделенного сегмента.

Совет: Чтобы изменить изгиб линии вручную:

1. Активируйте параметр Вручную на панели параметров инструмента.
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Рис. 9: Нажмите и перетащите, чтобы изменить изгиб; Shift-щелчок, чтобы добавить кончики; Ctrl
(PC) или Cmd (Mac)-щелчок, чтобы добавить угол.

2. Измените длину сегмента, на который воздействует инструмент, выполнив одно из следующих
действий:

• Установите значение Размер на панели параметров инструмента.

• Нажмите и перетащите маленький квадрат на одном конце ручки, отображаемой вдоль выделен-
ной линии.

3. Щелкните или щелкните с нажатой клавишу Shift или Ctrl (ПК) или Cmd (Mac) и перетащите,
чтобы изменить изгиб выделенного сегмента.

Совет: Чтобы исключить угловую точку из сегмента:

1. Нажмите и перетащите точку, пока гладкий сегмент не будет сформирован снова.

2. Нажмите и перетащите, чтобы исправить изгиб недавно сглаженного сегмента.

Применение других модифицирующих инструментов

Чтобы изменить толщину штриха, вы можете использовать инструмент Насос ( ). Вы можете ис-
пользовать его где угодно, чтобы увеличить или уменьшить толщину локально. Когда инструмент
выбран, сегмент ближайшей линии подсвечивается: сегмент показывает длину линии, на которую воз-
действует инструмент. Чтобы изменить эту длину, вы можете изменить значение Размер на панели
параметров инструмента.

Примечание: Можно изменить толщину линии, выделенных линий или линии на всех рисунках

уровней с помощью инструмента Выделения ( ) и связанных с ним параметров (см. Использование
инструмента выделения).

Чтобы исказить более одной линии одновременно, вы можете использовать инструмент Магнит ( ).
Инструмент влияет на все линии, включенные в круглую область, и позволяет искажать их в направле-
нии перетаскивания. Выделенные сегменты покажут линии, которые будут затронуты. Чтобы изменить
диапазон действия инструмента, представленный кружком, вы можете изменить размер инструмента
на панели параметров инструмента.

Чтобы согнуть часть рисунка, например руку персонажа, вы можете использовать инструмент Клещи

( ). Инструмент позволяет определить линию, а затем согнуть все линии, пересекаемые сегментом.
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Во время изгиба вы можете видеть пораженные линии, принимающие их положение после трансфор-
мации. Изгиб может быть выполнен как по часовой стрелке, так и против часовой стрелки; как только
вы начинаете перетаскивать, вы не можете изменить направление изгиба.

Примечание: Если вы переместите курсор далеко от центра изгиба, вы сможете с большей точностью
установить величину изгиба, который вы хотите применить к линиям.

Чтобы сгладить линии, вы можете использовать инструмент Утюг ( ). При повторном и повторном
использовании одного и того же хода он все больше сглаживает изгибы хода. Когда инструмент выбран,
курсор привязывается к ближайшей линии, чтобы указать, где вы собираетесь работать.

Совет: Чтобы изменить толщину линии:

1. Выберите инструмент Насос ( ).

2. Установите значение Размер: на панели параметров инструмента.

3. Щелкните в точку линии, где вы хотите изменить толщину, и перетащите вверх, чтобы увеличить
ее, или вниз, чтобы уменьшить ее.

Рис. 10: С помощью инструмента Насос измените толщину нарисованных штрихов.

Совет: Чтобы деформировать несколько линий одновременно:

1. Выберите инструмент Магнит ( ).

2. Щелкните в окне просмотра: инструмент будет влиять на все линии, включенные в круг.

3. Перетащите, чтобы исказить линии в направлении вашего перетаскивания.

Совет: Чтобы согнуть одну или несколько строк:

1. Выберите инструмент Клещи ( ).
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2. Нажмите на одну сторону линий, которые вы хотите согнуть, чтобы установить центр сгиба.

3. Нажмите на противоположную сторону линий: изгиб повлияет на все линии, пересекаемые опре-
деленной линией.

4. Перетащите в нужном направлении, чтобы согнуть линии.

Совет: Для выпрямления линии:

1. Выберите инструмент Утюг ( ).

2. Нажмите и перетащите вдоль линии, которую вы хотите спрямить. При перетаскивании снова и
снова линия будет все больше выпрямляться.

Присоединение и разделение

Чтобы соединить концы двух разных векторных линий, вы можете использовать инструмент Скотч

( ). Таким образом, будет возможно обрабатывать их как одну линию, например, для изменения их
изгиба или толщины в целом.

Когда инструмент используется, указатель привязывается к ближайшей обнаруженной конечной точке
хода, чтобы упростить операцию.

Примечание: Инструмент Скотч ( ) также можно использовать для закрытия зазоров вдоль
контура рисунка в целях заливки (см. Закрытие пробелов в контуре рисунка).

Чтобы сделать наоборот, то есть разделить черту на две части, вы можете использовать инструмент

Нож ( ).

Совет: Чтобы соединить два открытых конца одной или двух линий:

1. Выберите инструмент Скотч ( ) и активируйте опцию Соеднинять векторы; активируйте
также параметр Плавность, если вы хотите плавное соединение без углов.

2. Выполните одно из следующих действий:

• Установите режим Обычный и режим Вершина к вершине, щелкните конечную точку линии
и перетащите на другую конечную точку; указатель привязывается к ближайшей обнаруженной
конечной точке линии.

• Установите режим Прямоугольный, нажмите и перетащите, чтобы определить поле, включа-
ющее конечные точки, которые вы хотите подключить; конечные точки будут автоматически
соединены в соответствии с установленным значением Расстояние.

Примечание: Если линии, которые вы собираетесь соединить, имеют разные стили, стиль первого
вектора, на котором вы щелкнете, будет назначен второму после соединения.

Совет: Чтобы разделить линию:
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1. Выберите инструмент Нож ( ): указатель привязывается к ближайшей линии, указывая ма-
леньким выделенным сегментом точку, в которой вы собираетесь разделить линию.

2. Нажмите, чтобы разделить линию в выделенной точке.

Очистка пересечения линий

Пересечения векторных линий могут быть слабым местом на рисунках, которые нужно покрасить,
потому что если возникает разрыв, области рисования не могут быть нарисованы должным образом.

Лучшее решение для такого рода проблем - перекрыть последний участок линиями, чтобы определить
четкие пересечения, а затем автоматически удалить излишние концы линий.

Совет: Для очистки векторных пересечений:

1. С помощью инструмента Выделение ( ) выберите линии, пересечения которых вы хотите
очистить.

2. Выполните одно из следующих действий:

• Choose Level → Optimize → Remove Vector Overflow.

• Щелкните правой кнопкой мыши по выделенной области и выберите пункт Удалить векторные
излишки в открывшемся меню.

10.4 Техники анимации

Помимо рисования покадрово, по одному изображению за раз, пока вы не достигнете нужной анимации,
некоторые функции легче реализовать благодаря функциям OpenToonz.

Какой бы ни была техника, вы можете контролировать свою работу и плавность анимации, используя
кальку, которая позволяет просматривать более одного изображения в средстве просмотра одновре-
менно в качестве справочного.

10.4.1 Моделирование векторного рисунка

Вместо того, чтобы анимировать уровень, начиная каждый раз с пустого кадра, вы можете продуб-
лировать векторный рисунок и внести последующие изменения. Вы можете сделать это, даже если
рисунки покрашены, потому что стили, используемые для рисования, будут автоматически следовать
форме областей, которые вы изменяете (см. Редактирование рисунков).

Последовательность рисунков уровня анимации можно легко контролировать в Level Strip.

Вы можете использовать обе команды Ячейки → Дублировать рисунок и стандартные команды
Копировать и Вставить, чтобы сделать копию рисунка, которую впоследствии можно изменить,
чтобы создать небольшие движения.

При использовании команды Дублировать рисунок выбранный рисунок дублируется в следующем
кадре. Если следующий кадр уже содержит рисунок, он сдвигается вниз, чтобы вставить дублирован-
ный рисунок в последовательность.

Когда вы используете команды Копировать и Вставить, вы также можете выбрать кадр уровня,
куда вы хотите вставить рисунок.
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Закончив, вы можете сделать копию измененного рисунка и изменить его в свою очередь. Вы можете
продолжать дублировать и изменять рисунки, пока не пройдете уровень анимации.

Совет: Чтобы создать уровень анимации путем моделирования векторных рисунков:

1. В окне просмотра выберите рисунок уровня векторной анимации, который вы хотите редактиро-
вать.

2. На Level Strip выберите рисунок, который вы хотите дублировать.

3. Скопируйте выбранный рисунок в следующем кадре, выполнив одно из следующих действий:

• Выберите Ячейки → Дублировать рисунок.

• Выберите Правка → Копировать, затем выберите следующий кадр и выберите пункт меню
Вставить.

4. Выберите новый рисунок в Level Strip.

5. Используйте инструменты-модификаторы для изменения рисунка.

6. Продолжайте дублировать и модифицировать рисунки, пока не пройдете уровень анимации.

10.4.2 Использование фазовки с векторными рисунками

Техника анимации, зарезервированная для уровней векторной анимации, - это использование команды
Фазовка. создает промежуточные рисунки из двух крайних значений диапазона выбранных кадров в
Level Strip.

Если в Level Strip выбрано более двух кадров, справа от каждого кадра отображается вертикальная
полоса с надписью INBETWEEN. Если щелкнуть по ней, все кадры между первым и последним
выбранным будут перезаписаны изображениями, интерполированными от первого до последнего ри-
сунка.

Интерполированные рисунки создаются с учетом количества линий и их направления. Это означает,
что результат будет зависеть от того, как были сделаны чертежи. Например, если первое изображение
представляет собой одну фигуру, нарисованную по часовой стрелке, а последнее - другую фигуру, вы
получите разные результаты в зависимости от того, как оно было нарисовано, по часовой стрелке или
против часовой стрелки.

Чтобы получить наилучшие результаты со сложными рисунками, скопируйте рисунок, с которого вы
хотите выполнить интерполяцию, и вставьте его в другой кадр Level Strip. Модифицируйте вставлен-
ный рисунок, не добавляя и не удаляя линии, а только деформируя и перемещая существующие линии
(см. Редактирование рисунков). Выберите весь диапазон и затем выполните интерполяцию.

Ускорением интерполяции можно управлять в диалоговом окне, которое открывается перед выполне-
нием режима фазовки. Варианты следующие:

• Линейная, для постоянной интерполяции.

• Замедл. в начале, для интерполяции, начинающейся медленно, а затем ускоряющейся.

• Замедл. в конце, для быстрой, а затем медленной интерполяции.

• Замедл. в нач./ конце, для интерполяции, начинающейся медленно, становясь быстрее, а затем
снова замедляясь.

Если вы хотите, чтобы интерполяция происходила медленнее или быстрее, вы можете вставить кадры
или обрезать их и снова использовать промежуточный элемент.
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Рис. 11: Продублируйте рисунок; измените его; вставьте пустые кадры; выберите диапазон кадра, затем
нажмите вертикальную черту INBETWEEN.
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Совет: Для создания фазованных рисунков:

1. Выберите уровень, на котором вы хотите выполнить интерполяцию.

2. В Level Strip выберите диапазон кадра, от рисунка, с которого вы хотите интерполировать, до
того, к которому вы хотите интерполировать. Если вы хотите, чтобы интерполяция длилась
больше кадров, освободите место для большего количества рисунков с помощью команды Правка
→ Вставить.

3. Нажмите вертикальную полосу с надписью INBETWEEN, отображаемую справа от выделенной
последовательности кадров.

4. Выберите режим Интерполяция: среди Линейная, Замедление в начале, Замедление в
конце, Замедление в начале/конце, и щелкните кнопку Фазовка.

Совет: Для оптимизации фазовочного процесса:

1. Создайте и покрасьте рисунок, с которого вы хотите выполнить интерполяцию.

2. Выполните одно из следующих действий:

• Скопируйте и Вставьте его в другой кадр Level Strip, учитывая количество промежуточных
рисунков, которые вы хотите достичь.

• Дублируйте его и вставьте столько пустых кадров, сколько вы хотите достичь между рисунка-
ми.

3. Измените вставленный или дублированный рисунок с помощью инструментов-модификаторов,
чтобы создать окончательный рисунок интерполяции.

4. Выделите последовательность кадров от рисунка, с которого вы хотите интерполировать, до того,
к которому вы хотите интерполировать.

5. Нажмите на вертикальную полосу INBETWEEN, отображаемую справа от выделенной после-
довательности кадров.

10.4.3 Ротоскопирование

Ротоскопирование состоит из отслеживания рисунков с использованием живого клипа в качестве ре-
ференса.

Поскольку вы можете импортировать клипы и последовательности изображений в сцену, вы можете
просто загрузить их и создать уровень анимации, рисуя в окне просмотра, в то время как кадры клипов
видны снизу. См. Использование браузера файлов.

Способ получения наилучших результатов заключается не в попытке воспроизвести клип с верно-
стью, а в том, чтобы использовать его кадры просто как справку, чтобы лучше понять движение или
трансформацию объекта клипа. Таким образом, вы можете воспользоваться, например, естественным
движением, представленным в клипе, не отказываясь от выразительного стиля рисования.

Совет: Чтобы выполнить ротоскопирование:

1. Загрузите видеоклип или последовательность изображений в столбец Xsheet (или слой Timeline).

2. В Xsheet/Timeline выберите ячейку в столбце справа от столбца (или в слое поверх слоя), со-
держащую загруженный клип. Изображение клипа, размещенного в том же кадре выбранной
ячейки, будет отображаться в окне просмотра во время рисования.
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Рис. 12: Использование техники ротоскопии для отслеживания движения руки.

3. Создайте новый уровень анимации и используйте инструменты, чтобы проследить первый рису-
нок в средстве просмотра.

4. Перейдите к последующим кадрам и проследите следующие рисунки.

10.4.4 Клонирование уровней

Иногда может быть полезно создать клон уровня или его части, чтобы редактировать его, не затраги-
вая исходный. Например, вы можете захотеть создать новый уровень анимации, начиная с рисунков
другого уровня, чтобы две последовательности были похожими, но не идентичными.

The Clone Cells command allows you to create an independent copy of the selected cells, preserving the
numbering order and assigning a new name to it. The _clone suffix appended to the name of the level is
the default.

Клонированный уровень будет содержать только рисунки, отображаемые в выбранных ячейках, даже
если исходный уровень состоит из нескольких рисунков; они будут автоматически отображаться в
столбце справа (или в слое сверху) выделения, сдвигая следующие столбцы/слои.

Новый уровень будет доступен в Scene Cast как новый элемент; он будет сохранен в папке +drawings
или +extras по умолчанию в соответствии с форматом исходного файла, как только вы сохраните его
с помощью команды Сохранить уровень или сохраните сцену.

Выбор ячеек также может распространяться на несколько столбцов/слоев: в этом случае будет вставле-
но такое же количество новых столбцов/слоев, чтобы освободить место для результата клонирования.
Если выбрано более одного уровня, будет создано такое же количество новых уровней, и невозможно
присвоить имя клонированным уровням.

Совет: Чтобы клонировать уровни:

1. Выберите ячейки, которые вы хотите клонировать.
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2. Choose Cells → Clone Cells.

3. Введите Имя уровня: и нажмите OK для подтверждения.

10.5 Применение кальки

Если вы хотите одновременно просматривать несколько уровней в окне просмотра в качестве спра-
вочного материала при создании рисунков или проверить анимацию, вы можете активировать режим
кальки.

Калька доступна как на Xsheet/Timeline, так в Level Strip, в зависимости от того, где отображается
курсор, показывающий текущий кадр, так как калька может быть активирована, начиная с курсора,
и управляться в столбце/строке номера кадра.

Рис. 13: Анимация столбца, отображаемая с относительной калькой, установленной для 6 предыдущих
кадров, шаг два, и калькой, установленной в кадре 35.

Когда выбран кадр Level Strip, калька применяется только к текущему уровню, ссылаясь на последо-
вательность уровня полной анимации, которая была создана.

Когда ячейка Xsheet/Timeline выбрана, калька применяется к текущему уровню в соответствии с тем,
как последовательность рисунка отображается в сцене, включая движения и преобразования, выпол-
няемые благодаря анимации объекта (см. Анимация объектов), а остальная часть сцены в текущем
кадре будет видна как обычно. Если вы хотите, вы также можете расширить кальку на все содержимое
Xsheet/Timeline, чтобы разрешить ссылки на все анимированные или движущиеся элементы сцены.

Относительный режим кальки отображает кадры относительно позиции текущего кадра. Например,
вы можете активировать кадр, предшествующий текущему, и каждый раз, когда вы меняете текущий
кадр, будет отображаться предыдущий кадр.

10.5. Применение кальки 155



OpenToonz Documentation, Выпуск 1.7.1

Режим абсолютной кальки отображает выбранный кадр независимо от текущего кадра. Например, вы
можете активировать кадр 5, и каждый раз, когда вы меняете текущий кадр, кадр 5 будет отображаться
в режиме кальки.

The way images are displayed in Onion Skin mode can be customized in the Preferences. . . → Onion Skin
section. It’s possible to define the Paper Thickness, to set an independent color correction for previous
and following frames, and to Display Lines Only for Toonz Vector and Toonz Raster.

Совет: Чтобы активировать или деактивировать кадры в режиме относительной кальки:

Выполните одно из следующих действий:

• На листе Xsheet щелкните маленькие маркеры ромбоида, доступные слева от столбца кадров (или
над панелью кадров на временной шкале). Нажатие и перенесение автоматически активирует или
деактивирует ряд кадров.

• На Level Strip щелкните маленькие круглые маркеры, доступные слева от рамок полосы. Нажми-
те и перетащите автоматически активирует или деактивирует ряд кадров.

Совет: Чтобы активировать или деактивировать кадры в режиме абсолютной кальки:

Выполните одно из следующих действий:

• На листе Xsheet щелкните маленькие маркеры с призрачными ромбами, доступные в левой части
столбца кадров (или над панелью кадров на временной шкале). Нажмите и перетащите автома-
тически активирует или деактивирует ряд кадров.

• На Level Strip нажмите на маленькие круглые маркеры с призраками, доступные слева от рамок
полосы. Нажмите и перетащите автоматически активирует или деактивирует ряд кадров.

Совет: Чтобы деактивировать (или снова активировать) режим кальки:

Выполните одно из следующих действий:

• Дважды щелкните большой круг слева от курсора текущего кадра. Дважды щелкните снова,
чтобы активировать его обратно.

• Щелкните правой кнопкой мыши в окне просмотра или в столбце/строке кадров в
Xsheet/Timeline и выберите Деактивировать кальку или Активировать кальку в открыв-
шемся меню.

Примечание: При первой активации режима кальки путем щелчка правой кнопкой мыши
в окне просмотра или столбце/строке кадров Xsheet/Timeline включается режим относи-
тельной оболочки кальки по умолчанию, отображающий предыдущие три кадра.

Совет: Расширение кальки до содержания всей сцены:

1. Активируйте кальку в Xsheet/Timeline.

2. Щелкните правой кнопкой мыши в окне просмотра по кадру или в столбце/строке
Xsheet/Timeline» и выберите пункт Расширить кальку на все уровни из открывшегося меню.
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Совет: Чтобы ограничить кальку текущим уровнем:

Щелкните правой кнопкой мыши в окне просмотра или в столбце/строке Xsheet/Timeline и выберите
пункт Ограничить кальку до одного уровня в открывшемся меню.

Совет: Чтобы настроить способ отображения изображений в режиме кальки:

1. Choose File → Preferences. . . → Onion Skin.

2. Выполните любое из следующих действий:

• Установить значение для параметра Толщина бумаги; чем ниже значение, тем более прозрач-
ными будут рисунки, отображаемые в режиме кальки.

• Используйте Коррекция предыдущих кадров, чтобы установить цвет для отображения
предыдущих кадров.

• Используйте Коррекция последующих кадров, чтобы установить цвет для отображения сле-
дующих кадров.

• Активируйте опцию Отображать только линии, чтобы отображать уровни Toonz Vector или
Toonz Raster только с линиями.

10.6 Использование Shift и Trace

Функции Shift и Trace могут помочь вам в создании анимированных уровней, как если бы вы рисовали
на бумаге, используя стол с подсветкой; фактически это позволяет вам использовать предыдущий и
следующий ключевые рисунки в качестве референса, в то время как вы вставляете фазовку или break
down.

Можно временно перемещать и поворачивать рисунки, которые вы хотите использовать в качестве
эталона, чтобы соответствовать положению, в котором вы хотите нарисовать фазовку. Также можно
автоматически устанавливать положение референсных рисунков, создавая и редактируя линию дей-
ствия.

Чтобы лучше проверить новый рисунок и анимацию, вы можете включить или выключить визуализа-
цию Shift и Trace.

Совет: Для входа в режим Shift и Trace:

1. Поместите курсор кадра на кадр, где вы хотите нарисовать промежуточный рисунок.

2. Включите Вид → Shift и Trace; предыдущий и следующий рисунки будут визуализированы.

Совет: Чтобы изменить положение референсных рисунков:

1. Поместите курсор кадра в том месте, где вы хотите нарисовать промежуточный рисунок, и на-
рисуйте путь линии действия между вашими контрольными точками.

2. Активируйте Вид → Редактировать сдвиг.

3. Нажмите на рисунок, который вы хотите изменить в окне просмотра, или используйте парамет-
ры Предыдущий рисунок/Следующий рисунок на панели параметров инструмента; будет
отображена ограничительная рамка связанного референсного рисунка.
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4. Выполните любое из следующих действий:

• Щелкните и перетащите внутри ограничительной рамки, чтобы переместить референсный ри-
сунок.

• Щелкните и перетащите за пределы ограничительной рамки, чтобы повернуть референсный
рисунок.

• Нажмите и перетащите центральную ручку, чтобы изменить центр вращения.

• Нажмите и перетащите любой угловой маркер ограничительной рамки, чтобы масштабировать
референсный рисунок из его центра.

5. Повторите те же шаги на втором референсном рисунке.

Совет: Для автоматического редактирования положения референсных рисунков:

1. Поместите курсор кадра в том месте, где вы хотите нарисовать промежуточный рисунок, и на-
рисуйте путь линии действия между вашими контрольными точками.

2. Активируйте Вид → Редактировать сдвиг.

3. Удерживая клавишу Ctrl, перетащите, чтобы создать путь от контрольной точки на первом ри-
сунке до контрольной точки на втором. Начальная и конечная точки будут перекрываться в
центре пути.

4. Нажмите и перетащите маркер вдоль пути, чтобы изменить его форму; референсные рисунки
будут перемещаться в соответствии с положением ручки и вращаться в соответствии с изменением
формы пути.

5. При необходимости используйте ручки ограничительной рамки, чтобы зафиксировать поворот
референсного рисунка.

Примечание: Нажатие и перетаскивание одного из референсных рисунков удалит путь линии дей-
ствия.

Совет: Для переключения визуализации Shift и Trace:

Активируйте Вид → Без сдвига, чтобы переключить визуализацию референсных рисунков обратно
в исходное положение.

Совет: Чтобы сбросить положение референсных рисунков:

Выберите команду Вид → Сбросить сдвиг.

Совет: Для сброса преобразований одного из референсных рисунков:

На панели параметров инструмента нажмите кнопку Сбросить изменения или Сбросить измене-
ния.

Совет: Чтобы создать промежуточный рисунок с помощью функции Shift и Trace:
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1. Создайте первый ключевой рисунок.

2. Создайте второй ключевой рисунок.

3. Выберите ячейку, в которой вы хотите создать промежуточный рисунок.

4. Активируйте Вид → Shift и Trace.

5. Проложите путь линии действия между вашими контрольными точками.

6. Активируйте Вид → Редактировать сдвиг и отредактируйте положение референсных рисун-
ков.

7. Создайте промежуточный рисунок.
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Глава 11

Редактирование уровней анимации

После того, как вы создали свои уровни анимации, вам может потребоваться поработать над ними,
чтобы добавить или вставить новые рисунки или изменить последовательность кадров.

Все изменения можно сохранить, сохранив уровень или сохранив сцену с помощью команды Сохранить
все, тем самым автоматически сохранив все ее уровни.

11.1 Использование Level Strip

Уровенем анимации можно управлять Level Strip. Level Strip показывает все рисунки текущего уровня
(даже рисунки, которые в настоящее время не отображаются в Xsheet/Timeline) в соответствии с
порядком их нумерации.

Примечание: В случае если диапазон кадров уровня анимации был загружен в диалоговом окне
Загрузить уровень, только кадры внутри выделенного диапазона кадров будут видны в Level Strip
(см. Использование обозревателя файлов).

Когда уровень выбран, каждый кадр Level Strip содержит рисунок уровня в соответствии с порядком
нумерации уровней. Когда в Level Strip выбран кадр, соответствующий рисунок отображается в окне
просмотра, заменяя собой любой предыдущий отображаемый контент, чтобы вам было легче работать
с ним.

Когда выбран один или несколько кадров, вы можете выполнять стандартные операции вырезания,
копирования, вставки, удаления и вставки. Новые рисунки могут быть добавлены, и любая последо-
вательность может быть перенумерована. С Level Strip рисунки также могут быть представлены в
Xsheet/Timeline.

Когда вы изменяете порядок рисунков в Level Strip или когда рисунок вырезается, удаляется или встав-
ляется, а рисунки экспонируются в сцене, Xsheet/Timeline будет по-прежнему содержать ссылку на
этот конкретный кадр уровня анимации каким бы ни было его содержание. Когда Xsheet/Timeline со-
держит ссылку на рисунок, который исключен в Leve Strip, имя и номер уровня становятся красными,
чтобы предупредить вас, что для этой ячейки больше нет рисунка.
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The width of the level strip pane cannot be resized freely, because it depends on the size of the animation
level preview icons, but it can be customized in the Preferences. . . → Interface dialog.

Совет: Чтобы редактировать уровень анимации в Level Strip:

Выполните одно из следующих действий:

• Выберите в Xsheet/Timeline ячейку, содержащую рисунок с уровня анимации, который вы хотите
редактировать.

• Щелкните правой кнопкой мыши значок уровня в Состав сцены и выберите Отобразить в Level
Strip в открывшемся меню.

Совет: Чтобы прокрутить Level Strip:

Выполните одно из следующих действий:

• Нажмите среднюю кнопку мыши и п, чтобы прокрутить вверх или вниз.

• Используйте колесо мыши для прокрутки вверх или вниз.

• Используйте полосы прокрутки для прокрутки только в пределах фактического уровня экстента.

• Используйте клавиши со стрелками вверх и вниз для перемещения на один кадр вверх или вниз.

• Используйте клавиши Page Up и Page Down для прокрутки видимых кадров вверх или вниз.

• Используйте клавиши Home и End для прокрутки вверх до начала или конца содержимого Level
Strip.

Совет: Чтобы выбрать рисунки на Level Strip:

Выполните одно из следующих действий:

• Нажмите на рисунок, чтобы выбрать его.

• Нажмите и перетащите, чтобы выбрать серию рисунков.

• Удерживая клавишу Shift, щелкните рамку, чтобы расширить выделение до этой рамки.

• Удерживая клавишу Ctrl (PC) или Cmd (Mac), добавьте или удалите кадры из выделения.

• Use the Edit → Select All command to select all of the level drawings.

• Use the Edit → Invert Selection command to invert the current selection of drawings.

Примечание: Команды Выбрать все и Обратить выделенное также доступны в меню, которое от-
крывается при щелчке правой кнопкой мыши по Level Strip.

Совет: To exit the Level Strip editing mode:

Щелкните ячейку или выберите кадр в области кадров Xsheet/Timeline.

Совет: To customize the Level Strip thumbnail size:
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1. Choose File → Preferences. . . → Interface.

2. Set the width and height values of the Level Strip Thumbnail Size option.

3. Перезапустите OpenToonz, чтобы изменения вступили в силу.

11.1.1 Редактирование кадров уровня

Контент уровня может быть отредактирован по одному кадру за раз, например, для ретуширования
некоторой иллюстрации или копирования части рисунка в другой кадр или нескольких кадров одно-
временно, например, чтобы изменить порядок следования рисунка.

Совет: Чтобы отредактировать рисунок уровня анимации:

1. Выберите кадр в Level Strip, содержащую рисунок, который вы хотите изменить.

2. Используйте инструменты для редактирования рисунка в окне просмотра.

Совет: Чтобы редактировать рисунки уровня анимации с помощью команд меню Правка:

1. Выберите кадры, которые вы хотите редактировать.

2. Выполните любое из следующих действий:

• Use the Copy command to keep in memory selected drawings for further operations.

• Use the Cut command to eliminate selected drawings from the animation level and keep them in
memory for further operations. The frames elimination causes a gap in the level numbering order.

• Use the Paste command to paste drawings kept in memory in the animation level, starting from the
selected insertion frame. The operation shifts down the following frames, and automatically renumbers
them. If before the insertion frame there is a numbering gap, the pasted frames will fill the gap before
starting to shift and renumber the following frames.

• Use the Paste Into command to paste drawings kept in memory in the frames selected in the level
strip, overwriting their content. If the selection contains less frames than those kept in memory, frames
in excess will be ignored; if the selection contains more frames than those kept in memory, frames in
excess will be left as they are.

• Use the Delete command to delete selected drawings.

• Use the Insert command to insert empty (white) frames before the selection; inserted frames will
be as many as the selected ones. The operation shifts down the following frames, and automatically
renumbers them.

Примечание: All of the Edit menu commands are also available in the menu that opens when right-clicking
in the Level Strip.

Совет: Чтобы редактировать рисунки уровня анимации с помощью команд меню Ячейки:

1. Выберите кадры, которые вы хотите редактировать.

2. Выполните любое из следующих действий:

• Use the Reverse command to invert the order of selected drawings.
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• Use the Swing command to append selected drawings to the end of the selection in a reversed order.
The last drawing of the selection will not be repeated.

• Use the Step 2, Step 3 or Step 4 command to repeat selected drawings in order to have a step 2,
step 3 or step 4 animation.

• Use the Each 2, Each 3 or Each 4, command to preserve only one drawing each 2, each 3 or each 4,
of the selection, and delete the others.

• Use the Duplicate Drawing command to make a copy of the first drawing of the selection in the
following frame. If the following frames already contain drawings, the duplicated drawing will be
inserted by shifting the others down in the Xsheet (or right in the Timeline).

• Use the Merge command to paste in the current level the drawings copied from a different level,
according to their original frame position and regardless of the currently selected frames.

Примечание: All of the Cells menu commands are also available in the menu that opens when right-clicking
in the Level Strip.

11.1.2 Изменение нумерации и добавление кадров на уровне

When you need to add one or several drawings to a level, you first need to create room for the new
drawings. This task can be achieved either using the Insert command (see Editing Level Frames ), or
the Renumber. . . dialog.

В то время как операция вставки автоматически сдвигает нумерацию следующих кадров, чтобы осво-
бодить место для новых, перенумерация позволяет контролировать способ нумерации кадров.

После перенумерации рисунки переупорядочиваются, чтобы иметь добавочную нумерацию в Level
Strip, где пустые кадры не рассматриваются. Например, для уровня, где кадры 4 и 5 перенумерованы
в 11 и 12, Level Strip будет отображать только пять кадров с правильными номерами 1, 2, 3, 11 и 12.

Если вам нужно добавить последовательность кадров к уровню, например, для их сканирования или
создания какого-либо графического объекта, вы можете добавить его в диалоговом окне Добавить кад-
ры. Этот диалог позволяет вам также вставлять рисунки на уровне, который нумеруется нерегулярно,
например, после того, как некоторые кадры были вырезаны или перенумерованы.

Операция перенумерации и добавления кадров завершается неудачей, если нумерация, назначенная
кадрам, используется уже существующими кадрами.

Примечание: If the Automatically Create Drawings option is activated in the Preferences. . . →
Drawing dialog, when you want to add a drawing at the end of the sequence simply select the first grey
frame available, and draw in the Viewer.

Совет: Чтобы изменить нумерацию рисунков уровня анимации:

1. Выберите рисунки, которые вы хотите изменить нумерацию; также допускается непостоянный
выбор.

2. Select Level → Renumber. . .

3. In the dialog that opens set the Start Frame number that will be assigned to the first drawing of the
selection, and the Step used to number all following frames in the selection.
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Совет: Чтобы добавить рисунки на уровень анимации:

1. Select Level → Add Frames. . .

2. In the dialog that opens sets the frame range you want to add, and the Step used to number the
frames in the range.

Примечание: Команды Добавить кадры и Пересчитать также доступны в меню, которое открывается
при щелчке правой кнопкой мыши на Level Strip.

11.1.3 Возврат кадров уровня к предыдущей версии

Если при редактировании уровня или в процессе рисования были допущены некоторые ошибки, напри-
мер часть рисурка была случайно удалена, можно получить последнюю сохраненную версию кадров
уровня.

For Toonz Raster levels generated from a cleanup process, it is also possible to retrieve the original cleaned
up drawings.

Примечание: In order to revert to the original cleaned up drawings the Preferences. . . → Drawing →
Keep Original Cleaned Up Drawings As Backup option has to be activated when the cleanup is performed
(see Cleaning up Drawings ).

Совет: To reload the level drawings to the last saved version:

1. In the Level Strip select the drawings you want to reload.

2. Выполните одно из следующих действий:

• Choose Level → Reload.

• Right click the selection and choose Reload from the menu that opens.

Совет: Чтобы вернуться к исходным очищеным рисункам:

1. В Level Strip выберите рисунки, которые вы хотите вернуть.

2. Выполните одно из следующих действий:

• Choose Level → Revert to Cleaned Up.

• Right click the selection and choose Revert to Cleaned Up from the menu that opens.

11.2 Объединение уровней анимации

Toonz Vector levels and standard Raster levels can be easily merged into a single animation level generated
by flattening them according to their stacking order, using the Xsheet → Merge Levels command. Toonz
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Raster levels can be merged using the Xsheet → Merge TLV Levels command.

Это может быть полезно, например, если вы рисуете анимацию с рисунками, которые повторяются в
нескольких ячейках и отображаются в нескольких столбцах, и вы хотите создать одну последователь-
ность рисунков.

In both cases there is no limit to the number of columns/layers you can merge.

11.2.1 Слияние векторных уровней Toonz или растровых уровней

Using the Xsheet → Merge Levels command the number of resulting drawings will depend on the number
of drawings exposed in the first Xsheet column on the left of the selection (or in the first Timeline layer
on the bottom of the selection). When merging Raster levels, the resolution of the resulting drawings will
depend on the resolution of the drawings exposed in the first Xsheet column on the left of the selection (or
in the bottom Timeline layer on the bottom of the selection).

Уровни анимации объединяются в соответствии со следующими рекомендациями:

• The frame numbering order is followed; this means that all the drawings exposed at frame 1 will be
merged to the drawing exposed at frame 1 of the first column/layer of the selection.

• If two different drawings are associated at different frames to the same drawing exposed in the first
column/layer of the selection, only the first one will be applied.

• Drawings not corresponding to any drawing exposed in the first column/layer of the selection will be
ignored.

• It is not possible to merge columns/layers if more than one level is exposed in any of them.

Когда уровни объединены, любое геометрическое преобразование, достигнутое путем редактирования
и перемещения соответствующего столбца или переключателя, будет сохранено.

For Toonz Vector levels each drawing of the merged levels will be retained as a group of vectors in the
resulting level; the palette of the resulting level will contain all of the styles used in the drawings of the
merged levels.

Совет: Чтобы объединить уровни анимации:

1. Select the columns/layers where the animation levels you want to merge are exposed.

2. Choose Xsheet → Merge Levels.

11.2.2 Слияние растровых уровней Toonz

The Xsheet → Merge TLV Levels allows to combine several columns containing Toonz Raster Levels
creating a new TLV level. The merged columns will be eliminated from the Xsheet/Timeline and replaced
with a new TLV level.

Using the Xsheet → Merge TLV Levels command the number of resulting drawings will depend on the frames
combination of the involved levels. When merging Toonz Raster levels, the resolution of the resulting level
will depend on the resolution of the drawings exposed in the first Xsheet column on the left of the selection
(or in the first Timeline layer on the bottom of the selection).

Уровни анимации объединяются в соответствии со следующими рекомендациями:

• The frame numbering order is followed; this means that the merged level will be created following the
frames numbering.
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• If a combination of drawings will be reused, the drawing previously created will be reused.

• Also, the palettes of the selected levels will be merged.

Когда уровни объединены, любое геометрическое преобразование, достигнутое путем редактирования
и перемещения соответствующего столбца или переключателя, будет сохранено.

Совет: It is not possible to merge columns/layers if more than one level is exposed in any of
them.

Совет: To merge Toonz Raster (TLV) levels:

1. Select two ore more columns/layers where the levels you want to merge are exposed.

2. Choose Xsheet → Merge TLV Levels

3. Define the File Name and Save in location in the pop up that opens and press Apply.

11.3 Обработка уровней

Some commands are available to process Raster level images in order to adjust their brightness and contrast,
to fade their colors toward a defined set of Red, Green, Blue and Alpha values, to adjust their levels or to
binarize them. The Adjust Thickness command is available to modify the thickness of the lines in Toonz
Vector Levels only.

Область предварительного просмотра доступна для проверки результатов примененной обработки: вы
можете перемещаться по ее содержимому и устанавливать еее размер.

The processed images are stored in the cache and will be saved on disk by using the Save Level, Save All
Levels, or Save All commands.

Совет: Чтобы изменить размер области предварительного просмотра:

Выполните любое из следующих действий:

• Нажмите и перетащите горизонтальный разделитель.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть область предварительного
просмотра.

• Нажмите и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить область предварительного просмотра.

Совет: Для навигации по области предварительного просмотра:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте горячую клавишу сброса просмотра (по умолчанию клавиша 0), чтобы отобразить
предварительный просмотр в его реальном размере.
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11.3.1 Яркость и контрастность

В случае, если необходимо отрегулировать рисунки для увеличения темноты и непрозрачности рисунка,
их можно обработать, откалибровав яркость и контрастность. Это доступно только для растровых
уровней.

Совет: Для обработки рисунков яркость и контрастность:

1. Select the level frames to process in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Brightness and Contrast. . .

3. В открывшемся диалоговом окне установите изменение яркости и контрастности.

4. Click the Apply button.

11.3.2 Antialias

Allows to add antialias or to make it smoother or harder on Raster and Toonz Raster levels.

Совет: To use the Antialias command:

1. Select the level frames to process in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Antialias. . .

3. In the dialog that opens set the Threshold and Softness values.

4. Click the Apply button.

11.3.3 Регулировка уровней

Регулирует блики и тени содержимого источника путем переназначения интенсивности пикселей в соот-
ветствии со значениями уровней входного и выходного сигналов для каналов RGB, Красный, Зеленый,
Синий и Альфа.

Совет: Чтобы настроить уровни изображений:

1. Select the level frames to adjust in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Adjust Levels. . .

3. Отрегулируйте уровни изображения

4. Click the Apply button.

11.3.4 Регулировка толщины

The Adjust Thickness command allows to modify the thickness of the selected lines in the level. If no line is
selected the command acts on the whole level, otherwise it works only on selected lines.

Совет: Чтобы настроить толщину линий:
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1. Select the level frames to adjust in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Adjust Thickness. . .

3. Choose a mode. The modes are: Scale Thickness that scale lines up or down using a percentage
value, Add Thickness that add an amount of thickness to the lines using the current unit, Costant
Thickness that apply a thickness value, ignoring its variations, using the current unit.

4. Set Start and End values.

5. Press the Apply button.

11.3.5 Спад цвета

In case it is needed to adjust the drawing colors it is possible to fade the drawings toward a color defined
by Red, Green, Blue and Alpha values. The Intensity, expressed as a percentage, ranges from 0 to 100.The
original color will fade to the color you set according with the Intensity parameter. This is available only for
Raster levels.

Совет: Чтобы затенить цвета рисования:

1. Select the level frames to fade in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Color Fade. . .

3. In the dialog that opens set the color you want to fade the selection to, by doing one of the following:

• Set the Red, Green, Blue and Alpha values.

• Click the color thumbnails and use the Style Editor to edit them (see Editing Styles ).

• Move the intensity sliders to set the color values.

4. Click the Apply button.

11.3.6 Бинаризация

Allows you to process images with colored Raster lines, recognizing basic colors (red, green, blue, cyan,
magenta and yellow) plus black. The process will produce an uniform background color, eliminating shadows
and dirty pixels.

The colored lines are identified and all the pixels belonging to each line are changed to the maximum value
of the identified color. Anti-aliasing is removed.

The use of this command is useful to pre-process scanned images, in order to simplify the Cleanup process.

The preview is available to check the result. The Alpha toggle allows to produce images with a transparent
background.

Совет: Для бинаризации изображений:

1. Select the level frames to process in the Xsheet/Timeline or the Level Strip.

2. Choose Level → Adjust → Binarize. . .

3. Activate the Preview toggle to check the result.

4. Activate the Alpha toggle if you need transparent background.
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5. Click the Apply button.

11.4 Сохранение уровней

All the editing performed in the Level Strip is not saved until you manually save the level. You can also
automatically save all of the editing done on any level of the Xsheet/Timeline by saving the scene using the
Save All command (see Saving and Loading Scenes ).

When saving an animation level it is possible to automatically create a backup file of the previous version by
setting the Backup Scene and Animation Levels when Saving option in the Preferences. . . → Saving
dialog section. The backup version will be created in the same location where the level is saved, and will
have an _backup suffix.

Примечание: An asterisk after the level name in the Level Strip title bar denotes that there are unsaved
changes for the current level.

Совет: Чтобы сохранить текущий уровень:

Выполните одно из следующих действий:

• Choose Level → Save Level.

• Right-click in the Scene Cast and choose Save Level from the menu that opens.

Совет: Чтобы сохранить текущий уровень с другим именем в другом месте:

1. Choose Level → Save Level As. . .

2. In the file browser that opens select a location and name for the level you want to save, and click the
Save button.

Примечание: The Save Level As. . . command creates a copy of the level with a different file name and
location, but does not change the name and location of the level used in the scene.

11.5 Экспорт уровней

Animation levels created with OpenToonz can be exported in a variety of image file formats, in order to be
used in third-party software. The levels are exported as a sequence of files named with a progressive four-digits
number written between the file name and the file extension, e.g. animation.0001.tif , animation.0002.
tif , etc. or a single file in case of the .TLV format. File formats available are BMP, JPG, PNG, TGA ,TIF
and TLV (the .TLV format is available only to export vector levels (.PLI); aditional options for the chosen
format can be set in the same way as to when using the Render → Output Settings. . . dialog (see Choosing
the Output Settings ).

When exporting Vector levels, the size and resolution of the exported sequence can be defined in the Export
Level. . . dialog. The default size and resolution are those defined in the Camera Settings window, and the
preview of the resulting image is visible in the preview area of the Export Options tab, to understand how
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the exported images will be cropped (see Defining Camera Settings ). The size of the exported image can
be changed by entering a scale value in the Scale field.

Примечание: Any trucking, resizing and animation of the camera is not considered when exporting Vector
levels.

The Retas Compliant option can be used to automatically name the exported sequence with a a progressive
four-digits number suffix before the file extension (e.g. animation0001.tga , animation0002.tga , etc.) and
set the exporting format to TGA.

Background Color option allows to set the RGBA values of the background color.

The No Antialias option allows to remove the antialiasing from the exported sequence.

Совет: Чтобы экспортировать текущий уровень:

1. Choose Level → Export Level. . .

2. In the File Browser tab, select the location and name of the level you want to save.

3. Выполните одно из следующих действий:

• Выберите формат файла, который вы хотите иметь экспортируемый уровень.

• Activate the Retas Compliant option to export the level in the same format and with the same
options that the Retas software uses, when exporting painted drawings.

• In the Export Options tab, set the RGBA values for the background color.

• Activate the No Antialias option if you want to remove the anitialias from the exported levels sequence
images.

4. Если вы экспортируете векторный уровень Toonz:

• Set the output size using the Vectors Export Box section options.

• Set Start and End percentage values for the lines thickness.

5. Click the Export button.

Примечание: Команда Экспорт уровня создает новую версию уровня с другим именем файла, ме-
стоположением и форматом, но не изменяет имя, местоположение и формат уровня, используемого в
сцене.

Совет: Чтобы установить параметры формата файла:

1. At the bottom of the window, choose a file Format from the dropdown.

2. Press the Options button for setting additional options for the format previously chosen.
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Глава 12

Управление палитрами и стилями

В OpenToonz уровни анимации Toonz Vector и Toonz Raster имеют собственную палитру, содержащую
стили, которые можно использовать для рисования линий и рисования линий и областей. Напротив,
растровые уровни можно редактировать, используя стили, доступные в Палитре растровых рисун-
ков, которая используется всеми растровыми уровнями в проекте.

На уровнях Toonz Vector и Toonz Raster стили палитры интерактивно «связаны» с нарисованными
линиями и заполненными областями с помощью индексов. Основным преимуществом этого метода
является то, что если вы редактируете стиль палитры, все линии и заполненные области, использующие
этот стиль, будут автоматически обновляться. Это позволяет изменять или калибровать цвета даже
после завершения процесса рисования без необходимости корректировать стиль строка за строкой или
область за областью изображения.

В растровых уровнях стили палитры просто используются для рисования или корректировки изобра-
жения, и между стилями и уже нарисованными линиями не существует никакой связи. Эта палитра с
именем Raster Drawing Palette используется всеми уровнями растра, принадлежащими определен-
ному проекту, и хранится в папке проекта +palettes по умолчанию (см. Папки проекта по умолча-
нию).

Примечание: Все изменения, выполняемые в палитрах и стилях, не сохранятся до тех пор, пока
вы не сохраните соответствующий уровень Toonz, саму палитру или команду Сохранить все (см.
Сохранение уровней).

12.1 Редактор палитры

Редактор палитр отображает стили текущего уровня анимации, которые (или могут быть) использо-
ваны для рисования и поскраски уровня.
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Палитра по умолчанию любого нового уровня Toonz Vector содержит только простой черный цвет;
палитра по умолчанию уровня Toonz Raster содержит либо простой черный цвет для новых уров-
ней, либо цвета, распознаваемые в процессе очистки, для очищенных уровней от сканирования. Любая
палитра всегда содержит элемент Color_0, который позволяет удалить любой стиль из линий и за-
полненных областей.

Примечание: Каждая палитра может содержать до 4096 стилей.

Стили в Редакторе палитр могут отображаться в разных режимах:

• Просмотр в режиме Маленьких иконок отображает стили в виде маленьких квадратов. Ин-
декс стиля отображается в правом нижнем углу. Полное имя стиля может отображаться в виде
всплывающей подсказки.

• Просмотр в режиме Средних иконок отображает стили в виде средних квадратов. Вы можете
прочитать первые буквы названия стиля прямо внутри фишек; индекс стиля отображается в пра-
вом нижнем углу. Полное название стиля может отображаться в виде всплывающей подсказки.

• Просмотр в режиме Больших иконок отображает стили в виде больших квадратов. Вы можете
прочитать первые буквы названия стиля прямо внутри фишек; индекс стиля отображается в пра-
вом нижнем углу. Полное название стиля может отображаться в виде всплывающей подсказки.

• Просмотр в режиме Посмотреть список отображает миниатюры стилей рядом с их именами
в списке; индекс стиля отображается в виде всплывающей подсказки. Если стили палитры ссы-
лаются на Studio Palette, ее путь будет отображаться вместе с именем стиля (см. Использование
Studio Palette).

По умолчанию редактор палитр активен, это означает, что он автоматически отображает стили теку-
щего уровня анимации, но его можно сделать неактивным, чтобы не обновляться при выборе другого
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уровня. Таким образом, открыв более одного редактора палитр, можно будет одновременно сравнивать
и редактировать несколько палитр, относящихся к разным уровням анимации.

Палитры также могут быть сохранены как независимые файлы в формате TPL для загрузки обратно
в сцену для получения цветов или для использования с эффектом Внешняя палитра (см. Использо-
вание файлового браузера и Внешняя палитра).

Примечание: Большая часть редактирования палитры, описанного ниже, может быть применима и
к средству просмотра Палитра, доступному в Studio Palette (см. Использование Studio Palette).

Совет: Чтобы изменить режим отображения палитры:

Выполните одно из следующих действий:

• Нажмите кнопку параметров ( ) справа от верхней панели Редактора палитры и выберите
режим отображения в открывшемся меню.

• Используйте стандартные горячие клавиши + или - в Редакторе палитр, чтобы увеличить или
уменьшить размер фишек стилей.

Совет: Чтобы сделать Редактор палитры неактивным или активным:

Нажмите кнопку Switch ( ) справа от строки заголовка Редактора палитр.

Совет: Чтобы сохранить палитру под другим именем в другом месте:

1. Нажмите кнопку Сохранить палитру как ( ) в верхней панели Редактора палитр.

2. В открывшемся браузере файлов выберите местоположение и имя палитры, которую вы хотите
сохранить и нажмите кнопку Сохранить.

Примечание: Команда Сохранить палитру как создает копию палитры с другим именем файла
и местоположением, но не меняет имя и расположение палитры, используемой в сцене.

12.1.1 Организация стилей и страниц палитры

Стили палитры могут быть добавлены, названы, переупорядочены и расположены на страницах. Их
можно копировать и вставлять из одной позиции в другую или из одной палитры в другую.

Примечание: Когда для рисования рисунков используются стили Вырезать, линии и области, за-
крашенные ими, будут отображаться красным; если они удалены, вам будет предложено удалить
только стили и показать линии и области, закрашенные ими красным, или также удалить линии и
области, закрашенные ими.

Совет: Чтобы выбрать стиль:

Выполните одно из следующих действий:

12.1. Редактор палитры 175



OpenToonz Documentation, Выпуск 1.7.1

• Нажмите на его в Редакторе палитры.

• Используйте цифровые клавиши на основной или цифровой клавиатуре, чтобы выбрать соответ-
ствующий стиль.

Примечание: При отображении средних или больших иконок визуальная подсказка того, какая
комбинация клавиш соответствует стилю, отображается в верхнем центре каждого чипа стиля.

Примечание: Если в текущей палитре более 10 стилей, вы можете использовать клавишу Tab на
клавиатуре, чтобы переключиться на следующий банк из 10 стилей.

Совет: Чтобы выбрать несколько стилей:

Выполните одно из следующих действий:

• Shift-клик, чтобы расширить выделение.

• Нажмите, удерживая нажатой клавишу Ctrl (PC) или Cmd (Mac), чтобы добавить стиль или
удалить его из выделения.

Совет: Чтобы добавить новый стиль:

Нажмите кнопку Новый стиль ( ) в верхней панели редактора палитры.

Совет: Чтобы назвать стиль:

Когда стили отображаются в режимах Средние или большие иконки или Посмотреть список»,
дважды щелкните имя стиля, чтобы отредактировать его.

Совет: Чтобы отредактировать стили палитры с помощью команд меню Правка:

1. Выберите стили, которые вы хотите редактировать.

2. Выполните любое из следующих действий:

• Используйте команду Вырезать, чтобы удалить выбранные стили из палитры и сохранить их в
памяти для дальнейших операций.

• Используйте команду Копировать, чтобы сохранить выбранные стили в памяти для дальнейших
операций.

• Используйте команду Вставить вставку, чтобы вставить стили, хранящиеся в памяти в палитре,
после выбранного в данный момент стиля. Вырезанные стили будут добавлены с сохранением
их индексов; Скопированные стили будут добавлены с использованием новых индексов.

• Используйте команду Вставить цвет и имя, чтобы вставить стили, хранящиеся в памяти, по-
верх стилей, выбранных в палитре, и перезаписать их содержимое. Если выбор содержит меньше
стилей, чем хранится в памяти, избыточные стили будут игнорироваться; если выборка содержит
больше стилей, чем хранится в памяти, избыток стилей останется без изменений.
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• Используйте команду Вставить цвет для вставки красного, зеленого, синего и альфа-значений
стилей, хранящихся в памяти, в стили, выбранные в палитре, с сохранением их имени. Если
выбор содержит меньше стилей, чем хранится в памяти, избыточные стили будут игнорироваться;
если выборка содержит больше стилей, чем хранится в памяти, избыток стилей останется без
изменений.

• Используйте команду Вставить имя, чтобы вставить имена стилей, сохраненных в памяти,
в стили, выбранные в палитре, сохранив их цвета. Если выбор содержит меньше стилей, чем
хранится в памяти, избыточные стили будут игнорироваться; если выборка содержит больше
стилей, чем хранится в памяти, избыток стилей останется без изменений.

• Используйте команду Удалить, чтобы удалить выбранные стили.

Примечание: Все команды меню Правка также доступны в меню, которое открывается при щелчке
правой кнопкой мыши на выбранном элементе.

Совет: Для перемещения выбранных стилей:

Ctrl-клик (PC) или Cmd-клик (Mac) и перетащите выделение на новую позицию; точка вставки отме-
чена во время перетаскивания.

Совет: Чтобы переместить выбранные стили на другую страницу:

Удерживая клавишу Ctrl (PC) или Cmd (Mac), перетащите выделенную область на вкладку страницы,
на которую нужно поместить выбранные стили.

Совет: Чтобы переместить стили на новую страницу:

Удерживая клавишу Ctrl (PC) или Cmd (Mac), перетащите выделенную область справа от последней
вкладки страницы: будет создана новая страница, содержащая перетаскиваемые стили.

Совет: Чтобы удалить все неиспользуемые стили:

Щелкните правой кнопкой мыши в палитре и выберите Удаление неиспользуемых стилей в от-
крывшемся меню.

Совет: Чтобы добавить новую страницу:

Выполните одно из следующих действий:

• Нажмите кнопку Новая страница ( ) в верхней панели редактора палитр.

• Щелкните правой кнопкой мыши в области палитры, где отображаются вкладки страниц, и вы-
берите Новая страница в открывшемся меню.

Совет: Чтобы назвать страницу:
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Дважды щелкните имя страницы, чтобы изменить его.

Совет: Чтобы переместить страницу:

Нажмите и перетащите вкладку страницы на новую позицию.

Совет: Чтобы удалить страницу:

Щелкните правой кнопкой мыши вкладку страницы и выберите Удалить страницу в открывшемся
меню. Текущая страница не может быть удалена.
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12.2 Применение Studio Palette
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Studio Palette позволяет хранить и управлять неограниченным количеством палитр. Он предназначен
в качестве библиотеки палитр персонажей и персонажей, связанных с одним или несколькими кон-
кретными произведениями. Отсюда палитры или содержащиеся в них стили могут быть извлечены,
назначены или объединены с палитрой текущего уровня, без необходимости определять одни и те же
стили снова и снова.

Он состоит из Дерева палитр и Окна просмотра палитр: в Дереве палитр приведены две основные
папки: Global Palettes и Project Palettes, а также все папки и палитры, которые вы добавляете;
Окно просмотра палитр отображает текущую выбранную палитру и позволяет редактировать ее
как стандартную палитру (см. Окно палитры).

Палитра любого уровня может быть добавлена в Studio Palette; если для этого уровня определена
Цветовая модель, она будет сохранена вместе с палитрой и извлечена каждый раз, когда палитра
будет назначена уровню (см. Использование цветовой модели).

Палитры, добавленные в папку Global Palettes, будут доступны в Studio Palette в любом сеансе
OpenToonz независимо от текущего проекта.

Палитры, добавленные в папку Project Palettes, будут доступны только в том случае, если текущий
проект является релевантным. Например, если ваш текущий проект - Проект 1, и вы добавили несколь-
ко палитр в папку Project Palettes, эти палитры будут доступны, только если текущим проектом
является Проект 1.

Если вы хотите добавить в Studio Palette серию палитр, которые вы ранее создали и сохранили в
папке, вы также можете автоматически получить их, выполнив поиск в этой конкретной папке.

Стили, импортированные из Studio Palette в палитру текущего уровня, отмечены белым квадрати-
ком. Эта ссылка может использоваться для связи стилей с оригинальными стилями Studio Palette:
ссылка может быть активирована или деактивирована в любое время для любых выделенных стилей.

Когда ссылка активирована, на маленьком белом квадрате отображается стрелка и стиль будет об-
новляться в соответствии с оригинальным стилем Studio Palette. Когда ссылка деактивирована, стиль
может быть изменен независимо от исходного стиля Studio Palette.

Связывание палитр уровней анимации с Studio Palette может обеспечить согласованность цветов для
всего производства, поскольку, как только требуется изменение, это можно сделать в Studio Palette,
автоматически обновляя все связанные палитры уровней анимации и, следовательно, рисунки.

В палитре уровня информацию о том, на какую студийную палитру ссылаются стили палитры, можно
получить в режиме Посмотреть список, где рядом с миниатюрами и именами стилей отображается
путь к исходной Studio Palette.

Когда палитры добавляются в Global Palettes, они копируются в папку studiopalette, в которой
хранятся проекты OpenToonz (см. Настройка проектов).

Когда палитры добавляются в Project Palettes, они копируются в папку +palettes, указанную для
текущего проекта (см. Папки проекта по умолчанию).

Эти папки можно использовать, например, для перемещения вашей Studio Palette или Project Palettes
в другую сеть или для создания ее резервной копии.

Совет: Чтобы добавить пустую палитру:

1. Выберите папку, в которой вы хотите создать новую палитру.
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2. Щелкните правой кнопкой мыши папку, в которой вы хотите разместить палитру, и выберите
Новая палитра в открывшемся меню.

Совет: Чтобы назвать палитру:

Дважды щелкните его имя и введите новое имя.

Совет: Для просмотра палитры в Studio Palette:

Выберите его в Palette Tree.

Совет: Чтобы добавить палитру уровня в Studio Palette:

1. Выберите уровень, чтобы отобразить его палитру.

2. Выполните одно из следующих действий:

• Нажмите кнопку Палитра ( ) в верхней панели редактора палитр и перетащите текущую
палитру в папку Studio Palette, где вы хотите ее найти. Палитра сохранит свое имя.

• Добавьте пустую палитру в редакторе Studio Palette, щелкните ее правой кнопкой мыши и вы-
берите Заменить текущую палитру в открывшемся меню.

Совет: Чтобы добавить палитры путем поиска в папке на компьютере:

1. Выберите папку, в которую вы хотите поместить палитры, полученные во время поиска.

2. Щелкните правой кнопкой мыши папку и выберите Поиск палитр в открывшемся меню.

3. Найдите папку на компьютере, которую хотите отсканировать.

Совет: Чтобы добавить новую папку:

1. Выберите папку, в которой вы хотите создать новую папку.

2. Щелкните правой кнопкой мыши папку, в которой вы хотите найти новую папку, и выберите
Новая папка в открывшемся меню.

Совет: Чтобы назвать папку:

Дважды щелкните его имя и введите новое имя.

Совет: Чтобы удалить палитру или папку:

1. Выберите его в Palette Tree.

2. Щелкните правой кнопкой мыши палитру или папку, которую вы хотите удалить, и выберите
Удалить палитру в открывшемся меню.
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Совет: Чтобы переставить палитры в папках Studio Palette:

Нажмите и перетащите палитру из текущего местоположения в новое.

Совет: Чтобы загрузить палитру из палитры Studio в палитру текущего уровня:

Выполните одно из следующих действий:

• Нажмите и перетащите палитру из Древа Studio Palette на кнопку Палитра ( ) в верхней
панели Редактора палитры.

• Щелкните правой кнопкой мыши палитру, которую вы хотите использовать, и выберите Загру-
зить в текущую палитру в открывшемся меню.

Примечание: Если в палитре отсутствуют некоторые стили, используемые для покраски рисунков
уровней, вам будет предложено удалить только стили и показать линии и области, закрашенные ими
красным, или удалить линии и области, закрашенные их тоже.

Совет: Чтобы изменить порядок текущей палитры, используя конкретную палитру Studio
в качестве образца:

1. Выберите уровень, который использует палитру, которая должна быть изменена.

2. Выберите в окне Studio Palette палитру, которую вы хотите использовать в качестве образца.

3. Щелкните правой кнопкой мыши палитру и выберите Отрегулировать текущий уровень до
этой палитры.

4. Вставьте Допуск значение в открывшемся окне.

Примечание: Параметр Допуск определяет диапазон значений RGB, которые будут использоваться
для сопоставления цветов от палитры курсора до Studio Palette. Значение по умолчанию 0 означает
отсутствие использования диапазона, поэтому только цвета с одинаковыми значениями RGB будут
переупорядочены, а все остальные будут добавлены в качестве новых цветов.

Примечание: Все цвета Studio Palette будут перенесены в текущую палитру, все эти цвета будут
отображаться в поле Референс на Studio Palette. Цвета, используемые в обеих палитрах, будут
упорядочены по положению и цветовому индексу, как в эталонной Studio Palette. Все цвета, которые
являются новыми в текущей палитре, будут перемещены после последнего переданного цвета. Стра-
ницы будут добавлены при необходимости.

Совет: Чтобы объединить палитру из Studio Palette с палитрой текущего уровня:

Выполните одно из следующих действий:

• Нажмите и перетащите палитру из дерева Studio Palette в палитру уровня.
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• Щелкните правой кнопкой мыши палитру, которую вы хотите использовать, и выберите Объ-
единить с текущей палитрой в открывшемся меню.

Совет: Чтобы заменить палитру из Studio Palette на текущую палитру:

1. Выберите палитру, которую вы хотите изменить, в Global Palette или Project Palette.

2. Щелкните правой кнопкой мыши палитру и выберите Заменить текущую палитру.

Совет: Чтобы скопировать стили из Studio Palette в палитру текущего уровня и наоборот:

1. Выберите палитру в Studio Palette, чтобы отобразить ее в окне просмотра палитры.

2. Выберите стили, которые вы хотите скопировать в одной палитре.

3. Удерживая клавишу Ctrl (PC) или Cmd (Mac), перетащите выделенную область на другую па-
литру.

Примечание: Если вы перетащите выделение справа от последней вкладки страницы, будет создана
новая страница, содержащая перетаскиваемые стили.

Совет: Чтобы активировать ссылку на стиль в Studio Palette:

1. Выберите стили, которые были импортированы из Studio Palette.

2. Щелкните правой кнопкой мыши выделенную область и выберите Переключить линк на
Studio Palette в открывшемся меню.

Совет: Чтобы деактивировать ссылку на стиль в Studio Palette:

1. Выберите стили, которые были связаны с Studio Palette.

2. Щелкните правой кнопкой мыши выделенную область и выберите Переключить линк на
Studio Palette в открывшемся меню.

Совет: Чтобы удалить ссылку на стиль в Studio Palette:

1. Выберите стили, которые имеют ссылку на Palette Studio.

2. Щелкните правой кнопкой мыши выделенную область и выберите Удалить референс на
Studio Palette в открывшемся меню.

Совет: Чтобы изменить размеры разделов Studio Palette:

Выполните любое из следующих действий:

• Нажмите и перетащите разделитель, чтобы изменить размеры разделов.

• Нажмите и перетащите разделитель к границе панели, чтобы скрыть раздел.
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• Нажмите и перетащите разделитель, свернутый к границе панели, к центру панели, чтобы снова
отобразить скрытый раздел.

12.3 Анимационные палитры

Для уровней Toonz Vector и Toonz Raster цвета в палитре можно анимировать и изменять в соответ-
ствии с кадрами Xsheet/Timeline.

Анимация определяется ключами, которые ссылаются на абсолютную синхронизацию Xsheet/Timeline:
это означает, что нет никакой связи между длиной уровня и длиной анимации цветов палитры. Напри-
мер, вы можете создать палитру, анимированную от 1 до 100 кадров, даже если ее уровень составляет
всего пять кадров.

Цветовая анимация всегда ссылается на временные рамки Xsheet/Timeline, даже если вы перемещаете
связанный уровень в другой диапазон кадров. Например, если вы анимируете палитру из кадра 1 в кадр
20, а уровень отображается после кадра 20, цветовая анимация не будет видна, а цвет, используемый
для уровня, будет ссылаться на последний ключ анимации цветов.

Клавиши установлены для всех цветов и настроек палитры (в случае сгенерированных стилей и тек-
стур) одновременно, и их можно перемещать непосредственно в редакторе палитры (с ожидаемым
обновлением содержимого окна просмотра) для проверки цветовой анимации.

Совет: Чтобы определить ключ палитры:

1. Выберите в Xsheet/Timeline кадр, в котором вы хотите определить ключ.

2. Нажмите кнопку Ключ ( ) в верхней панели редактора палитр.

Совет: Чтобы проверить, есть ли у палитры ключ в определенном кадре:

Выберите кадр, который вы хотите проверить: если кнопка Key ( ) в верхней панели редактора
палитр синего цвета, у цветов есть клавиша в текущем кадре.

Совет: Для навигации по клавишам палитры:

Используйте кнопки Следующий ключ ( ) и Предыдущий ключ ( ), расположенные сбоку
от кнопки на верхней панели редактора палитр.

Совет: Чтобы удалить ключ палитры:

1. Выполните одно из следующих действий, чтобы выбрать кадр, из которого вы хотите удалить
ключ:

• Выберите его в столбце кадров Xsheet или временной шкалы Timeline.

• Перемещайтесь по ключам палитры.

2. Нажмите кнопку Ключ ( ) в верхней панели редактора палитры, чтобы удалить ее.
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12.4 Редактирование стилей

Стили палитры можно изменить с помощью редактора стилей. Существует четыре типа стилей на
выбор: Цвет, Текстура, Вектор и Растр. На вкладке Вектор есть категории Сформирован, Хвост
и Векторная кисть, доступные только для уровней Toonz Vector. Для нескольких типов стилей есть
также контроль над различными вариантами стилей на вкладке Настройки.

Кнопка Автоматически позволяет вам решить, должны ли изменения автоматически назначаться
стилю или только после того, как вы нажмете кнопку Применить. В правом нижнем углу вы можете
увидеть образцы предыдущего и нового стилевого статуса; если вы хотите вернуться к предыдущему
стилю, просто нажмите на него.

Только первый стиль в палитре, помеченный Color_0, не может быть отредактирован: вместо этого
он позволяет удалить любой стиль из линий и заполненных областей.

Совет: Чтобы открыть Редактор стилей в виде плавающего окна:

Выполните одно из следующих действий:

• Выберите Окна → Редактор стилей.

• Дважды щелкните стиль, который вы хотите изменить, в Редакторе палитр.

Совет: Чтобы автоматически применить редактирование к стилю:

Активируйте кнопку Автоматически в Редакторе стилей.

Совет: Чтобы вручную применить редактирование к стилю:

1. Отключите кнопку Автоматически в Редакторе стилей.

2. Нажимайте кнопку Применить каждый раз, когда вы хотите применить редактирование к сти-
лю.

Совет: Чтобы вернуться к старому стилю, отменив редактирование:

Нажмите образец стиля в самом нижнем правом углу Редактора стилей.
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12.4.1 Цвета

Цвета могут быть определены либо значениями Оттенок/Насыщенность/Значениями красного/синего
или зеленого каналов. Их можно использовать как для рисования линий, так и для заполнения обла-
стей.

Вы также можете установить непрозрачность с помощью ползунка Альфа: чем меньше значение, тем
прозрачнее цвет. Вы можете проверить непрозрачность цвета с рисунком шахматной доски, видимым
под цветом, видимость которого пропорциональна прозрачности цвета.

Для редактирования цвета вы можете использовать ползунки или цветовое колесо. Чтобы выбрать
цвет из ползунков или колеса, щелкните по нему; чтобы настроить значения, вы можете использовать
кнопки со стрелками на каждом конце ползунка.

Цвета также можно выбирать из содержимого средства просмотра с помощью инструмента RGB Пи-

петка ( ), чья опция Режим: позволяет выбрать следующее: Обычная, чтобы выбрать значения
цвет; Прямоугольная, чтобы выбрать средние значения цветов, включенных в поле, которое вы опре-
деляете; От руки, чтобы выбрать средние значения цветов, включенных в область, которую вы обво-
дите, щелкая и перетаскивая; и Полилиния, чтобы выбрать средние значения цветов, включенных в
контур, который вы очерчиваете, определив ряд линий.

Если текущий стиль не является простым цветом, цвет, который вы редактируете на вкладке Цвет,
является цветом, используемым специальным стилем. Если специальный стиль использует более одного
цвета, вы можете выбрать цвет для редактирования в строке миниатюр, доступных под кнопками
Автоматически и Применить. (см. Специальные стили).

Совет: Чтобы выбрать цвет из содержания окна просмотра:

1. Выберите инструмент RGB Пипетка ( ).

2. Выполните одно из следующих действий:
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• Нажмите в окне просмотра, чтобы выбрать необходимые значения цвета.

• Установите режим Прямоугольная, затем щелкните и перетащите в окне просмотра, чтобы
определить блок, который выбирает средние значения цветов, включенных в блок.

• Установите режим От руки, затем щелкните и перетащите в окне просмотра, чтобы выделить
область, которая выбирает средние значения цветов, включенных в область.

• Установите режим Полилиния, затем щелкните в средстве просмотра, чтобы очертить область,
задав серию линий, и при этом будут выбраны средние значения цветов, включенных в область.

12.4.2 Текстуры

Текстуры можно использовать как для рисования линий, так и для заливки областей. Их можно
выбрать из списка, доступного на вкладке Текстура, где также можно добавить свои собственные
текстуры или добавить пользовательские текстуры, нажав кнопку Пользовательская текстура.

Стили текстур можно использовать как на уровнях Toonz Vector, так и на уровне Toonz Raster, но
только применительно к уровням Toonz Raster они реагируют на значения настроек на вкладке На-
стройки (см. Настройки текстуры).

Последовательности изображений также можно загружать в виде текстур, при условии, что они сле-
дуют правилам OpenToonz для обнаружения в качестве таковых. В случае, когда последовательность
изображений загружается в качестве текстуры, их кадры будут меняться с каждым новым кадром
Xsheet/Timeline, и будут циклически повторяться, когда достигнут последний кадр.

Совет: Чтобы добавить новую текстуру в библиотеку текстур:

1. Создайте изображение, которое вы хотите использовать в качестве текстуры со следующими
характеристиками:
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• Количество пикселов ширины и высоты изображения должно быть равно 2 степени любого числа
(то есть 2, 4, 8, 16, 32, 64, 128, 256 и т. д.); если нет, текстуры будут отображаться растянутыми.

• Файл должен быть сохранен в любом из следующих форматов: TIF, TGA, PNG, BMP, JPG, NOL,
RGB и SGI.

2. Сохраните файл текстуры в одной из следующих папок: <projectroot>\library\textures или
Opentoonz stuff\library\textures (см. Настройка проектов).

Пользовательские текстуры

Пользовательские текстуры могут быть загружены для рисования как линий, так и заливки областей.
Пользовательская текстура будет сохранена в палитре, а ее значок будет заменен значком загруженной
текстуры.

Совет: Чтобы добавить пользовательскую текстуру:

1. Выберите стиль в Редакторе палитр.

2. Перейдите на вкладку Текстура в редакторе стилей и нажмите кнопку Пользовательская
текстура.

3. Перейдите на вкладку Настройки, используйте поле Загрузить из файла. . . и выберите изоб-
ражение (или последовательность изображений), которое вы хотите использовать в качестве тек-
стуры.

4. На уровнях Toonz Raster нажмите кнопку Предпросмотр, чтобы визуализировать текстуру.

Наложение текстур

Отображение текстуры - это способ применения текстуры к линиям или областям с использованием
стиля. Он применяется по-разному, в зависимости уровень является Toonz Vector или Toonz Raster:

• Toonz Vector: отображение текстуры выполняется с использованием параметрических коорди-
нат векторного обводки; это означает, что для линий текстура автоматически «следует» за фор-
мой и толщиной обводки, будь то для областей изображение текстуры мозаично, чтобы покрыть
область, окрашенную стилем.

• Toonz Raster: отображение текстуры выполняется с использованием стандартных координат
отображения; это означает, что изображение текстуры мозаично, чтобы покрыть линии или об-
ласти, нарисованные стилем.

Примечание: Более мощное наложение текстур можно выполнить с помощью специальных текстур
Текстура и Pinned Texture (см. Уровень Toonz ).

Настройки текстур

Текстуры, применяемые к стилям, используемым в уровнях Toonz Raster, позволяют устанавливать
различные параметры, такие как:

• Use As Pattern, позволяет использовать яркость изображения для модуляции яркости простого
цвета стиля, к которому он применяется.
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• Position, позволяет контролировать, как текстура применяется к рисунку. Опции включа-
ют в себя: FIXED (текстура будет фиксироваться и скользить при перемещении персонажа),
AUTOMATIC (текстура будет следовать позиции персонажа во время анимации) и RANDOM
(позиция текстуры будет изменить в каждом кадре случайным образом);

• Scale, позволяет установить масштаб рисунка текстуры.

• Rotation, позволяет установить угол поворота для текстуры рисунка.

• X displ и Y displ, позволяют сместить рисунок текстуры по горизонтали или по вертикали.

• Contrast, позволяет изменить контраст изображения, применяемого в качестве текстуры.

12.4.3 Сгенерированные стили

Сгенерированные стили используют ряд математических функций для создания эффектов, которые
можно использовать как для векторных линий, так и для заполнения областей, определенных векто-
рами. Их можно выбрать из списка, доступного в разделе Сформирован на вкладке Вектор, где стили,
подходящие для векторных штрихов, имеют миниатюру, представляющую, как они будут выглядеть
в виде диагональной линии; стили, подходящие для заполнения, имеют миниатюру, представляющую
верхний правый угол области.

Сгенерированные стили могут имитировать, например, фриз, лист растения или мазок карандашом
вдоль вектора, или позволяют заполнять области специальными эффектами, такими как узор в горо-
шек.

Сгенерированные стили могут быть настроены путем определения параметров, доступных на вкладке
Настройки. Это позволяет вам иметь много похожих стилей, каждый из которых имеет свою конфи-
гурацию настроек.

Цвета, используемые сгенерированными стилями, можно изменить с помощью вкладки Цвет, доступ-
ной в Редакторе стилей.
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Первый элемент, доступный в списке, позволяет удалить сгенерированный стиль, чтобы вернуть его к
цветному стилю.

Совет: Чтобы изменить цвета, используемые сгенерированным стилем:

1. Перейдите на вкладку Цвет в Редакторе стилей.

2. Отредактируйте цвет, используя колесо и ползунки.

3. Если сгенерированный стиль использует более одного цвета, выберите цвет для редактирования
в строке образцов, доступных под кнопками Автоматически и Применить.

12.4.4 Хвостовые стили

Хвостовые стили доступны только для векторных уровней. Хвостовой стиль повторяет изображение
или уровень анимации, созданные с помощью OpenToonz или стороннего программного обеспечения,
по векторам векторного уровня. Хвостовой стиль нельзя использовать для рисования областей.

В разделе Хвост на вкладке Вектор вы можете выбрать изображение или уровень анимации, который
вы хотите использовать в качестве стиля. Вы также можете добавить в список свои собственные уровни
анимации: уровни анимации OpenToonz (PLI) и полноцветные изображения или последовательности
полноцветных изображений (BMP, JPG, NOL, PIC, PICT, PCT, PNG, RGB, SGI , TGA, TIF и TIFF)
поддерживаются.

Примечание: Уровни PLI отображаются в соответствии с длиной и толщиной вектора, поэтому при
приближении они выглядят неровными. Если выходной формат является векторным, то уровень PLI
останется векторным. (см. Выбор настроек вывода).
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Изображения повторяются, изменяя их расположение и размер в соответствии с формой и толщиной
вектора. Если уровни анимации содержат разные рисунки, они циклически повторяются по длине
вектора.

Такие параметры, как расстояние между последующими изображениями вдоль вектора и их вращение,
можно определить на вкладке Настройки (см. Настройки).

Совет: Чтобы добавить новый пользовательский стиль:

1. Создайте изображение или уровень анимации с помощью OpenToonz или стороннего программ-
ного обеспечения.

2. Сохраните его в папке Projectroot\library\custom styles (см. Настройка проектов).

12.4.5 Стили векторной кисти

Стили векторной кисти доступны только для векторных уровней. Векторная кисть применяет вектор-
ное изображение, созданное с помощью OpenToonz, вдоль векторных линий векторного уровня. Стили
векторных кистей нельзя использовать для рисования областей.

В разделе Векторная кисть на вкладке Вектор вы можете выбрать изображение, которое хотите ис-
пользовать в качестве стиля. Вы также можете добавить в список свои собственные изображения PLI.

Примечание: Уровни PLI отображаются в соответствии с длиной и толщиной вектора, поэтому при
приближении они выглядят неровными. Если выходной формат является векторным, то уровень PLI
останется векторным. (см. Выбор настроек вывода).
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Изображение векторной кисти применяется к каждой линии рисунка, использующей этот стиль, в
соответствии с формой и толщиной мазка. Если уровни анимации, используемые в качестве векторной
кисти, содержат разные рисунки, будет учитываться только первый.

Цвета, используемые векторными кистями, можно изменить с помощью вкладки Цвет, доступной в
Редакторе стилей.

Первый элемент, доступный в списке, позволяет удалить векторную кисть, чтобы вернуть ее в цветовой
стиль.

Совет: Чтобы добавить новую векторную кисть:

1. Создайте уровень PLI в OpenToonz.

2. Сохраните его в папке Projectroot\library\vector brushes (см. Настройка проектов).

Совет: Чтобы изменить цвета, используемые в стиле векторной кисти:

1. Перейдите на вкладку Цвет в Редакторе стилей.

2. Отредактируйте цвет, используя колесо и ползунки.

3. Если векторная кисть использует более одного цвета, выберите цвет для редактирования в ряду
образцов, доступных под кнопками Автоматически и Применить.

12.4.6 Растровые кисти

Растровые кисти доступны для рисования на растровых уровнях и, с некоторыми ограничениями, на
Toonz Raster уровнях. По сути, они совместимы с кистями MyPaint - программным обеспечением для
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рисования с открытым исходным кодом.

Растровые кисти используют Цвет из текущего стиля в качестве основы, а все остальные параметры
можно найти на вкладке Настройки окна Редактора стилей (см. Настройки для растровых кистей).

Примечание: В уровнях Toonz Raster в настоящее время могут использоваться только аддитивные
растровые кисти (т.е. кисти, которые добавляют краску к уровню, а не те, которые стирают, смешивают
или размывают уже нарисованные мазки).

Примечание: В уровнях Toonz Raster кисти Raster используют только значения Непрозрачность
выбранной кисти для рисования текущим цветом стиля и не могут использовать какие-либо другие
связанные с цветом настройки этой кисти.

Примечание: На уровнях Toonz Raster кисти Raster могут рисовать только линии (их нельзя ис-
пользовать для заполнения областей).

12.4.7 Настройки

Вкладка Настройки доступна для определения некоторых свойств стиля.

Для уровней Toonz Raster он содержит только параметр Автозаливка линий, который можно исполь-
зовать для автоматического рисования границ линий области, с тем же цветом, который используется
для заполнения этой области (см. Использование опции Автозаливка линий).

Для уровней Toonz Vector он содержит параметры только в том случае, если стиль является Сфор-
мирован или Хвост.
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Если стиль Сформирован, вкладка Настройки содержит один или несколько ползунков, которые
позволяют точно настроить предопределенный стиль в соответствии с вашими потребностями. Когда
стиль Хвост один, вкладка Настройки содержит два ползунка: Расстояние устанавливает интер-
вал между двумя последующими изображениями уровня анимации, используемого в качестве следа;
Вращение устанавливает угол всех изображений.

Вы можете добавлять один и тот же стиль Сформирован или Хвост столько раз, сколько хотите,
каждый раз определяя для него различные настройки.
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Настройки растровых кистей
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Растровые кисти имеют широкий набор параметров для точной настройки их поведения. Эти пара-
метры можно изменить на вкладке Настройки окна Редактор стилей. Они включают в себя:

Основные

• Радиус, базовый радиус кисти (логарифмический). 0,7 означает 2 пикселов; 3,0 означает 20
пикселов.

• Случайный радиус меняет радиус случайно в каждом мазке. Вы также можете сделать это
с помощью входного параметра _random в настройке радиуса. Если вы делаете это здесь, есть
два отличия: 1) непрозрачное значение будет исправлено так, чтобы мазки большого радиуса
были более прозрачными. 2) он не изменит фактический радиус, видимый в параметре Мазков
на текущий радиус.

• Жёсткость, жесткие границы круга кисти (установка в 0 ничего не будет рисовать).

• Сглаживание границ, (требуется информация).

• Ластик, насколько этот инструмент ведет себя как ластик. 0,0 для нормальной окраски; 1.0 для
стандартного поведения ластика; 0,5 пиксела идут к 50% прозрачности.

• Дрожание, добавить случайное смещение в положение, где рисуется каждый мазок. 0.0 отклю-
чен; 1,0 стандартное отклонение составляет один базовый радиус; <0.0 отрицательные значения
не дают дрожания.

• Эллиптический мазок: угол, это определяет угол, на который наклоняются эллиптические
мазки. 0.0 делает горизонтальные мазки; 45.0 производит 45 градусов, повернутые по часовой
стрелке; 180.0 снова в горизонтальном положении.

• Эллиптический мазок: соотношение, форматное соотношение мазков; должен быть >= 1,0,
где 1,0 означает идеально круглое прикосновение.

• Фильтр направления, низкое значение заставит вводить направление быстрее, а высокое зна-
чение сгладит.

• Привязка к пикселам, (требуется информация).

• Усиление нажатия изменить коэффициент усиления для давления кисти.

Непрозрачность

• Непрозрачность, 0 означает, что кисть прозрачна; 1 полностью виден (также известный как
альфа).

• Множитель непрозрачности, это умножается на непрозрачность. Используется для создания
непрозрачной зависимости от давления (или других входов).

• Линеаризация непрозрачности, исправить введенную нелинейность путем наложения
нескольких мазков друг на друга. Эта коррекция должна дать вам линейный («естественный»)
отклик давления, когда давление отображается непрозрачным opaque_multiply, как это обычно
делается. 0,9 хорошо для стандартных мазков, установите его меньше, если ваша кисть сильно
рассеивается, или выше, если вы используете Мазков в секунду. 0.0 значение Непрозрачность
выше для отдельных мазков; 1.0 значение Непрозрачность, приведенное выше, относится к
последнему мазку кисти, при условии, что каждый пиксель получает (dabs_per_radius*2) мазки
кисти в среднем за удар.

• Блокирование альфа-канала, (требуется информация).
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Мазки

• Мазков на основной радиус, сколько мазков нужно нарисовать, когда указатель перемещается
на расстояние 1 радиуса кисти (т.е. базовое значение радиуса).

• Мазков на текущий радиус, то же, что указано выше, но фактически используется радиус,
который может изменяться в зависимости от давления.

• Мазков в секунду, мазки к рисованию каждую секунду, независимо от того, как далеко пере-
мещается указатель.

Размазывание

• Размазывание, рисуйте цветом пятна, а не цветом кисти. Цвет пятна медленно меняется на
цвет, на котором вы рисуете. 0.0 не используйте пятно цвета; 0.5 смешайте цвет пятна с цветом
кисти; 1.0 используйте только цвет пятна.

• Длина размазывания определяет, насколько быстро цвет пятна становится цветом, на котором
вы рисуете. 0.0 немедленно изменить цвет пятна; 1.0 никогда не меняет цвет пятна.

• Радиус, (требуется информация).

Скорость

• Фильтр точной скорости, насколько медленная скорость ввода соответствует реальной скоро-
сти. 0.0 изменяется немедленно по мере изменения вашей скорости (не рекомендуется, но попро-
буйте).

• Фильтр главной скорости, то же, что и Фильтр точной скорости, но обратите внимание,
что диапазон отличается.

• Гамма точной скорости, изменяет реакцию входа Точная скорость на экстремальную фи-
зическую скорость. Вы увидите разницу лучше всего, если Точная скорость отображается на
радиус. -8.0 очень быстрая скорость не увеличивается Точная скорость намного больше; +8.0
очень быстрая скорость увеличивается Точная скорость сильно. Для очень медленной скорости
происходит обратное.

• Гамма главной скорости то же, что и Гамма точной скорости для главной скорости.

• Смещение вдоль скорости - изменение положения в зависимости от скорости указателя. = 0
отключить; > 0 рисует, куда перемещается указатель; <0 рисовать, откуда приходит указатель.

• Фильтр смещения по скорости, насколько медленно смещение возвращается к нулю, когда
курсор перестает двигаться.

Перемещение

• Замедление перемещения скорость отслеживания указателя замедления. 0 отключает его,
более высокие значения убирают больше дрожания в движениях курсора. Полезно для рисования
гладких, комических контуров.

• Замедление перемещения на мазок, аналогично описанному выше, но на уровне кисти (иг-
норирование того, сколько времени прошло, если кисти не зависят от времени).
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• Дрожание траектории добавляет случайность к указателю мыши; это обычно генерирует мно-
го маленьких линий в случайных направлениях; возможно попробуйте это вместе с Замедление
перемещения на мазок.

Штрих

• Порог штриха какое давление необходимо для начала штриха. Это влияет только на вход штри-
ха. OpenToonz не требует минимального давления, чтобы начать рисовать.

• Длительность штриха то, как далеко вы должны продвинуться, пока входной штрих не до-
стигнет 1,0. Это значение является логарифмическим (отрицательные значения не будут инвер-
тировать процесс).

• Время удержания штриха, это определяет, как долго ввод штриха остается на уровне 1,0.
После этого он сбрасывается до 0,0 и снова начинает расти, даже если ход еще не завершен. 2,0
означает вдвое больше времени, необходимого для перехода от 0,0 до 1,0; 9,9 и больше означает
бесконечность.

Цвет

• Оттенок, (требуется информация).

• Насыщенность, (требуется информация).

• Светлота, (требуется информация).

• Изменение оттенка, меняет цветовой тон. -0.1 небольшое смещение цвета по часовой стрелке;
0.0 отключить; 0,5 против часовой стрелки сдвиг оттенка на 180 градусов.

• Изменение светлоты (HSL) изменить яркость цвета (яркость) с помощью цветовой модели
HSL. -1,0 чернее; 0.0 отключить; 1,0 белее.

• Изменение насыщенности (HSL) меняет насыщенность цвета, используя цветовую модель
HSL. -1,0 больше сероватого цвета; 0.0 отключить; 1,0 более насыщенный.

• Изменение значения (HSV) изменить значение цвета (яркость, интенсивность) с помощью
цветовой модели HSV. Изменения HSV применяются до изменений HSL. -1,0 темнее; 0.0 отклю-
чить; 1,0 ярче.

• Изменение насыщенности (HSV) изменить насыщенность цвета, используя цветовую модель
HSV. Изменения HSV применяются до изменений HSL. -1,0 больше сероватого цвета; 0.0 отклю-
чить; 1.0 более насыщенный.

• Сохранить цвет, (требуется информация).

• Цвет, (требуется информация).

Пользовательский

• Ввод пользователя установите пользовательский ввод на это значение. Если он замедлен, пере-
местите его к этому значению (см. ниже). Идея состоит в том, что вы делаете этот ввод зависимым
от сочетания давление/скорость/что угодно, а затем делаете другие настройки зависимыми от
этого «пользовательского ввода» вместо того, чтобы повторять эту комбинацию везде, где вам это
нужно. Если вы сделаете это случайным, вы можете создавать медленный (плавный) случайный
ввод.
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• Фильтр ввода пользователя насколько медленно пользовательский ввод фактически следует
желаемому значению (указанному выше). Это происходит на уровне кисти (игнорируя, сколько
времени прошло, если кисти не зависят от времени). 0.0 замедления нет (изменения применяются
мгновенно).

12.4.8 Изменение типа стиля

Когда вы выбираете стиль Цвет, Текстура, Сформирован, Хвост, Векторная кисть или Растр в Редак-
торе стилей, вы автоматически назначаете его текущему стилю, тем самым изменяя его стиль.

Другой случай, когда вы хотите изменить обратно с Сформирован, Векторная кисть или Растр
стиля кисти на Цвет, потому что когда текущий стиль равен единице из этих типов вкладка Цвет
используется для установки их цветов. Таким образом, в этом случае сначала необходимо удалить
стили Сформирован, Векторная кисть или Растр с помощью первого образца, доступного в списке
образцов, а затем перейти на вкладку Цвет.

Также обратите внимание, что при переходе от стиля, подходящего как для линий, так и областей,
к стилю, подходящему только для линий, областей, окрашенные этим стилем, станут невидимыми, и
наоборот. Например, если вы измените стиль с Цвета на Хвост, все области, окрашенные этим стилем,
станут невидимыми. Если вы измените стиль так, чтобы он снова подходил для линий и областей,
невидимые части снова станут видимыми.

Совет: Чтобы изменить тип стиля с Цвет на любой другой:

Выберите элемент на вкладках Текстура, Вектор или Растр.

Совет: Чтобы изменить тип стиля обратно на Цвет:

Выберите вкладку Цвет и начните перемещать ползунок или селектор в цветовом круге.

Совет: Чтобы изменить тип стиля с Сформирован, Векторная кисть или Растровая кисть
обратно на цвет:

1. В секциях кисти Сформирован, Векторная кисть или Растр Редактора стилей выберите
первый стиль в списке (самый верхний левый), чтобы удалить любой специальный тип из текущий
стиль.

2. Выберите вкладку Цвет и начните перемещать ползунок или селектор в цветовом круге.

12.4.9 Редактирование нескольких стилей одновременно

Вы можете изменить несколько стилей одновременно, используя Палитра Gizmo. Он позволяет мас-
штабировать или сдвигать значение, насыщенность, оттенок и альфа выбранных стилей, смешивать
их или затемнять до определенного цвета.
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Примечание: Редактирование Палитра Gizmo и смешивание влияют только на стили Цвет. на-
пример Сформирован и Хвост стили не будут затронуты.

Совет: Чтобы открыть палитру Gizmo:

Щелкните правой кнопкой мыши выбранные стили и выберите Палитра Gizmo в открывшемся меню.

Совет: Чтобы изменить значения выбранных стилей:

1. Установите процент изменения или величину сдвига, которую вы хотите применить к значению
стилей.

2. Выполните одно из следующих действий:

• Нажмите на кнопку +, чтобы увеличить значение на заданный процент или величину сдвига.

• Нажмите кнопку -, чтобы уменьшить значение на заданный процент или величину сдвига.

Совет: Чтобы изменить насыщенность выбранных стилей:

1. Установите процент изменения или величину сдвига, которую вы хотите применить к насыщен-
ности стилей.

2. Выполните одно из следующих действий:

• Нажмите кнопку +, чтобы увеличить насыщенность на заданный процент или величину сдвига.

• Нажмите кнопку -, чтобы уменьшить насыщенность на установленный процент или величину
сдвига.
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Совет: Чтобы изменить оттенок выбранных стилей:

1. Установите величину смещения, которую вы хотите применить к оттенкам стилей.

2. Выполните одно из следующих действий:

• Нажмите кнопку +, чтобы увеличить оттенок на установленную величину сдвига.

• Нажмите кнопку -, чтобы уменьшить оттенок установленной величины сдвига.

Совет: Чтобы изменить значение альфа-канала выбранных стилей:

1. Установите процент изменения или величину сдвига, которую вы хотите применить к стилям
альфа.

2. Выполните одно из следующих действий:

• Нажмите кнопку +, чтобы увеличить альфа на заданном проценте или величине сдвига.

• Нажмите кнопку -, чтобы уменьшить альфа на установленный процент или величину сдвига.

Совет: Чтобы смешать выбранные стили:

1. Выделите ряд стилей в Редакторе палитры.

2. Нажмите кнопку Однородно: цвета стилей будут смешиваться от первого до последнего цвета
выбранных стилей.

Совет: Затемнить выбранные стили к определенному цвету:

1. Выберите цвет, к которому хотите добавить затемнение, выполнив одно из следующих действий:

• Установите значения каналов Красный, Зеленый и Синий.

• Нажмите на миниатюру цвета и используйте Редактор стилей, чтобы отредактировать его (см.
Простые цвета).

2. Установите процент затемнения, который вы хотите применить к стилям.

3. Нажмите кнопку Затухание, чтобы добавить стили к заданному цвету в соответствии с задан-
ным процентом.

12.4.10 Использование Редактора имен

Редактор имен позволяет систематизировать наименования стилей, используемых в производстве,
путем определения предустановленных имен для Character, Часть и Суффикс. Таким образом,
стилям в палитре могут быть легко присвоены важные имена, что облегчит их использование в даль-
нейшем.
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Примечание: В настоящее время нет стандартного символа-разделителя, вставляемого между раз-
личными именами предустановок, поэтому, если вы хотите, чтобы они разделялись, например, подчер-
киванием, вы должны вставить этот символ в начале или в конце разных имен в каждом категория,
как показано на рисунке выше.

Совет: Чтобы открыть Редактор имен:

Щелкните правой кнопкой мыши в Редакторе палитр и выберите Редактор имен в открывшемся
меню.

Совет: Чтобы удалить имя предустановки:

Щелкните правой кнопкой мыши на желаемом имени предустановки и выберите Удалить в открыв-
шемся меню.
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Глава 13

Покраска уровней анимации

Уровни анимации Toonz, как очищенные, так и созданные непосредственно в OpenToonz, могут быть
покрашены с использованием стилей, сохраненных в палитре, и набора инструментов.

Все рисунки уровней Toonz состоят из линий (определенных штрихами отсканированных или век-
торных рисунков) и областей, определенных замкнутыми линиями. Растровые и векторные линии
могут быть закрашены или стерты, частично или полностью; области могут быть заполнены стилями
или оставаться пустыми с полной прозрачностью.

Примечание: Все работы по покраске не сохраняются до тех пор, пока вы не сохраните соответству-
ющий уровень или не воспользуетесь командой Сохранить все (см. Сохранение уровней).

Примечание: If the computer performance worsens during the painting process of Toonz Raster animation
levels, try activating the Minimize Raster Memory Fragmentation option in the Preferences. . . →
General dialog section (see Optimizing the Memory Usage ).

13.1 Инструменты покраски

Операции рисования можно выполнить с помощью инструмента Заливки ( ) и инструмента По-

краски ( ).

Если вы хотите получить стиль, уже использующийся на рисунке, то вы можете выбрать его с помощью

инструмента Пипетка ( ).

Операция заливки может быть выполнена путем активации различных опций, которые могут быть
объединены вместе для выполнения конкретных задач, например, для одновременного заполнения
нескольких областей одним и тем же стилем или нескольких кадров одной операцией.
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Инструмент Заливка ( ) позволяет рисовать область или линию рисования, щелкая ее. Доступны
следующие варианты:

• Тип: имеет параметры Обычная, чтобы заполнить область, нажав на нее; Прямоугольная,
чтобы заполнить все области, включенные в поле, которое вы определяете; От руки, чтобы за-
полнить все области, включенные в область, которую вы обводите, нажав и перетащив; и Поли-
линия, чтобы заполнить все области, включенные в область, которую вы очерчиваете, определив
серию линий.

• Режим: имеет параметры Области, чтобы заполнить только области, Линии, чтобы нарисовать
только штрихи, и Линии и области, чтобы выполнить обе операции.

• Избирательно предотвращает выполнение операции заполнения на уже залитых областях.

• Глубина заливки устанавливает, насколько стиль заливки проходит через сглаживание линий
области. При низких значениях даже очень тонкая линия, состоящая из полупрозрачных пиксе-
лей, будет эффективной, чтобы остановить операцию заполнения; с высокими значениями, только
более непрозрачные пиксели не позволят цвету затопить снаружи. Эта опция применяется только
к чертежам Toonz Raster. Можно установить два значения: минимальное значение используется
при использовании инструмента со стандартным щелчком мыши, максимальное значение при
использовании инструмента с зажатой клавишей Shift.

• Сегмент позволяет применять заливку только к сегменту растровых линий. Сегмент опреде-
ляется резким изменением толщины или направления хода. Это доступно только для рисунков
Toonz Raster.

• Калька позволяет вам выбрать стиль, который будет использоваться для операции заливки из
других рисунков, видимых в режиме кальки и применить его к текущему рисунку (см. Приме-
нение кальки).

• Диапазон кадров позволяет выполнять заполнение диапазона кадров, щелкая первый, а затем
последний кадр диапазона. Вы также можете нажать Shift, чтобы определить позицию заполне-
ния для промежуточных кадров.

Инструмент Покраски ( ) позволяет закрасить область рисования или линию как если бы вы ис-
пользовали кисть. Он доступен только для рисунков Toonz Raster. Присутствуют следующие настрой-
ки:

• Размер устанавливает размер кисти.

• Режим: имеет опции Области, для рисования только внутри областей, Линии, для рисования
вручную только линий рисования, и Линии и области, для выполнения обеих операций.

• Избирательно предотвращает выполнение операции покраски на уже окрашенных участках.

13.2 Заливка областей

Области могут быть заполнены когда их контур четко определен и вдоль них не должно быть пробелов.
Для векторных рисунков контур может быть определен одним вектором с перекрывающимися или
соединенными концами или разными векторами.

Опции, доступные для инструментов покраски могут помочь вам ускорить работу покраски. Вы можете
решить, какие варианты являются наиболее подходящими для вашей задачи, следуя приведенным
ниже инструкциям.

Примечание: In Toonz Raster levels, the areas that can be painted are limited either by the image border
or by the image Savebox, according to the Use the TLV Savebox to Limit Filling Operations option
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available in Preferences. . . → Tools.

Примечание: Некоторые стили могут не подходить для заполнения областей, например, стили Хвост
или Вектор или некоторые стили Сформирован. Если вы выберете один из этих стилей в палитре
и используете его для заполнения области, никакие операции выполняться не будут.

Совет: Чтобы залить область:

1. Выберите Инструмент Заливки ( ), установите тип заливки Обычная, а режим - Области
и выберите стиль в палитре.

2. Нажмите на область, которую вы хотите залить.

Примечание: Если цвет заливки не заливает самые узкие области в растровых чертежах из-за по-
лупрозрачных пикселов, попробуйте увеличить минимальное значение Глубина заливки или клик-
нуть, зажав клавишу Shift, чтобы использовать максимальное значение (см. Инструменты по-
краски).

Совет: Чтобы покрасить несколько кадров одной командой:

1. Выберите инструмент Заливки ( ), установите тип заполнения на Обычная, а режим на
Области и активируйте опцию Диапазон кадров.

2. Выберите первый кадр диапазона и нажмите по области, которую вы хотите заполнить, напри-
мер, по лицу персонажа.

3. Выполните одно из следующих действий:

• Выберите последний кадр диапазона, к которому вы хотите применить заливку, и щелкните по
той же области, как в примере с лицом персонажа: области во всех кадрах в диапазоне будут
автоматически заполнены в соответствии с первой и второй позицией нажатия.

• Выберите промежуточный кадр диапазона, к которому вы хотите применить заливку, и клик-
ните с нажатым Shift в той же области, в примере с лицом персонажа: области во всех кадрах
в диапазоне будут автоматически заполнены согласно первой и второй позиции нажатия. Выбе-
рите другой промежуточный кадр и снова нажмите с нажатым Shift: области во всех кадрах
в новом диапазоне будут автоматически заполнены в соответствии со второй и третьей позици-
ями щелчка. Сделайте столько раз, сколько вам требуется, затем нажмите в той же области в
последнем кадре диапазона, чтобы завершить режим заполнения нескольких кадров.

Примечание: Поскольку применяется Заливка с параметром Диапазон кадров, делая линейную
интерполяцию от первой точки щелчка до следующей, могут возникнуть некоторые ошибки рисования.
Чем больше область, которую вы хотите заполнить, перемещается вдоль диапазона кадра, тем больше
ошибок может быть сделано.

Совет: Чтобы заполнить несколько областей одновременно одним и тем же стилем:

1. Выберите инструмент Заливки ( ), установите режим заполнения на Области.

13.2. Заливка областей 205



OpenToonz Documentation, Выпуск 1.7.1

2. Выполните одно из следующих действий:

• Установите тип Прямоугольный и щелкните и перетащите, чтобы определить поле: все области
полностью включенные в поле будут заполнены текущим стилем.

• Установите тип От руки и нажмите и перетащите, чтобы обвести область: все области, полно-
стью включенные в область, которую вы обрисовали, будут заполнены текущим стилем. Если
концы нарисованного контура открыты, область будет определяться так, как если бы она соеди-
няла два открытых конца.

• Установите тип Полилиния и щелкните, чтобы обвести область, определив серию линий: все
области полностью включенные в области, которую вы наметите, будут заполнены текущим
стилем. Если концы нарисованного контура открыты, область будет определяться так, как если
бы она соединяла два открытых конца.

Совет: Чтобы заполнить все оставшиеся области на рисунке уровня одним и тем же
стилем:

1. Выберите Инструмент Заливки ( ), установите тип заливки Прямоугольный и режим Об-
ласти, и активируйте опцию Избирательно.

2. Нажмите и потяните, чтобы задать поле: все выделенные незаполненные области полностью
включенные в поле будут заполнены текущим стилем. Эта комбинация опций может быть полезна,
если на рисунке много областей, которые должны быть окрашены в одном стиле, который можно
покрасить в конце сразу с помощью этой команды.

Примечание: Вы также можете добавить к этой комбинации параметр Диапазон кадров, чтобы
выполнить ту же задачу, расширенную для диапазона кадров.

Совет: Чтобы залить области рисования, используя в качестве эталона заранее приготов-
ленный рисунок:

1. Активируйте режим кальки, чтобы отобразить нарисованный рисунок за текущим рисунком
(см. Использование кальки)

2. Выберите Инструмент Заливка ( ), установите режим заполнения на Области и активируйте
опцию Калька.

3. Нажмите, чтобы выбрать стиль для использования на рисунке, отображаемом в режиме кальки.

4. Выполните одно из следующих действий:

• Отпустите кнопку мыши, чтобы заполнить область, где находится курсор.

• Перетяните в область, которую вы хотите заполнить и отпустите кнопку мыши.

Примечание: Если в режиме Кальки отображается несколько рисунков, будет рассматриваться толь-
ко рисунок, ближайший к текущему.

Совет: Чтобы автоматически залить весь рисунок, используя в качестве ссылки ранее
нарисованный изображение:
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1. Активируйте режим кальки, чтобы отобразить нарисованный рисунок за текущим рисунком
(см. Использование кальки)

2. Выберите инструмент Заливки ( ), установите тип заливки Прямоугольный, режим Обла-
сти и активируйте опцию Калька.

3. Нажмите и потяните, чтобы определить блок: все области, полностью включенные в блок бу-
дут заполнены стилями, выбранными из окрашенных областей рисунка, отображаемых в режиме
кальки.

Примечание: Если в режиме Кальки отображается несколько рисунков, будет рассматриваться толь-
ко рисунок, ближайший к текущему.

Примечание: Если некоторые области автоматически закрашиваются с неправильным стилем, ис-
правьте их, чтобы избежать усиления ошибки в следующих кадрах, которые вы собираетесь рисовать.

Совет: Чтобы извлечь стиль из рисунка:

1. Выберите инструмент Пипетка ( ).

2. Нажмите на область, стиль которой вы хотите выбрать. Выбранный стиль становится текущим.

13.2.1 Закрытие пробелов в контуре рисунка

Если контур области определен не полностью, вы не сможете его залить. Разрыв можно закрыть,

добавив линию с помощью инструментов Кисть ( ) или Геометрический (|geometry|) (см. Ин-

струменты рисования), или с помощью инструмент Скотч ( ).

Для векторных рисунков Toonz инструмент Скотч ( ) позволяет вам присоединять векторные штри-
хи вручную или автоматически, с учетом их конечных точек и любой точки вдоль самих штрихов, в
соответствии с настройками инструмента. Доступны следующие варианты:

• Тип: имеет параметры Обычный, чтобы вручную определить векторы соединения,
или Прямоугольный, чтобы автоматически закрыть все пропуски, обнаруженные в
определенном вами поле.

Примечание: Когда тип установлен на Прямоугольный, рассматриваются
только промежутки между конечными точками, а также между конечной точкой
и линией.

• Режим: имеет параметр Вершина к вершине, чтобы соединить две конечные точки
линии; Вершина к линии, чтобы присоединить конечную точку к любой точке вдоль
линии; и Линия к Линии, чтобы соединить любую точку вдоль линии с любой другой
точкой вдоль другой линии.

• Расстояние устанавливает максимальное расстояние между конечными точками, а
также между конечной точкой и линией, которые автоматически объединяются при
использовании параметра Прямоугольный.
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• Соединять векторы когда активировано, соединяет штрих соединения с конечной
точкой, создавая тем самым один штрих; если деактивировано, объединяющий штрих
будет новым независимым штрихом (см. Соединение и разделение).

Примечание: Если штрихи, к которым вы собираетесь присоединиться, имеют
разные стили, стиль первого, на который вы щелкнете, будет назначен второму
после присоединения.

• Плавность, когда активировано, создает гладкий соединенный штрих без углов.

Для чертежей Toonz Raster инструмент Скотч ( ) автоматически соединяет открытые концы, об-
наруженные на рисунке, в соответствии с настройками инструмента. Доступны следующие варианты:

• Тип: имеет параметры Обычный, чтобы закрыть все пробелы, обнаруженные на ри-
сунке, щелкнув по нему; Прямоугольный, чтобы закрыть все пробелы, обнаруженные
в поле, которое вы определяете; От руки, чтобы закрыть все пробелы, обнаруженные
в области, которую вы определяете, щелкая и перетаскивая; и Полилиния, чтобы за-
крыть все пропуски, обнаруженные в области, которую вы определяете, рисуя серию
прямых линий.

• Диапазон кадров позволяет выполнять объединение для диапазона кадров, щелкая
в первом, а затем в последнем кадре диапазона.

• Расстояние устанавливает максимальное расстояние между двумя открытыми конца-
ми, которые будут обнаружены, чтобы соединить их.

• Угол устанавливает максимальный угол между двумя открытыми концами, которые
будут обнаружены, чтобы соединить их.

• Номер стиля устанавливает стиль, который будет использоваться для линии, соеди-
няющей открытые концы. Если вместо индекса стиля вы наберете current, будет ис-
пользован текущий выбранный стиль.

• Непрозрачность устанавливает непрозрачность стиля, используемого для линии, со-
единяющей открытые концы.

Примечание: Обратите внимание что по умолчанию значение Непрозрачно-
сти установлено равным 1, и с этим значением разрыв будет закрыт с помощью
прозрачной линии, которая не будет видна в средстве просмотра. Также обрати-
те внимание, что значение этой опции будет в равной степени влиять на то, как
функция Проверка замкнутости отображается в Окне просмотра.

Совет: Чтобы закрыть разрыв в контуре векторного рисования:

1. Выберите инструмент Скотч ( ), установите тип Обычный и укажите, следует ли объединять
векторы или создать плавное соединение.

2. Выполните одно из следующих действий:

• Установите режим Вершина к вершине, затем щелкните конечную точку обводки и перетащите
на другую конечную точку; указатель привязывается к ближайшей обнаруженной конечной точке
хода, как к началу, так и к концу.

• Установите режим Вершина к линии, затем щелкните конечную точку обводки и перетащите
ее в любую точку вдоль обводки; указатель привязывается к ближайшей обнаруженной конечной
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точке штриха в качестве начала и к любой ближайшей точке вдоль штриха в качестве конца.

• Установите режим Линия к линии, затем щелкните любую точку вдоль обводки и перетащите
ее в любую другую точку вдоль обводки; указатель привязывается к ближайшей точке по обводке
в качестве начала и к любой другой ближайшей точке по обводке в качестве конца.

Совет: Чтобы закрыть все пропуски в контуре векторного рисования в определенной
области:

1. Выберите инструмент Скотч ( ), установите тип Прямоугольный.

2. Щелкните и перетащите, чтобы определить область: все промежутки между конечными точка-
ми, а также между конечными точками и линиями, обнаруженными в области в соответствии с
заданным расстоянием, будут закрыты.

Совет: Чтобы закрыть все пропуски в контуре растрового рисунка:

1. Выберите инструмент Скотч ( ).

2. Щелкните в окне просмотра, чтобы закрыть все обнаруженные промежутки в соответствии с
заданным расстоянием и углом.

Совет: Чтобы закрыть определенный разрыв в контуре растрового рисунка:

1. Выберите инструмент Скотч ( ) и активируйте опцию Прямоугольный.

2. Нажмите и перетащите, чтобы определить область: все зазоры, обнаруженные в области в соот-
ветствии с заданным расстоянием и углом, будут закрыты.

Проверка замкнутости контуров рисунка

Чтобы управлять контуром чертежа и видеть, хорошо ли определены области, чтобы их можно было
закрасить цветами, можно активировать серию проверок:

• Проверка замкнутости выделяет пурпурными линиями промежутки, которые могут быть ав-

томатически закрыты с помощью инструмента Скотч ( ) с его текущими настройками; если
вы измените значения Расстояние и Угол инструмента Скотч, когда проверка активирована,
вы можете в интерактивном режиме проверить, обнаружены ли пропуски.

Примечание: Обратите внимание, что значение инструмента Скотч Непрозрачность
повлияет на отображение уровней Проверка замкнутости в Toonz Raster, поэтому, если для
него установлено значение по умолчанию 1, вы не сможете ничего видеть с функция Про-
верка замкнутости. Вместо этого установите 255, чтобы иметь возможность использовать
эту проверку.

• Проверка заполнения отображает все четко определенные области, которые могут быть за-
полнены серым цветом, все линии или векторные штрихи черным, а также нечетко определенные
области и фон белым; если включена На черном фоне, все линии или векторные штрихи отоб-
ражаются белым цветом (см. Проверка закрашенных рисунков).
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Примечание: Все проверки также могут быть объединены для достижения определенных режимов
отображения (см. также Проверка покрашенных рисунков).

Совет: Чтобы проверить, есть ли пропуски в контуре рисунка:

Активируйте или деактивируйте Проверка заполнения из меню Вид.

Совет: Чтобы проверить, хорошо ли определены области на чертеже:

Активируйте или деактивируйте Проверка заполнения из меню Вид.

13.2.2 Проверка покрашенных рисунков

Чтобы контролировать, правильно ли покрашены все области рисунков, и чтобы увидеть, оставила ли
заливка небольшие зазоры вдоль сглаживания линий или где определенный стиль используется для
рисования линий или областей, можно активировать серию проверок:

• The Transparency Check displays all the painted areas in the color defined in Preferences → Colors
→ Paint Color, all the lines or vector strokes in the color defined in Preferences. . . → Colors → Ink
Color on White BG (or Ink Color on Black BG, depending on the chosen background color).

• Проверка штриха отображает линии или векторные штрихи текущего стиля в красном цвете.

• Проверка цвета отображает области текущим цвета в красном цвете.

• На черном фоне отображает цвет фона, определенный в настройках сцены, черным цветом
(см. Настройка окна просмотра).

Примечание: Все проверки также могут быть объединены для достижения определенных режимов
отображения (см. также Проверка пропусков в контуре рисунка).

Совет: Чтобы активировать или деактивировать проверку:

Активируйте или деактивируйте проверку в меню Вид.

13.3 Линии покраски

Линии покраски могут быть покрашены с помощью инструмента Заливка ( ). Для рисунков Toonz

Raster инструмент Заливка ( ) влияет на сплошные линии, имеющие одинаковый стиль; для вектор-
ных рисунков Toonz - только один векторный штрих за раз.

Для рисунков Toonz Raster линии также можно рисовать с помощью инструмента Покраски ( ),
установленного в режим Линии. В этом случае, установив размер инструмента, вы можете нарисовать
любой участок линий, как если бы вы использовали кисть.
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Для векторных рисунков Toonz векторную обводку также можно нарисовать, сначала выделив ее, а
затем выбрав нужный стиль в палитре уровней.

Совет: Чтобы покрасить линию Toonz Raster:

1. Выберите инструмент Заливки ( ), установите режим заливки на Линии и выберите стиль в
палитре.

2. Нажмите на линию, которую хотите залить.

Совет: Чтобы покрасить штрих Toonz Vector:

Выполните одно из следующих действий:

• Выберите инструмент Заливки ( ), установите режим заливки на Линии, выберите стиль в
палитре и щелкните по линии, которую вы хотите залить.

• С помощью инструмента Выделения ( ) выберите линии, которые вы хотите нарисовать,
затем выберите стиль в палитре (см. Использование инструмента выделения).

Совет: Чтобы частично покрасить линию Toonz Raster:

Выполните одно из следующих действий:

• Выберите инструмент Заливки ( ), установите режим заливки на Линии, активируйте опцию
Сегмент и щелкните участок линии, который вы хотите нарисовать.

• Выберите инструмент Покраски ( ), установите режим на Линии и используйте его на участ-
ке линии, который вы хотите нарисовать.

• Используйте инструмент Покраски ( ) с соответствующим стилем, чтобы разбить непрерыв-

ную линию на секции, затем используйте инструмент Заливки ( ), чтобы закрасить ранее
разделенные секции.

Совет: Чтобы нарисовать несколько отдельных линий или векторных штрихов, одновре-
менно:

1. Выберите инструмент Заливки ( ), установите режим заполнения на Линии.

2. Выполните одно из следующих действий:

• Установите тип Прямоугольный, щелкните и перетащите, чтобы определить блок: все линии,
включенные в блок, будут окрашены в текущем стиле.

• Установите тип От руки, нажмите и перетащите, чтобы определить область: все линии, вклю-
ченные в определенную область, будут окрашены в текущем стиле. Если концы нарисованной
области открыты, она будет определяться так, как если бы она соединяла два открытых конца.

• Установите тип Полилиния и щелкните, чтобы определить область путем рисования серии пря-
мых линий: все линии полностью включенные в определенной вами области будут окрашены в
текущем стиле. Если концы нарисованной области открыты, эта область будет определяться так,
как если бы она соединяла два открытых конца.
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Примечание: Векторный штрих будет покрашен только если он полностью включен в определенную
вами область.

Совет: Для покраски линий или векторных штрихов в нескольких кадрах одной коман-
дой:

1. Выберите инструмент Заливки ( ), установите режим заполнения на Линии и активируйте
опцию Диапазон кадров.

2. Выберите первый кадр диапазона и нажмите линию, которую вы хотите нарисовать.

3. Выполните одно из следующих действий:

• Выберите последний кадр диапазона, к которому вы хотите применить покраску, и нажмите на
той же строке: линия во всех кадрах в диапазоне будет автоматически окрашена в соответствии
с первой и второй позициями щелчка.

• Выберите промежуточный кадр диапазона, к которому вы хотите применить краску, и кликните
с зажатым Shift в той же строке: линия во всех кадрах в диапазоне будет автоматически по-
крашена, в соответствии с первым и вторым позиции нажатия. Выберите другой промежуточный
кадр и снова кликните с зажатой клавишей Shift: линия во всех кадрах в новом диапазоне
будет автоматически закрашена в соответствии со вторым и третьим положениями щелчка. Сде-
лайте столько раз, сколько хотите, затем нажмите в той же строке в последнем кадре диапазона,
чтобы завершить режим многокадрового рисования.

Примечание: Поскольку инструмент Заливка ( ) с параметром Диапазон кадров применяется с
линейной интерполяцией от первой до второй точки щелчка, могут возникнуть некоторые ошибки
рисования. Чем больше линия, которую вы хотите заполнить, перемещается вдоль диапазона кадра,
тем больше ошибок может быть сделано.

Совет: Чтобы нарисовать линию, используя в качестве образца ранее нарисованный ри-
сунок:

1. Активируйте режим кальки, чтобы отобразить нарисованный рисунок за текущим рисунком
(см. Использование кальки)

2. Выберите инструмент Заливки ( ), установите режим заполнения на Линии и активируйте
опцию Калька.

3. Нажмите, чтобы выбрать стиль для использования из рисунка, отображаемого в режиме кальки.

4. Выполните одно из следующих действий:

• Отпустите, чтобы нарисовать линию, где находится курсор.

• Перетащите на линию, которую хотите нарисовать, и отпустите кнопку мыши.

Совет: Чтобы извлечь стиль из рисунка:

1. Выберите инструмент Пипетка ( ).
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2. Нажмите на линию, стиль которой вы хотите выбрать. Выбранный стиль становится текущим.

13.3.1 Использование разделительных линий

Иногда бывает полезно разделить нарисованный от руки уровень анимации на несколько уровней ани-
мации, которые можно отсканировать отдельно, а затем заново собрать перед процессом рисования.
Например, вы можете нарисовать уровень анимации с некоторыми теневыми линиями, которые идеаль-
но соответствуют анимации персонажа, а затем применить их цветом, отличным от линий персонажа,
чтобы нарисовать их более легко.

В некоторых других случаях вам может понадобиться объединить два или несколько уровней анимации
в один или автоматически добавить один и тот же чертеж на все чертежи уровня анимации, например,
линию, закрывающую области рисования, которые выходят за пределы кадра, и что Аниматор оставлен
открытым.

В обоих случаях вы можете использовать функцию линий соответствия для выполнения ваших задач,
так как она позволяет объединять уровни, представленные в двух столбцах/слоях, и при необходимости
удалять объединенные линии соответствия.

Разделительные линии могут применяться только к уровням анимации Toonz Raster (TLV).

В Xsheet при объединении двух столбцов рисунки столбцов справа рассматриваются как разделитель-
ные линии, примененные к рисункам слева (на Timeline при объединении двух слоев чертежи слоев
сверху рассматриваются как примененные разделительные линии к рисункам внизу).
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В обоих случаях можно определить следующее:

• Добавить цвет разделительных линий сохраняет исходные стили линий соответствия и до-
бавляет их в палитру целевого уровня на отдельной странице с именем разделительных линий.

• Использовать цвет: позволяет вам определить, какой из стилей в палитре целевого уровня
должен использоваться для применяемых разделительных линий, заменяя любые оригинальные
стили, которыми могут быть окрашены разделительные линии.

• Слить цвета если целевой уровень имеет те же стили (т.е. с тем же индексом и цветом), что
и цвета разделительных линий, будут использоваться существующие стили. В противном случае
исходные стили разделительных линий будут сохранены и добавлены в палитру целевого уровня
на отдельной странице с именем разделительных линий.
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• Порядок переркрытия линий позволяет вам графически выбрать, какой из двух столбцов
(левый или правый) будет нарисован сверху, а также как объединить их: Держать полутон
или Заполнить Пробелы

• Распространение линий устанавливает, должны ли разделительные линии располагаться по-
зади линий целевого уровня (значение установлено на 0) или поверх них (значение установлено
на 100).

Примечание: Когда значение Распространение линий установлено равным 0, разде-
лительные линии применяются без изменения линий на уровне назначения вообще.

При применении разделительных линий любое геометрическое преобразование, достигнутое путем ре-
дактирования и перемещения соответствующего столбца/слоя или pegbar будет сохранено.

Разделительные линии связаны с рисунками уровня анимации в соответствии со следующими реко-
мендациями:

• Порядок нумерации кадров Xsheet/Timeline соблюдается. Это означает, что рисунок раздели-
тельной линии, экспонированный в кадре 1, будет применен к анимационному рисунку, экспони-
рованному в кадре 1.

• Если два разных рисунка разделительных линий связаны с одним и тем же рисунком уровня ани-
мации в разных кадрах, будет применяться только первый (в соответствии с порядком нумерации
кадров).

• Для всех рисунков, не соответствующих ни одной из разделительных линий, разделительные
линии не применяются.

• Разделительные линии, не соответствующие ни одному рисунку, будут игнорироваться.

• Если в столбце/слое, к которому должны быть применены разделительные линии, выставлено
несколько уровней анимации, будет рассматриваться только первый (в соответствии с порядком
нумерации кадров).

• Если в столбце, используемом в качестве разделительной линии, отображается несколько уровней
анимации, все они будут применены.

• Несколько разделительных линий могут быть добавлены к одному и тому же уровню анимации,
применяя их по одной за раз.

Применяемые разделительные линии могут быть удалены целиком с целевого уровня, либо можно
удалить определенные линии в соответствии с их индексами стилей.

Совет: Чтобы применить разделительные линии к уровню анимации:

1. Выставьте в столбце/слое уровень, к которому вы хотите применить линии соответствия.

2. Расположите уровни анимации разделительные линии в другом столбце таблицы Xsheet справа
от предыдущего (или, если используется Timeline, откройте уровни анимации разделительные
линии в другом слое выше предыдущего).

3. Перемещайте, масштабируйте, поворачивайте рисунки разделительных линий, если это необхо-
димо.

4. Выделите два столбца, кликая с зажатой Shift или перетаскивая их заголовки.

5. Выберите пункт меню Xsheet → Применить разделительные линии. . .

6. В открывшемся диалоговом окне выберите стили, которые будут использоваться для раздели-
тельных линий и распространенности линий, и нажмите кнопку Применить.
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Совет: Чтобы удалить все примененные разделительные линии:

1. Выберите столбцы/слои, ячейки или кадры Level Strip, где находится уровень анимации с при-
мененными разделительными линиями.

2. Выберите пункт меню Xsheet → Удалить разделительные линии.

Совет: Чтобы удалить линии выбрав индекс стиля:

1. Выберите столбцы/слои, ячейки или кадры Level Strip, где находится уровень анимации, линии
которого вы хотите удалить.

2. Выберите Xsheet → Удалить линии. . .

3. В открывшемся диалоговом окне выберите индексы стилей, используемых для линий, которые
вы хотите удалить, и кадры, к которым вы хотите применить удаление.

4. Нажмите кнопку Удалить.

Примечание: Чтобы указать несколько индексов или кадров, значения должны быть разделены
запятой; чтобы определить диапазон значений, вы можете ввести первое и последнее, разделенные
тире (например, 4-7 относятся к значениям 4, 5, 6 и 7).

13.3.2 Использование опции Автозаливка линий

Уровни Toonz Raster могут включать в себя цветные линии, поступающие из сеанса очистки цвета
или из некоторых примененных уровней разделительных линий (подробности см. в разделе Обработка
цветных рисунков линейных линий и Использование разделительных линий).

В большинстве случаев эти цветные линии предназначены для установки контура тени тела или под-
светки тела, и по этой причине обычно они должны быть окрашены в тот же цвет тени или областей
подсветки, которые они помогают определить.

Эту задачу можно выполнить автоматически, установив специальное свойство для цвета, чтобы при
рисовании области, определенной полностью или частично линией, цвет которой имеет это свойство,
линия автоматически закрашивается тем же цветом, который вы используете для этой области.

Совет: Чтобы установить свойство автозаливки для цвета:

1. Выберите цвет в палитре.

2. В редакторе стилей выберите страницу настроек и активируйте опцию Автозаливка линий.

Совет: Чтобы автоматически закрашивать линии при рисовании областей:

Нарисуйте область, определенную полностью или частично линией, цвет которой включает опцию
Автозаливка линий: линия автоматически закрашивается тем же цветом, который вы используете
для этой области.
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13.4 Использование цветовой модели

Цветовые модели, обычно создаваемые для точной цветовой привязки во время производства, в виде
изображений или уровней анимации, могут использоваться при рисовании уровней анимации.

Любое изображение или уровень анимации можно использовать в качестве образца, загрузив его во
окно просмотра цветовой модели. Если загружен уровень анимации, вы можете в любой момент вы-
брать любой кадр в качестве образца; таким образом, вы также можете создавать цветовые модели из
нескольких рисунков, например, один рисунок для вида персонажа спереди и один для вида сзади.

Когда цветовая модель загружается для текущего уровня, вы можете решить загрузить ее палитру,
перезаписав, таким образом, палитру текущего уровня или сохранить текущую палитру уровней ани-
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мации.

Если цветовая модель имеет уровень Toonz Raster или Vector (файл TLV или PLI), она уже поставля-
ется с палитрой, чьи имена стилей и конфигурация страницы будут сохранены.

Если цветовая модель представляет собой полноцветное растровое изображение или уровень анимации,
палитра автоматически создается путем извлечения цветов из изображения или первого изображения
уровня. Если полноцветное изображение содержит много затененных цветов, палитра будет оптими-
зирована для уменьшения количества цветов.

Примечание: Наилучших результатов можно достичь, подготовив модели, окрашенные в плоские
цвета, в линиях которых нет сглаживания.

Когда цветовая модель загружается для определенного уровня анимации, она ассоциируется с этим
уровнем и соответствующей палитрой и отображается в окне просмотра цветовой модели при каждом
выборе этого уровня.

Цветовая модель может быть связана с палитрами, хранящимися в палитре Studio. Таким образом,
каждый раз, когда вы назначаете палитру для уровня анимации, извлекая ее из палитры Studio,
связанная с ней цветовая модель будет автоматически ассоциироваться с уровнем (подробности см.
в разделе Использование палитры Studio).

Вы также можете использовать любой рисунок, принадлежащий к уровню анимации, в качестве цве-
товой модели, которая будет использоваться на лету, но в этом случае он не будет связан ни с уровнем,
ни с палитрой, сохраненной в палитре Studio.

Когда изображение отображается в средстве просмотра Цветовой модели, вы можете использовать
его не только в качестве визуальной справки, но и для выбора стилей без необходимости использо-

вать инструмент Палитру или Пипетка ( ). Цветовая модель также может быть панорамирована и
увеличена или уменьшена с помощью стандартных сочетаний клавиш.

Совет: Чтобы загрузить цветовую модель:

1. Выполните одно из следующих действий:

• Выберите пункт меню Файл → Загрузить цветовую модель. . . и загрузите уровень Toonz
или полноцветное растровое изображение, которое вы хотите использовать в качестве образца.

• Right-click in the Color Model viewer and choose Load Color Model. . . from the menu that opens.

• Перетащите уровень Toonz или полноцветное растровое изображение, которое вы хотите исполь-
зовать в качестве образца на окно просмотра Цветовой модели.

2. Выберите, следует ли перезаписать текущую палитру с помощью палитры Цветовой модели или
оставить текущую палитру уровня анимации.

Примечание: Если вы решите сохранить текущую палитру уровней анимации, палитра
текущего уровня будет применена и к цветовой модели.

Совет: Чтобы выбрать кадр из уровня загруженной цветовой модели:

Выполните одно из следующих действий:

• Используйте кнопки воспроизведения.
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• Переместите ползунок полосы кадров.

• Введите в поле панели кадров номер кадра, который вы хотите просмотреть.

Совет: Чтобы выбрать стили из цветовой модели:

Нажмите на область или линию, стиль которой вы хотите выбрать, независимо от того, какой у вас
текущий инструмент.

Примечание: Если вы используете растровое изображение в качестве образца и решили сохранить
текущую палитру уровней анимации, при нажатии на область или линию будет выбран ближайший
стиль, доступный в палитре.

Совет: Для навигации в окне просмотра цветовой модели:

Выполните одно из следующих действий:

• Используйте горячие клавиши масштабирования (по умолчанию клавиши + и -), чтобы увели-
чивать и уменьшать масштаб с определенным шагом (например, 50%, 100%, 200% и т.д.).

• Используйте колесико мыши для увеличения и уменьшения масштаба.

• Используйте горячую клавишу Вид по умолчанию (по умолчанию клавиша 0) или щелкните
правой кнопкой мыши в окне просмотра и выберите Вид по умолчанию в открывшемся меню,
чтобы отобразить содержание Flipbook в его реальном размере с центром в центре изображения.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

Совет: Чтобы создать цветовую модель из оригинального рисунка:

1. Отсканируйте и очищайте или нарисуйте вашу цветовую модель.

2. Создайте требуемые стили в палитре и нарисуйте изображение.

3. Сохраните изображение и загрузите его в качестве цветовой модели всякий раз, когда это необ-
ходимо.

Совет: Чтобы использовать рисунок из текущего уровня анимации в качестве модели:

1. Выберите рисунок, который вы хотите использовать в качестве образца для текущего уровня
анимации.

2. Щелкните правой кнопкой мыши в окне просмотра Цветовой модели и выберите Использовать
текущий кадр в открывшемся меню.

Совет: Чтобы сохранить цветовую модель вместе с палитрой в Studio Palette:

1. Загрузите цветовую модель, чтобы связать ее с палитрой текущего уровня.

2. Сохраните палитру уровня в палитре Studio (подробности см. в разделе Использование Studio
Palette).
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Совет: Чтобы связать цветовую модель с палитрой, уже сохраненной в Studio Palette:

1. В палитре Studio выберите палитру, с которой вы хотите связать цветовую модель, и выполните
одно из следующих действий:

• Выберите пункт меню Файл → Загрузить цветовую модель. . . .

• Щелкните правой кнопкой мыши палитру в дереве Studio Palette и выберите Загрузить цвето-
вую модель. . . в открывшемся меню (подробности см. в разделе Использование Studio Palette).

2. Получите цветовую модель из открывшегося браузера.

Примечание: Если цветовая модель использует палитру, отличную от той, которая хранится в па-
литре Studio, вам будет предложено сохранить ее или перезаписать.

Совет: Чтобы получить цветовую модель, сохраненную в Studio Palette:

Загрузите палитру, с которой она связана, из палитры Studio в качестве палитры текущего уровня
(подробности см. в разделе Использование палитры Studio).

Совет: Чтобы удалить связь палитры с цветовой моделью:

Щелкните правой кнопкой мыши в окне просмотра Цветовой модели и выберите Удалить цветовую
модель в открывшемся меню.
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Глава 14

Работа в Xsheet/Timeline

Xsheet, цифровая версия традиционного экспозиционного листа, позволяет вам контролировать син-
хронизацию всех элементов сцены. Он организован в столбцы и строки: каждый столбец содержит
слой анимации, а каждая строка представляет содержимое кадра. Столбцы делятся на ячейки, пред-
ставляющие содержимое этого столбца в определенном кадре.

Timeline является горизонтальной копией таблицы Xsheet, она служит той же цели и имеет те же функ-
ции. Основные различия с таблицей Xsheet заключаются в том, что на временной шкале различные
уровни расположены в горизонтальных слоях, а содержимое каждого кадра представлено столбцами
Timeline.

В обоих из них в сцену можно загружать различные элементы, обычно называемые здесь уровнями:
уровни анимации, изображения для фона и наложений, а также видеоклипы.

Также можно загрузить другие сцены OpenToonz: они будут вложены в столбец/слой и будут рассмат-
риваться как SubXsheet текущего Xsheet/Timeline.

Все содержимое Xsheet/Timeline можно проверить в окне просмотра, где можно воспроизводить ани-
мацию и редактировать содержимое сцены.

14.1 Использование Окна просмотра

Окно просмотра имеет различные режимы визуализации содержимого сцены. В соответствии с ваши-
ми потребностями вы можете просматривать всю рабочую область, только элементы, включенные в
текущий снимок с камеры, или визуализировать всю сцену в трехмерной среде. Окно просмотра так-
же можно заморозить, чтобы визуализация не обновлялась до тех пор, пока вы не введете указатель
в окне просмотра. Когда режим предварительного просмотра активирован, окно просмотра может
отобразить визуализированную анимацию, как в финальном рендере (см. Предварительный просмотр
анимации).

В нижней части окна просмотра доступен другой настраиваемый набор кнопок. Некоторые из них ис-
пользуются для воспроизведения (см. Использование окна просмотра), некоторые другие актуальны
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Рис. 1: Стандартный вид с камеры, 3D-просмотр и Вид с камеры.

только при использовании Инструмента Анимирования ( ) для анимации объектов и при предвари-
тельном просмотре анимации в окне просмотра (см. Анимация объектов и Предварительный просмотр
анимации).

Дополнительные элементы, такие как направляющая сетка или стол, могут быть отображены или
скрыты, а также может быть установлен цвет фона (см. Настройка окна просмотра).

Совет: Чтобы переключить режим просмотра в окне просмотра:

Используйте кнопки, доступные в строке заголовка средства просмотра, чтобы сделать следующее:

• Кнопка Стандартный вид с камеры ( ) предназначена для стандартного просмотра, где
может отображаться любая часть рабочей области. При воспроизведении сцены рабочая область
останавливается, в то время как все остальные элементы, включая камеру, перемещаются отно-
сительно ее положения.

• Кнопка 3D-просмотр ( ) предназначена для активации или деактивации 3D-вида элементов,
составляющих сцену (см. Работа в 3D-среде).

• Кнопка Вид с камеры ( ) предназначена для удержания рамки, представляющей камеру, в то
время как все остальные элементы перемещаются относительно ее положения. Это может помочь
вам лучше понять снимок, когда есть смены кадр или повороты.

Примечание: Когда в Level Strip выбран кадр, режим просмотра устанавливается соответственно
для отображения только этого уровня. Нажатие одной из этих кнопок вернет окно просмотра обратно
к отображению всего содержимого сцены.

Совет: Чтобы заморозить/разморозить окно просмотра:

Нажмите кнопку Заморозить ( ) в строке заголовка окна просмотра, чтобы заморозить/разморозить
отображаемый контент; при активации слово FROZEN отображается в центре рабочей области.

Совет: Чтобы обновить содержимое окна просмотра, когда оно заморожено:

Наведите курсор на окно просмотра.
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14.2 Использование браузера файлов

Все элементы, необходимые для сцены, можно получить с помощью браузера файлов.

Вы можете использовать стандартный браузер файлов OpenToonz для перетаскивания уровней или
папок в окно Xsheet/Timeline или Состав сцены, или использовать команды Загрузить уровень. . . и
Загрузить папку. . . из меню Файл. В обоих случаях вы можете выполнить множественный выбор для
загрузки нескольких уровней или папок одновременно, каждый из которых будет отображаться в от-
дельном столбце; если вы используете команду Загрузить уровень. . . при загрузке уровня анимации вы
также можете указать диапазон кадров для загрузки. При использовании команды Загрузить папку. . .
все файлы, содержащиеся в папке (если они поддерживаются) загружаются в Xsheet/Timeline.

Примечание: When a level is loaded, OpenToonz checks if its syntax matches one of the level formats
specified into Preferences. . . → Loading → Level Settings by File Format. In this case the Level Settings
specified will be applied. It is possible to add as many formats as you want, defining them by using a Regular
Expression. This way, different settings can be automatically applied to different kind of levels.

Примечание: It is possible to Ignore Alpha Channel on Levels in Column 1 by activating the
option in Preferences. . . → Xsheet dialog section.

В доступном слева дереве файлов есть следующие основные элементы:

• My Computer содержит файлы и папки, расположенные на вашем компьютере.

• Network разрешает доступ к сетевым компьютерам.
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• My Documents содержит файлы и папки, расположенные в папке ОС My Documents.

• Library отображает файлы и папки, расположенные в папке Projectroot\library (см. Настрой-
ка Projectroot).

• History содержит недавно сохраненные сцены, сгруппированные в папки, по одной на каждый
из последних семи дней использования OpenToonz.

• Projectroot перечисляет все проекты, которые были созданы как папки, содержащие инфор-
мацию о проекте и материал; фактический путь к корню проекта отображается в скобках (см.
Использование браузера проектов).

Примечание: В случае, если определено более одного projectroot, каждый из них будет отоб-
ражаться со связанным путем projectroot в скобках (см. Настройка Projectroot).

• Version control папка репозитория, помеченная в соответствии с конфигурацией контроля вер-
сий, содержит папки и файлы в системе контроля версий (см. Использование контроля версий).

Примечание: Если определено несколько репозиториев, каждое из них будет отображаться с
соответствующей меткой (см. Настройка контроля версий в OpenToonz ).

Вы можете открывать папки и подпапки для получения файлов, которые отображаются в области
справа. Текущий путь к местоположению отображается в верхней части браузера; существующие папки
можно переименовывать и создавать новые папки. Файлы могут отображаться в виде значков или в
виде списка, отображая дополнительную информацию, которая также может быть использована для
их сортировки.

Примечание: The way file icons are generated in the OpenToonz browser depends on the images resolution
and on the Level Strip Thumbnail Size option set for the Level Strip frames in the Preferences. . . →
Interface dialog section (see Using the Level Strip ).

14.2.1 Загрузка уровней

В качестве части сцены вы можете загрузить уровни анимации Toonz Vector и Toonz Raster (PLI и TLV),
палитры Toonz (TPL), полноцветные растровые изображения или последовательности изображений
(BMP, JPG, NOL, PNG, RGB, SGI, TGA, TIF и TIFF), видеоклипы (AVI, MOV, MP4 и WebM с
помощью FFMPEG, если установлен), документы Photoshop (PSD), векторные изображения (SVG)
и аудиофайлы (AIFF, WAV и MP3 с помощью FFMPEG, если установлен). Изображения или клипы с
информацией альфа-канала сохранят свою прозрачность после импорта.

Примечание: Также можно загружать устаревшие файлы TZU и TZP, созданные с Toonz версии
4.x: в этом случае файлы будут автоматически преобразованы и загружены в формате TLV.

Примечание: SVG файлы автоматически конвертируются и загружаются в формате PLI.

Примечание: Файлы Photoshop можно загружать с учетом слоев, из которых сделан документ (см.
Загрузка документов Photoshop).
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Файлы с одним изображением могут содержать цифры и буквы как часть своих имен, но они долж-
ны соответствовать определенным правилам, чтобы считаться действительными. Ниже приведено
несколько описательных примеров действительных и недействительных имен файлов изображений:

• Допустимые типы имен: a1.tga, 1a1.tga, 1aa.tga, 1aaa.tga

• Недопустимые типы имен: 1.tga, 111.tga, 1a.tga, 111a.tga

Последовательности изображений распознаются и загружаются браузером файлов OpenToonz как
один уровень анимации, если они названы с прогрессивным четырехзначным числом, записанным меж-
ду базовым именем файла и расширением файла, например. animation.0001.tif, animation.0002.
tif, etc. или animation_0001.tif, animation_0002.tif, etc.. Они отображаются в браузере файлов
с двойной точкой или подчеркиванием и точкой перед расширением файла: например, animation..
tif или animation_.tif

Из браузера вы можете Вид изображения и клипы, которые вы собираетесь загрузить как уровни,
открыв flipbook, коэффициент сжатия по умолчанию которого можно задать в окне Настроек про-
граммы, и просмотреть информацию о соответствующем файле, открыв Инфо (см. Использование
Flipbook).

Сцены OpenToonz (файлы TNZ) также могут быть загружены как часть другой сцены, в таком случае
они загружаются как Sub-Xsheet(см. Загрузка сцены в виде Sub-Xsheet).

When you load levels using the standard OpenToonz file browser, you can set whether to automatically
expose them in the Xsheet/Timeline or not, by setting the Expose Loaded Levels in Xsheet option in
the Preferences. . . → Loading dialog section. If activated, each level will be placed in a different column/layer,
starting from the first empty one. If deactivated, the loaded levels will be stored in the Scene Cast, from
where they can be selectively exposed in Xsheet columns or Timeline layers (see Using the Scene Cast ).

Если вы загружаете один или несколько файлов, расположенных за пределами папок текущего проекта
по умолчанию, вам будет предложено Импорт их в базу данных проекта или Загрузить их откуда
они находятся. В первом случае файлы будут скопированы в соответствующую папку проекта (уровни
PLI, TLV и их палитры в папке + drawing ; растровые изображения, видеоклипы и аудиофайлы в
папке + extras; автономные палитры в +palettes папку и т.д.) и загружается с относительным путем из
этого нового местоположения (см. Управление проектами); в последнем случае они будут загружены
с использованием абсолютного пути к их исходному местоположению.

Если какой-либо из файлов, которые вы хотите импортировать, имеет то же имя, что и файл, уже
существующий в целевой папке проекта, вам будет предложено сохранить существующий файл, пе-
резаписать его новым или переименовать, добавив суффикс, который вы можете выберите. Таким
образом, вы можете контролировать, если импортируемые вами файлы уже были импортированы ра-
нее, или управлять файлами с одинаковыми именами.

Примечание: ВНИМАНИЕ: Настоятельно рекомендуется Импорт ресурсы в папки текущего про-
екта, поскольку OpenToonz может перезаписывать файлы, связанные с уровнями, представленными в
Xsheet/Timeline, каждый раз, когда были вызваны команды Сохранить Уровень, Сохранить все
уровни или Сохранить все.

Примечание: Файлы, загруженные в сцену без импорта, могут быть импортированы позже сразу с
помощью команды Сбор активов (см. Сбор активов).

Примечание: Браузер файлов OpenToonz отображает только релевантные файлы, которые можно
загрузить в OpenToonz. Для проверки полного содержимого папки вы можете использовать параметр
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Показать содержимое папки (см. ниже).

Совет: Чтобы выбрать режим отображения браузера:

Выполните одно из следующих действий:

• Нажмите кнопку Значок ( ) в нижней панели браузера, чтобы отобразить файлы со связанными
значками.

• Click the List button ( ) in the bottom bar of the browser to display files in a list with related s;
click the labels at the top of the columns to sort files accordingly; right-click the label at the top of the
columns to open the menu that allows to toggle the visualization of the columns.

Совет: Чтобы изменить размеры разделов браузера:

Выполните любое из следующих действий:

• Нажмите и перетащите разделитель, чтобы изменить размеры разделов.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть раздел.

• Щелкните и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить скрытый раздел.

Совет: Чтобы переименовать существующую папку:

Дважды щелкните имя папки и переименуйте ее.

Совет: Чтобы создать новую папку:

Нажмите кнопку Новая папка ( ) в нижней панели браузера.

Совет: Чтобы переместить одну папку вверх в дереве файлов:

Нажмите кнопку Открыть родительскую папку( ) в нижней панели браузера.

Совет: Чтобы загрузить уровни из диалогового окна Загрузить уровень:

1. Выберите ячейку Xsheet/Timeline, с которой вы хотите начать выставлять уровень; если какой-
либо уровень уже выставлен в этой ячейке, будет вставлен новый столбец/слой, чтобы открыть
новый уровень.

2. Выполните одно из следующих действий:

• Choose Level → Load Level. . .

• Right-click in the Xsheet/Timeline cell and choose Load Level. . . from the menu that opens.

3. В открывшемся окне выберите файл, который вы хотите загрузить в качестве уровня; если вы
выберете файл последовательности изображений или видео, вы можете выбрать диапазон кадров,
который хотите загрузить, используя параметры Загрузить субсеквенционный уровень.
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4. Нажмите кнопку Загрузить.

Совет: Чтобы загрузить уровни из стандартного браузера OpenToonz:

1. Выберите ячейку Xsheet/Timeline, с которой вы хотите начать выставлять уровень; если какой-
либо уровень уже выставлен в этой ячейке, будет вставлен новый столбец/слой, чтобы открыть
новый уровень.

2. В браузере OpenToonz выберите файл, который вы хотите загрузить в качестве уровня.

3. Выполните одно из следующих действий:

• Перетащите выделенную область на окно Состав сцены или в Окно просмотра.

• Перетащите выделение в ячейку Xsheet / Timeline, где вы хотите начать ее показывать.

• Right-click the selection and choose Load from the menu that opens.

Примечание: Файлы также можно загружать, перетаскивая их из Проводника Windows или Finder
macOS в Состав сцены, Xsheet/Timeline или Окно просмотра.

Совет: Для загрузки папок:

1. Выберите ячейку Xsheet/Timeline, с которой вы хотите начать выставлять уровни; если какой-
либо уровень уже открыт в этой ячейке, будет вставлен новый столбец/слой, чтобы отобразить
новые уровни.

2. Use the File → Load Folder. . . command.

3. В открывшемся браузере файлов выберите папку, которую вы хотите загрузить.

4. Press the OK button.

Примечание: Папки также могут быть загружены путем перетаскивания их из Проводника Windows
или macOS Finder в приведение сцены, Xsheet / Timeline или Viewer.

Примечание: Когда уровень загружен, OpenToonz проверяет, соответствует ли его синтаксис одно-
му из форматов уровней, указанных в Настройках программы → Загрузка → Настройки уровня
по формату файла. В этом случае будут применены настройки уровня, указанные при открытии
соответствующей кнопки Правка. Можно добавить столько форматов файлов, сколько вы хотите,
определяя их с помощью регулярного выражения. Таким образом, различные настройки могут авто-
матически применяться к разным видам уровней.

Совет: Чтобы загрузить недавно загруженный уровень:

Choose Level → Open Recent Level File, then select the level you want to load from the available
submenu.

Совет: Чтобы выделить несколько файлов в браузере:
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Выполните одно из следующих действий:

• Нажмите, чтобы выбрать файл.

• Кликните с зажатой клавишей Ctrl (PC) или Cmd (Mac), чтобы добавить или удалить файл из
выделения.

• Кликните с зажатой клавишей Shift чтобы расширить выделение.

• Right-click in the right area of the browser and choose Select All from the menu that opens to select
all the files contained in the current folder.

Совет: Для просмотра уровня в Flipbook:

Выполните одно из следующих действий:

• In the OpenToonz browser or in the Xsheet/Timeline right-click the level you want to view
and choose View from the menu that opens.

• Choose Windows → Flipbook and drag and drop in the window the file you want to view.

Примечание: Открыв несколько окон Flipbook, вы можете просматривать несколько уровней одно-
временно.

Совет: To set the default shrink factor and step for the file Viewer:

1. Choose File → Preferences. . . → Interface.

2. Установите значения по умолчанию Viewer Shrink и Шаг.

Совет: Для просмотра информации о файле уровня:

В браузере файлов OpenToonz или на Xsheet/Timeline щелкните правой кнопкой мыши по уровню,
информацию которого вы хотите просмотреть, и выберите Инфо в открывшемся меню; если файл
представляет собой видео или последовательность изображений, используйте ползунок в нижней части
поля, чтобы изменить текущий кадр и просмотреть соответствующую информацию.

Совет: Чтобы просмотреть все содержимое текущей папки:

Щелкните правой кнопкой мыши в правой части браузера и выберите Показать содержимое папки
в открывшемся меню: все содержимое папки отображается в окне операционной системы по умолча-
нию.

14.2.2 Загрузка документов Photoshop

Документы Photoshop (PSD-файлы) можно загружать в OpenToonz в качестве элемента сцены с учетом
слоев, из которых сделан документ, и их порядка наложения; текстовые слои рассматриваются как
стандартные слои, а стили слоев рассматриваются только при загрузке документа как отдельного
изображения (см. ниже).

228 Глава 14. Работа в Xsheet/Timeline



OpenToonz Documentation, Выпуск 1.7.1

Поддерживаемые форматы - изображения RGB или оттенки серого, использующие глубину цвета 8
или 16 бит на канал.

Когда документ Photoshop загружен, открывается диалоговое окно, чтобы установить способ отобра-
жения документа в Xsheet. Варианты следующие:

• Еденичное изображение, объединяет все слои документа в одно изображение. Учитываются
только слои, которые были видны при сохранении документа Photoshop. Имя уровня и путь в
настройках уровня и приведение сцены относятся к исходному имени документа Photoshop (см.
Редактирование настроек уровня и Использование Состава сцены).

Примечание: Документы Photoshop можно загружать как одно изображение, только если при
сохранении исходного файла из Photoshop был выбран параметр Максимизировать совмести-
мость. Если опция была отключена вместо нее отображается фиктивное изображение; загрузка
и сохранение документа с включенной опцией решает проблему.

• Кадры загружает каждый слой документа в виде кадра и представляет их в виде последователь-
ности в столбце Xsheet. Любая группа слоев, определенная в исходном документе, игнорируется.
Имя уровня и путь в Настройках уровня и Составе сцены ссылаются на исходное имя документа
Photoshop с суффиксом #frames (см. Редактирование настроек уровня и Использование Cостава
сцены).

• Столбцы, загружает каждый слой документа в виде столбца, и можно автоматически создать
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Sub-Xsheet, содержащий столбцы, включив опцию Экспонировать в Sub-xsheet.

Когда документ Photoshop загружен в виде столбцов, также можно указать, как будут назначаться
новые имена уровней. Варианты следующие:

• ИмяФайла#ИмяСлоя, использует имя файла PSD и имена слоев в качестве имен вновь созда-
ваемых уровней.

• ИмяСлоя использует имена слоев PSD в качестве имен вновь создаваемых уровней.

Когда документ Photoshop загружен в виде столбцов, также можно задать способ, которым следует
учитывать группы слоев. Варианты следующие:

• Игнорировать группы, пропускает любую группу слоев, определенных в документе, и каждый
слой отображается в отдельном столбце. Имя уровня и путь в настройках уровня и приведение
сцены для каждого уровня относятся к исходному имени документа Photoshop с суффиксом
#ИмяСлоя (см. Редактирование настроек уровня и Использование Состава сцены).

• Выставлять слои в группе в виде столбцов в sub-xsheet для каждой группы создаст Sub-
Xsheet, содержащий каждый слой группы в виде столбца. Если группа содержит другие группы,
Sub-Xsheet будет содержать другие Sub-Xsheet, которые будут содержать связанные слои в виде
столбцов. Имя уровня и путь в настройках уровня и cостав сцены для каждого уровня относятся
к исходному имени документа Photoshop с суффиксом #layerID (см. Редактирование настроек
уровня и Использование Состава сцены).

• Выставлять слои в группе в виде кадров в столбце создает для каждой группы столбец,
содержащий каждый слой группы в качестве ячейки. Если группа содержит другие группы,
они будут игнорироваться. Имя уровня и путь в настройках уровня и состав сцены для каждого
уровня относятся к исходному имени документа Photoshop с суффиксом группы #groupID#group
(см. Редактирование настроек уровня и Использование Состава сцены).

Примечание: Для правильного отображения при финальном рендере изображения, основанные на
слоях документов Photoshop, необходимо предварительно умножить, используя параметр Умножение
в диалоговом окне Настройки уровня, или эффект Premultiply (см. Редактирование настроек уровня
и Premultiply).

14.2.3 Выполнение задач в браузере файлов

Некоторые задачи, касающиеся файлов, могут быть выполнены непосредственно в браузере файлов.

Files can be duplicated, converted to a different format, converted to TLV (Toonz Raster image) format,
renamed, premultiplied, and you can choose to separate their colors.

При дублировании файлов новые файлы будут переименованы путем добавления подчеркивания с
последующей последовательной нумерацией.

Вы также можете разделить цвета изображения или последовательности изображений с помощью
команды Разделить цвета. . . . Для получения более подробной информации о его параметрах, по-
жалуйста, обратитесь к разделу Разделение цветов.

При переименовании файлы будут переименованы в соответствии с указанным вами именем; опция
также позволяет вам удалить исходные файлы. Это можно использовать как для переименования
последовательностей файлов изображений в одном снимке, так и для преобразования режимов ну-
мерации последовательностей в стандартный режим OpenToonz (т.е. возрастающее четырехзначное
число, записанное между именем файла и расширением файла) путем выбора только первого файла
последовательности.
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При предварительном умножении альфа-канал файла изменяется для правильного отображения в
OpenToonz. Изображения с осмысленным альфа-каналом бывают двух типов: предварительно умно-
женные или прямые. Не предварительно умноженное (прямое) изображение может быть распознано,
когда оно загружено в OpenToonz, потому что его края, где есть полная прозрачность на одной стороне
и непрозрачность на другой, не являются гладкими, но дисплеи показывают сплошной ореол; предва-
рительно умножив изображение, можно решить эту проблему. Это доступно только для полноцветных
изображений.

При преобразовании файлов диалоговое окно запрашивает диапазон кадров для преобразования, место
сохранения, имя, новый формат со связанными параметрами и цвет фона для преобразованного файла.
Также возможно выбрать больше файлов одновременно, но в этом случае диапазон кадра и поля имени
файла не будут доступны. Все уровни, изображения и клипы, поддерживаемые OpenToonz, могут быть
конвертированы. Векторные файлы PLI также можно преобразовать в формат SVG.

Примечание: Команда Конвертировать. . . также доступна в меню Файл как Конвертировать
файл. . . .

При преобразовании файлов в формат TLV можно выбрать покрашенные или неокрашенные форматы
TLV; все уровни, изображения и клипы, поддерживаемые OpenToonz, могут быть конвертированы,
кроме файлов PSD.

Преобразование в неокрашенный формат TLV доступно, когда выбран один или несколько файлов, и
оно предназначено для лайнарт изображений: изображения и уровни преобразуются в черные лайнарт
изображения с прозрачным фоном, чтобы их можно было рисовать с помощью тех же методов и ин-
струментов. Вы можете использовать другие уровни Toonz Raster (см. Уровни рисования анимации).
В частности, если изображения имеют некоторую прозрачность, прозрачные пиксели остаются про-
зрачными, а сплошные пиксели преобразуются в черные; если изображения не имеют прозрачности,
белые и светлые пиксели будут считаться прозрачными, а темные пиксели преобразуются в черные.

Преобразование в окрашенный формат TLV доступно, когда выбраны два файла или когда выбранные
файлы имеют Raster Full color без сглаживания. В случае двух файлов один из них - лайнарт, а другой
- покрашенная версия одного и того же изображения: изображения и уровни преобразуются в окра-
шенные лайнарт изображения с помощью палитры, чтобы их можно было редактировать с помощью
тех же методов и инструментов, которые вы можете использовать для других уровней Toonz Raster
(см. Управление палитрами и стилями и Покраска уровней анимации). В случае преобразования из
Raster Full color без сглаживания, эвристика используется для распознавания линий и окрашенных
областей, создавая уровень TLV, где линии видны как чернила, а окрашенные области - как краска.

В частности, если изображения имеют некоторую прозрачность, прозрачные пикселы остаются про-
зрачными, а сплошные пикселы преобразуются в линии в соответствии с их цветом; если изображения
не имеют прозрачности, белые и светлые пикселы будут считаться прозрачными, а темные пикселы
преобразуются в черные линии.

Примечание: При преобразовании в формат TLV поддерживаются режимы нумерации последова-
тельностей, отличные от стандартного OpenToonz (т.е. возрастающее четырехзначное число, записы-
ваемое между именем файла и расширением файла), так что только первый файл последовательность
должна быть выбрана, чтобы включить всю последовательность в преобразование.

Совет: Чтобы продублировать файлы:

1. Выберите файлы, которые вы хотите дублировать.

2. Щелкните правой кнопкой мыши любой из выбранных файлов и выберите Дублировать в от-
крывшемся меню.
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Совет: Чтобы переименовать файлы:

1. Выберите файлы, которые вы хотите переименовать.

2. Щелкните правой кнопкой мыши любой из выбранных файлов и выберите Переименовать в
открывшемся меню.

3. В открывшемся диалоговом окне присвойте файлу новое имя и выберите, следует ли Удалить
исходные файлы, активировав соответствующий параметр.

4. Нажмите кнопку Переименовать.

Совет: Чтобы умножить полноцветные изображения:

1. Выберите файлы, которые вы хотите умножить.

2. Right-click any of the selected files and choose Premultiply from the menu that opens.

Совет: Чтобы конвертировать файл в другой формат:

1. Right-click the file you want to convert and choose Convert. . . from the menu that opens. The Convert
window change depending on the format of the selected files.
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2. Выберите диапазон кадров для преобразования, место сохранения, имя, новый формат и цвет
фона преобразованного файла.

3. Activate the Skip Existing Files to to prevent overwriting already exixting files.

4. If needed, set the options for the file format chosen pressing the Options button and inserting the new
values.

5. Click the Convert button.

Совет: Чтобы конвертировать несколько файлов одновременно в другой формат:

1. Выберите файлы, которые вы хотите конвертировать.

2. Right-click any of the selected files and choose Convert. . . from the menu that opens.

3. Проверьте количество файлов, которые вы собираетесь преобразовать, читая значение из заго-
ловка окна конвертации.
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4. Выберите место сохранения, новый формат и цвет фона преобразованных файлов.

5. Activate the Skip Existing Files to to prevent overwriting already exixting files.

6. При необходимости установите параметры для выбранного формата файла, нажав кнопку Опции
и вставив новые значения.

7. Click the Convert button.

Совет: Для преобразования файлов в неокрашенный формат TLV:

1. Выберите лайнарт файлы, которые вы хотите конвертировать.

2. Right-click any of the selected files and choose Convert from the menu that opens.

3. Select Unpainted tlv from the Mode drop down menu.

4. Выберите место сохранения и, если вы выбрали одну последовательность, диапазон кадров.

5. Activate the Skip Existing Files to to prevent overwriting already existing files.

6. Activate the Apply Autoclose.

7. Choose how to manage Antialiasing fom the drop down menu. You can preserve the original antialiasing
selecting Keep Original Antialiasing; add some antialiasing selecting Add Antialiasing with
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Intensity: and writing an intensity value in the righthand input field; remove the antialiasing selecting
the Remove Antialiasing using Threshold: option and writing a threshold value in the righthand
input field.

8. Choose how to manage the Palette of the TLV file(s) you are going to create. By default a new palette
will be created. If you prefer to use an existing palette press the button next the palette field and use
the Browser to locate the palette file (TPL) you wish to use. Set a Tolerance value for the correlation
between the RGB value of the areas and the indexes color of the palette.

9. Click the Convert button.

Совет: Преобразование файлов в окрашенный формат TLV из двух изображений:

1. Выберите файл lineart и покрашенную версию того же файла, который вы хотите преобразовать.

2. Right-click any of the selected files and choose Convert. . . from the menu that opens.

3. Select Painted tlv from two images from the Mode drop down menu.

4. Выберите место сохранения и, если вы выбрали одну последовательность, диапазон кадров.

5. Activate the Skip Existing Files to to prevent overwriting already existing files.

6. Выберите папку, в которой находятся неокрашенные файлы.
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7. Specify the Unpainted File Suffix used for naming the unpainted version of the files (default is _np,
but you can use anything you like when preparing the files for convertion).

8. Activate the Apply Autoclose.

9. Choose how to manage Antialiasing fom the drop down menu. You can preserve the original antialiasing
selecting Keep Original Antialiasing; add some antialiasing selecting Add Antialiasing with
Intensity: and writing an intensity value in the righthand input field; remove the antialiasing selecting
the Remove Antialiasing using Threshold: option and writing a threshold value in the righthand
input field.

10. Choose how to manage the Palette of the TLV file(s) you are going to create. By default a new palette
will be created. If you prefer to use an existing palette press the button next the palette field and use
the Browser to locate the palette file (TPL) you wish to use. Set a Tolerance value for the correlation
between the RGB value of the areas and the indexes color of the palette.

11. Click the Convert button.

Совет: Чтобы преобразовать файлы в покрашенный формат TLV из источника без сгла-
живания:

1. Select the raster full color file you want to convert.
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2. Выберите место сохранения и, если вы выбрали одну последовательность, диапазон кадров.

3. Activate the Skip Existing Files to to prevent overwriting already existing files.

4. Выберите выходную папку.

5. Activate the Apply Autoclose if needed.

6. Choose how to manage the Palette of the TLV file(s) you are going to create. By default a new palette
will be created. If you prefer to use an existing palette press the button next the palette field and use
the Browser to locate the palette file (TPL) you wish to use.

7. Click the Convert button.

Разделение цветов

Функция Разделить цвета позволяет разделять отдельные рисунки по цвету карандашей, генери-
руя независимые файлы изображений, чтобы упростить их использование в последующем процессе
компоновки.

В отличие от обычных основанных на пороге алгоритмов, эта функция может давать более естествен-
ные результаты, поскольку она разделяет пиксели более гибким способом, используя цветовое про-
странство HLS.

Примечание: В настоящее время это «служебная» функция, которая означает, что она не зависит
от текущей загруженной сцены или активного проекта. Он работает только с выбранными файлами
растровых изображений в браузере файлов.
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Полученные выходные изображения содержат альфа-канал, равный интенсивности линии.

Примечание: Вы можете составить линию, загрузив разделенные изображения в виде уровней, или
вы также можете соединить уровни с эффектом MatteIn с помощью некоторой цветовой карты, если
вы хотите изменить цвет линии.

Доступные параметры:

• Просмотр кадра: определяет кадр, который будет отображаться в области предварительного
просмотра.

• Показать маску показывает результаты Альфа-маттирования в области предварительного
просмотра.

• Показать альфу показывает сгенерированный альфа-канал в области предварительного про-
смотра. Это альфа-канал, который будет присутствовать в новых сгенерированных файлах изоб-
ражений, продукт работы разделения.

• Выбрать цвет, позволяет пользователю выбрать цвет из левой области предварительного про-
смотра. Выбранный цвет будет присвоен текущему выбранному образцу цвета.

Примечание: Вы можете щелкнуть и перетащить любое изображение области предвари-
тельного просмотра, чтобы выбрать средний цвет для определенного прямоугольника.

• Цвет бумаги:, позволяет определить цвет бумаги, используемый для расчета прозрачности раз-
деленных изображений.

• Основной цвет:, позволяет определить цвет для основных чернил на рисунках. Для лучших
результатов рекомендуется выбирать самый темный цвет.

• Подцвет1:, Подцвет2: и Подцвет3: позволяют определить цвет для других соответствующих
цветных чернил на рисунках, которые вы хотите разделить. Для достижения наилучших резуль-
татов рекомендуется выбирать максимально глубокий (самый темный, более насыщенный) цвет.

Примечание: Параметры Подцвета3: отображаются только при включенном суффиксе
Sub3 в области параметров Суффикс:.

• Доп. коррекция: позволяет регулировать преобладание подцветов по отношению к черным
чернилам.

• Сглаживание каймы: позволяет сделать пересечение линий, имеющих разные цвета, более
плавным.

• Альфа-матирование позволяет лучше удалять шумные фоны, сохраняя при этом тонкие сла-
бые участки мазка карандаша.

Примечание: Для предварительного просмотра альфа-маттирования должна быть активиро-
вана опция Показать маску в верхней части области предварительного просмотра.

• Предел маски позволяет сделать фоновые пиксели с шумом прозрачными.

Примечание: Области, которые должны стать прозрачным фоном в выходном
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изображении, отображаются красным или синим цветом в области предваритель-
ного просмотра.

• Радиус маски может создать сплошную область границы вокруг обнаруженных цвет-
ных штрихов, чтобы сохранить едва различимые слабые их части.

• Начало: и Конец: при разделении последовательностей изображений позволяют установить
диапазон кадров для выполняемой работы по разделению цветов.

• Формат:, определяет формат файла, который будет использоваться для новых сгенерированных
файлов. Доступные опции: PNG и TIF.

• Сохранить в: определяет, где будут сохранены новые созданные файлы.

• Суффикс: позволяет определить суффиксы файла для файлов изображений Основной, Суб
1, Суб 2 и Суб 3.

Примечание: Если Суб 3 включен, левая область предварительного просмотра изменит-
ся, чтобы вместить новый цвет разделения. Также и дополнительная опция Подцвет 3:
будет отображаться в правой области параметров.

• Авто, включает автоматический предварительный просмотр разделения в левой области пред-
варительного просмотра.

• Просмотр позволяет вручную просмотреть разделение в левой области предварительного про-
смотра. Активируется только когда опция Авто отключена.

• Разделить выполняет операцию разделения цвета для выбранных файлов.

Совет: Чтобы разделить цвета изображения на отдельные файлы изображений:

1. Щелкните правой кнопкой мыши по нужному файлу и выберите Разделить цвета. . . в от-
крывшемся меню. Откроется окно Разделить цветь, где вы можете выбрать несколько опций для
операции.

2. Выберите подходящий вариант предварительного просмотра и разделения для желаемого резуль-
тата.

3. Нажмите кнопку Разделить, чтобы выполнить задание разделения цвета.

4. Закройте окно, нажав кнопку Закрыть.

14.3 Размещение уровней

Файлы уровня Toonz, изображения для фона и оверлеев, аудиофайлы, видеоклипы и другие сцены
OpenToonz должны быть представлены в столбцах Xsheet/Timeline, чтобы быть частью сцены.

Если ресурс, который вы хотите использовать, уже был загружен, но не выставлен, или он был удален
со сцены, его можно извлечь из окна Состав сцены.

В случае, если вам нужно извлечь некоторые конкретные рисунки с уровня анимации, вы можете
отобразить их в Level Strip, чтобы выбрать рисунки для показа.
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Примечание: Уровни анимации, которые вы определяете непосредственно в сцене, например уровни,
которые вы сканировали или рисовали непосредственно в OpenToonz, автоматически отображаются в
Xsheet/Timeline.

14.3.1 Использование Состава сцены

Все уровни анимации, которые вы создаете или загружаете в сцену, размещены в окне Состав сцены.
Уровни остаются доступными в Составе сцены, даже если они больше не используются в сцене. Из
Состава сцены они могут быть выставлены, отредактированы, сохранены и удалены.

В древе слева вы можете найти следующее:

• Значок хлопушки, относящийся к текущей сцене.

• Папка Cast, содержащая все уровни анимации, которые вы создаете или загружаете.

• Папка Audio, содержащая все аудиофайлы, которые вы загружаете или создаете (см. Создание
саундтрека).

Вы можете создавать новые папки и подпапки, в которых можно организовать уровни анимации. Путь
к текущему местоположению в дереве набора сцены отображается на верхней панели окна; папки могут
быть переименованы и новые папки могут быть созданы. Уровни могут отображаться с помощью
связанных значков или в списке, отображающем дополнительную информацию, которая также может
использоваться для сортировки файлов.

Примечание: Уровни анимации, которые больше не доступны по заданному пути, отмечены красным
цветом.
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Совет: Чтобы отобразить все приведенные элементы определенной папки:

Нажмите на значок папки в дереве состава сцены слева от панели.

Совет: Для отображения всех элементов сцены:

Нажмите на значок хлопушки в верхней части дерева сцены слева от панели.

Совет: Чтобы выбрать режим отображения состава сцены:

Выполните одно из следующих действий:

• Нажмите кнопку Значок ( ) в нижней панели состава, чтобы отобразить уровни со связанными
значками.

• Нажмите кнопку Список ( ) в нижней панели состава, чтобы отобразить уровни в списке;
щелкните метки в верхней части столбцов, чтобы отсортировать файлы соответствующим обра-
зом.

Совет: Чтобы изменить размеры разделов Состава сцены:

Выполните любое из следующих действий:

• Нажмите и перетащите разделитель, чтобы изменить размеры разделов.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть раздел.

• Щелкните и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить скрытый раздел.

Совет: Чтобы переименовать существующую папку:

Дважды щелкните имя папки и переименуйте ее.

Совет: Чтобы создать новую папку:

Нажмите кнопку Новый ( ) в нижней панели состава.

Совет: Чтобы переместиться на одну папку вверх по иерархии:

Нажмите кнопку Открыть родительскую папку ( ) в нижней панели окна.

Совет: Чтобы сделать выделение:

Выполните одно из следующих действий:

• Нажмите, чтобы выделить уровень.
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• Щелкните с зажатой клавишей Ctrl (PC) или Cmd (Mac), чтобы добавить уровень или удалить
его из выделения.

• Кликните с зажатой клавишей Shift чтобы расширить выделение.

Совет: Чтобы переместить уровни в папку:

Выберите их и перетащите их в папку в составе сцены.

Совет: Чтобы выставить выделенное:

Выполните одно из следующих действий:

• Выберите пункт меню Уровень → Экспонировать в Xsheet.

• Щелкните правой кнопкой мыши выделение в Составе сцены и выберите Экспонировать в
Xsheet в открывшемся меню. В случае выбора нескольких уровней каждый уровень будет раз-
мещен в отдельном столбце/слое, начиная с первого свободного.

• Перетащите выделение в ячейку Xsheet/Timeline, где вы хотите начать ее показывать. В случае
выбора нескольких уровней каждый уровень будет размещен в отдельном столбце/слое.

Совет: Чтобы отобразить уровень анимации в Level Strip:

Выполните одно из следующих действий:

• Выберите его в Составе сцены и выберите Уровень → Отобразить в Level Strip.

• Щелкните правой кнопкой мыши в Составе сцены и выберите Отобразить в Level Strip в
открывшемся меню.

Совет: Чтобы удалить выбранные элементы:

Щелкните правой кнопкой мыши выделение в Составе сцены и выберите Удалить уровень
в открывшемся меню.

Примечание: Уровни могут быть удалены, только если они не используются в сцене.

Совет: Чтобы удалить все неиспользуемые элементы:

Выполните одно из следующих действий:

• Выберите Уровень → Удалить все неиспользуемые в сцене уровни.

• Щелкните правой кнопкой мыши в Составе сцены и выберите Удалить все неиспользуемые
в сцене уровни в открывшемся меню.
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14.3.2 Использование Level Strip

Когда уровень анимации отображается в Level Strip, вы можете выбрать определенные рисунки, ко-
торые вы хотите отобразить на Xsheet/Timeline. Эта функция может оказаться полезной, особенно
когда вам нужно получить некоторые рисунки, которые относятся к уровню, но которые недоступны
в ячейках Xsheet/Timeline.

Совет: Чтобы отобразить уровень анимации в Level Strip:

Выполните одно из следующих действий:

• Выберите любой уровень рисунка, представленный в Xsheet/Timeline.

• Выберите его в Составе сцены и выберите Уровень → Отобразить в Level Strip.

• Кликните по нему правой кнопкой мыши в Составе сцены и выберите пункт Отобразить в Level
Strip в открывшемся меню.
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Совет: Чтобы выбрать рисунки на Level Strip:

Выполните одно из следующих действий:

• Нажмите, чтобы выбрать рисунок.

• Кликните по рисунку с зажатой клавишей Ctrl (PC) или Cmd (Mac) чтобы добавить или удалить
в выделение.

• Кликните с зажатой клавишей Shift чтобы расширить выделение.

Совет: Чтобы выставить выделенное:

Выполните одно из следующих действий:

• Скопируйте и вставьте выделение в нужную ячейку Xsheet/Timeline.

• Щелкните правой кнопкой мыши в выделении Level Strip и выберите Экспонировать
в Xsheet в открывшемся меню. Рисунки будут выставлены в начале первого пустого
столбца.

• Перетащите выделение в ячейку Xsheet / Timeline, где вы хотите начать ее показывать.

• Перетащите выделенную область в ячейку Xsheet/Timeline, где вы хотите начать ее
экспонирование, и удерживайте нажатой клавишу Shift, чтобы вставить их, если в
ячейках назначения уже отображается другой контент.

• Перетащите выделенную область в ячейку Xsheet/Timeline, где вы хотите начать экспо-
нировать ее, и удерживайте нажатой клавишу Alt, чтобы перезаписать любой другой
контент, ранее экспонированный в ячейках назначения.

Примечание: Когда невозможно выставить выделение, вместо выделения отображается красный
контур.

14.3.3 Замена уровней

Уровень анимации, отображаемый в Xsheet/Timeline, может быть легко заменен другим уровнем ани-
мации, сохраняя любое редактирование, выполненное в последовательности рисунков, отображаемых в
ячейках столбца/слоя. Таким образом, можно повторно использовать одну и ту же отредактированную
последовательность для разных уровней. Например, вы можете повторно использовать отредактиро-
ванную последовательность уровня символов для соответствующего уровня тени, скопировав и вставив
последовательность персонажей, а затем заменить уровень персонажа на уровень тени.

Можно заменить уровень целиком или ограниченный только выбранными ячейками. В обоих случаях
будет заменено только содержимое выбранных ячеек: если какой-либо рисунок замененного уровня
будет открыт где-то еще в Xsheet/Timeline, операция замены не будет выполнена.

Если новый уровень не содержит некоторые кадры, которые вы собираетесь заменить, имя и номер
уровня в ячейке станут красными, чтобы предупредить вас, что для этой ячейки нет рисунка.

Исходный уровень сохраняется в Составе сцены, откуда его можно извлечь или удалить (см. Исполь-
зование Состава сцены).
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Совет: Чтобы заменить уровень в Xsheet / Timeline:

1. Выберите ячейки, на которых выставлен уровень, который вы хотите заменить.

2. Выполните одно из следующих действий:

• Выберите Уровень → Заменить уровень. . . .

• Щелкните правой кнопкой мыши выделенную область и выберите один из параметров в подменю
Заменить уровень в открывшемся меню.

3. In the browser select the new level, and click the OK button (see Using the File Browser ).
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14.4 Изменение настроек уровня

Как только уровень выставлен, его свойствами (путь, DPI, субсемплинг и т.д.) можно управлять в
диалоговом окне Настройки уровня. Настройки следующие:

• Имя - это имя, используемое для определения уровня, по умолчанию это то же имя файла.

• Путь отображает местоположение файла, используя псевдонимы папок по умолчанию, если это
необходимо. Напечатав это поле или используя кнопку браузера, вы можете обновить путь к
другому местоположению или к другому файлу.

Примечание: Если в браузере вы выбираете любую папку проекта по умолчанию, в поле пути
полный путь будет заменен на связанный псевдоним папки по умолчанию (см. Папки проекта
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по умолчанию).

• Путь сканирования отображает местоположение отсканированных изображений, которые бы-
ли очищены для получения фактического уровня (см. Очистка отсканированных рисунков). Это
доступно только для растровых уровней Toonz.

• DPI позволяет изменить уровень DPI, тем самым изменив его размер. Чтобы вернуться к исход-
ному DPI изображения, установите Пользовательское значение DPI в выпадающем меню выше.

• Принудительно квадратные пиксели заставляет уровень, который имеет разные горизон-
тальные и вертикальные DPI, и, следовательно, отображается растянутым, чтобы иметь квад-
ратную форму пикселя и, таким образом, отображаться правильно.

• Ширина и Высота позволяют вам установить другой размер для уровня, тем самым изменяя
его DPI. Уровень поддерживает свой A/R.

• Использовать DPI камеры применяется для автоматического определения уровня DPI каме-
ры. Это полезно, когда уровень имеет одинаковый размер камеры, но разные DPI, и вы хотите,
чтобы он идеально соответствовал камере.

• Информация о Камера DPI, DPI изображения и Разрешении изображения отображается в
справочных целях.

• Умножение предварительно умножает альфа-канал уровня. Изображения с осмысленным
альфа-каналом бывают двух типов: предварительно умноженные или нет. Не предварительно
умноженное изображение может быть распознано, когда оно загружено в OpenToonz, потому что
его край, где имеется полная прозрачность с одной стороны и непрозрачность с другой, не являет-
ся гладким, но отображает сплошной ореол. С помощью операции предварительного умножения
можно преобразовать альфа-канал изображения таким образом, чтобы он правильно отображал-
ся на стенде камеры OpenToonz, в режиме предварительного просмотра и рендеринга.

• Белый как прозрачный устанавливает чистый белый цвет (то есть со значениями красного,
зеленого и синего в 255) как прозрачный и автоматически добавляет сглаживание к изображе-
ниям уровня. Эта опция предназначена для уровней анимации, сгенерированных из стороннего
программного обеспечения (такого как Retas), у которого нет прозрачного фона, но сплошного
белого цвета, и у линий которого нет сглаживания.

• Добавить сглаживание дает пользователю возможность добавить сглаживание на уровень.
Значение сглаживания должно быть указано в поле Мягкость сглаживания, которое может
находиться в диапазоне от 0 до 100. Этот параметр доступен на уровнях Toonz Raster и Raster.

• Субсемплинг устанавливает упрощающий коэффициент, который будет применяться к уровням
анимации, клипам и изображениям при отображении в рабочей области, чтобы обеспечить более
быструю визуализацию и воспроизведение; например, если это 2, один пиксель каждые два пик-
селя отображается. Значения по умолчанию определены в диалоговом окне Xsheet → Настройки
сцены, где можно определить значения для субсемплинга уровня растра (изображение) и Toonz
растра (TLV).

Примечание: Коэффициент субсемплинга также можно применить ко всем уровням анима-
ции, отображаемым в выбранных столбцах, щелкнув правой кнопкой мыши заголовок любого
выбранного столбца и выбрав одну из команд Субсемплинг в открывшемся меню.

Совет: Чтобы открыть диалоговое окно настроек уровня:

Выполните одно из следующих действий:

• Выберите уровень в Xsheet/Timeline и выберите пункт меню Уровень → Настройки уровня. . . .
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• Right-click a level in the Xsheet/Timeline and choose Level Settings. . . from the menu that opens.

• Right-click a level in the Scene Cast and choose Level Settings. . . from the menu that opens.

14.5 Панель инструментов Xsheet

Панель инструментов Xsheet, расположенная в верхней части панелей Xsheet и Timeline, это место,
где пользователь может отображать любимые инструменты и команды OpenToonz, чтобы они были
легко доступны.

Панель панели инструментов Xsheet можно переключать в зависимости от предпочтений пользователя.

Примечание: Если панель инструментов Xsheet слишком короткая для отображения всех командных
кнопок, справа от нее появится символ двойной стрелки, позволяющий отобразить раскрывающееся
меню с остальными.

Совет: Чтобы переключить панель инструментов Xsheet:

Выполните одно из следующих действий:

• Right click on any column/layer header and choose Toggle Xsheet Toolbar from the menu that
opens.

• Activate the File → Preferences. . . → Xsheet → Show Toolbar in the Xsheet option.

Примечание: Когда отображается панель инструментов Xsheet, также можно активировать пара-
метр Развернуть заголовок редактора функций, чтобы соответствовать высоте панели ин-
струментов XSheet, чтобы правильно сопоставлять ряды кадров в обоих редакторах, когда они
расположены рядом.

Совет: Чтобы настроить кнопки панели инструментов Xsheet:

1. Щелкните правой кнопкой мыши по нему и выберите Настроить панель инструментов
Xsheet в открывшемся меню. Откроется окно Настроить панель инструментов Xsheet.
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2. Чтобы добавить команду: найдите команду в списке Элементы панели инструментов (спра-
ва) и перетащите ее в список Панель инструментов Xsheet (слева).

3. Чтобы добавить разделитель: в конце списка Элементы панели инструментов (справа) пе-
ретащите элемент —-Разделитель—- в список Панель инструментов Xsheet (слева).

4. Чтобы удалить команду: найдите команду в списке Панель инструментов Xsheet (слева),
щелкните ее правой кнопкой мыши и выберите Удалить в открывшемся меню.

5. Нажмите OK, чтобы принять изменения или Отмена, чтобы отменить их.

14.6 Работа со столбцами/слоями

Когда уровни отображаются в таблице Xsheet, они помещаются в столбцы (слои в случае Timeline).
Порядок расположения столбцов/слоев устанавливает, какие рисунки и изображения размещаются
поверх или позади других изображений. Его направление слева направо в Xsheet и снизу вверх на
Timeline, поэтому то, что находится слева/снизу, позади того, что находится справа/вверху. Вы можете
использовать клавиши со стрелками на клавиатуре для перемещения между столбцами/слоями и во
времени.
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The Xsheet is divided into sections divided by horizontal markers (vertical, in case of the Timeline), whose
interval can be customized; at each marker the name of the levels exposed can be displayed, when the option
Display Level Name on Each Marker is active in the Preferences. . . → Interface dialog section.

Column/layer cells may have different colors according to the type of level they contain. Toonz Vector levels
are displayed in dark yellow ; Toonz Raster levels in green; Raster levels in light blue; Sub-Xsheets in violet
(see Using Sub-Xsheets ); Effect levels generated by OpenToonz in brown (see Using the FX Schematic );
Audio levels in pale green (see Creating a Soundtrack ); and Note levels in grey.

Каждый заголовок столбца/слоя содержит информацию о его содержимом. Такую:

• Имя, по умолчанию это имя первого выставленного уровня. Цвет области указывает тип уровня,
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выставляемого в столбце/слое.

• Переключение видимости ( ), позволяющий включать или не включать содержимое столб-
ца/слоя в рендеринг.

• Переключатель видимости камеры ( ), позволяющий скрыть или отобразить содержимое
столбца/слоя в средстве просмотра.

Примечание: Переключатели видимости и камеры работают с аналогичными переключателя-
ми, доступными в узлах Schematic столбца/слоя (см. Использование Схема сцены и Использова-
ние FX Schematic).

• Блокировка переключения ( ) позволяет предотвратить любое редактирование в столб-
це/слое.

• Кнопка Дополнительные настройки столбцов ( ), позволяет установить значение Непро-
зрачность или Цвет столбцов для содержимого столбца/слоя при отображении в окне про-
смотра. Когда столбец/слой имеет частичную непрозрачность, Переключатель видимости
камеры изменяется на блеклый значок, чтобы указать его.

Примечание: При желании эти дополнительные свойства также можно использовать во время
рендера, активировав параметр Учитывать цвет столбцов и прозрачность при рендеринге
в диалоговом окне Xsheet → Настройки сцены. . . .

• Значок предварительного просмотра первого рисунка или изображения, выставленного в
столбце/слое.

Примечание: The icons on the Xsheet column headers can either be displayed at once when the
scene is opened, or on demand by clicking on the column header, according to the Column Icon
option available in Preferences. . . → Xsheet dialog section.

• Parent information, is an area where the object (by default the Table) and center (by default center
B) to which each column/layer is parented is displayed (see Linking Objects ). Currently this is not
shown in the Timeline header.

В Xsheet в крайнем левом столбце отображается номер кадра с курсором, указывающим текущий
кадр. Курсор может использоваться для установки текущего кадра и позволяет вам активировать ре-
жим кальки, чтобы лучше проверить анимацию (см. Применение кальки). В Timeline те же элементы
управления размещаются в линейке времени в верхней части Timeline, имея эквивалентную функцио-
нальность.

Примечание: When the animation is played back, the Xsheet/Timeline scrolls according to the current
frame cursor position, in order to display the current frame. To disable the scrolling deactivate the Xsheet
Autopan during Playback option available in the Preferences. . . → Xsheet dialog section.

Над столбцом номера кадра расположены кнопки для создания и навигации по заметкам, которые
можно публиковать на Xsheet/Timeline (см. Использование заметок).

Xsheet/Timeline можно прокрутить, чтобы проверить его содержимое, при этом область заголовка и
столбец кадра всегда видны; таким образом легче понять, как строится сцена.
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Столбцы/слои, которые вы хотите скрыть в Xsheet/Timeline, можно сложить, чтобы сэкономить ме-
сто в интерфейсе. После сворачивания их можно развернуть в любой момент и увидеть в исходном
положении, щелкнув область заголовка столбца/слоя.

Совет: Для прокрутки Xsheet/Timeline:**

Выполните одно из следующих действий:

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте колесо мыши для прокрутки вверх или вниз.

• Используйте полосы прокрутки для прокрутки в пределах открытого раздела Xsheet/Timeline.

• Используйте клавиши-стрелки вверх и вниз, чтобы переместить один кадр назад или вперед в
Xsheet.

• Используйте клавиши со стрелками влево и вправо, чтобы переместить один кадр назад или
вперед на Timeline.

• Используйте клавиши Shift + cтрелка вверх и Shift + Стрелка вниз, чтобы перейти к предыду-
щему или следующему рисунку, либо на Xsheet, либо на Timeline. Используйте эту опцию, если
вы хотите пропустить удерживающие кадры.

• Используйте клавиши Page Up и Page Down для прокрутки видимых кадров вверх или вниз в
Xsheet.

• Используйте клавиши Home и End для прокрутки вверх до начала или конца содержимого Xsheet.

Совет: Чтобы установить интервал маркера:

1. Выберите Xsheet → Настройки сцены. . .

2. В открывшемся диалоговом окне используйте Интервал маркеров, чтобы установить интервал
между двумя маркерами, и Начальный кадр, чтобы указать, в каком кадре должен отобра-
жаться первый маркер.

Совет: Чтобы назвать столбец:

Дважды щелкните имя столбца/слоя в заголовке и введите новое имя.

Совет: Чтобы выделить столбцы/слои:

Выполните одно из следующих действий:

• Щелкните заголовок столбца/слоя, чтобы выбрать столбец.

• Нажмите и перетащите значок столбца/слоя, чтобы выбрать смежные столбцы.

• Кликните с зажатой клавишей Ctrl (PC) или Cmd (Mac), чтобы добавить столбец/слой или
удалить его из выделения.

• Кликните с зажатой клавишей Shift чтобы расширить выделение.

Совет: Чтобы переместить выделение столбца/слоя:
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Щелкните любую область, отображающую имя столбцов в заголовке, и перетащите ее на новую пози-
цию.

Совет: Чтобы изменить выделенный столбец/слоя:

1. Выберите столбцы/слои, которые вы хотите редактировать.

2. Выполните одно из следующих действий:

• Используйте команду Копировать, чтобы сохранить в памяти выбор для дальнейших операций.

• Use the Cut command: to eliminate the selection from the scene and keep it in memory for further
operations. The column/layer elimination causes the following columns to shift left (or the layers above
to shift down).

• Use the Paste command to paste the selection kept in memory starting from the selected column/layer.
The command causes following columns to shift right (or layers above to shift up).

• Use the Delete command to delete the selection.

• Use the Insert command to insert empty columns before the selection; inserted columns/layers will
be as many as the selected ones.

Примечание: Все эти команды также доступны в меню, которое открывается, если щелкнуть правой
кнопкой мыши заголовок столбца/слоя.

Совет: Чтобы включить или исключить содержимое столбца/слоя из рендера:

Щелкните на переключатель видимости ( ) в заголовке столбца/слоя. Если вы щелкнете правой
кнопкой мыши по кнопке, вы сможете выбрать команды в открывшемся меню, которые позволят вам
воздействовать на несколько столбцов/слоев одновременно.

Совет: Чтобы показать или скрыть содержимое столбца/слоя в окне просмотра:

Выполните одно из следующих действий:

• Щелкните переключатель видимости камеры ( ) в заголовке столбца/слоя. Значок исчезает, ес-
ли установлена частичная непрозрачность (см. ниже). Если вы щелкнете правой кнопкой мыши
по кнопке, вы сможете выбрать команды в открывшемся меню, которые позволят вам воздей-
ствовать на несколько столбцов/слоев одновременно.

• Щелкните правой кнопкой мыши содержимое столбца/слоя в окне просмотра и выберите команду
Скрыть или Показать, относящуюся к столбцу/слою, который вы хотите скрыть или показать.

Совет: Чтобы заблокировать или разблокировать содержимое столбца/слоя:

Нажмите блокировка переключения ( ) в заголовке столбца/слоя. Если вы щелкните правой кнопкой
мыши по кнопке, вы сможете выбрать команды в открывшемся меню, которые позволят вам заблоки-
ровать или разблокировать несколько столбцов/слоев одновременно.
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Совет: Чтобы установить непрозрачность для содержимого столбца / слоя:

Щелкните по значку треугольника ( ) в заголовке столбца/слоя и выполните одно из следующих
действий:

• Используйте ползунок Непрозрачность, чтобы установить непрозрачность столбца/слоя.

• Введите желаемое значение Непрозрачности в числовое поле, чтобы установить непрозрачность
столбца/слоя.

Совет: Чтобы установить цветовой фильтр для содержимого столбца/слоя:

Щелкните по значку треугольника ( ) в заголовке столбца/слоя и установите для параметра
Фильтр один из его предопределенных цветов.

Примечание: Вы можете включить непрозрачность и цветовой фильтр во время рендера, активи-
ровав параметр Учитывать цвет столбцов и прозрачность при рендеринге в диалоговом окне
Xsheet → Настройки сцены. . . .

Совет: Чтобы свернуть столбцы/слои:

1. Выберите столбцы/слои, которые вы хотите свернуть.

2. Щелкните правой кнопкой мыши выделенную область и выберите Свернуть столбцы в от-
крывшемся меню.

Совет: Чтобы развернуть столбцы/слои:

Нажмите на сгиб, видимый между заголовками столбцов/слоев.

14.7 Работа с ячейками

Когда уровень отображается в столбце, каждая ячейка содержит ссылку на конкретное изображение.
Вы можете очистить некоторые ячейки, повторить некоторые из них или изменить их порядок, не
затрагивая последовательность реальных рисунков, потому что вы работаете со ссылками. Это озна-
чает, что когда сцена содержит несколько ячеек, относящихся к рисунку уровня анимации, все они
ссылаются на один и тот же рисунок. Это подразумевает, что когда вы изменяете рисунок уровня
анимации, все ячейки в Xsheet/Timeline, ссылающиеся на этот рисунок, будут, следовательно, менять
свое содержимое.

Примечание: Когда сцена содержит ссылку на рисунок, который исключен из уровня, имя и номер
рисунка в ячейке становятся красными, чтобы предупредить вас, что для этой ячейки больше нет
рисунка.

Когда вы выбираете ячейку, вы можете работать с рисунком, который она содержит, используя ин-
струменты в окне просмотра.
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Когда выбрана одна или несколько ячеек, вы можете выполнять стандартные операции вырезания,
копирования, вставки, удаления и вставки в Xsheet/Timeline. В этом случае вы не изменяете кадры
уровня анимации, а просто меняете способ их отображения в Xsheet/Timeline.

Выбранные ячейки также можно перетащить на новую позицию на Xsheet/Timeline, а также в ре-
жиме дублирования, вставки или перезаписи. Когда они перетаскиваются в пустой столбец, можно
перемещаться вдоль данных столбца/слоя, то есть движения и эффекты, где они были изначально
выставлены.

Совет: Чтобы изменить рисунок, отображаемый в ячейке:

1. Выберите ячейку на Xsheet/Timeline, где представлен рисунок.

2. Use the tools to edit it in the Viewer.

Совет: Чтобы выбрать несколько ячеек:

Выполните одно из следующих действий:

• Нажмите и перетащите, чтобы выбрать серию ячеек.

• Удерживая клавишу Shift, щелкните ячейку, чтобы расширить выделение до этой ячейки.

• Нажмите Ctrl и перетащите, чтобы включить ключи в выделение. Красная рамка будет отобра-
жаться вокруг выделения.

• Щелкните по вертикальной полосе, доступной слева от ячеек в Xsheet, чтобы выбрать непрерыв-
ную последовательность рисунков, принадлежащих одному и тому же уровню анимации.

• Щелкните горизонтальную полосу, доступную поверх ячеек на Timelin, чтобы выбрать непре-
рывную последовательность рисунков, принадлежащих одному и тому же уровню анимации.

Совет: Чтобы редактировать ячейки с помощью команд меню Правка:

Вы можете сделать следующее:

• Используйте команду Копировать, чтобы сохранить в памяти выбор для дальнейших операций.

• Используйте команду Вырезать, чтобы исключить выделение из Xsheet или Timeline и сохра-
нить его в памяти для дальнейших операций. Удаление ячеек приводит к смещению следующих
ячеек в Xsheet или на Timeline влево.

• Используйте команду Вставить, чтобы вставить выделенный в памяти выбор в Xsheet/Timeline,
начиная с выбранной ячейки вставки. Эта команда приводит к смещению следующих ячеек в
таблице Xsheet или на Timeline вправо.

• Используйте команду Удалить, чтобы очистить выбранные ячейки от любой ссылки.

• Используйте команду Вставить, чтобы вставить пустые ячейки перед выделением; вставленных
ячеек будет столько же, сколько и выбранных.

Примечание: Все команды меню Правка также доступны в меню, которое открывается при щелчке
правой кнопкой мыши по ячейкам Xsheet/Timeline.

Совет: Чтобы редактировать ячейки с помощью команд меню Ячейки:
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Вы можете сделать следующее:

• Используйте команду Обратить, чтобы инвертировать порядок выбранных ячеек.

• Используйте команду Добавить в обратном порядке, чтобы добавить выбранные ячейки в
конце выделения в обратном порядке. Последняя ячейка выбора не будет повторяться.

• Используйте команду Случайно, чтобы перегруппировать выбранные ячейки в случайном по-
рядке. Порядок меняется каждый раз, когда вы используете команду.

• Используйте команду Автоэкспонирование, чтобы повторить выбранные ячейки, как если бы
заполнял пробел между двумя последующими рисунками. Например, если команда применяется
к двум ячейкам, где отображаются рисунки 2 и 5, результатом будут четыре ячейки с рисунками
2, 2, 2 и 5. Команда работает только в том случае, если выборка все больше пронумерована.

Примечание: Если команда Автоэкспонирования используется на уровне с номерами 1,
3, 5, 7 и т.д., уровень будет автоматически выставлен на шаге 2.

• Используйте команду Повторение, чтобы открыть диалоговое окно, которое позволяет цикли-
чески повторять выбранные ячейки, указав количество раз или номер кадра, до которого должен
повторяться выбор.

• Используйте команду Сбросить шаг, чтобы удалить любой шаг анимации в выбранных ячейках,
сохраняя порядок экспонированных рисунков.

• Используйте команду Увеличить шаг, чтобы увеличить шаг анимации выбранных ячеек на
одну единицу.

• Используйте команду Уменьшить шаг, чтобы уменьшить шаг анимации выбранных ячеек на
одну единицу; если рисунок отображается только в одной ячейке, он будет сохранен.

• Используйте команду Шаг 2, Шаг 3 или Шаг 4, чтобы повторить выбранные ячейки для
анимации шага 2, шага 3 или шага 4.

• Используйте команду Каждые 2, Каждые 3 или Каждые 4, чтобы сохранить только одну
ячейку каждые 2, каждые 3 или каждые 4 выбора и удалить остальные.

• Используйте команду Первый вниз, чтобы сместить содержимое выбранных ячеек вверх, при
этом содержимое верхней ячейки заменяет содержимое нижней ячейки.

• Используйте Последний наверх, чтобы сдвинуть содержимое выбранных ячеек вниз, при этом
содержимое нижней ячейки заменяет верхнюю ячейку.

Примечание: Все команды меню Ячейки также доступны в меню, которое открывается при щелчке
правой кнопкой мыши по ячейкам Xsheet/Timeline.

Совет: Чтобы перетащить выделенную ячейку в таблицу Xsheet:

Выполните одно из следующих действий:

• Нажмите вертикальную полосу слева от ячеек и перетащите, чтобы переместить их в новое
положение.

• Кликните, зажав клавишу Ctrl (PC) или Cmd (Mac) по вертикальной полосе, доступной слева
от ячеек, и перетащите их на новую позицию, дублируя их.
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• Удерживая клавишу Shift, щелкните вертикальную полосу слева от ячеек и перетащите их на
новую позицию, вставив их, если в ячейках назначения отображается другое содержимое.

• Удерживая клавишу Alt, щелкните вертикальную полосу, доступную слева от ячеек, и пе-
ретащите их на новую позицию, перезаписав любой другой контент, ранее экспонированный в
ячейках назначения.

Примечание: Когда невозможно вставить выделение, вместо выделения отображается красный кон-
тур.

Совет: Чтобы перетащить выделение ячейки на Timeline:

Выполните одно из следующих действий:

• Щелкните на горизонтальной полосе, доступной в верхней части ячеек, и перетащите, чтобы
переместить их на новую позицию.

• Щелкните, зажав клавишу Ctrl (PC) или Cmd (Mac) на клавиатуре по горизонтальной полосе,
доступной в верхней части ячеек, и перетащите их на новую позицию, дублируя их.

• Удерживая клавишу Shift, щелкните горизонтальную полосу, доступную в верхней части ячеек,
и перетащите их на новую позицию, вставив их, если в ячейках назначения отображается другое
содержимое.

• Удерживая клавишу Alt, нажмите на горизонтальную полосу, расположенную в верхней части
ячеек, и перетащите их на новую позицию, перезаписав любой другой контент, ранее экспониро-
ванный в ячейках назначения.

Примечание: Когда невозможно вставить выделение, вместо выделения отображается красный кон-
тур.

Совет: Чтобы перетащить выделение ячейки, перемещаясь вдоль данных столбца/слоя:

1. Choose File → Preferences. . . → Xsheet.

2. Установите для параметра Поведение при перетаскивании ячейки значение Ячейки и данные
столбцов.

Примечание: Column/layer data is moved along only when dragging the selected cells to an empty
column/layer.

Примечание: Column/layer data is moved along except for the linked columns/layers, because linked
columns/layers can only have one parent column/layer.

14.7.1 Использование Smart Fill Handle

Fill Handle позволяет редактировать ячейки непосредственно из Xsheet/Timeline.
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Это небольшая вкладка, появляющаяся в нижней части выбора ячеек на Xsheet или справа от выбора
ячеек на Timeline. Перетаскивая этот маркер, вы можете повторить ячейку или группу ячеек, вы
можете добавить ячейки или удалить последние ячейки последовательности. Поведение дескриптора
разумно: это означает, что способ повторения, добавления или удаления ячеек зависит от содержимого
выделения.

Примечание: Редактирование ячеек с помощью Fill Handle делает ячейки, расположенные ниже
выделенной области, для смещения вверх/вниз в Xsheet (или ячейки, расположенные справа от выде-
ленной области для смещения влево/вправо на Timeline).

Совет: Чтобы редактировать содержимое ячейки с помощью Fill Handle в Xsheet:

Выполните одно из следующих действий:

• Если вы хотите повторить содержимое ячейки для некоторых кадров, выберите ячейку и пере-
тащите маркер заполнения вниз.

• Если вы хотите удлинить возрастающую последовательность, выберите ячейки, в которых показа-
на последовательность, и перетащите ручку заполнения вниз: последовательность будет удлинена
в соответствии с прогрессивной нумерацией. Например, если последовательность 1, 3, 5, добав-
ленные изображения будут 7, 9, 11 и т.д. Это работает для любого шага, который может иметь
последовательность.

• Если вы хотите, чтобы случайная последовательность повторялась, выберите последовательность
и перетащите маркер заполнения вниз: последовательность будет удлинена в соответствии с ну-
мерацией последовательности. Например, если последовательность 3, 6, 4, 1, добавленные изоб-
ражения будут 3, 6, 4, 1, 3, 6 и т.д.

• Если вы хотите, чтобы последовательная последовательность повторялась, сначала скопируйте
первый рисунок последовательности в конце последовательности, затем выберите все и перета-
щите вниз маркер заполнения. Например, если последовательность 1, 2, 3, 4, скопируйте чертеж
1 в конце последовательности (результат будет 1, 2, 3, 4, 1), а добавленные рисунки будут 2, 3, 4,
1, 2 и т.д.

• Если вы хотите удалить несколько ячеек, выберите область таким образом, чтобы ячейки, кото-
рые вы хотите удалить, были в последних столбцах, и перетащите маркер заполнения вверх.

Совет: Чтобы редактировать содержимое ячейки с помощью маркера заполнения на
Timeline:

Выполните одно из следующих действий:

• Если вы хотите повторить содержимое ячейки для некоторых кадров, выберите ячейку и пере-
тащите маркер заполнения вправо.

• Если вы хотите удлинить возрастающую последовательность, выберите ячейки, в которых по-
казана последовательность, и перетащите маркер заполнения вправо: последовательность будет
удлинена в соответствии с возрастающей нумерацией. Например, если последовательность 1, 3,
5, добавленные изображения будут 7, 9, 11 и т.д. Это работает для любого шага, который может
иметь последовательность.

• Если вы хотите, чтобы случайная последовательность повторялась, выберите последовательность
и перетащите маркер заполнения вправо: последовательность будет удлинена в соответствии с ну-
мерацией последовательности. Например, если последовательность 3, 6, 4, 1, добавленные изоб-
ражения будут 3, 6, 4, 1, 3, 6 и т.д.

258 Глава 14. Работа в Xsheet/Timeline



OpenToonz Documentation, Выпуск 1.7.1

• Если вы хотите, чтобы последовательная последовательность повторялась, сначала скопируйте
первый рисунок последовательности в конце последовательности, затем выберите все и перетащи-
те маркер заполнения вправо. Например, если последовательность 1, 2, 3, 4, скопируйте рисунок
1 в конце последовательности (результат будет 1, 2, 3, 4, 1), а добавленные рисунки будут 2, 3, 4,
1, 2 и т.д.

• Если вы хотите удалить несколько ячеек, выберите область так, чтобы ячейки, которые вы хотите
удалить, были в последних строках, и перетащите маркер заполнения влево.

14.7.2 Тайминг

Если вам нужно изменить время выделенных ячеек, выбранного диапазона кадров или всего
Xsheet/Timeline, вы можете использовать диалог Растяжение времени.

Настройки следующие:

• Растяжение определяет, должно ли новое время применяться к Выбранные ячейки, Вы-
бранный диапазон кадров или к Весь Xsheet.

• Старый диапазон отображает продолжительность выделенных кадров.

• Новый диапазон определяет новую продолжительность выделенных кадров.

Совет: Чтобы изменить тайминг Xsheet/Timeline:

1. Выберите ячейки или определите диапазон кадра, который вы хотите растянуть.

2. Выполните одно из следующих действий:

• Выберите Ячейки → Растяжение времени. . . ..

• Щелкните правой кнопкой мыши по выделению и выберите Растяжение времени. . . в открыв-
шемся меню.

3. Определите параметры растяжения времени, затем нажмите кнопку Растяжение.

14.8 Глобальная работа с кадрами

Можно вставить или удалить кадры, влияющие на Xsheet / Timeline в целом, или выделение столбцов
Xsheet или слоев Timeline.
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Вставка или удаление кадров могут быть полезны, если вы хотите изменить время анимации, например,
если вы хотите замедлить или ускорить анимацию.

Когда кадр вставлен, ячейки текущего кадра дублируются, а все последующие ячейки сдвигаются вниз
(вправо на Timeline). Если ключи анимации определены для преобразования объектов и параметров
эффектов, они также будут смещены вниз (или вправо на Timeline), чтобы сохранить согласованность
анимации (см. Анимация объектов и Редактирование Настроек эффектов).

При удалении кадра ячейки текущего кадра удаляются, а следующие ячейки сдвигаются вверх (или
влево на Timeline). Если ключи анимации для преобразования объектов и параметров эффектов опре-
делены в удаленном кадре, они будут удалены, а следующие ключи будут сдвинуты вверх (или вправо
на Timeline) (см. Анимация объектов и Редактирование настроек эффектов).

Совет: Чтобы вставить кадр:

1. Выберите кадр, перед которым вы хотите вставить новый кадр.

2. Выберите пункт меню Xsheet → Вставить кадр.

Совет: Чтобы удалить кадр:

1. Выберите кадр, который вы хотите удалить.

2. Выберите пункт меню Xsheet → Вставить кадр.

14.9 Использование Sub-Xsheet

Sub-Xsheet это сцена, отображаемая в одном столбце Xsheet или на Timeline. Она может содержать
столько столбцов/слоев, сколько вы захотите, а также другие Sub-Xsheet.

Когда он открыт, содержимое Sub-Xsheet отображается на панели Xsheet/Timeline. Когда он закрыт,
он отображается на Xsheet/Timeline в виде фиолетового столбца/слоя, а его значок отображает визуа-
лизацию его содержимого. Ячейки столбца/слоя отображают имя Sub-Xsheet, а номер ячейки является
ссылкой на кадр содержимого Sub-Xsheet, то есть ячейка 4 является ссылкой на 4-й кадр Sub-Xsheet.

Длина закрытого уровня Sub-Xsheet зависит от того, сколько кадров длится его содержимое во время
его создания, и на него не влияют изменения содержимого Sub-Xsheet.

Уровни Sub-Xsheet могут быть анимированы, как и любой другой уровень анимации, и ему может
быть присвоен эффект, влияющий на весь контент Sub-Xsheet в целом.

Ячейки уровня Sub-Xsheet можно редактировать, например, для создания цикла, или вырезать, копи-
ровать и вставлять, как и любой другой доступный уровень (см. Работа с ячейками Xsheet). Как и на
любом другом уровне, если какое-либо редактирование выполняется в его кадрах, все ячейки в основ-
ном Xsheet/Timeline, ссылающиеся на этот кадр Sub-Xsheet, соответственно изменят свое содержимое.
Если вы хотите создать копию Sub-Xsheet, которая ссылается на ту же базу данных уровня анимации,
но содержимое которой можно редактировать независимо, вы можете выбрать Клонировать ее.

Если вы хотите сбросить редактирование уровня Sub-Xsheet, вы можете Пересчитать секвенцию,
вернув исходную длину и порядок его содержимого.

Вы можете загрузить сцену, ранее созданную с помощью OpenToonz, в качестве уровня текущей сцены.
Вы также можете свернуть выбранные столбцы/слои, чтобы сформировать новый Sub-Xsheet, чтобы
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лучше управлять сценой, например, вы можете свернуть в Sub-Xsheet все столбцы/слои, использу-
емые для определения персонажа, или разбить Sub-Xsheet, чтобы автоматически перенести все его
содержимое в Xsheet/Timeline, где оно представлено.

Так как Sub-Xsheet можно загружать и сохранять, их также можно использовать для импорта или
экспорта разделов Xsheet/Timeline из одной сцены в другую. Например, если вы создаете сцену, в
которой персонаж состоит из нескольких уровней (голова, тело, тень и т.д.) вы можете сохранить его
и затем импортировать в другую сцену в виде Sub-Xsheet.

При работе внутри Sub-Xsheet по умолчанию в окне просмотра отображается только его собственное
содержимое. Если вам нужно отредактировать содержимое Sub-Xsheet, просматривая все содержимое
сцены, вы можете активировать режим Редактировать на месте.

Подобно стандартным Xsheets/Timelines, Sub-Xsheet также может содержать аудиофайлы, которые
будут использоваться для синхронизации саундтрека с анимацией. Однако аудиофайлы, загруженные
в Sub-Xsheet, игнорируются при визуализации выходного файла, поддерживающего звук, потому что
возможность редактировать порядок кадров столбцов/слоев Sub-Xsheet может сделать полученную
звуковую дорожку несогласованной (см. Создание звуковой дорожки).

14.9.1 Создание Sub-Xsheet

Sub-Xsheet управляются командами меню Xsheet и кнопками на панели инструментов Xsheet.

Вы можете создать Sub-Xsheet, свернув один или несколько столбцов/слоев, на которых выставлены
уровни, выбрав при необходимости включение штифтов, с которыми связаны столбцы; или вы можете
вырезать или копировать столбцы/слои и рисунки за пределы Sub-Xsheet, а затем вставлять их в него.

Примечание: Основной Xsheet/Timeline поделится со своими вложенными Xsheets базой данных
уровня анимации, поэтому, если тот же уровень отображается в основном Xsheet/Timeline и в одной
из его Sub-Xsheet, уровень и его свойства будут общими.

При копировании столбцов/слоев и ячеек Sub-Xsheet их копии всегда ссылаются на одно и то же со-
держимое Sub-Xsheet: если в Sub-Xsheet вносятся изменения, все ячейки в основном Xsheet/Timeline,
ссылающиеся на этот Sub-Xsheet, соответственно изменят их содержание. Если вы хотите создать ко-
пию Sub-Xsheet, содержимое которого можно изменять независимо от внутреннего уровня экспозиции,
анимации объекта и примененного эффекта, можно Клонировать ее.

Совет: Чтобы создать Sub-Xsheet, свернув один или несколько столбцов:

1. Выберите столбцы, которые вы хотите включить в состав Sub-Xsheet, в Xsheet/Timeline или
Schematic.

2. Выполните одно из следующих действий:

• Выберите пункт меню Xsheet → Коллапс.

• Нажмите кнопку Коллапс на панели инструментов Xsheet.

• Щелкните правой кнопкой мыши заголовок любого столбца и выберите Коллапс в открывшемся
меню.

3. Выберите, следует ли включать релевантные штифты в Sub-Xsheet или свернуть только выбран-
ные столбцы, затем нажмите кнопку ОК.

Совет: Чтобы выйти из Sub-Xsheet:
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Сделайте одно из ниже перечисленного

• Выберите Xsheet → Закрыть Sub-Xsheet.

• Нажмите кнопку Закрыть на панели инструментов Xsheet.

Совет: Чтобы открыть закрытый Sub-Xsheet:

1. Выберите столбец Sub-Xsheet на Xsheet/Timeline или узел Sub-Xsheet на схеме.

2. Выполните одно из следующих действий:

• Выберите Xsheet → Открыть Sub-xsheet.

• Нажмите кнопку Открыть Sub-xsheet на панели инструментов Xsheet/Timeline.

• Щелкните правой кнопкой мыши заголовок столбца и выберите Открыть Sub-xsheet в открыв-
шемся меню.

Совет: Чтобы клонировать Sub-Xsheet:

1. Выберите столбец Xsheet (или слой Timeline), где отображается Sub-Xsheet, который вы хотите
клонировать.

2. Выполните одно из следующих действий:

• Выберите Xsheet → Клонировать Sub-Xsheet.

• Щелкните правой кнопкой мыши заголовок столбца и выберите Клонировать Sub-xsheet в
открывшемся меню.

Совет: Для переключения редактирония Sub-Xsheet в ее контексте:

Сделайте одно из ниже перечисленного

• Выберите Xsheet → Переключить Редактировать на месте.

• Нажмите кнопку Переключить Редактировать на месте на панели инструментов
Xsheet/Timeline.

Совет: Чтобы пересчитать секвенцию Sub-Xsheet:

1. Выберите столбец/слой, содержащий Sub-Xsheet.

2. Выполните одно из следующих действий:

• Выберите Xsheet → Пересчитать секвенцию.

• Щелкните правой кнопкой мыши заголовок столбца и выберите Пересчитать секвенцию в
открывшемся меню.

14.9.2 Загрузка сцены как Sub-Xsheet

Ранее сохраненные сцены OpenToonz могут быть загружены в Xsheet/Timeline как Sub-Xsheets.
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Каждый раз, когда сцена загружается как Sub-Xsheet ее содержимое импортируется в текущую базу
данных проекта в соответствии с папками проекта по умолчанию, так же, как если бы импортировался
каждый отдельный уровень (см. Использование Браузера файлов).

Это позволяет вам создать библиотеку основных анимаций, которые можно загружать и редактировать
в других Xsheet/Timeline, чтобы создавать более сложные анимации, не затрагивая исходные файлы
или рисунки. Даже если один и тот же Sub-Xsheet загружается дважды, он обрабатывается так, как
если бы были загружены два разных Sub-Xsheet, содержание и уровни которых можно редактировать
отдельно.

Чтобы сохранить порядок в базе данных, вы также можете активировать параметр Создавать под-
папки при импорте Sub-xsheet в диалоговом окне Настройки программы → Загрузка, который
автоматически создаст в папке проекта по умолчанию папку с именем Xsheet вы импортируете, куда
будут скопированы уровни из Sub-Xsheet.

Как только Sub-Xsheet загружен, его уровни доступны в Scene Cast в подпапке, названной как загру-
женная сцена.

Если настройки камеры сцены, загружаемой вами в качестве Sub-Xsheet, отличаются от настроек
вашей текущей сцены, вам будет предложено сохранить исходные настройки камеры Sub-Xsheet или
применить настройки камеры текущей сцены к Sub-Xsheet также.

Примечание: Если импортируемая сцена содержит файл, имя которого совпадает с именем файла,
уже существующего в целевой папке по умолчанию, вам будет предложено сохранить существующий
файл, перезаписать его новым или переименовать, добавив суффикс, который вы можете решить.
Таким образом, вы можете контролировать, были ли импортируемые вами файлы уже импортированы
ранее, или управлять файлами с одинаковыми именами.

Совет: Чтобы загрузить ранее сохраненную сцену в качестве Sub-Xsheet:

Выполните одно из следующих действий:

• Choose Level → Load Level. . . and use the browser to load a TNZ file.

• Choose File → Load As Sub-Xsheet. . . and use the browser to load a TNZ file.

• Use the OpenToonz standard browser to drag the scene icon to the Scene Cast pane, the
Xsheet/Timeline or the Viewer.

• В браузере файлов щелкните правой кнопкой мыши по значку сцены и выберите Загрузить как
Sub-xsheet в открывшемся меню.

Примечание: Файлы сцен OpenToonz также можно загружать, перетаскивая их из проводника
Windows или Finder macOS в Scene Cast, Xsheet/Timeline или в окно просмотра.

14.9.3 Разбиение Sub-Xsheet

Sub-Xsheet листы можно развернуть, чтобы автоматически перенести их содержимое в
Xsheet/Timeline, где они отображаются. При развертывании Sub-Xsheet можно по желанию пе-
ренести на основной Xsheet/Timeline, при необходимости, штифты, с которыми связаны столбцы.
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Примечание: Когда Sub-Xsheet разбит его столбцы/слои и связанные с ним ноды эффектов отобра-
жаются как группа в FX Schematic, чтобы лучше их извлечь (см. Использование Schematic FX ).

Примечание: Если эффекты применяются к столбцу/слою Sub-Xsheet, они не будут применяться к
разбитым столбцам, но отсоединенные FX ноды останутся в качестве ссылки в Schematic FX.

Совет: Чтобы разбить Sub-Xsheet:

1. Выберите столбец/слой Sub-Xsheet на Xsheet/Timeline или на Schematic.

2. Выполните одно из следующих действий:

• Choose Xsheet → Explode Sub-Xsheet.

• Right-click the Sub-Xsheet column header and choose Explode Sub-Xsheet from the menu that
opens.

3. Выберите, хотите ли вы перенести относительные штифты на основной Xsheet/Timeline или толь-
ко колонки/слои, затем нажмите кнопку ОК.

14.9.4 Сохранение Sub-Xsheet в качестве сцены

Содержимое Sub-Xsheet может быть сохранено как обыкновенная сцена, то есть файл TNZ, для за-
грузки в качестве отдельной сцены или для повторного использования в других сценах.

Содержимое Sub-Xsheet будет сохранено в соответствии с текущими настройками проекта для папок
по умолчанию, как если бы вы сохраняли файл сцены (см. Папки проекта по умолчанию).

Совет: Чтобы сохранить Sub-Xsheet как сцену:

1. Откройте Sub-Xsheet, который вы хотите сохранить, чтобы его содержимое отображалось на
Xsheet/Timeline.

2. Выберите пункт меню Сохранить Sub-xsheet как. . . и используйте браузер файлов для со-
хранения сцены (см. Сохранение и загрузка сцен ).

14.10 Создание звуковой дорожки

Audio clips can be loaded and edited in order to create a soundtrack for the scene; natively supported file
formats are non-compressed WAV and AIFF files at 8 and 16 bit. If FFmpeg is installed and configured in
Preferences. . . → Import/Export dialog section, MP3 audio files can be loaded too. There is no limit to the
number of audio clips that can be loaded in a scene.

Для загрузки аудиоклипа вы можете использовать браузер файлов; если аудиоклип импортирован,
он сохраняется в папке +extras (см. Использование обозревателя файлов). Загруженные аудиоклипы
также хранятся в папке Audio в Scene Cast.

Каждый загруженный аудиоклип отображается в отдельном столбце Xsheet или на слое Timeline в
виде серии видимых звуковых волн, что облегчает редактирование; количество кадров, которые оно
охватывает, зависит от длины аудиофайла и частоты кадров, заданной для текущей сцены. Например,
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аудиоклип длиной 3 секунды, импортированный в сцену с частотой кадров 12, будет занимать 36 кад-
ров; если он импортирован в сцену с частотой кадров 24, она будет занимать 72 кадра (см. Установка
частоты кадров).

Аудио столбцы/слои можно редактировать так же, как вы редактируете любой другой столбец/слой.
Его заголовок содержит следующую информацию о содержимом:

• Название, по умолчанию это номер столбца/слоя, в котором отображается аудио. Например,
Col5.
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• Переключатель видимости ( ) позволяющий включать или не включать содержимое зву-
кового столбца/слоя при рендере.

• Переключатель видимости камеры ( ) позволяет включать или не включать содержимое
столбца/слоя при очистке звука с помощью курсора текущего кадра (см. ниже).

• Блокировка переключения ( ) позволяет предотвратить любое редактирование в столб-
це/слое.

• Кнопка Дополнительные настройки столбцов ( ), позволяющая настроить громкость.

• Значок громкоговорителя, который позволяет воспроизводить содержимое.

Диалоговое окно Настройки уровня также доступно для аудиоклипов, позволяя проверить местопо-
ложение соответствующего файла или обновить путь загрузки в другое место или в другой файл (см.
Редактирование Настроек уровня).

Звуковая дорожка, которую вы определяете с помощью аудиоклипов, будет создана путем слияния
всего содержимого аудиоколонок/слоев в соответствии с громкостью, установленной для каждого из
них. Хотя его нельзя воспроизвести при использовании элементов управления воспроизведением в
окне просмотра, его можно очистить с помощью курсора текущего кадра в столбце кадров Xsheet,
линейке кадров Timeline или на панели кадров окна просмотра и воспроизвести при предварительном
просмотре сцены (см. Редактирование аудиоклипов и Предварительный просмотр анимации).

Когда сцена отображается в формате файла, поддерживающем аудио (MP4, MOV, WebM или AVI), в
файл включается звуковая дорожка (см. Рендеринг анимации).

Примечание: Аудиоклипы, загруженные в Sub-Xsheets, не будут включены в выходной саундтрек
(см. Использование Sub-Xsheet).

Примечание: As the soundtrack cannot be played back when viewing files in the OpenToonz flipbook,
you can activate the Use Default Viewer for Movie Formats option in the Preferences. . . → General
dialog section, in order to view files with their own default viewer, e.g. QuickTime for the MOV format, thus
playing back the soundtrack as well.

Совет: Чтобы воспроизвести содержимое аудио колонки/слоя назад:

Нажмите значок громкоговорителя, доступный в заголовке столбца/слоя. Нажмите еще раз, чтобы
остановить воспроизведение.

Совет: Чтобы установить громкость звукового столбца/слоя:

Нажмите кнопку Дополнительные настройки столбцов ( ) и используйте там ползунок громкости.

Совет: Включение или исключение аудио при очистке аудио с помощью курсора текущего
кадра

Нажмите на Переключатель видимости камеры ( ) в заголовке столбца/слоя. Если вы щелкнете
правой кнопкой мыши по переключателю, вы сможете выбрать команды в открывшемся меню, которые

266 Глава 14. Работа в Xsheet/Timeline



OpenToonz Documentation, Выпуск 1.7.1

позволят вам воздействовать на несколько столбцов/слоев одновременно.

Совет: Чтобы включить или исключить содержимое звукового столбца/слоя из ренде-
ринга:

Нажмите на Переключатель видимости ( ) в заголовке столбца/слоя. Если вы щелкнете правой
кнопкой мыши по переключателю, вы сможете выбрать команды в открывшемся меню, которые поз-
волят вам воздействовать на несколько столбцов/слоев одновременно.

Совет: Чтобы заблокировать или разблокировать содержимое столбца/слоя:

Нажмите Переключатель блокировки переключения ( ) в заголовке столбца/слоя. Если вы щелкнете
правой кнопкой мыши по переключателю, вы сможете выбрать команды в открывшемся меню, которые
позволят вам заблокировать или разблокировать несколько столбцов/слоев одновременно.

14.10.1 Редактирование аудиоклипов

После загрузки аудиоклипы можно перемещать вверх и вниз в столбце Xsheet, влево и вправо в слое
Timeline или в другой столбец/слой, чтобы воспроизводить их, начиная с определенного кадра ани-
мации. Их можно обрезать для выбора части всего клипа и отредактировать, удалив или скопировав
некоторые разделы, используя стандартные команды редактирования так же, как вы используете их
на стандартных уровнях.

Когда клип обрезан, обрезанная часть не удаляется, а скрывается, и у нее есть цветной горизонтальный
маркер в начале или конце, в зависимости от того, где он был обрезан: можно извлечь обрезанную
часть, переместив назад маркеры.

Когда клип разделяется на разделы с помощью операций удаления, вырезания или перемещения, он
автоматически дублируется и обрезается для получения правильного результата.

Примечание: Аудиоклипы можно перемещать и вставлять только в пустые столбцы/слои или в
другие звуковые столбцы/слои.

Примечание: Все редактирование не влияет на файл на диске, так как оно относится только к тому,
как клип используется в сцене.

Чтобы найти конкретный раздел в аудиофайле, вы можете проверить его, очистив его с помощью
курсора текущего кадра, либо в столбце фрейма Xsheet, линейке кадров Timeline, в панели кадров
окна просмотра, либо выбрав любой раздел и автоматически воспроизведя его вместе с анимацией.
Это позволяет вам легко найти и извлечь нужные фрагменты из аудиофайла.

Совет: Чтобы выбрать аудиоклипы:

Выполните одно из следующих действий:

• Нажмите и перетащите, чтобы выбрать раздел клипа.

• Удерживая клавишу Shift, щелкните по ячейке клипа, чтобы расширить выделение до этой ячей-
ки.
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• В Xsheet щелкните по вертикальной полосе слева от клипа, чтобы выделить весь клип.

• В Timeline щелкните по горизонтальной полосе, доступной в верхней части клипа, чтобы выде-
лить весь клип.

Совет: Чтобы редактировать аудиоклипы с помощью команд меню Правка:

Вы можете сделать следующее:

• Используйте команду Копировать, чтобы сохранить в памяти выбор для дальнейших операций.

• Используйте команду Вырезать, чтобы исключить выделение из Xsheet/Timeline и сохранить
его в памяти для дальнейших операций. Удаление ячеек приводит к смещению следующих ячеек
вверх в Xsheet или влево на Timeline.

• Используйте команду Вставить, чтобы вставить выделенную область из памяти в
Xsheet/Timeline, начиная с выбранной ячейки вставки. Команда вызывает смещение следующих
ячеек вниз в Xsheet или вправо на Timeline.

• Используйте команду Удалить, чтобы очистить выбранные ячейки от любой ссылки.

• Используйте команду Вставить, чтобы вставить пустые ячейки перед выделением; вставленных
ячеек будет столько же, сколько и выбранных.

Примечание: Все команды меню Правка также доступны в меню, которое открывается при щелчке
правой кнопкой мыши по ячейкам Xsheet/Timeline.

Совет: Чтобы переместить выделение клипа в Xsheet:

Выполните одно из следующих действий:

• Нажмите на вертикальную полосу слева от ячеек клипа и перетащите их, чтобы переместить в
новую позицию.

• Нажмите, зажав клавишу Ctrl (PC) или Cmd (Mac) по вертикальной полосе, доступной слева
от ячеек клипа, и перетащите их на новую позицию, дублируя их.

• Удерживая нажатой клавишу Shift, щелкните вертикальную полосу слева от ячеек клипа
и перетащите их на новую позицию, вставив их, если в ячейки назначения загружены другие
аудиоклипы.

• Удерживая нажатой клавишу Alt, нажмите на вертикальную полосу, расположенную слева
от ячеек клипа, и перетащите их на новую позицию, перезаписав любые другие аудиоклипы,
ранее загруженные в ячейки назначения.

Совет: Чтобы переместить выделение клипа на Timeline:

Выполните одно из следующих действий:

• Щелкните на горизонтальной полосе, доступной в верхней части ячеек клипа, и перетащите их,
чтобы переместить их на новую позицию.

• Нажмите, удерживая нажатой клавишу Ctrl (PC) или Cmd (Mac) по горизонтальной полосе,
доступной в верхней части ячеек клипа, и перетащите их на новую позицию, дублируя их.

268 Глава 14. Работа в Xsheet/Timeline



OpenToonz Documentation, Выпуск 1.7.1

• Удерживая клавишу Shift, щелкните по горизонтальной полосе, расположенной в верхней
части ячеек клипа, и перетащите их на новую позицию, вставив их, если в ячейки назначения
загружены другие аудиоклипы.

• Удерживая клавишу Alt, нажмите на горизонтальную полосу, расположенную в верхней части
ячеек клипа, и перетащите их в новую позицию, перезаписав любые другие аудиоклипы, ранее
загруженные в ячейки назначения.

Примечание: Когда невозможно отменить выделение, вместо выделения отображается красный кон-
тур.

Совет: Чтобы обрезать аудиоклип:

Выполните любое из следующих действий:

• Нажмите и перетащите начало клипа, чтобы обрезать его начальную часть.

• Нажмите и перетащите конец клипа, чтобы обрезать его конечную часть.

• Нажмите и перетащите маркер обрезанного клипа, чтобы переопределить обрезанную часть.

Совет: Чтобы очистить аудиоклипы:

Выполните одно из следующих действий:

• Перетащите курсор рамки Xsheet вверх или вниз, чтобы очистить все звуковые столбцы, для
которых активен переключатель Переключатель видимости камеры.

• Перетащите курсор на Timeline влево или вправо, чтобы очистить все звуковые слои, у которых
активен переключатель видимости камеры.

• Перетащите курсор кадров на панели окна просмотра, чтобы очистить все звуковые столбцы, для
которых активен переключатель видимости камеры.

• Только для Windows: в Xsheet нажмите и перетащите пунктирную вертикальную полосу, распо-
ложенную справа от ячеек звукового столбца, выбранный раздел будет автоматически воспроиз-
веден.

• Только для Windows: на Timeline нажмите и перетащите пунктирную горизонтальную полосу,
расположенную в нижней части ячеек звукового слоя, выбранный раздел будет автоматически
воспроизведен.

14.11 Lip Syncing

Когда вам нужно синхронизировать движение губ персонажа со звуком речи, вы можете воспользо-
ваться возможностью изучить аудиофайлы, загруженные в сцену.

После того как вы создали разные изображения рта, вы можете проанализировать аудиофайлы, чтобы
найти места для размещения определенных рисунков рта. Если рисунки рта принадлежат одному
единственному уровню анимации, вы можете быстро изменить рисунок рта в определенном кадре,
выбирая рисунки из Level Strip или перелистывая рисунки, используя одну из функций инструмента

Скелет ( ) ( см. Использование Level Strip и Анимация моделей).
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Разбивка аудиофайлов может быть выполнена путем просмотра звуковой волны в столбце сцены, на-
пример, чтобы определить, где начинается каждое слово; очисткой загруженных аудиоклипов курсо-
ром текущего кадра либо в панели кадров Xsheet/Timeline, либо в панели кадров окна просмотра; и
слушая определенные разделы аудио файлов.

Когда изображения рта размещены в нужном месте, вы можете проверить синхронизацию, вычистив
или снова выбрав интересующий вас раздел аудиофайла, потому что при прослушивании выбранного
раздела аудиозаписи зритель отобразит соответствующие кадры анимации.

Эту технику можно использовать в любом случае, когда вам нужно, чтобы звук был идеально синхро-
низирован с действием, например, персонаж играет на инструменте или сцена, основанная на ритме
музыки.

Совет: Чтобы очистить аудиоклипы:

Выполните одно из следующих действий:

• Перетащите курсор кадров Xsheet/Timeline вперед или назад, чтобы очистить все уровни звука,
у которых активен переключатель видимости камеры.

• Перетащите курсор кадров в окне просмотра, чтобы очистить все звуковые столбцы, для которых
активен переключатель видимости камеры.

• Только для Windows: щелкните и перетащите пунктирную полоску, доступную в ячейках уровня
звука: выбранный раздел будет автоматически воспроизведен.

Совет: Чтобы пролистать рисунки рта:

1. Выполните одно из следующих действий:

• Выберите в Xsheet или Timeline уровень анимации, содержащий рисунки рта.

• Щелкните правой кнопкой мыши в окне просмотра поверх рисунка рта, который хотите про-
листать, и выберите команду Выбрать, относящуюся к столбцу/слою, содержащему рисунок,
который вы щелкнули.

2. Выберите инструмент Скелет ( ) и установите режим инструмента на Анимировать.

3. В окне просмотра щелкните метку с именем уровня справа от точки поворота текущего раздела
и пролистайте следующие и предыдущие кадры, выполнив одно из следующих действий:

• Перетащите вверх или вниз.

• Нажмите стрелки вверх или вниз.

14.11.1 Automated Lip-Synching using Rhubarb

Automatic lip-sync can be obtained by using the Rhubarb software (which is not bundled with OpenToonz,
and must be separately installed and then configured in Preferences window, as explained in ??? section).
The Auto Lip-Sync feature can analyze an audio track and automatically expose the appropriate drawing
for each phoneme in the audio to the corresponding cells in the Xsheet/Timeline.
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Совет: To apply auto lip-sync to a column/layer:

1. Load the audio track onto its own column/layer, if it is not already there (right-click on the cell the
audio should begin and select «Load Level»).

2. Выставьте в Xsheet/Timeline хотя бы один рисунок уровня, содержащий набор форм рта.

3. Select the cell of the column/layer where you want the lip sync to start, and using the right-click menu,
choose the Lip Sync → Apply Auto Lip Sync to Column option.

4. In the Auto Lip Sync Dialog, choose the desired Xsheet/Timeline audio column/layer or a supported
audio file from disc, by using the Audio Source drop-down menu.

Примечание: Press play to preview the track if needed.

Примечание: You can optionally type a transcript of the spoken words in the Audio Script field, which
will help improve the accuracy of the lip syncing result.

5. Choose which level drawings to assign to each phoneme using the arrow buttons below each phoneme.

Примечание: Rhubarb utilizes its own phonemes that have been interpreted as Preston Blair phonemes,
without a unique phoneme for WQ.

6. Click the «Apply» button
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14.11.2 Импорт файлов Papagayo-NG

Можно импортировать в Xsheet/Timeline DAT файлы, экспортированные из Papagayo-NG, инструмен-
та синхронизации губ и анимации.

While Papagayo-NG takes care of the audio file analysis and phoneme recognition, importing the DAT file into
OpenToonz allows you to assign a frame from an animation level to each phoneme and automatically expose
the result in an Xsheet column or Timeline layer; to be able to hear the synced sound, the correspondent
sound level should be manually loaded too.

Совет: Чтобы экспортировать файл синхронизации губ OpenToonz в Papagayo-NG:

1. В Papagayo-NG в раскрывающемся меню Export: выберите MOHO.

2. Нажмите кнопку Export, чтобы экспортировать файл .DAT.

Совет: Чтобы импортировать файл Papagayo-NG:

1. Выставьте в Xsheet/Timeline хотя бы один рисунок уровня, содержащий набор форм рта.

2. Select the cell of the column/layer where you want the lip sync to start, and using the right click menu
choose the Apply Lip Sync Data to Column option or from Xsheet → Apply Lip Sync Data
to Column.

3. Откроется диалоговое окно, позволяющее выбрать рисунки уровней для каждой фонемы.

4. Используйте браузер Файл данных липсинк:, чтобы получить файл DAT, который вы экспор-
тировали из Papagayo-NG, и нажмите кнопку Выбрать.

5. Параметр Вставить в кадр: уже должен показывать номер кадра ячейки, которую вы ранее
выбрали. Тем не менее, вы можете изменить его, чтобы синхронизация губ начиналась с другого
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кадра.

6. Активируйте Растянуть рисунок закрытого рта до конца маркера, если вы хотите скопи-
ровать закрытый рот во все оставшиеся кадры между окончанием синхронизации загруженной
губы и кадром, где установлен конечный маркер Xsheet/Timeline.

7. Нажмите кнопку Применить.

14.11.3 Импорт файлов Magpie

Можно импортировать в файлы Xsheet/Timeline .TLS (например, Toonz Lip Sync), экспортированные
из Magpie, инструмента синхронизации губ и анимации.
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В то время как Magpie занимается анализом аудиофайлов и распознаванием фонем, импорт файла .TLS
в OpenToonz позволяет назначать кадры с уровня анимации для каждой фонемы и автоматически отоб-
ражать результат в столбце Xsheet или слое Timeline; дополнительный столбец/слой, отображающий
речевой текст (как распознано в Magpie), создается для справки.

Совет: Чтобы экспортировать файл синхронизации губ OpenToonz в Magpie:

1. Скопируйте файл export-toonz.lua, находящийся в папке OpenToonz stuff\config, в папку
C:\Program Files (x86)\Third Wish Software & Animation\Magpie Pro\Scripts\Export.

2. В Magpie выберите File → Export и выберите Toonz в списке 2D-программ для экспорта файла
TLS.

Совет: Для импорта файла Magpie:

1. Choose File → Import Toonz Lip Sync File. . . .

2. В открывшемся браузере найдите файл TLS, который вы экспортировали из Magpie, и нажмите
кнопку Загрузить.

3. В открывшемся диалоговом окне выберите следующее:

• Используйте Диапазон кадров, чтобы определить, какой раздел файла Magpie вы хотите ис-
пользовать для создания столбца синхронизации губ в Xsheet/Timeline.

• Используйте раздел Уровень анимации, чтобы получить уровень анимации, который вы хотите
показать в Xsheet/Timeline, и указать, какой кадр уровня должен быть назначен каждой фонеме;
Вы также можете использовать окно просмотра, доступное в нижней части диалогового окна,
чтобы просмотреть кадры выбранного уровня анимации.

4. Нажмите кнопку Импорт.

14.12 Использование заметок

Записки могут быть размещены в Xsheet/Timeline в определенных местах, чтобы добавлять заметки
и комментарии к сцене.
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При редактировании заметки можно установить ее цвет, а текст, который вы пишете, можно отфор-
матировать. После публикации заметки отображают первые буквы их содержимого, чтобы их можно
было идентифицировать, и их можно найти в Xsheet/Timeline, перемещаясь по ним.

Совет: Чтобы опубликовать заметку:

1. Нажмите кнопку Добавить новую заметку в верхней части столбца с номерами кадров в
Xsheet (или в верхней части заголовков слоев на временной шкале).

2. Введите текст заметки в открывшемся окне, отформатируйте его и выберите цвет заметки (см.
ниже), затем нажмите кнопку Прикрепить: заметка размещается в текущем кадре в текущем
столбце.

3. Нажмите и перетащите опубликованную заметку, чтобы изменить ее положение.

Совет: Чтобы отформатировать текст в заметке:

1. Выберите текст, который вы хотите отформатировать.

2. Нажмите стрелку ( ), отображаемую справа от выделения, чтобы открыть текстовую панель
инструментов.
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3. Выберите семейство шрифтов, размер, цвет, стиль и выравнивание абзаца, нажав на соответству-
ющее меню и кнопки на панели инструментов текста.

Совет: Чтобы изменить цвет заметки:

Выберите цвет в палитре, доступной внизу открытой заметки; цвета палитры также можно выбирать
и редактировать с помощью редактора стилей.

Совет: Для навигации по заметкам, опубликованным в Xsheet:

Нажмите кнопки со стрелками рядом с кнопкой Добавить новую заметку, чтобы проверить преды-
дущую или следующую заметку: Xsheet/Timeline автоматически перемещается, чтобы показать, где
размещена выбранная заметка.

Совет: Чтобы открыть заметку:

Выполните одно из следующих действий:

• Дважды щелкните по ней.

• Щелкните правой кнопкой мыши и выберите Открыть заметку в открывшемся меню.

Совет: Чтобы удалить заметку:

Выполните одно из следующих действий:

• Откройте его и нажмите кнопку Сбросить.

• Щелкните правой кнопкой мыши и выберите Удалить заметку в открывшемся меню.
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14.13 Сохранение и загрузка сцен

При работе с новой сценой имя по умолчанию (без названия), за которым следует возрастающий
номер, присваивается сцене до тех пор, пока вы не сохраните ее под другим именем. Это имя также
используется в случае, если переменная $scenepath используется в настройках проекта для временного
хранения материала, используемого в сцене.

Примечание: Сцена без названия и связанный материал хранятся в папке OpenToonz
stuff\projects\temp и удаляются, когда сцена сохраняется с правильным именем или не сохраня-
ется вообще. Регулярно проверяйте папку temp и, если она есть, удаляйте ее, чтобы освободить место
на диске.

Файлы сцены могут быть сохранены и загружены как файлы TNZ с помощью соответствующих команд
меню. Сцены должны быть сохранены в папке +scenes текущего проекта или в любой из ее подпапок,
чтобы извлечь весь материал, когда они загружены обратно.

При использовании команды Сохранить как. . . , если в определении папок по умолчанию использует-
ся $scenepath, весь материал, используемый в сценах и расположенный в папках проекта по умолчанию,
будет дублироваться в папках, связанных с новой сценой (см. Использование переменной $scenepath в
определении папки).

An option Save Automatically allows to save the scene every given number of minutes, and is available in
the Preferences. . . → Saving dialog section. If the option is activated, during the saving operation a message
is displayed to notify the process.

Примечание: Звездочка справа от названия сцены в заголовках Окна просмотра и Xsheet/Timeline
указывает на наличие несохраненных изменений текущей сцены.

Совет: Для работы над новой сценой:

Выберите пункт меню Файл → Новая сцена.

Совет: Чтобы сохранить сцену и все связанные с ней уровни:

Выберите пункт меню Файл → Сохранить все.

Совет: Чтобы сохранить сцену:

Выберите Файл → Сохранить сцену.

Совет: Чтобы сохранить текущую сцену под другим именем:

1. Выберите Файл → Сохранить сцену как. . .

2. В открывшемся браузере выберите папку +scenes текущего проекта или любую из его подпапок,
в которую вы хотите сохранить сцену.

3. Присвойте имя сцене и нажмите кнопку Сохранить.
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Совет: Чтобы загрузить сцену из окна Загрузить сцену:

1. Выберите Файл → Загрузить сцену. . .

2. В открывшемся браузере выберите в папке +scenes текущего проекта или в любой из его подпапок
сцену, которую вы хотите загрузить, и нажмите кнопку Загрузить.

Совет: Чтобы загрузить сцену из стандартного браузера OpenToonz:

Выполните одно из следующих действий:

• Щелкните правой кнопкой мыши по значку сцены и выберите Загрузить сцену. . . в открыв-
шемся меню.

• Перетащите значок сцены на значок хлопушки в окне Scene Cast.

Примечание: Сцены также можно загружать, перетаскивая их из Проводника Windows или mac OS
Finder на значок хлопушки в Scene Cast.

Совет: Чтобы загрузить недавно загруженную сцену:

Выберите Файл → Открыть предыдущую сцену, затем выберите сцену, которую вы хотите загру-
зить, из доступного подменю.

Совет: Чтобы вернуть текущую сцену к последней сохраненной версии:

Выберите пункт меню Файл → Откатить сцену.

Совет: Чтобы автоматически сохранять сцену каждые несколько минут:

1. Choose File → Preferences. . . → Saving.

2. Активируйте параметр Сохранять автоматически и введите количество минут, которое долж-
но пройти между каждой операцией сохранения.

3. Выберите одну или обе опции чтобы Сохранять файл сцены или Сохранять файлы без сцены.

14.14 Импорт и экспорт сцен

В OpenToonz каждый файл сцены принадлежит определенному проекту, так что материал, созданный
и используемый в сцене, находится и может быть получен из папок проекта по умолчанию.

Если вам нужно скопировать сцену и связанный материал в другой проект, можно либо импортировать
любой файл сцены в текущем проекте, либо экспортировать его в любой другой проект, доступный в
корне проекта (см. Настройка проектов).
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14.14.1 Импорт сцен из другого проекта

При попытке загрузить сцену, созданную в другом проекте или не находящуюся в папке +scenes теку-
щего проекта или любой из ее подпапок, вам будет предложено решить, хотите ли вы импортировать
сцену (Импорт сцены) или измените текущий проект (Сменить проект) (см. Настройка проектов).

Если вы решите импортировать сцену, сцена будет загружена, и весь материал сцены будет импорти-
рован следующим образом:

• Все файлы, которые были расположены в исходных папках проекта по умолчанию (то есть, за-
гружены в сцену с использованием относительных путей), будут скопированы в соответствующие
папки по умолчанию текущего проекта (см. Папки проекта по умолчанию).

• Все файлы, которые были расположены во внешних папках (т.е. загруженные в сцену с исполь-
зованием абсолютных путей), останутся там, где они есть.

While the material is automatically imported and saved in the current project, the scene file will not be
saved until you will save it by using the Save Scene or Save Scene As. . . commands.

It is also possible to import one or several scenes into the current project with no need to load and save
them by using the Import Scene command.

В этом случае и файлы материалов, расположенные в исходных папках исходного проекта, и файл
сцены будут скопированы в соответствующие папки по умолчанию текущего проекта.

Примечание: Если импортируемая сцена содержит файл, имя которого совпадает с именем файла,
уже существующего в целевой папке по умолчанию, вам будет предложено сохранить существующий
файл, перезаписать его новым или переименовать, добавив суффикс, который вы можете решить.
Таким образом, вы можете контролировать, были ли импортируемые вами файлы уже импортированы
ранее, или управлять файлами с одинаковыми именами.

Совет: Чтобы загрузить и импортировать сцену из другого проекта:

1. Загрузите сцену, которую вы хотите импортировать, используя браузер Загрузить сцену. . . или
стандартный браузер файлов OpenToonz.

2. Выберите Импортировать сцену в открывшемся диалоговом окне: сцена загружена, и связан-
ные файлы будут скопированы в стандартные папки текущего проекта.

3. Сохраните файл сцены в папке текущего проекта +scenes

Совет: Чтобы импортировать одну или несколько сцен из другого проекта, не загружая
их:

1. Загрузите сцену, которую вы хотите импортировать, используя браузер Загрузить сцену. . . или
стандартный браузер OpenToonz.

2. Выберите Импортировать сцену в открывшемся диалоговом окне: сцена загружена, и связан-
ные файлы будут скопированы в стандартные папки текущего проекта.

14.14.2 Экспорт сцен в другой проект

Сцены можно экспортировать, если вам нужно либо скопировать их из проекта в любой другой суще-
ствующий проект, либо скопировать их в новый проект, который может быть автоматически создан в
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соответствии с текущими настройками проекта.

В обоих случаях файлы сцен и связанные с ними ресурсы будут автоматически собраны и скопированы
в соответствующие папки по умолчанию целевого проекта (см. Сбор активов).

Примечание: Если экспортируемая сцена содержит какой-либо файл, имя которого совпадает с
именем файла, уже существующего в целевой папке по умолчанию, вам будет предложено сохранить
существующий файл, перезаписать его новым или переименовать, добавив суффикс, который вы мо-
жете решить. Таким образом, вы можете контролировать, если экспортируемые вами файлы уже были
экспортированы ранее, или управлять файлами с одинаковыми именами.

Совет: Чтобы экспортировать одну или несколько сцен в другой проект:

1. Выберите сцены, которые вы хотите экспортировать, в стандартном браузере OpenToonz.

2. Щелкните правой кнопкой мыши выделенную область и выберите Экспортировать сцену. . .
в открывшемся меню: откроется диалоговое окно Экспортировать сцену.

3. В диалоговом окне выполните одно из следующих действий:

• Выберите опцию Выберите существующий проект, если вы хотите экспортировать выбран-
ные сцены в существующий проект, затем перейдите в дерево папок и выберите целевой проект.

• Выберите параметр Создать новый проект, если вы хотите экспортировать выбранные сцены
в новый проект на основе текущего, а затем назначьте имя для нового проекта.

4. Нажмите кнопку Экспорт.
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14.14.3 Сбор активов

Файлы, используемые в сцене, могут быть расположены в папках по умолчанию текущего проекта
или загружены из внешней папки (см. Папки проекта по умолчанию и Использование обозревателя
файлов) .

Это означает, что когда проекту по какой-либо причине необходимо изменить местоположение (напри-
мер, для резервной копии), перемещение всех папок по умолчанию не гарантирует, что все файлы,
необходимые для сцен проекта, будут перемещены, поскольку файлы, загруженные из внешних папок,
останутся там, где они есть.

По этой причине возможно собрать все файлы, используемые в сцене, таким образом, автоматически
импортируя в папки проекта по умолчанию все файлы, которые не были импортированы во время за-
грузки. В то же время файл сцены, для которого вы собираете ресурсы, будет автоматически обновлен,
чтобы исправить все пути загрузки вновь импортированных файлов, чтобы сохранить согласованность.

Совет: Чтобы собрать активы одной или нескольких сцен:

1. Выберите сцены, для которых вы хотите собрать активы.

2. Щелкните правой кнопкой мыши выделенную область и выберите Собрать активы в открыв-
шемся меню: все файлы сцены, находящиеся во внешних папках, копируются в стандартные
папки проекта, а также связанные пути, используемые в файлах сцены. обновляются.

14.14.4 Файлы резервных копий сцены

При сохранении сцен файлы резервных копий предыдущих версий автоматически сохраняются в папке
с именем сцены, которая находится в +scenes\backups текущего проекта.

Четыре предыдущих версии сцены сохраняются и называются сценой с порядковым номером резервной
копии: чем больше число, тем более свежая резервная копия.

Например, если вы семь раз сохранили сцену с именем моя_сцена, 4 резервные версии сцены с именем
моя_сцена_3, моя_сцена_4, моя_сцена_5 и моя_сцена_6 доступны в папке +scenes\backups\моя сцена.

Если вы хотите восстановить резервную копию сцены сцены, вам нужно удалить номер резервной
копии, чтобы иметь правильное имя сцены, и переместить файл в папку +scenes.

Совет: Для восстановления резервной версии сцены:

1. Извлеките в +scenesbackups папку, названную в качестве сцены, резервную копию которой вы
хотите восстановить.

2. В папке найдите файл TNZ, связанный с последней резервной копией, которую вы хотите вос-
становить, и переименуйте его, удалив номер резервной копии, чтобы получить правильное имя
сцены.

3. Скопируйте и вставьте его в папку +scenes, чтобы заменить версию, которую вы хотите очистить.
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14.15 Печать Xsheet

Xsheet можно сохранить в виде HTML-файла, чтобы просмотреть его на любом компьютере с помощью
интернет-браузера и распечатать на бумаге.

HTML-файл содержит заголовок с общей информацией, несколько таблиц, длину и ширину которых
вы можете выбрать, представляющих Xsheet с открытыми уровнями и движениями объектов, и список
уровней, представленных в Xsheet, с соответствующим расположением на диске.

Если в сцене используются какие-либо Sub-Xsheet, они отображаются после основного листа Xsheet,
где они выставлены.

Информация, отображаемая в заголовке и внешнем виде таблицы HTML, может быть
задана путем редактирования следующих файлов, расположенных в папке OpenToonz
stuff\profile\layouts\settings :

• xsheet_html.xml содержит информацию, используемую для заголовка HTML-листа Xsheet, и
размер таблиц, используемых для представления содержимого Xsheet.

• xsheet.css - это файл каскадных таблиц стилей, который используется для определения цветов,
макета и других аспектов файла HTML Xsheet (см. ниже).

При использовании команды Экспортировать Xsheet в HTML отображается диалоговое окно с инфор-
мацией о расположении и имени сгенерированного файла HTML; затем сгенерированный файл HTML
отображается в браузере по умолчанию.

Файл HTML сохраняется в том же месте, что и файл TNZ; CSS-файл, используемый для его фор-
матирования, также генерируется путем копирования файла, расположенного в папке OpenToonz
stuff\profile\layouts\settings. Если файл CSS уже доступен в том месте, где сохранен файл HTML
Xsheet, он будет использоваться вместо создания нового.

Примечание: Если вы хотите переместить файл HTML Xsheet, вам следует также переместить файл
CSS, чтобы сохранить внешний вид файла HTML, определенный в файле CSS.

14.15.1 Редактирование заголовка HTML Xsheet и размера таблицы

Заголовок Xsheet в формате HTML и размер таблиц, используемых для представления содержимо-
го Xsheet, можно определить, отредактировав файл xsheet_html.xml, доступный в папке OpenToonz
stuff\profile\layouts\settings. Его можно редактировать с помощью любого текстового редакто-
ра, например, Блокнот или TextEdit.

Весь текст включен в тег xsheet_html, который содержит элементы page и info, где определены
разные пользователи и роли. Основная структура файла выглядит следующим образом:

<xsheet_html>
<page rows="50">
<page columns="10">
<info name="Company" value="Company name"/>
<info name="Name" value="Value"/>

</xsheet_html>

Отредактировав значения page row и page columns, вы можете установить размер таблицы, исполь-
зуемой для разбиения Xsheet по разделам. Размер таблицы позволяет подогнать каждый раздел листа
Xsheet к размеру бумаги, который вы хотите использовать для печати листа Xsheet на бумаге.
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Строки info позволяют установить информацию, которая будет отображаться в заголовке, например,
название производства.

В файле примера вы можете найти следующие строки:

<info name="Company" value="Company name"/>
<info name="Name" value="Value"/>

Эти строки можно редактировать и добавлять новые строки с тем же синтаксисом, чтобы предоставить
всю информацию, которую вы хотите отобразить в заголовке файла HTML Xsheet.

Примечание: По умолчанию заголовок содержит имена Project и Scene и количество кадров, из
которых состоит сцена; эта информация не может быть отредактирована, так как они автоматически
извлекаются из файла сцены.

Примечание: Файл xsheet_html.xml должен быть правильно сформирован, и поэтому он не может
содержать открывающий тег без связанного с ним закрывающего тега, иначе OpenToonz не запустится.
Если вы решите отредактировать файл xsheet_html.xml, сначала сделайте резервную копию на тот
случай, если вам потребуется вернуть файл к исходной версии.

Совет: Чтобы редактировать файл xsheet_html.xml

Откройте файл xsheet_html.xml, доступный в папке OpenToonz stuff\profile\layouts\settings с
помощью текстового редактора (например, Notepad или TextEdit).

Совет: Чтобы изменить размер таблицы, используемой для разбиения Xsheet на разделы:

Измените значения page row и page columns в файле xsheet_html.xml.

Совет: Для редактирования информации, отображаемой в шапке:

Отредактируйте строки info, доступные в файле xsheet_html.xml, и добавьте новые, если это необ-
ходимо.

Совет: Чтобы проверить, правильно ли сформирован файл xsheet_html.xml:

Откройте его с помощью интернет-браузера и проверьте, отображаются ли все элементы во вложен-
ном списке, где их можно открывать и закрывать для отображения или скрытия соответствующего
содержимого.

14.15.2 Редактирование внешнего вида HTML Xsheet

Внешний вид HTML Xsheet можно определить, отредактировав файл xsheet.css, доступный в папке
OpenToonz stuff\profile\layouts\settings.

Xsheet.css - это файл каскадных таблиц стилей, который используется для определения цветов, макета
и других аспектов файла HTML Xsheet. Его можно редактировать с помощью любого текстового
редактора, например, Блокнот или TextEdit.
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Редактирование файла CSS требует определенных навыков в языке CSS, но некоторые изменения,
такие как толщина таблицы или цвета ячеек, могут быть легко выполнены путем выражения толщины
в пикселях и цветах в виде триплета RGB в шестнадцатеричном формате.

Элементы, определенные в CSS, следующие:

• header относится к таблице, используемой в качестве заголовка в файле HTML Xsheet.

• table относится к таблице, используемой для отображения разделов Xsheet.

• TH относится к ячейкам заголовка таблиц.

• first_numeric относится к первому числовому столбцу таблиц Xsheet.

• fxcell относится к ячейкам таблицы, принадлежащим к столбцам эффектов.

• subxsheetcell относится к ячейкам таблицы, принадлежащим столбцам Sub-Xsheet.

• TD относится к общим ячейкам таблицы.

• TH.frame относится к столбцу кадра

• TD.levelcell относится к ячейкам таблицы, принадлежащим столбцам стандартного уровня.

Примечание: Файлы CSS должны быть написаны в соответствии с определенным синтаксисом. Если
вы решите отредактировать файл xsheet.css, сначала сделайте резервную копию на тот случай, если
вам потребуется вернуть файл к исходной версии.

Совет: Для редактирования файла xsheet.css:

Откройте файл xsheet.css, доступный в папке OpenToonz stuff\profile\layouts\settings с помо-
щью приложения для текстового редактора (например, Notepad или TextEdit).
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Глава 15

Создание движений

Каждая сцена имеет набор объектов, которые могут быть преобразованы; это могут быть столбцы
Xsheet (или слои Timeline), штифты, камеры или стол.

Каждое преобразование, которое вы устанавливаете для объекта в определенном кадре, автоматически
определяет ключевой кадр. Когда ключевые кадры определены в нескольких кадрах, промежуточные
позиции автоматически интерполируются.

Чтобы создавать более сложные анимации, вы также можете работать в трехмерной среде, где камеры
и элементы сцены можно размещать как на сцене на разных расстояниях друг от друга.

15.1 Использование Схемы сцены

Схема сцены содержит ноды всех объектов, используемых в сцене, что позволяет управлять их связями
друг с другом. Она организована в иерархию, начиная с анимационного стола, где размещены все
столбцы/слои и штифты. Камера также доступна, и дополнительные камеры могут быть определены.
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По умолчанию Схема сцены содержит узел таблицы и один узел камеры.

Узлы столбца/слоя добавляются, как только вы загружаете или создаете некоторый контент; штифты
и камеры могут быть добавлены в любое время (штифты будут автоматически связаны со столом).

Когда создано более одной камеры, вы можете установить, какая из них будет активной в Окне про-
смотра; активный узел камеры отображается синим цветом, а остальные неактивны серым. Каждая
камера может иметь различный размер и разрешение, и каждая из них может быть анимирована
независимо (см. Определение настроек камеры).

Узлы объектов могут быть легко добавлены и упорядочены, и их можно выбрать для вырезания,
копирования, вставки или удаления. Когда выбрано, ребра узлов выделены белым; текущая метка
узла отображается желтым цветом; если выбран хотя бы один узел, связанные ссылки отображаются
синим цветом.

Также возможно сгруппировать несколько узлов в один узел, чтобы лучше управлять сложной схе-
мой этапов. Группы могут быть открыты для изучения, и их компоненты могут быть выбраны для
дальнейших операций, таких как создание анимации или новых групп.

Примечание: Узлы столбцов/слоев имеют кнопки, определяющие их видимость в представлениях

Стандартный вид с камеры ( ) и Рендер ( ), эти кнопки расположены в верхнем правом углу
узлов: переключатели связаны с доступны в заголовках столбцов Xsheet (слои Timeline) (см. Работа

288 Глава 15. Создание движений



OpenToonz Documentation, Выпуск 1.7.1

со столбцами Xsheet).

Совет: Для доступа к Cхеме сцены:

• Перейдите в меню Окна и выберите Схема.

• При необходимости нажимайте кнопку Переключение схемы FX ( ) в нижней панели Схема
сцены, пока в строке заголовка не отобразится Stage Schematic.

Совет: Для навигации по схеме сцены:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте кнопку По размеру окна ( ) в нижней панели окна сцены, чтобы отобразить
все объекты в текущем окне.

• Используйте кнопку Фокус на текущем ( ) в нижней панели окна сцены, чтобы центрировать
сцену на текущем объекте.

• Используйте кнопку Изменение порядка узлов ( ) в нижней панели окна рабочей области,
чтобы изменить положение узлов в схеме на расположение по умолчанию.

• Используйте кнопку Сбросить размер ( ) в нижней панели окна сцены или используйте
горячую клавишуа (по умолчанию клавиша 0), чтобы отобразить все объекты с размером по
умолчанию.

Совет: Чтобы добавить столбец/слой:

Загрузите или создайте некоторый контент для столбца Xsheet (слоя Timeline): он будет автоматически
отображаться в схеме сцены.

Совет: Чтобы добавить штифты:

Выполните одно из следующих действий:

• Нажмите кнопку Новый Pegbar ( ) в нижней панели окна Схемы сцены.

• Щелкните правой кнопкой мыши в Stage Schematic и выберите Новый Pegbar в открывшемся
меню.

Совет: Чтобы добавить камеру:

Выполните одно из следующих действий:

• Нажмите кнопку Новая камера ( ) в нижней панели окна Схема сцены.
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• Щелкните правой кнопкой мыши на схеме сцены и выберите Новая камера в открывшемся
меню.

Совет: Чтобы установить активную камеру:

В Cхеме сцены щелкните правой кнопкой мыши узел камеры, который вы хотите установить в качестве
активного, и выберите Активировать в открывшемся меню.

Совет: Чтобы переименовать объект:

Щелкните два раза по имени узла зажав клавишу Ctrl и введите новое имя.

Совет: Чтобы свернуть или развернуть узлы столбцов/слоев:

Выполните одно из следующих действий:

• Нажмите кнопку со стрелкой слева от имени узла, чтобы выборочно свернуть/развернуть его.

• Нажмите кнопку Максимизировать узлы ( ) в нижней панели Stage Schematic , чтобы свер-
нуть/развернуть все узлы.

Совет: Для выбора объектов и ссылок:

Выполните одно из следующих действий:

• Нажмите, чтобы выбрать объект.

• Нажмите и перетащите, чтобы выбрать группу объектов.

• Кликните, зажав клавишу Ctrl (PC) или Cmd (Mac), чтобы добавить объект или удалить его из
выделения.

Примечание: Ссылки можно выбирать вместе с объектами (см. Связывание объектов).

Совет: Чтобы переместить выделение:

Нажмите и перетащите любой объект выделения.

Совет: Чтобы изменить выделение объектов:

Выполните одно из следующих действий:

• Используйте команду Копировать, чтобы сохранить выбор в памяти для дальнейших операций.

• Используйте команду Вырезать, чтобы исключить выбор узлов из Stage Schematic и сохранить
их в памяти для дальнейших операций.

• Используйте команду Вставить, чтобы вставить выделенную область, сохраненную в памяти в
Cхеме сцены: вставленная выделенная область будет связана с тем же объектом, с которым были
связаны скопированные или вырезанные объекты.

290 Глава 15. Создание движений



OpenToonz Documentation, Выпуск 1.7.1

• Используйте команду Удалить, чтобы удалить выбор.

Примечание: Все эти команды доступны в меню, которое открывается при щелчке правой кнопкой
мыши узлов и ссылок.

Примечание: Стол и камера по умолчанию не могут быть удалены из Stage Schematic.

Совет: Сгруппировать выбранные объекты:

Щелкните правой кнопкой мыши любые выбранные узлы и выберите Сгруппировать в открывшемся
меню.

Примечание: Узлы могут быть сгруппированы, только если они совместно используют родительский
узел, а родительский узел включен в выделение.

Совет: Чтобы открыть группу:

Щелкните правой кнопкой мыши группу и выберите Открыть группу в открывшемся меню: объекты
группы отображаются в окне, показывая ссылки между узлами группы и ссылки с узлами вне группы.

Примечание: В Stage Schematic, когда отображается содержимое группы, невозможно редактировать
ссылки между узлами группы и ссылки с узлами вне группы.

Совет: Чтобы закрыть группу:

Нажмите кнопку Закрыть справа на панели группового блока.

Совет: Чтобы разгруппировать группу:

Щелкните правой кнопкой мыши группу и выберите Разгруппировать в открывшемся меню.

Совет: Чтобы изменить порядок узлов в Stage Schematic:

Нажмите кнопку Изменение порядка узлов ( ) в нижней панели окна сцены.

15.2 Связывание объектов

Объекты могут быть связаны, чтобы создавать общие движения (движения, которые все связанные
объекты делят с родительским объектом) и относительные движения (движения, которые являются
суммой собственного движения объекта и движения его родительского объекта).
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Поскольку родительские объекты, в свою очередь, могут быть связаны с другими движущимися объ-
ектами, можно определить сложную иерархию преобразований.

Иерархия между объектами может быть отредактирована путем установки ссылок, которые позволяют
вам устанавливать родительские и связанные объекты: столбцы/слои могут быть связаны с другими
столбцами/слоями, штифтами, таблицей или камерами; штифты могут быть связаны с другими штиф-
тами, таблицей или камерами; камеры могут быть связаны с любым объектом для создания сложных
снимков, например, с помощью камеры, следящей за движением персонажа в сцене.

Ссылки могут быть установлены с помощью портов, расположенных на каждой стороне узла объекта:

• порт слева предназначен для связывания объекта с родительским объектом.

• порт справа предназначен для связывания объекта с дочерним объектом.

• порт в нижней части предназначен для назначения объекту траектории движения, по ко-
торой следует следовать (см. Создание движения по траектории движения).

Ссылки также могут быть выбраны для удаления: при выборе ссылки подсвечиваются; когда выбран
хотя бы один объект, связанные ссылки отображаются синим цветом.

Столбцы/слои и штифты всегда связаны, по крайней мере, с таблицей: это означает, что их ссылки
не могут быть удалены, но могут быть заменены только другими или восстановлены по умолчанию:
таблица.

Совет: Чтобы связать узел с другим:

В Stage Schematic щелкните и перетащите с левого порта узла на правый порт родительского узла или
наоборот.

Совет: Чтобы связать столбец/слой с другим объектом:

Выполните любое из следующих действий:

• Определите ссылку в схеме сцены.

• Выберите Инструмент Анимирования ( ) с параметром Выбрать:, установленным на Стол-
бец, и в окне просмотра кликните, удерживая нажатой клавишу Shift содержимое столбца,
к которому нужно связать текущий столбец.

Совет: Чтобы выбрать связанный объект для редактирования в иерархии:

Выполните одно из следующих действий:

• Выберите его в схеме сцены.

• Используйте Инструмент Анимирования ( ) с параметром Выбрать:, установленным на
Pegbar, чтобы щелкнуть рисунок в окне просмотра и выбрать первый pegbar в иерархии в столб-
це, содержащем связанный рисунок.

• Щелкните правой кнопкой мыши рисунок в окне просмотра, чтобы выбрать из меню, которое
открывает команду Выбрать, связанную с объектом, который вы хотите редактировать.

Совет: Для выбора ссылок:

Выполните одно из следующих действий:
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• Нажмите, чтобы выбрать ссылку.

• Нажмите и перетащите, чтобы выбрать несколько ссылок.

• Кликните, зажав клавишу Ctrl (PC) или Cmd (Mac), чтобы добавить ссылку или удалить ее из
выделения.

Примечание: Объекты могут быть выбраны вместе со ссылками (см. Использование схемы сцены).

Совет: Чтобы удалить выбранные ссылки:

Выберите пункт меню Правка → Удалить, ссылки будут заменены ссылками по умолчанию (т.е. на
стол).

15.2.1 Расширенные ссылки

Опционально, порты соединителей могут отображаться в виде букв (вместо кружков по умолчанию),
чтобы иметь возможность более сложным образом контролировать положение центров, которые будут
использоваться при связывании узлов:
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• Центр B - это геометрический центр каждого объекта (и вариант подключения по умолчанию).

• Центр A расположен на 8 дюймов влево.

• Центр C расположен на 8 дюймов вправо.

• и так далее.

Когда ссылка создается, буквы на ее концах определяют способ, которым связанный объект перекры-
вается с родительским объектом. Если на обоих концах ссылки вы установите одну и ту же букву, два
объекта будут перекрываться без смещения относительно их центров по умолчанию; в то время как,
например, если столбец с центром в B связан с pegbar с центром в A, он будет иметь смещение в 8
дюймов влево.

Помимо букв, столбцы также имеют пронумерованные центры; они служат для установки ссылок
относительно положения Крюков, назначенных этим столбцам (см. Использование крюков).

• Центр 1 - это центр, определяемый крючком №1.

• Центр 2 является центром, определяемым крюком №2.

• и так далее.

Примечание: В этом режиме для каждого узла всегда будет доступен свободный соединительный
порт, чтобы принимать ссылку на другой центр. Таким образом, если вы хотите связать другой объект
с тем же родительским объектом, вы можете выбрать, использовать ли тот же центр или другой.

Примечание: Определяя родительские и дочерние объекты, вы также можете создавать перекладную
анимацию (см. Создание перекладной анимации).

Совет: Для переключения режима отображения портов разъема:

• Нажмите кнопку Переключениеотображения выходного порта ( ) в нижней панели окна
Stage Schematic, пока не увидите буквы на каждой стороне узлов вместо кружков по умолчанию.

Совет: Чтобы установить центр объекта:

1. Наведите указатель мыши на левый порт объекта и дождитесь появления кнопки с двойной
стрелкой.

2. Нажмите и перетащите вверх или вниз кнопку с двойной стрелкой, чтобы прокрутить
доступные параметры: буквы и цифры для столбцов и буквы для всех других типов объектов.

Совет: Чтобы установить способ, которым дочерний объект перекрывает свой родитель-
ский объект:

Выполните любое из следующих действий:

• Установите одинаковую букву для двух портов в конце ссылки, чтобы перекрывать объекты без
смещения.

• Установите следующую букву в алфавитном порядке на левом порту дочернего объекта,
чтобы сместить его влево: для каждой последующей буквы имеется смещение в 8 дюймов влево.
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• Установите следующую букву в алфавитном порядке на правом порту родительского объ-
екта, чтобы сместить его вправо: для каждой последующей буквы есть смещение на 8 дюймов
вправо.

15.2.2 Использование крюков

Крюки - это опорные точки, которые можно определить для любого уровня анимации непосредственно

в окне просмотра с помощью инструмента Крюк ( ).

После того, как они определены для столбца/слоя, они могут использоваться в схеме этапа для свя-
зывания с ним другого объекта по отношению к конкретному крюку или для его перемещения в соот-
ветствии с любым из его наборов крюков.

В первом случае крюк используется в качестве точки отслеживания, чтобы связать другой объект
(столбец/слой или камеру) с определенной особенностью уровня анимации. Например, если у вас есть
персонаж, несущий лампу, вы можете отследить положение лампы с помощью крючка и привязать к
нему радиальный градиент (размещенный над лампой для каждого кадра анимации), чтобы создать
свечение.

Во втором случае крюк используется в качестве центра столбца/слоя, где будет зацеплен уровень
зацепления, создавая тем самым разные центр и смещение для каждого кадра уровня. Например, если
у вас есть цикл анимации при ходьбе, вы можете установить новый центр, следуя за ногами персонажа
с помощью крюка, и заставить уровень двигаться соответствующим образом, чтобы предотвратить
эффект лунной прогулки на заднем плане.

Крюки также могут быть разделены и переданы из одного объекта рисунка в другой, автоматически
создавая положение смещения. Например, крюк, следующий за особенностью ноги персонажа, может
переходить с одной ноги на другую, чтобы персонаж непрерывно двигался вперед.

Рис. 1: Набор крюков 2 следует за лампой, а набор крюков 1 следует за ногами персонажа, переходя
от одной ноги к другой, когда оба находятся на земле.

Крюк может быть создан, начиная с любого кадра. Как только он будет создан, он появится на сле-
дующих уровнях кадров в том же положении, откуда он может быть перемещен.

Вы можете использовать до 20 крюков для каждого уровня; каждый крюк помечен номером, чтобы
ссылаться на него в каждом уровне кадра.

Активировав опцию Привязка, можно точно установить крюки для текущего уровня, привязав их
точно к тому же положению крюков, которое определено для других уровней анимации, видимых в
окне просмотра. В случае, если текущий уровень является векторным уровнем Toonz, крюки также
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будут привязываться к центру любых закрытых фигур, которые он может содержать (например, пря-
моугольники, круги или отдельные векторные фигуры, закрытые инструментом Скотч). Эта опция
может оказаться полезной, особенно при определении крюков для моделей перекладной анимации (см.
Создание перекладной анимации).

Информация о крюках сохраняется вместе с каждым уровнем в виде файла в формате XML, име-
нуемого как файл, но с суффиксом _hooks. Например, крюки, определенные для уровня мышь, будут
сохранены в файле мышь_hooks.xml.

Примечание: Крюки также видны в режиме Кальки (см. Использование кальки).

Примечание: Крюки могут также использоваться для создания модели перекладной анимации, по-
скольку они позволяют связывать разделы модели в соответствии с конкретными точками поворота
(см. Создание перекладной анимации).

Совет: Чтобы определить крюк для уровня:

1. Выберите кадр уровня, для которого вы хотите установить крюки.

2. Выберите инструмент Крюк ( ).

3. Выполните одно из следующих действий:

• Нажмите, чтобы создать крюк, и перетащите, чтобы определить начальную позицию крюка.

• Щелкните в другом месте, чтобы создать другой крюк и соответствующую начальную позицию
крюка.

Совет: Чтобы выбрать крюки:

Выполните одно из следующих действий:

• Нажмите на крюк, чтобы выбрать его.

• Кликните, зажав клавишу Ctrl (PC) или Cmd (Mac), чтобы добавить крюк или убрать его из
выделения.

Совет: Для перемещения выбранных крюков:

Выполните одно из следующих действий:

• Перетащите их на новую позицию.

• Перетащите, зажав клавишу Shift, чтобы ограничить горизонтальное или вертикальное движе-
ние.

• Активируйте опцию Привязка, чтобы поместить крюк точно в то же положение, что и крюки,
определенные для других уровней анимации, видимых в окне просмотра, или в случае, если этот
уровень является векторным уровнем Toonz, также в центре замкнутых фигур.

Совет: Чтобы переместить крюк из одной позиции в другую:
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1. Удерживая нажатой клавишу Alt, перетащите крючок, чтобы разделить его на две части.

2. Поместите двойной круг там, где должен быть крюк для текущего кадра.

3. Поместите крестик там, где вы хотите, чтобы точка отсчета находилась со следующего кадра.

Совет: Чтобы удалить крючок:

Выберите связанный крюк в любом кадре и выберите пункт меню Правка → Удалить.

Совет: Чтобы связать объект с крюком уровня:

1. Свяжите объект со столбцом, содержащим крюк.

2. Наведите указатель мыши на правый порт столбца и дождитесь появления кнопки с двойной
стрелкой.

3. Нажмите и перетащите вверх кнопку с двойной стрелкой, чтобы прокрутить числа, доступ-
ные перед буквой A, и отпустите кнопку мыши, чтобы определить номер крюка, который будет
использоваться.

Совет: Чтобы уровень двигался в соответствии с одним из его крюков:

1. Поместите указатель мыши над левым портом столбца, содержащего зацепку, и дождитесь по-
явления кнопки с двумя стрелками.

2. Нажмите и перетащите вверх кнопку с двойной стрелкой, чтобы прокрутить числа, доступ-
ные перед буквой A, и отпустите кнопку мыши, чтобы определить используемый крюк.

Совет: Чтобы предотвратить цикл анимации скольжения ног по полу:

Определите крюк, следуя этим рекомендациям:

• Поместите крюк на тот же элемент стопы вдоль всей последовательности, например, на кон-
чик стопы.

• Если персонаж должен двигаться горизонтально по земле, крючок всегда должен лежать на ли-
нии земли (без изменения его вертикального положения вдоль последовательности). Если функ-
ция, которой вы следуете, сходит с земли, все равно поместите крюк на линию земли под той
функцией, которой вы следовали.

• Когда обе ноги находятся на линии земли, вы можете разделить крюк, чтобы передать его от
одной ноги к другой.

• Если анимация является циклом, и вы хотите, чтобы персонаж продолжал идти, последняя по-
зиция крючка должна быть связана с первой, и крюк должен пройти от одной ноги к другой,
разделив ее, а затем на первый снова, разделив его снова.

15.2.3 Точки слежения

Можно автоматически отслеживать определенные области в последовательности изображений с помо-

щью инструмента Трекер ( ). Результаты этого инструмента представляют собой серию крюков,
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Рис. 2: Столбец 3 связан с набором крюков 2 столбца 2, а столбец 2 движется в соответствии со своим
собственным набором 1 крюков.
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которые можно использовать для связывания объекта с другим (см. выше).

При выборе инструмента Трекер ( ) вы можете определить одну или несколько областей на изоб-
ражении, указав центр и размер; области также могут быть связаны друг с другом, чтобы лучше
отслеживать точки, имеющие визуальные геометрические отношения. Область, определенная с помо-
щью инструмента, задает как шаблон, который система отслеживания будет пытаться распознать на
следующих изображениях, так и размер области поиска, в которой она будет ее искать (примерно в
два раза больше этой области).

После того как области, которые нужно отслеживать, определены в первом кадре диапазона, можно
автоматически отслеживать области в выбранном диапазоне, указав следующие параметры:
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• Предел устанавливает величину разницы между определенным шаблоном и распознанным. При
использовании низких значений система отслеживания будет искать область с почти идентичным
рисунком, а при использовании высоких значений - область, которая может сильно отличаться
от исходной. Это означает, что если значение слишком низкое, более вероятно, что отслежива-
ние не удастся на определенных изображениях; если оно слишком высокое, отслеживание может
завершиться ошибкой, если следовать неправильным областям.

• Чувствительность устанавливает частоту обновления определенного шаблона в соответствии
с его вариациями на следующих изображениях. Для максимального значения шаблон будет об-
новляться после отслеживания каждого изображения.

• Размер изменяемого региона при активации будет искать определенный шаблон, учитывая
также различные размеры, которые он может иметь на следующих изображениях.

• Включить фон, при активации он рассматривает фон как часть определенного шаблона. Па-
раметр можно отключить при отслеживании элемента, фон которого не влияет на рисунок, на-
пример, фон зеленого/синего экрана.

Совет: Чтобы определить регион для отслеживания:

1. Выберите инструмент Трекер ( ) и щелкните и перетащите изображение.

2. Используйте маркеры вдоль определенной области, ограничивающей кадр, чтобы изменить ее
размер.

3. Щелкните и перетащите в другое место, чтобы определить второй регион: центр региона будет
помечен другой буквой.

Совет: Чтобы определить регион, связанный с другим:

1. Выберите инструмент Трекер ( ) и выберите регион, к которому вы хотите подключить
другой регион.

2. Щелкните и перетащите в другое место, чтобы определить связанную область: центр области
будет помечен той же буквой, что и первая.
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Совет: Чтобы удалить определенный регион:

1. Выберите инструмент Трекер ( ) и выберите регион, который вы хотите удалить.

2. Выберите пункт меню Правка → Удалить.

Совет: Чтобы отслеживать определенный регион в серии изображений:

1. Выберите первое изображение диапазона, который вы хотите отслеживать.

2. Выберите инструмент Трекер ( ) и определите регионы для отслеживания.

3. Выберите диапазон кадров в Xsheet/Timeline или в Level Strip.

4. Choose Level → Tracking. . . , set the tracking options and click the Track button.

Совет: Чтобы связать объект с отслеживаемым регионом:

Свяжите объект с одним из крюков, определенных процессом отслеживания (см. Использование крю-
ков).

15.3 Анимация объектов

Вы можете анимировать положение, вращение, масштаб и наклон (плюс редактировать центр) столб-
цов, штифтов, камер и стола с помощью инструмента Анимирования. Анимационные объекты можно
выбрать либо в Stage Schematic, в окне просмотра, на Xsheet/Timeline или с помощью раскрывающе-
гося меню на панели параметров инструмента Анимирования.

В панели параметров Инструмента Анимирования ( ) вы можете установить следующее:

• Объект:, позволяет выбрать, какой объект сцены должен быть обработан инструмен-
том. Здесь будут перечислены все созданные столбцы, камеры и штифты, а также сам
стол.

• Режим:, позволяет выбрать, какие параметры преобразования отображать на панели
параметров инструмента. Возможные варианты: Положение, Вращение, Масштаб,
Скос, Центр и Все.

• Position, X: and Y: set the horizontal and vertical positions of the selected object, Z: sets
its position along the Z axis, for defining the depth of the object in 3D space (see Working
in a 3D Environment ), and SO: sets the column/layer stacking order, that can override the
default one defined by the Xsheet column (or Timeline layer) order (see Changing Columns
Stacking Order ).

• Rotation:, sets the rotation of the selected object around the Z axis.
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• Масштаб, Глобальный:, H: и V: устанавливают глобальное, горизонтальное и верти-
кальное масштабирование выбранного объекта. Поддерживать: устанавливает огра-
ничение для операций масштабирования, выполняемых с помощью ручки инструмента
Анимирования: если он установлен на A/R, объект будет сохранять свои пропорции,
если он установлен на Масса объект будет поддерживать свой общий объем.

• Скос, H: и V: устанавливают горизонтальный и вертикальный сдвиг выбранного объ-
екта.

• Center, X: and Y: set the horizontal and vertical position of the center of the selected
object. The Center of an object cannot be animated.

• Все отображает все типы преобразования одновременно. В окне просмотра также будет
доступен дескриптор, который позволяет пользователям визуально изменять любой из
типов преобразования: Положение, Вращение, Масштаб, Скос и Центр.

• Выбрать: (доступно только в режиме Все) позволяет пользователю выбрать авто-
матический выбор столбцов/слоев или штифтов для анимации, когда выбор сделан,
щелкнув в окне просмотра: при установке на Столбец, нажав рисунок автоматически
выбирает связанный столбец/слой; если установлено значение Pegbar, щелчок по ри-
сунку автоматически выбирает pegbar, с которым связан столбец/слой, содержащий
рисунок (если он есть); при значении Нет выбор рисунков в окне просмотра отключен.

• Кнопки блокировки ( ) определяют, какие значения остаются заблокированными
при трансформации объекта.

• Глобальный ключ, когда активирован, устанавливает ключ для всех преобразований
объекта, как только ключ устанавливается для любого из его преобразований в интер-
активном режиме в окне просмотра. Например, если вы измените положение объекта,
определив для него ключевой кадр, ключи также будут автоматически определены
для преобразований вращения, масштабирования и сдвига. Эта опция не будет иметь
никакого эффекта, если значения для свойства вводятся непосредственно на панели
инструментов, а не в интерактивном режиме.

Примечание: Если панель параметров инструмента слишком короткая для отображения всех па-
раметров инструмента, ее можно прокручивать с помощью кнопок со стрелками, имеющихся на ее
концах.

Примечание: Position values are expressed in the default unit of measure set in the Preferences. . . →
Interface dialog (see Choosing the Working Unit ).

15.3.1 Указатель инструмента анимирования

Когда инструмент Анимирование находится в режиме Все, вы также можете интерактивно управлять
значениями преобразования, используя указатель, доступный в окне просмотра. Указатель выполнен
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из двойного круга с тремя ручками, которые позволяют изменить любое из следующих преобразований:

Примечание: При наведении курсора на указатель курсор меняет форму, указывая на те операции,
которые вы можете выполнить.

Примечание: Для большей точности можно удерживать нажатой клавишу Alt перед началом любого
преобразования.

• Положение: Нажмите и перетащите в любое место, чтобы переместить объект; если во вре-
мя перетаскивания нажать клавишу Shift, движение будет ограничено в горизонтальном или
вертикальном направлении.

• Поворот: Нажмите и перетащите конец круга, чтобы повернуть объект;

• Масштаб: Нажмите и перетащите внешний квадрат конца двойного квадрата, чтобы равно-
мерно масштабировать объект по вертикали и горизонтали; щелкните и перетащите внутренний
квадрат конца двойного квадрата, чтобы масштабировать объект в соответствии с ограничением,
установленным на панели параметров; если ограничение не установлено и при перетаскивании
нажата клавиша Shift, масштабирование будет равномерным.

• Скос: Нажмите и перетащите конец параллелограмма, чтобы наклонить объект; если во время
перетаскивания нажать клавишу Shift, сдвиг будет ограничен в горизонтальном или вертикаль-
ном направлении.
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• Центр: Нажмите и перетащите двойной круг в центре, чтобы изменить центр объекта.

Примечание: Центр объекта может быть перемещен, но не может быть анимирован. Как только он
установлен или изменен, он сохраняется в этой позиции в течение всей анимации. Если центр много
раз менялся, и вы хотите вернуть его в исходное положение, щелкните правой кнопкой мыши объект
в схеме сцены и выберите Сброс центра в открывшемся меню.

При вводе значения или работе с указателем ключевой кадр будет автоматически генерироваться в
текущем кадре только для заданного преобразования; если опция Глобальный ключ активирована,
ключи будут сгенерированы для всех преобразований.

Если вы хотите установить ключ для преобразования объекта, сохраняя его значение таким, как оно
есть в текущем кадре, вы можете просто нажать Enter на отображаемом значении. Если вы хотите
установить ключи для всех преобразований объектов, сохраняя их значения такими, как они есть в

текущем кадре, вы можете использовать кнопку Установить ключ ( ), доступную в нижней панели
средства просмотра; в этом случае ключи создаются для всех преобразований объекта, независимо от
параметра Глобальный ключ.

Примечание: Объекты также можно анимировать, работая в Редакторе функций (см. Редактирова-
ние кривых и числовых столбцов).

Примечание: Движение содержимого столбца можно проверить, активировав режим Кальки, по-
скольку он будет отображать положение рисунков, содержащихся в текущем столбце, в разных кадрах
(см. Использование кальки ).

Совет: Чтобы выбрать объект для редактирования:

Выполните одно из следующих действий:

• Выберите его в Stage Schematic.
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• Если объект является столбцом/слоем, выберите его на Xsheet/Timeline.

• Используйте инструмент Анимирования ( ) с параметром Выбрать:, установленным на
Столбец, чтобы щелкнуть рисунок в окне просмотра, чтобы выбрать связанный столбец.

• Используйте инструмент Анимирования ( ) с параметром Выбрать:, установленным на
Pegbar, чтобы щелкнуть рисунок в окне просмотра, чтобы выбрать Pegbar, с которым связан
столбец, содержащий рисунок.

• Щелкните правой кнопкой мыши в окне просмотра рисунок, чтобы выбрать объект из списка
объектов сцены.

Совет: Для анимации объекта с помощью инструмента Анимирования:

1. Выберите объект, который вы хотите анимировать.

2. Выберите инструмент Анимирования ( ).

3. Установите кадр, в котором вы хотите определить ключ, выполнив одно из следующих действий:

• Переместите курсор текущего кадра в Xsheet/Timeline или в Редакторе функций.

• Используйте панель кадров или кнопки воспроизведения в нижней панели окна просмотра.

• При анимации только столбцов выберите соответствующую ячейку в столбце/слое.

4. Определите ключевой кадр.

5. Выберите другой кадр и продолжайте определять ключевые кадры.

Совет: Чтобы определить ключевой кадр только для некоторых преобразований объекта:

1. Отключите параметр Глобальный ключ на панели параметров инструмента.

2. Выполните одно из следующих действий:

• Введите значения на панели параметров инструмента Анимирования для преобразований объ-
ектов, для которых вы хотите задать ключ.

• Если в режиме Все, используйте указатель для перемещения, масштабирования, вращения или
сдвига объекта, автоматически генерируя ключ только для измененного преобразования.

Примечание: Поскольку этот ключевой кадр является частичным и относится только к некоторым
преобразованиям, кнопка Установить ключ становится полосатой синей.

Совет: Чтобы определить ключевой кадр для всех преобразований объекта:

1. Активируйте параметр Глобальный ключ на панели параметров инструмента.

2. Интерактивно перемещайте, вращайте, масштабируйте или сдвигайте объект в окне просмотра.

Примечание: Поскольку этот ключевой кадр является глобальным и относится ко всем преобразо-
ваниям, кнопка Установить ключ становится синей.
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Совет: Чтобы определить ключ для преобразования объекта, оставив его значение в
текущем кадре:

1. Отключите параметр Глобальный ключ на панели параметров инструмента.

2. На панели параметров инструмента Анимирования щелкните поле преобразования объекта,
для которого вы хотите установить ключ, и нажмите кнопку Enter.

Примечание: Поскольку этот ключевой кадр является частичным и относится только к некоторым
преобразованиям, кнопка Установить ключ становится полосатой синей.

Совет: Чтобы определить ключи для всех преобразований объекта, оставив их значения
такими, какие они есть в текущем кадре:

Выполните одно из следующих действий:

• Нажмите кнопку Установить ключ ( ).

• При анимации только столбцов/слоев щелкните правой кнопкой мыши ячейку столбца/слоя и
выберите Установить ключ в открывшемся меню.

Примечание: Поскольку этот ключевой кадр является глобальным и относится ко всем преобразо-
ваниям, кнопка Установить ключ становится синей.

Совет: Чтобы превратить частичный ключевой кадр в глобальный ключ:

Нажмите кнопку Установить ключ ( ): она превращается из синей в полоску в синюю.

Совет: Чтобы удалить установленный ключевой кадр из нижней панели окна просмотра:

Выполните одно из следующих действий:

• Если ключевой кадр является глобальным, нажмите кнопку Установить ключ ( ): он станет
из синего серым.

• Если ключевой кадр является частичным, дважды нажмите кнопку Установить ключ ( ):
при первом щелчке он превращается из полосатого синего в синий, а во втором из синего в серый.

Совет: Для навигации по кадрам, в которых ключевые кадры определены в нижней
панели окна просмотра:

Используйте кнопки Предыдущий ключ ( ) и Следующий ключ ( ), доступные сбоку от
кнопки Установить ключ.

306 Глава 15. Создание движений



OpenToonz Documentation, Выпуск 1.7.1

Примечание: Ключи также можно удалять или перемещать, работая в Редакторе функций (см.
Редактирование кривых и числовых столбцов).

Совет: Чтобы настроить панель параметров инструмента Анимирования:

Выполните любое из следующих действий:

• Используйте раскрывающееся меню Режим инструмента:, чтобы выбрать один из его режимов:
Положение, Вращение, Масштаб, Скос, Центр или Все: будут отображаться только параметры
для выбранной категории преобразования.

• Используйте кнопку блокировки ( ), чтобы выбрать, какие преобразования должны быть
заблокированы при преобразовании объекта: блокируются только выбранные элементы.

15.3.2 Изменение порядка расположения столбцов/слоев

Порядок расположения столбцов/слоев, который определяет, какие рисунки и изображения размеща-
ются сверху или сзади, другие изображения, по умолчанию зависит от того, как столбцы/слои разме-
щены на Xsheet/Timeline: направление Xsheet слева направо, а направление Timeline находится снизу
вверх, делая то, что слева/снизу, позади того, что справа/сверху.

Это будет означать, что если элемент анимации должен перемещаться за другим элементом анимации,
а затем перед ним, он должен быть представлен в двух разных столбцах, один до и один после столбца,
содержащего второй элемент анимации.

Путем редактирования значения Порядка (то есть порядка наложения) можно изменить и анимиро-
вать порядок наложения элементов без изменения положения столбцов/слоев на Xsheet/Timeline.

Значение по умолчанию Порядка для всех столбцов равно 0, что означает, что порядок столбцов
Xsheet (или слоя Timeline) учитывается при отсутствии изменений в позиции Порядка. Как толь-
ко столбец/слой получит более высокое значение Порядка, он будет размещен сверху, независимо от
положения столбца/слоя на Xsheet/Timeline; и наоборот, если значение Порядка ниже, оно будет раз-
мещено сзади.

Примечание: В случае редактирования позиции Z столбца/слоя столбцы/слои, расположенные бли-
же к камере, будут скомпонованы поверх других, игнорируя как порядок Xsheet/Timeline, так и зна-
чение Порядка (см. Работа в 3D-среде).

Совет: Чтобы редактировать и анимировать значение порядка столбца/слоя:

1. Выберите столбец/слой, для которого вы хотите изменить значение порядка.

2. Выберите инструмент Анимирования ( ).

3. Установите кадр, в котором вы хотите определить ключ.

4. На панели параметров инструмента введите значение в поле Порядок.

Примечание: Значения Порядка также можно редактировать и анимировать, работая в Редакторе
функций (см. Редактирование кривых и числовых столбцов).
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15.3.3 Создание движения по траектории

Объекты могут перемещаться по траектории движения в соответствии с двумя различными типами
движений: один без изменения ориентации объекта, а другой с автоматической ориентацией, установ-
ленной в соответствии с направлением траектории движения.

Путь движения может быть назначен узлу объекта в Stage Schematic, и его можно определить с по-
мощью инструментов рисования и отредактировать в окне просмотра, как если бы это был векторный
рисунок. После определения он отображается в виде пунктирной красной линии с небольшими циф-
рами, обозначающими контрольные точки, определяющие вектор обводки.

Рис. 3: Траектория движения, назначенная pegbar 2.

As soon as a path is assigned to an object’s node, the object will be automatically placed at the beginning
of the path according to its center, and it will only be able to move along it (and not in the standard X and
Y directions anymore).

Ключевые кадры объекта на пути движения могут быть определены путем перетаскивания объекта
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вдоль него, и они выражены в процентах, где 0% является начальной точкой, а 100% - конечной точкой
пути.

Также возможно связать ключевые кадры объектов с позициями контрольных точек, определяющих
траекторию движения, чтобы они оставались согласованными при редактировании траектории дви-
жения. Чтобы помочь вам лучше понять, где находятся контрольные точки, объект привязывается к
ним, когда он перетаскивается по траектории движения.

Примечание: Если вы хотите изменить центр объекта, вы можете переместить его с помощью ин-

струмента Анимирования ( ), а затем использовать команду Сброс центра в Stage Schematic.

Примечание: Траектория также может быть создана путем копирования и вставки обводки векто-
ра рисунка, и наоборот, обводка вектора рисунка может быть создана путем копирования и вставки
траектории.

Совет: Чтобы создать траекторию движения:

1. Выберите объект, для которого вы хотите определить траекторию движения.

2. Выполните одно из следующих действий:

• Нажмите кнопку Новая траектория движения ( ) в нижней панели окна сцены.

• Щелкните правой кнопкой мыши по сцене и выберите Новая траектория движения в открыв-
шемся меню.

Совет: Для определения и редактирования траектории движения:

Выберите узел траектории движения на сцене и выполните любое из следующих действий:

• Используйте инструменты рисования, чтобы определить его в окне просмотра.

• Используйте инструменты-модификаторы для редактирования.

• Нарисуйте новую линию и подтвердите в открывшемся диалоговом окне, чтобы заменить ранее
созданную траекторию движения новой.

Совет: Чтобы назначить траекторию движения объекту:

Нажмите и перетащите верхний порт траектории движения к нижнему порту узла объекта.

Совет: Чтобы удалить траекторию движения от объекта:

1. Выберите связь между объектом и траекторией движения.

2. Выберите пункт меню Правка → Удалить.

Совет: Чтобы установить тип движения по траектории движения:
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Нажмите кнопку в крайнем левом нижнем порту объекта, чтобы переключиться между двумя вари-

антами: кнопка Квадрат ( ) сохранит исходную ориентацию объекта и кнопку Ромб ( )
автоматически повернет объект в соответствии с направлением движения.

Совет: Чтобы связать ключевые кадры объекта с контрольными точками, определяющи-
ми траекторию движения:

Нажмите кнопку рядом с нижним портом объекта, чтобы активировать или деактивировать параметр

Link to Control Points ( ).

Совет: Чтобы изменить центр объекта:

1. Выберите инструмент Анимирования ( ).

2. Переместите центр объекта на новую позицию.

3. Щелкните правой кнопкой мыши узел объекта в Stage Schematic и выберите Сбросить центр в
открывшемся меню.

Совет: Чтобы сохранить траекторию движения:

1. Щелкните правой кнопкой мыши и выберите Сохранить траекторию движения в открыв-
шемся меню.

2. В браузере выберите местоположение и имя и нажмите кнопку Сохранить. Файл будет сохранен
с расширением MPATH.

Совет: Чтобы загрузить траекторию движения:

1. Щелкните правой кнопкой мыши траекторию движения и выберите Загрузить траекторию
движения в открывшемся меню.

2. В браузере найдите файл MPATH, который вы хотите загрузить, и нажмите кнопку Загрузить.

Совет: Чтобы использовать векторную черту рисования в качестве траектории движения:

1. Выберите векторную строку, который вы хотите использовать в качестве траектории движения,

с помощью инструмента Выделения ( ).

2. Скопируйте/вырежьте его.

3. Выберите траекторию движения, в которую вы хотите вставить, в Stage Schematic.

4. Щелкните в окне просмотра и вставьте скопированный/вырезанный вектор, который автомати-
чески станет траекторией движения.
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Совет: Чтобы использовать траекторию движения в качестве векторной линии на рисун-
ке:

1. Выберите траекторию движения в Stage Schematic.

2. Выберите траекторию движения с помощью инструмента Выделения ( ) в окне просмотра.

3. Скопируйте/вырежьте его.

4. Выберите рисунок, куда вы хотите вставить новую линию.

5. Вставьте скопированную/вырезанную траекторию движения, которая автоматически станет ли-
нией.

Совет: Чтобы удалить траекторию движения из Stage Schematic:

Выполните одно из следующих действий:

• Выберите узел траектории движения и выберите пункт меню Правка → Удалить.

• Щелкните правой кнопкой мыши узел траектории движения и выберите Удалить в открывшемся
меню.

15.4 Использование ключей в столбцах/слоях

Когда столбцы/слои анимированы, их анимацией можно быстро управлять, управляя ключевыми кад-
рами и интерполяциями непосредственно в Xsheet или на Timeline, без необходимости использования
Редактора функций.

Как только ключевой кадр определен для столбца/слоя, справа от ячейки столбца/слоя отобража-
ется символ ключа; ключ отображается независимо от того, сколько параметров анимировано.
Ключи можно перемещать в столбце/слое, к которому они относятся, и выбирать их для выреза-
ния/копирования и вставки из одной ячейки в другую.
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Когда опция Глобальный ключ активирована для инструмента Анимирования, и интерполяция
по умолчанию не установлена на Линейный, как только для столбца будут созданы как минимум
два ключевых кадра, a отображается строка, соединяющая их двумя стрелками (см. Аними-
рование объектов и Настройка интерполяции сегментов). Две стрелки делят линию на три секции,
указывающие фазы скорости, постоянной скорости и скорости всех преобразований, определенных. Это
позволяет вам контролировать скорость перемещения между двумя клавишами по своему желанию,
включая постоянную скорость движения.

Вы также можете циклически создавать ранее созданные ключи, чтобы автоматически повторять все
ранее определенные ключи для всей длины сцены без необходимости копировать и вставлять ключи
из ячеек в ячейки.

Все анимации и интерполяции, установленные для столбца/слоя, можно увидеть и отредактировать с
помощью редактора функций. Когда вы редактируете любое преобразование столбца/слоя в редакторе
функций, стрелки больше не будут отображаться между клавишами, чтобы подчеркнуть тот факт, что
определенная интерполяция была изменена с помощью редактора функций. При необходимости вы
можете выполнить Сброс всех преобразований столбца/слоя до значений интерполяции по умолчанию
и снова сделать стрелки доступными (см. Редактирование кривых и числовых столбцов).

Совет: Чтобы изменить ключ:

312 Глава 15. Создание движений



OpenToonz Documentation, Выпуск 1.7.1

1. Выберите ячейку, к которой относится ключ.

2. Выполните одно из следующих действий:

• Используйте инструмент Анимирования ( ) для изменения положения и размера.

• Введите значения, которые вы хотите изменить, на панели параметров инструмента Анимирова-

ния ( ).

Совет: Чтобы выбрать ключи:

Выполните одно из следующих действий:

• Нажмите значок ключа, чтобы выделить его.

• Нажмите значок ключа и перетащите, чтобы выбрать диапазон ключей в разных столбцах
и в разных кадрах.

• Кликните с зажатой клавишей Shift, чтобы расширить выбор до определенной клавиши.

• Щелкните с зажатой клавишей Ctrl (PC) или Cmd (Mac), чтобы добавить или удалить
ключ к выделению.

• Щелкните правой кнопкой мыши по значку ключаи выберите соответствующую команду в
открывшемся меню для выполнения определенного выделения, такого как все ключи в ряду, все
предыдущие, все последующие и т.п.

Совет: Чтобы переместить выделение ключей:

Нажмите на любой из выделенных ключей и перетащите выделенную область на новую позицию.
Перетаскивание разрешено только внутри собственного столбца/слоя.

Совет: Чтобы изменить выделенный ключ:

Выполните одно из следующих действий:

• Используйте команду Вырезать, чтобы исключить выделение из сцены и сохранить его в памяти
для дальнейших операций.

• Используйте команду Копировать, чтобы сохранить выбор в памяти для дальнейших операций.

• Используйте команду Вставить, чтобы вставить выделенную область памяти, начиная с выбран-
ной ячейки.

• Используйте команду Удалить, чтобы удалить выбор.

Примечание: Все эти команды также доступны в меню, которое открывается при щелчке правой
кнопкой мыши по значку ключа.

Совет: Чтобы установить скорость движения или трансформации:

Нажмите на стрелки, доступные на линии, соединяющей два последующих ключа, и перетащите
их вверх или вниз на новую позицию. В частности:
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• Чтобы установить постоянную скорость, перетащите верхнюю стрелку рядом со значком пер-
вой клавиши, чтобы исключить элемент облегчения ввода, и нижнюю стрелку рядом со значком
второй клавиши, чтобы исключить участок ослабления.

• Чтобы установить непрерывное ускорение, перетащите обе стрелки рядом со значком второго
ключа, чтобы увеличить скорость в сечении.

• Чтобы установить непрерывное замедление, перетащите обе стрелки рядом с первым значком
ключа, чтобы увеличить участок ускорения.

Совет: Чтобы сделать стрелки доступными, когда их нет:

Щелкните правой кнопкой мыши линию, соединяющую два последующих ключа, и выберите Сбро-
сить интерполяцию в открывшемся меню.

Совет: Чтобы активировать/деактивировать повторное использование ранее созданных
ключей:

Щелкните значок Круговая стрелка ( ), видимый после последнего ключа серии. Ячейки, затро-
нутые циклическим движением, отмечены справа зигзагообразной линией.

Совет: Чтобы открыть редактор функций:

Выполните одно из следующих действий:

• Дважды щелкните ключ.

• Кликните правой кнопкой мыши и выберите Редактор функций в открывшемся меню.

15.4.1 Работа с несколькими ключами столбца/слоя

Можно вставлять или удалять ключи, влияющие на Xsheet/Timeline в целом, или выделение столбцов
Xsheet (или слоев Timeline).

Вставка или удаление нескольких ключей позволяет вам управлять ключами для нескольких столб-
цов/слоев одновременно, например, когда вы работаете с перекладной анимацией, где ключи могут
потребоваться для всех столбцов/слоев, где отображаются разделы модели (см. Создание перекладной
анимации).

Примечание: Вставленные ключи создаются для всех преобразований столбцов.

Когда множественный ключ вставляется в текущий кадр, ключ создается для каждого столбца Xsheet
(или слоя Timeline), где отображается уровень анимации; если выбор столбца/слоя определен, ключи
создаются только в выделенных столбцах/слоях (см. Работа с столбцами Xsheet).

При удалении множественных ключей в текущем кадре любой ключ, доступный в любом столбце
Xsheet (или слое Timeline) в текущем кадре, удаляется; если выбран столбец/слой, ключи удаляются
только в выбранных столбцах/слоях.

Совет: Чтобы создать несколько ключей одновременно:
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1. Выполните одно из следующих действий:

• Выберите столбцы/слои, для которых вы хотите создать ключи.

• Выберите столбец кликом в любом месте на Xsheet/Timeline, чтобы создать ключи для всех
столбцов/слоев.

2. Выберите кадр, в который вы хотите вставить ключи.

3. Выберите Xsheet → Вставить несколько ключей.

Совет: Чтобы удалить несколько ключей одновременно:

1. Выполните одно из следующих действий:

• Выберите столбцы/слои, из которых вы хотите удалить ключи.

• Выберите столбец кликом в любом месте на Xsheet/Timeline, чтобы удалить ключи из всех столб-
цов/слоев.

2. Выберите кадр, в котором вы хотите удалить ключи.

3. Выберите Xsheet → Удаление нескольких ключей.

15.5 Работа в трехмерной среде

Вы можете размещать и перемещать камеры, стол, штифты и столбцы/слои в трехмерной среде, как
если бы они были элементами на реальной трехмерной сцене.

This means that it’s possible to move the camera automatically generating a multiplane effect, or truck it
through characters and elements simulating a perspective effect, or create complex 3D motion paths for any
element by combining a depth movement with movements in the X and Y directions.

3D-среду можно активировать или деактивировать с помощью кнопки 3D-просмотр ( ) в строке
заголовка окна просмотра. При активации окно просмотра отображает конус камеры и все содержимое
сцены вдоль оси Z, которая является направлением от камеры к столу. Отображаемую область можно
перемещать и поворачивать для установки наилучшего угла обзора, а также можно установить боковую
или верхнюю точку обзора.

По умолчанию все штифты и столбцы находятся на столе: их позиция Z равна количеству горизонталь-
ных полей, определенных для камеры по умолчанию (так как значение представляет размер области,
снимаемой камерой) (см. Определение настроек камеры). При увеличении значения поля объекты
размещаются дальше от камеры; уменьшая его, объекты размещаются ближе к камере; в нуле они
находятся в той же позиции Z, что и камера, а для отрицательных значений они находятся за камерой.

Что касается камеры, то по умолчанию ее позиция Z равна количеству горизонтальных полей, опреде-
ленных для камеры по умолчанию. Увеличивая значение поля, камера перемещается дальше от стола;
уменьшая его, он приближается; в нуле он находится в той же позиции Z стола, а для отрицательных
значений - за столом.

Как только объекты перемещаются, проекции на воображаемый пол и боковую стену позволяют по-
нять положение рисунков по отношению друг к другу и к камере. Если текущим объектом является
столбец/слой, пунктирная ограничительная рамка отображает область его съемки в данный момент
камерой.

Размер объектов изменяется в соответствии с его положением Z, как в реальной трехмерной среде,
уменьшается, когда объект находится дальше от камеры, и увеличивается, когда он ближе. Чтобы
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сохранить контроль над этим поведением, можно определить дополнительное значение позиции Z на
панели параметров инструмента, которое устанавливает позицию, в которой объект должен сохранять
свой первоначальный размер.

Примечание: Столбцы ближе к камере отображаются поверх других, игнорируя порядок
Xsheet/Timeline и значение Порядка. Если два или несколько столбцов имеют одинаковое расстояние,
значение Порядка имеет преимущественную силу; если два или несколько столбцов имеют одинако-
вое расстояние и значение Порядка, преобладает порядок столбцов Xsheet (или слоя Timeline) (см.
Изменение порядка размещения столбцов).

Совет: Чтобы войти в 3D-среду:

Нажмите кнопку 3D-просмотр ( ), расположенную справа от строки заголовка окна просмотра.

Совет: Чтобы установить положение объекта в трехмерной среде:

1. Активируйте 3D-просмотр.

2. Выберите объект, который вы хотите переместить.

3. Выберите инструмент Анимирования ( ).

4. Выполните одно из следующих действий:

• Введите значение для позиции Z на панели параметров инструмента.

• Используйте указатель с двойной стрелкой, параллельную полу 3D-среды, чтобы переместить
выбранный объект и установить его положение Z.

Совет: Чтобы установить, в каком положении объект должен сохранять свой первона-
чальный размер:

Введите значение для дополнительного поля Z позиции, отображаемого в скобках на панели
параметров инструмента. Например, если вы хотите, чтобы содержимое столбца сохраняло свой пер-
воначальный размер при размещении в позиции Z 8, также введите 8 в качестве значения в скобках.

Совет: Чтобы переместить рабочую область, отображаемую в 3D:

Выберите инструмент Рука ( ) и перетащите его в окно просмотра.

Совет: Чтобы повернуть рабочую область, отображаемую в 3D:

Выберите инструмент Поворот ( ) и перетащите его в окно просмотра.

Совет: Чтобы установить вид сбоку или вид сверху:

Выполните одно из следующих действий:
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• Чтобы установить Вид сбоку, используйте кнопку ( ), доступную на боковой стене 3D-среды.

• Чтобы установить Вид сверху, используйте кнопку ( ), доступную на полу 3D-среды.

Совет: Чтобы выйти из 3D-среды:

Нажмите кнопки Стандартный вид с камеры ( ) или Вид с камеры ( ), доступные в правой
части строки заголовка окна просмотра.
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Глава 16

Редактирование с использованием электронных таблиц и кривых

Изменения в преобразованиях объектов и параметрах эффектов отображаются в окне Редактор
функций, где ключевые кадры и связанные с ними интерполяции можно контролировать и
изменять с помощью электронной таблицы числовых столбцов или редактора графиков.

Электронная таблица отображает изменения в столбцах, где каждый столбец представляет один
анимируемый параметр, а в каждой строке отображается значение параметра в каждом кадре.
Пустые ячейки представляют собой отсутствие изменения значения параметров из-за отсутствия
определяемых ключевых кадров.

Редактор графиков отображает изменения в виде кривых на графике, где кадры располагаются
горизонтально, а значения - вертикально.
Ключевые кадры представлены в виде точек, а интерполированные значения между ними
отображаются в виде красных линий.

Столбцы электронной таблицы и кривые редактора графиков представляют собой разные представ-
ления одних и тех же данных, поэтому любые изменения, сделанные в одном представлении, также
отражаются в другом.
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16.1 Использование редактора функций

Окно редактора функций разделено на три раздела. Слева находится область, где отображается элек-
тронная таблица или редактор графиков, справа вверху - область, где отображается интерполяция
текущего сегмента преобразования, а справа внизу - дерево объектов/эффектов.

В дереве есть две основные папки элементов, Сцена и FX : в первой вы можете найти папки для
определенных камер, таблицы, используемых штифтов и столбцов; во втором вы можете найти папки
для каждого используемого эффекта. Каждая папка содержит связанные параметры преобразования.

Дерево объектов/эффектов сообщает, является ли объект/эффект анимированным и какой параметр
анимирован, используя следующие значки:

• Простая папка для неанимированных объектов/эффектов.

• Папка со стрелкой предназначена для анимированных объектов/эффектов.

• Значок с пунктирной прямой линией предназначен для неанимированных параметров.

• Значок с непрерывной кривой для анимированных параметров.

Щелкнув по этим значкам, вы можете выбрать, какой объект/эффект и какие параметры должны
отображаться в виде электронной таблицы или кривых в области слева.

Данные преобразования могут быть сохранены и загружены в виде файла CURVE, чтобы разрешить
экспорт и импорт из одной сцены в другую, и их можно экспортировать, а также файл DAT для
использования в другом программном обеспечении.

Совет: Чтобы изменить размер разделов редактора функций:
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Выполните любое из следующих действий:

• Нажмите и перетащите разделители, чтобы изменить размер разделов.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть раздел.

• Щелкните и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить скрытый раздел.

Совет: Чтобы отобразить или скрыть параметры столбцов:

1. Получить объект или эффект в дереве объектов/эффектов.

2. Выполните одно из следующих действий:

• Нажмите на папку, чтобы отобразить или скрыть все столбцы или кривые, связанные с ее пара-
метрами.

• Щелкните значок параметра, чтобы отобразить или скрыть связанный столбец или кривую.

• Щелкните значок параметра и перетащите, чтобы отобразить или скрыть все столбцы или кри-
вые, по которым вы проходите.

• Щелкните правой кнопкой мыши папку и выберите Показать только анимированные в от-
крывшемся меню, чтобы отобразить или скрыть только анимированные столбцы или кривые,
связанные с ее параметрами.

• Щелкните правой кнопкой мыши папку и выберите Показать все в открывшемся меню, чтобы
отобразить или скрыть все столбцы или кривые, связанные с ее параметрами.

Совет: Чтобы открыть редактор графиков в отдельном окне:

1. Make sure the option Graph Editor Opens in Popup is selected from the Function Editor:
dropdown menu, in the Preferences. . . → Interface dialog section. (Restart OpenToonz).

2. Нажмите кнопку Переключатель редактора функций ( ) в верхней панели Редактора
функций.

Совет: Чтобы открыть электронную таблицу в отдельном окне:

1. Make sure the option Spreadsheet Opens in Popup is selected from the Function Editor:
dropdown menu, in the Preferences. . . → Interface dialog section. (Restart OpenToonz).

2. Нажмите кнопку Переключатель редактора функций ( ) в верхней панели Редактора
функций.

Совет: Для переключения между электронной таблицей и редактором графиков в редак-
торе функций:

1. Make sure the option Toggle Between Graph Editor and Spreadsheet is selected from the
Function Editor: dropdown menu, in the Preferences. . . → Interface dialog section. (Restart
OpenToonz).
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2. Нажмите кнопку Переключатель редактора функций ( ) в верхней панели Редактора
функций.

Совет: Для прокрутки таблицы:

Выполните одно из следующих действий:

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте колесо мыши для прокрутки вверх или вниз.

• Используйте полосы прокрутки для прокрутки только в пределах фактического экстента элек-
тронной таблицы.

• Используйте клавиши со стрелками вверх и вниз для перемещения на один кадр вверх или вниз.

• Используйте клавиши Page Up и Page Down для прокрутки видимых кадров вверх или вниз.

• Используйте клавиши Home и End для прокрутки вверх до начала или конца содержимого
Xsheet/Timeline.

Совет: Для навигации в редакторе графиков:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите на горизонтальную линейку и перетащите вверх, чтобы увеличить по горизонтали,
вниз, чтобы уменьшить; щелкните по значению вертикальной линейки и перетащите вверх, чтобы
увеличить по вертикали, вниз, чтобы уменьшить.

• Нажмите среднюю кнопку мыши и перетащите область графика для прокрутки в любом направ-
лении, горизонтальную линейку для горизонтальной прокрутки и вертикальную линейку для
вертикальной прокрутки.

• Используйте сочетание клавиш для сброса (по умолчанию клавиши Alt + 0) или щелкните
правой кнопкой мыши область графика и выберите Подогнать в открывшемся меню, чтобы отоб-
разить все видимые кривые в текущем окне редактора функциональных кривых.

Совет: Для сохранения данных трансформации:

1. Щелкните правой кнопкой мыши соответствующий параметр в дереве объектов/эффектов и вы-
берите Сохранить кривую в открывшемся меню.

2. Используйте Браузер, чтобы выбрать имя и местоположение файла для сохранения: данные будут
сохранены в виде файла CURVE.

Совет: Чтобы загрузить данные преобразования:

1. Щелкните правой кнопкой мыши соответствующий параметр в дереве объектов/эффектов и вы-
берите Загрузить кривую в открывшемся меню.

2. Используйте браузер, чтобы получить кривую для загрузки; допустимые файлы в формате
CURVE.
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Совет: Чтобы экспортировать данные преобразований:

1. Щелкните правой кнопкой мыши соответствующий параметр в дереве объектов и эффектов и
выберите Экспорт данных в открывшемся меню.

2. Используйте Браузер, чтобы выбрать имя и местоположение для файла, который будет сохранен:
данные будут сохранены как файл DAT, который может использоваться в другом программном
обеспечении, поддерживающем этот тип данных.

16.2 Определение ключевых кадров

Ключевые кадры, включая те, которые относятся к преобразованиям объектов, выполненным с помо-

щью инструмента Анимирования ( ), и те, которые определены для параметров эффектов в окне
FX Settings, можно контролировать и редактировать как с помощью числовых столбцов электронной
таблицы и кривые редактора графиков (см. Анимация объектов и Редактирование FX Settings).

В электронной таблице ключевые кадры отображаются в виде оранжевых ячеек; в редакторе графи-
ков ключевые кадры представлены в виде контрольных точек на кривой. В обоих случаях их можно
добавлять, редактировать, перемещать и удалять.

16.2.1 Использование электронной таблицы
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В электронной таблице отображаются преобразования в столбцах, подобные тем, которые доступны
на Xsheet/Timeline, по одному для каждого параметра. Для каждого кадра в ячейках столбца отобра-
жаются соответствующие значения преобразования.

Ключевые кадры отображаются в разноцветных ячейках и могут перемещаться вдоль столбца в разные
позиции кадров. Промежуточные значения автоматически генерируются в соответствии с ключевыми
кадрами и установленной интерполяцией (см. Настройка интерполяции сегментов).

Все столбцы, относящиеся к одному и тому же объекту или эффектам, сгруппированы в один заголовок.
Например, под заголовком штифта вы можете найти все столбцы, относящиеся к его преобразованиям.

Ячейки столбцов можно использовать для непосредственного ввода значений ключей, их редактиро-
вания или перемещения. Значения, содержащиеся в ячейках, могут быть вырезаны, скопированы и
вставлены, так что преобразования могут быть смещены, повторены и удалены.

Совет: Чтобы определить ключевые кадры непосредственно в столбцах электронной таб-
лицы:

1. Дважды щелкните ячейку столбца, в которой вы хотите определить ключевой кадр: ячейка станет
редактируемой.

2. Введите значение для клавиши и нажмите Enter для подтверждения.

Совет: Чтобы переместить ключевой кадр:

Нажмите на вертикальную полосу слева от ячейки ключевого кадра и перетащите ее вверх или вниз
на новую позицию; промежуточные значения изменяются соответственно.

Совет: Чтобы сместить канал вдоль столбца:

Нажмите вертикальную полосу слева от выбранных ячеек столбца и перетащите ее вверх или вниз
на новую позицию: содержимое сегментов, полностью включенных в выделение, будет перемещаться
вдоль столбца.

Совет: Чтобы скопировать/вырезать и вставить значения столбца:

Выполните одно из следующих действий:

• Нажмите и перетащите, чтобы выполнить выделение; выделение может быть расширено до
нескольких столбцов.

• Используйте команду Копировать: выделение будет сохранено в памяти для дальнейших опе-
раций.

• Используйте команду Вырезать: выделение будет удалена из столбцов и будет сохранена в па-
мяти для дальнейших операций. Удаление ячеек вызывает сдвиг следующих ячеек вверх.

• Используйте команду Вставить: сохраненное в памяти выделение будет вставлено, начиная с
выбранной ячейки вставки. Команда вызывает смещение следующих ячеек вниз.

• Используйте команду Удалить: выбранные ячейки будут удалены, в результате чего следующие
ячейки сместятся вверх.
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16.2.2 Использование редактора графиков

Редактор графиков отображает преобразования в виде кривых на графике, где время располагается
горизонтально, а значения параметра значения располагаются вертикально.

Кривые определяются контрольными точками, представляющими ключевые кадры. Точки можно лег-

ко добавлять, работая непосредственно на графике или используя кнопку Установить ключ ( ) в
верхней панели Редактора функций.

Контрольные точки также могут быть выбраны для редактирования, перемещения или удаления.

Кнопка Установить ключ ( ) либо серого цвета, если для текущей кривой в текущем кадре не
определен ключевой кадр, либо синего, если для текущей кривой в текущем кадре определен ключевой
кадр.

Кадры и ключевые кадры можно перемещать с помощью соответствующих кнопок в верхней панели

редактора. Кнопки Следующий ключ ( ) и Предыдущий ключ ( ) доступны, только если
определено более одного ключевого кадра.

Совет: Чтобы установить текущую кривую:

Выполните одно из следующих действий:

• Щелкните по имени соответствующего параметра в дереве объектов/эффектов.

• Отобразите кривую в Редакторе графиков, затем щелкните, чтобы выбрать ее.
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Совет: Чтобы установить текущий кадр:

Выполните одно из следующих действий:

• Нажмите на горизонтальную линейку рамки, чтобы установить позицию для текущего маркера
кадров.

• Нажмите и перетащите маркер текущего кадра в горизонтальном направлении.

• Введите номер кадра в текстовом поле Кадр или используйте кнопки Следующий кадр и
Предыдущий кадр, доступные в верхней панели редактора.

• Переместите курсор текущего кадра в Xsheet/Timeline.

• Используйте панель кадров или кнопки воспроизведения в нижней панели основного окна про-
смотра.

Совет: Чтобы добавить ключевой кадр:

Выполните одно из следующих действий:

• Нажмите кнопку Установить ключ ( ), чтобы добавить ключевой кадр в текущем кадре.

• Введите значение в текстовое поле Значение, чтобы добавить ключевой кадр в текущем кадре.

• Щелкните правой кнопкой мыши и выберите Установить ключ в открывшемся меню.

• Кликните с зажатой кнопкой Ctrl (PC) или Cmd (Mac) по кривой, где вы хотите добавить точку
ключевого кадра к нему.

Совет: Чтобы удалить ключевой кадр:

Выполните одно из следующих действий:

• Выберите ключевой кадр для удаления и выберите пункт меню Правка → Удалить.

• Установите текущий кадр, в котором находится ключевой кадр, и нажмите кнопку Установить

ключ ( ).

Совет: Чтобы выбрать ключевые кадры:

Выполните одно из следующих действий:

• Нажмите, чтобы выбрать ключевой кадр.

• Удерживая клавишу Shift, добавьте ключевой кадр или удалите его из выделенного фрагмента.

• Нажмите и перетащите, чтобы выбрать все ключевые кадры, которые находятся в области, ко-
торую вы определяете.

Совет: Чтобы выбрать сегменты кривой:

Выберите сегмент или контрольные точки на концах сегмента.
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Совет: Чтобы переместить выделение:

Нажмите и перетащите любую из выбранных контрольных точек.

Совет: Для редактирования кривых:

Выполните одно из следующих действий:

• Используйте команду Копировать: выбранные сегменты будут сохранены в памяти для даль-
нейших операций.

• Используйте команду Вырезать: выбранные сегменты будут удалены из кривой и будут сохра-
нены в памяти для дальнейших операций.

• Используйте команду Вставить: сегменты, хранящиеся в памяти, будут вставлены, начиная с
выбранного ключевого кадра, с сохранением любых других ранее определенных ключевых кад-
ров, не замененных новыми.

• Используйте команду Удалить: выбор будет удален.

Совет: Для навигации по ключевым кадрам текущей кривой:

Используйте кнопки Следующий ключ ( ) и Предыдущий ключ ( ), расположенные по
бокам от кнопки Установить ключ.

Совет: Для циклического воспроизведения ранее созданных ключевых кадров:

Щелкните правой кнопкой мыши пунктирную линию после конца кривой и выберите Включить цикл
в открывшемся меню.

Совет: Чтобы отключить цикл:

Щелкните правой кнопкой мыши по кривой и выберите Деактивировать цикл в открывшемся меню.

Примечание: При выполнении операций копирования, вырезания и вставки учитываются только
ключевые кадры, включенные в выделение.

Примечание: Все команды меню Правка также доступны в меню, которое открывается при щелчке
правой кнопкой мыши в ячейках Xsheet/Timeline.

16.3 Настройка сегментных интерполяций

Сегмент преобразования, то есть раздел между двумя ключевыми кадрами, может иметь различные
интерполяции, влияющие на то, как значение изменяется от одного ключа к другому. Заданная интер-
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поляция будет отображаться графически в редакторе графиков и в виде последовательности значений,
по одному для каждого кадра, в электронной таблице.

Available interpolations are the following: Linear, Speed In / Speed Out, Ease In / Ease Out, Ease In /
Ease Out %, Exponential, Expression, File, Constant and Similar Shape. The Default Interpolation
option can be set in the Preferences. . . → Animation dialog section, but it can be changed at any time in
the interpolation area of the Function Editor, on the top right of the window.

In the same area it is also possible to define an interpolation Step, that is to say the number of frames for
which the interpolation values have to be repeated, for instance to match a movement with an animation
level exposed at a specific step. The default animation step can be set in the Preferences. . . → Animation
dialog section.

Совет: Чтобы установить тип интерполяции для сегмента в электронной таблице:

1. Переместите курсор текущего кадра в кадр, принадлежащий сегменту.

2. Выберите интерполяцию в меню параметров, доступном в области Интерполяция: Редактора
функций.

3. Нажмите кнопку Применить, чтобы применить желаемое изменение.

Совет: Чтобы установить тип интерполяции для нескольких сегментов в электронной
таблице:

1. Выберите ячейку, охватывающую несколько сегментов ключевых кадров.

2. Щелкните правой кнопкой мыши одну из выбранных ячеек и выберите нужный тип интерполяции
в открывшемся меню.

Совет: Чтобы установить тип интерполяции для сегмента в редакторе графиков:

1. Задайте сегмент, выполнив одно из следующих действий:

• Нажмите сегмент, чтобы выделить его.

• Переместите Маркер текущего кадра в кадр, принадлежащий сегменту.

2. Выберите интерполяцию в раскрывающемся меню, доступном в области Интерполяция: Редак-
тора функций.

3. Нажмите кнопку Применить, чтобы применить желаемое изменение.

Примечание: Опции интерполяции также доступны при щелчке правой кнопкой мыши по сегменту.

Совет: Чтобы установить шаг интерполяции:

1. Укажите значение Шага в области интерполяции редактора функций.

2. Нажмите кнопку Применить, чтобы применить желаемое изменение.
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16.3.1 Использование линейных интерполяций

Когда интерполяция Линейная, сегмент кривой превращается в прямую линию, и скорость преобразо-
вания постоянна.

Совет: Чтобы установить линейную интерполяцию:

Выполните одно из следующих действий:

• Выберите Линейная в меню параметров, доступных в области интерполяции редактора функ-
ций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить интерпо-
ляцию, и выберите Линейная интерполяция в открывшемся меню.
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16.3.2 Использование интерполяции ускорения в начале/в конце

Когда интерполяцией выбрана в начале/конце, обе контрольные точки на концах сегмента имеют
указатели, направление и длина которых определяют наклон кривой, следовательно, скорость пре-
образования. Направление и длину маркеров можно задать, введя значения в области интерполяции
редактора функций или перетащив сами маркеры.

По умолчанию указатели связаны, что делает их степень перемещения зависимой от соседних сегмен-
тов, чтобы определить плавную кривую, но связь может быть разорвана, чтобы перемещать указатель
свободно. Например, если последующие сегменты имеют интерполяцию в начале/конце, маркеры об-
щих точек имеют одинаковое направление, но при разрыве связи каждый указатель может иметь
различное направление.

Указатели также можно свернуть в контрольных точках, чтобы превратить их в угловые точки; в этом
случае для извлечения указателей можно сбросить их длину и направление.

Совет: Чтобы установить интерполяцию в начале/конце:

Выполните одно из следующих действий:

• Выберите Ускорение в начале/конце из выпадающего меню, доступного в области интерпо-
ляции редактора функций, и нажмите кнопку Применить.

• Нажмите правой кнопкой мыши на сегмент кривой, для которого вы хотите установить интер-
поляцию, и выберите Speed In / Speed Out Interpolation в открывшемся меню.

Совет: Чтобы установить скорость интерполяции:

1. Выберите ключевой кадр в начале или в конце сегмента кривой, который вы хотите редактиро-
вать, или сам сегмент кривой.

2. Установите наклон кривой после или перед ключевым кадром, выполнив одно из следующих
действий:

• Введите значения направления и длины Замедл. в начале и Замедл. в конце в области
интерполяции редактора функций и нажмите кнопку Применить.
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• Нажмите и перетащите концы указателей чтобы свободно перемещать их.

• Удерживая нажатой клавишу Shift, перетащите конец маркеров, чтобы переместить их с
ограничением в горизонтальном или вертикальном направлении.

Совет: Чтобы переместить указатель контрольной точки от соседних сегментов:

Щелкните правой кнопкой мыши контрольную точку и выберите Разъединить Handles в открыв-
шемся меню.

Совет: Чтобы связать обратные указатели с соседними сегментами:

Щелкните правой кнопкой мыши контрольную точку и выберите Связать Handles в открывшемся
меню.

Совет: Чтобы превратить контрольную точку в угловую точку:

1. Выберите контрольную точку.

2. Переместите концы указателя к контрольной точке, чтобы сложить их.

Совет: Чтобы восстановить указатели из угловой точки:

Щелкните правой кнопкой мыши контрольную точку и выберите Сбросить Handles в открывшемся
меню.

16.3.3 Применение Ease In / Ease Out интерполяции
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Когда интерполяцией является Ease In / Ease Out, сегмент делится на три секции двумя вертикаль-
ными линиями: первая секция - ускорение, вторая - с постоянной скоростью, третья - замедление.
Длительность в кадрах каждого раздела можно установить, введя значения в области интерполяции
редактора функций или перетащив вертикальные линии, доступные на сегменте.

Совет: Чтобы установить интерполяцию Ease In / Ease Out:

Выполните одно из следующих действий:

• Выберите Замедл. в начале/в конце из выпадающего меню, доступного в области интерполя-
ции редактора функций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить преобразо-
вание, и выберите Ease In / Ease Out Интерполяция в открывшемся меню.

Совет: Чтобы установить Ease In / Ease Out из интерполяции:

1. Выберите ключевой кадр до или после сегмента кривой Ease In / Ease Out, который вы хотите
редактировать, или самого сегмента кривой.

2. Выполните одно из следующих действий:

• Введите значения Замедл. в нач и Замедл. в конце в области интерполяции редактора функ-
ций и нажмите кнопку Применить.

• Переместите вертикальную линию, устанавливая секцию Ease In или Ease Out сегмента, чтобы
изменить кривую после или перед ключевым кадром.

16.3.4 Использование Замедление в начале/в конце % интерполяции

Интерполяция Ease In / Ease Out % аналогична интерполяции Ease In / Ease Out, но секции Ease In
и Ease Out сегментов выражаются в процентах от длительности кадра сегмента.

332 Глава 16. Редактирование с использованием электронных таблиц и кривых



OpenToonz Documentation, Выпуск 1.7.1

Совет: Чтобы установить Ease In / Ease Out %:

Выполните одно из следующих действий:

• Выберите Ease In / Ease Out% в раскрывающемся меню, доступном в области интерполяции
редактора функций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить преобразо-
вание, и выберите Ease In / Ease Out % интерполяция в открывшемся меню.

Совет: Чтобы установить Ease In / Ease Out % от интерполяции:

1. Выберите ключевой кадр до или после сегмента кривой Ease In / Ease Out, который вы хотите
редактировать, или самого сегмента кривой.

2. Выполните одно из следующих действий:

• Введите значения Замедл. в нач и Замедл. в конце в области интерполяции редактора функ-
ций и нажмите кнопку Применить.

• Переместите вертикальную линию, устанавливая секцию Ease In или Ease Out сегмента кривой,
чтобы изменить кривую после или перед ключевым кадром.

16.3.5 Применение экспоненциальной интерполяции

Когда интерполяция Экспоненциальная, сегмент кривой превращается в кривую, которая постоянно
становится круче, из-за чего, чем выше кадр, тем быстрее растет соответствующее значение. Для этой
интерполяции важны только положительные значения.

Совет: Чтобы установить экспоненциальную интерполяцию:

Выполните одно из следующих действий:
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• Выберите Экспоненциальная в раскрывающемся меню, доступном в области интерполяции
редактора функций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить преобразо-
вание, и выберите Экспоненциальная интерполяция в открывшемся меню.

16.3.6 Использование интерполяции на основе выражений

Когда интерполяция определяется выражением, значения сегмента поступают из математической
формулы, которая может быть набрана с помощью обозначений алгебры. В этом случае ключевые
кадры на обоих концах сегмента также могут изменяться в соответствии с набранным выражением.

При вводе выражения, если синтаксис распознан, автоматически открывается меню, предлагающее
вам возможные термины: из меню вы можете выбрать термин, чтобы отобразить в окне подсказки его
правильный синтаксис и вставить его в выражение.

Как только термины распознаются, для их выделения используются разные цвета: операторы и
функции отображаются темно-синим, переменные - голубым, константы - зеленым. Когда выра-
жение введено, любая синтаксическая ошибка будет отображаться красным.

Ед. изм используемая для функции, отображается в поле рядом с выражением; если единица отно-
сится к движению, единицу по умолчанию можно изменить, и значения будут автоматически преоб-
разованы в единицу по умолчанию.

Помимо стандартных операторов и функций, некоторые переменные и предопределенные функции
также могут использоваться в выражениях.

Поддерживаются следующие термины:

Операторы
+ , - , * , / Сложение, вычитание, умножение, деление
% Модуль: 10%6=4 .
^ Возведение в степень: a^2 означает a*a ; a^0.5 - квадратный корень из a .
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Математические
функции
sin(), cos(),
tan(), atan(),
atan2()

Углы, выраженные в градусах.

sinh() , cosh() ,
tanh()

Гиперболические функции.

log() , exp()
floor(value) Наибольшее целое число, меньшее или равное value.
ceiling(value) Наименьшее целое число меньшее или равное value.
round(value) Целое число, ближайшее к value.
abs() Абсолютное значение: abs (a) это a без знака.
sign(value) Возвращает 0, если value равно 0; -1 если отрицательное; 1, если положи-

тельное.
sqrt(value) Возвращает квадратный корень из value.
min(a,b,c,...) Возвращает аргумент с минимальным значением.
max(a,b,c,...) Возвращает аргумент с максимальным значением.
clamp(value,min,
max)

Возвращает min, если значение меньше min; max, если значение больше max;
в противном случае оно возвращает value.

crop(value,min,
max)

Возвращает min, если значение меньше min; max, если значение больше max;
в противном случае оно возвращает value.

step(value,min) Возвращает 0, если value меньше, чем min, в противном случае возвращает
1.

smoothstep(value,
min,max)

Возвращает 0, если value меньше, чем min, 1, если value больше или равно
max, и выполняет плавную интерполяцию между 0 и 1 в интервале от min
до max.

Логические операторы
< Меньше
<= Меньше или равно.
> Больше
>= Больше или равно.
== Равно.
!= Не равно.

Булевы операторы
&& И.
|| Или.
! Не.

Условное выражение
(logical_expression)?
value1:value2

Если logical_expression истинно, то возвращается value1, иначе
возвращается value2.
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Перемен-
ные
t Изменяется от 0,0 до 1,0 вдоль перехода, позволяя переходы независимо от положе-

ния/длины.
f , frame Текущий номер кадра.
r , rframe Относительно перехода.

Постоянные
pi 3.141593. . .
числовая константа Например, 1, 2, 4,3 .

Предопределенные
функции
cycle(period) Циклический переход периода к предыдущим кадрам.
pulse(pos) ,
pulse(pos,length)

Генерирует импульс в диапазоне от 0,0 до 1,0, установленный в позиции pos,
с различной шириной в зависимости от длины самого импульса.

bump(pos) ,
bump(pos,length)

Создает удар в диапазоне от 0,0 до 1,0, установленный в позиции pos, с
различной шириной в зависимости от длины поднять себя.

random Генерирует случайные последовательности от 0,0 до 1,0.
random(max) Генерирует случайное число между 0,0 до max.
random(min,max) Генерирует случайное число между ‘‘ min‘‘ и ‘‘ max‘‘.
random_s(seed) Работает как random, но позволяет пользователю указать seed для измене-

ния значения функции random.
random_s(seed,max) Как и выше, с max в качестве максимального значения перехода.
random_s(seed,min,
max)

Как и выше, с min и max в качестве минимального и максимального значений
перехода.

saw(length) ,
saw(length,height)

Генерирует периодическую пилообразную кривую в соответствии со значе-
ниями length и height; если высота не выражена, предполагается, что она
равна длине.

sawtooth(length) ,
sawtooth(length,
height)

Генерирует периодическую пилообразную кривую в соответствии со значе-
ниями length и height; если высота не выражена, предполагается, что она
равна длине.

wave(length) То же, что и sin(f*2*pi/length).

Примечание: Предопределенные функции saw, wave и pulse неявно используют переменную,
независимую от номера кадра. Вы можете явно указать переменную, используя форму: fun (var;
arguments...).

Совет: Чтобы установить интерполяцию на основе выражения:

Выполните одно из следующих действий:

• Выберите Выражение в раскрывающемся меню, доступном в области интерполяции редактора
функций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить преобразо-
вание, и выберите Интерполяция выражений в открывшемся меню.
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Совет: Чтобы установить выражение:

1. Введите выражение в области интерполяции редактора функций. По мере ввода, если синтаксис
распознается, автоматически открывается меню, предлагающее вам возможные термины.

2. Нажмите Enter, чтобы отправить выражение и проверить его синтаксис.

3. Если выражение относится к движению, при необходимости измените единицу измерения.

4. Нажмите кнопку Применить, чтобы применить желаемое изменение.

Совет: Чтобы выбрать предложенный термин:

Выполните одно из следующих действий:

• Используйте клавиши Стрелка вверх и Стрелка вниз, чтобы выбрать термин в открывшемся
меню, затем нажмите Enter.

• Нажмите термин в открывшемся меню.

Примечание: При выборе термина с помощью клавиш со стрелками в окне подсказки отображается
термин правильный синтаксис.

Использование ссылок на трансформацию

В выражениях можно использовать ссылки на любое преобразование object, effect или Plastic vertex. Та-
ким образом, выражения могут использоваться для создания отношений между различными преобра-
зованиями, принадлежащими различным элементам, которые могут быть любого из вышеупомянутых
типов.

Синтаксис для создания ссылки на преобразование объекта следующий:

object.transformation или object.transformation (delta)

где object - это идентификационное имя camera, column, pegbar или *table *, которое можно прочитать
во всплывающих подсказках узлов Stage и FX Schematic; ‘‘ преобразование‘‘ может быть любым из
доступных преобразований; и delta - это разница между целевым кадром и текущим.

For example camera1.y refers to the Y position of the Camera1. Whereas camera1.y(f-5) refers to the Y
position of the Camera1, 5 frames before the current frame.

Поддерживаются следующие термины:

Объекты
cam<n> , camera<n> Относится к камере n.
col<n> Относится к столбцу n .
peg<n> , pegbar<n> Относится к штифтам n .
tab , table Относится к анимационному столу.
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Преобразования
x , y Refer to the horizontal and vertical position.
path , pos Относится к положению вдоль траектории движения.
rot Refers to the rotation around the z axis.
scale , scaleh ,
scalev

Относится к глобальному, вертикальному и горизонтальному масштабиро-
ванию.

shearh , shearv Относится к горизонтальному и вертикальному сдвигу.
z Относится к положению вдоль оси Z.

Синтаксис для создания ссылки на параметр эффекта следующий:

fx.name.parameter или fx.name.parameter (delta)

где name - это имя эффекта, которое можно прочитать во всплывающих подсказках к узлам FX
Schematic, parameter - любой из доступных параметров эффекта, а delta - разница между целевым
кадром и текущим.

Когда параметр эффекта имеет несколько подпараметров, например, параметр Center имеет подпара-
метры X и Y, синтаксис должен быть следующим:

fx.name.parameter.subparameter или fx.name.parameter.subparameter (delta)

где name может быть любым используемым эффектом, parameter основным параметром эффекта,
subparameter является субпараметром эффекта, а delta является разницей между целевым кадром и
текущим один.

Например, fx.blur2.value относится к параметру Value эффекта Blur2; fx.blur2.value(f-5) ссы-
лается на параметр Value эффекта Blur2, за 5 кадров до текущего кадра; и fx.raylit1.center.x
относится к подпараметру X параметра Center эффекта Raylit1.

Примечание: Если имя параметра эффекта состоит из нескольких слов, они должны быть набраны
в выражениях без пробелов.

Синтаксис для создания ссылки на пластическое преобразование вершины следующий:

vertex (column_number, "vertex_name").transformation или ‘‘vertex (column_number,
«vertex_name»).transformation(delta) ‘‘

где column_number - это идентификационный номер столбца, в котором существует указанная вершина,
vertex_name - точное имя упомянутой пластиковой вершины, transformation - любое из доступных
преобразований вершины (см. ниже), а delta - это разница между целевым кадром и текущим.

Пластиковые вершинные преобразова-
ния
angle Относится к углу между вершиной и ее родителем.
distance Относится к расстоянию между вершиной и ее родите-

лем.
so Относится к порядку сортировки вершин.

См. Использование математических выражений в пластической анимации для получения дополни-
тельной информации об анимации пластиковой сетки с использованием выражений.
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16.3.7 Использование интерполяций на основе данных файла

Когда интерполяция основана на данных файла, значения сегмента извлекаются из содержимого фай-
ла. В этом случае ключевые кадры на обоих концах сегмента также могут изменяться, согласно данным
файла.

Файл может быть создан внешним устройством или другими приложениями, такими как камеры управ-
ления движением или программное обеспечение 3D; поддерживаемые форматы файлов: BAT, DAT,
RTF и TXT.

Значение для каждого кадра берется из содержимого файла, которое должно состоять из последова-
тельности чисел, перечисленных в нескольких строках.

Если файл содержит несколько значений в каждой строке, можно определить, какое значение в каждой
строке следует использовать, указав номер столбца. Например, если у вас есть такой файл:

100, 200, 300

101, 201, 301

102, 202, 302

значение 2 приведет к загрузке 200, 201, 202.

Единица, используемая для данных, отображается в поле рядом с путем к файлу; если единица отно-
сится к движению, единицу по умолчанию можно изменить, и значения будут автоматически преоб-
разованы в единицу по умолчанию.

Совет: Чтобы установить интерполяцию на основе данных файла:

Выполните одно из следующих действий:

• Выберите Файл в меню параметров, доступном в области интерполяции редактора функций, и
нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить преобразо-
вание, и выберите Интерполяция из файла в открывшемся меню.
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Совет: Чтобы установить информацию о файле:

1. Введите в поле Путь к файлу или используйте кнопку браузера, чтобы указать путь к файлу
данных.

2. Укажите, какое значение в каждой строке следует использовать, указав число Столбец.

3. Если данные файла относятся к движению, при необходимости измените единицу измерения.

Примечание: Если в браузере вы выбираете какую-либо папку проекта по умолчанию, в поле пути
полный путь будет заменен соответствующим псевдонимом папки по умолчанию (см. Папки проекта
по умолчанию).

16.3.8 Использование постоянных интерполяций

Когда интерполяция Равномерная, значения сегмента всегда равны значению первого ключа, опре-
деляющего сегмент.

Совет: Чтобы установить постоянную интерполяцию:

Выполните одно из следующих действий:

• Выберите Постоянная в меню параметров, доступном в области интерполяции редактора функ-
ций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши сегмент кривой, для которого вы хотите установить интерпо-
ляцию, и выберите Равномерная Интерполяция в открывшемся меню.
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16.3.9 Использование интерполяций на основе похожих фигур

Когда интерполяция основана на аналогичной форме, значения сегмента изменяются в соответствии
с формой кривой, которую вы указываете в качестве ссылки (см. Использование ссылок на преобразо-
вание). Как только интерполяция установлена, каждый раз, когда эталонная кривая редактируется,
сегмент изменяется соответственно.

Эта интерполяция оказывается полезной, когда вы хотите управлять сразу несколькими кривыми: если
все они имеют одну и ту же базовую кривую, изменяя базовую кривую, вы автоматически модифици-
руете все кривые, относящиеся к ней.

Также можно установить значение Смещение кадра, чтобы интерполяция относилась не к тому же
диапазону кадров эталонной кривой, а к другому.

Совет: Чтобы установить интерполяцию на основе аналогичной формы:

Выполните одно из следующих действий:

• Выберите Аналогичная форма в меню параметров, доступных в области интерполяции редак-
тора функций, и нажмите кнопку Применить.

• Щелкните правой кнопкой мыши по сегменту кривой, для которого вы хотите установить преоб-
разование, и выберите Интерполяция аналогичной формы в открывшемся меню.

Совет: Чтобы установить референсную кривую:

1. Задайте Референсную кривую: в области интерполяции редактора функций, введя ссылку на
объект или преобразование эффекта, используя соответствующий синтаксис (см. Использование
ссылок на преобразование).

2. Установите Смещение кадра в области интерполяции редактора функций, если вы хотите,
чтобы интерполяция ссылалась не на тот же диапазон кадров эталонной кривой, а на другой.

3. Нажмите кнопку Применить, чтобы применить желаемое изменение.
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16.4 Управление несколькими функциональными кривыми од-
новременно

Можно управлять ключами и интерполяцией всех функциональных кривых, визуализированных в
Редакторе функций, используя виджеты, доступные в горизонтальной полосе в верхней части области
Редактор графиков, под линейкой кадров.

Это позволяет вам определять ключи и управлять скоростью интерполяции для разных кривых одно-
временно, например, для камеры и панорамирования, или для анимации эффекта и движения штиф-
тов.

Что касается ключей, ключевой кадр виден в полосе для каждого ключевого кадра, определенного для
любой кривой, видимой в редакторе графиков; линия соединяет ключевые кадры для всех кадров, в
которых происходит анимация. Ключевой кадр полосы можно перемещать, автоматически перемещая
ключевые кадры, к которым он относится; если ключевой кадр полосы ссылается на ключевые кадры
в одном и том же кадре в нескольких кривых, все ключевые кадры будут двигаться вдоль.

Что касается интерполяции, если все видимые кривые имеют ключ в одном и том же конкретном кад-
ре, а сегмент на стороне ключа имеет одинаковое значение Ease In/Ease Out или одинаковое Speed
In/Speed Out горизонтальный компонент, маркер будет виден в полосе на боковой стороне ключевых
кадров полосы. Маркер в форме открывающей квадратной скобки предназначен для сегмента справа
от ключевого кадра, а маркер в форме закрывающей квадратной скобки - для сегмента слева от клю-
чевого кадра. Маркеры можно перемещать, автоматически изменяя значения Ease In/Ease Out или
Speed In / Speed Out всех сегментов, к которым они относятся.

Совет: Чтобы установить, какие кривые должны контролироваться:

Отобразите кривые в редакторе графиков (см. Использование редактора графиков).

Совет: Чтобы добавить ключевой кадр:

Кликните, нажав клавишу Ctrl (PC) или Cmd (Mac) на линейке кадров, в которую вы хотите добавить
ключевой кадр: ключевой кадр будет добавлен ко всем видимым кривым.

Совет: Чтобы переместить ключевой кадр:

Нажмите и перетащите ключевой кадр полосы: все ключевые кадры, на которые он ссылается, будут
перемещаться.

Совет: Для контроля скорости интерполяции:

Переместите маркеры, видимые по бокам ключевых кадров полосы.

16.5 Примеры выражений

16.5.1 Example Expressions
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Aim At

This expression rotates column 1 (col1) to face column 2 (col2):

atan2(col2.ns - col1.ns, col2.ew - col1.ew)
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Глава 17

Создание перекладной анимации

Перекладная анимация основана на персонажах, состоящих из нескольких частей, соединенных вме-
сте для создания модели персонажа. Например, базовая модель может быть сделана из рисунка для
головы, одного для тела, одного для каждой руки и одного для каждой ноги.

Анимации в этом случае могут быть созданы не путем добавления рисунков, изображающих новые
анимированные позы, а путем преобразования (то есть перемещения или вращения) отдельных частей
модели в разных кадрах для создания разных действий.
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В OpenToonz можно создавать связи между различными разделами модели и устанавливать точки
поворота для каждого из них, чтобы лучше управлять анимацией. Например, вы можете связать руку
с рукой на запястье и связать руку с туловищем на плече: таким образом, когда вы двигаете туловище,
вы также будете двигать рукой и рукой; когда вы двигаете руку, она поворачивается вокруг плеча, и
рука будет следовать за ее движением; когда вы двигаете рукой, она поворачивается вокруг запястья.

Совет: Чтобы создать перекладную анимацию:

1. Поместите каждый раздел (который может быть одним рисунком или анимированным уровнем)
вашего персонажа в другой столбец/слой.

2. С помощью инструмента Скелет ( ) свяжите каждый раздел с другим и установите соответ-
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ствующие точки поворота.

3. Создайте ключевые кадры для каждого раздела в разных кадрах, чтобы анимировать персонажа.

17.1 Использование Инструмента Скелет

Инструмент Скелет ( ) позволяет определять модель, устанавливая иерархические связи между
различными ее разделами, представленными в разных столбцах Xsheet (или слоях Timeline) и аними-
ровать ее.

По сути, это позволяет с помощью одного и более непосредственного инструмента выполнять те же за-

дачи, которые можно выполнить с помощью схемы этапов и инструмента Анимирования ( ), когда
он используется для создания ссылок и анимации преобразований столбцов/слоев (см. Связывание объ-

ектов). Действительно, любое редактирование, выполняемое с помощью инструмента Скелет ( ),
также может быть замечено происходящим в схеме этапа и значениях преобразования столбцов/слоев,
и наоборот.

На панели параметров инструмента вы можете установить следующее:

• Режим устанавливает операцию, выполняемую с инструментом. Варианты: Создать скелет,
чтобы создать связи между различными разделами, Анимировать, чтобы анимировать модель
персонажа, и Обратная кинематика, чтобы анимировать модель персонажа, используя обрат-
ную кинематику.

• Глобальный ключ при активации устанавливает ключ для всех преобразований объекта, как
только ключ определен путем анимации скелета. Это означает, что если вы поворачиваете секцию
модели, автоматически будет определен ключ для трансформации положения, масштабирования
и сдвига.

• Параметр Показать только активный скелет если активирован, отображает только точки
разворота и скелет от текущего раздела до родительского раздела: таким образом, будет легче
управлять персонажами со скелетами более высокой сложности.

17.2 Построение скелета

Когда режим инструмента Скелет ( ) установлен на Создать скелет, можно устанавливать точки
поворота и связи между разделами, используя дескриптор, доступный в окне просмотра.
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Указатель представляет собой небольшой круг с рычагом, который по умолчанию направлен вверх.
Это позволяет выполнять следующие задачи:

• Нажмите и перетащите желтый круг, чтобы установить положение точки поворота.

• Нажмите и перетащите квадрат в конце расширенного рычага, чтобы установить ссылку на
другой раздел.

Примечание: Точка вращения секции может быть перемещена, но не может изменить свою позицию
во время анимации: после того, как она установлена или изменена, она сохраняется в течение всей
анимации. Если точка поворота менялась много раз, и вы хотите вернуть ее в исходное положение,
щелкните правой кнопкой мыши раздел в схеме сцены и выберите Сброс центра в открывшемся
меню.

Указатель ссылается на текущий раздел; когда вы связываете один раздел с другим, графически отоб-
ражается ссылка, соединяющая центры двух разделов. Когда один или несколько разделов связаны,
все их ссылки и связанные с ними центры также отображаются, конфигурируя каркас для модели.

17.3 Создание базовых моделей

Базовая модель состоит из секций, связанных между собой своими центрами. Его проще создавать по
сравнению с моделью, основанной на крюках (см. Создание моделей с крюками), и имеет некоторые
ограничения, но подходит для перекладной анимации в большинстве случаев.
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По умолчанию каждый раздел имеет центр, который находится в центре окна просмотра. При со-
здании модели этот центр должен быть перемещен туда, где должна быть точка поворота для этого
конкретного сечения.

Инструмент Скелет ( ) позволяет вам как изменить центральное положение выбранного в данный
момент раздела модели, так и связать его с центром другого раздела, видимого в окне просмотра.

Обычно проще начать работу с родительского раздела, а затем связать другие разделы один за другим,
следуя по одному элементу за раз. Например, сначала установите центр туловища модели, затем уста-
новите точку поворота руки и свяжите руку с туловищем, затем установите точку поворота предплечья
и свяжите предплечье с рукой, затем установите точку поворота руки и свяжите руку с предплечье и
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т.д.

Если разделы вашей модели нарисованы в нужном месте, все, что вам нужно сделать для определения
каркаса, это установить точки поворота и ссылки. Если это не так, вы можете установить правильное
положение сечения до или после установки ссылок с помощью инструмента Анимирования или ин-
струмента Скелет в режиме Анимировать (см. Анимирование объектов и Анимирование моделей).

Совет: Чтобы выбрать раздел модели:

Выберите инструмент Скелет ( ), установите режим Создать скелет и щелкните раздел в окне
просмотра.

Совет: Чтобы установить точку вращения выбранного раздела:

Нажмите и перетащите желтый круг.

Совет: Чтобы связать выбранный раздел с другим разделом:

1. Нажмите и перетащите квадрат в верхней части указателя в раздел, который вы хотите
стать родительским. Перетаскиваемый раздел выделяется отображением ограничивающего пря-
моугольника, а метка отображает информацию о ссылке, которую вы собираетесь создать.

2. Отпустите, чтобы установить ссылку.

Совет: Чтобы разорвать связь между выделенным разделом и его родителем:

Нажмите и перетащите квадрат в середине графической ссылки между связанными разделами от
родительского.

Совет: Для визуализации только скелета от текущего раздела до родительского раздела:

Активируйте параметр Показывать только активный скелет на панели параметров инструмента.

17.4 Создание моделей с помощью крюков

Иногда базовые модели могут не давать желаемых результатов, поскольку положения точек поворота в
каркасе являются фиксированными и, следовательно, не могут следовать изменениям разделов модели,
которые сами являются анимированными уровнями.
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Например, предположим, что у вас есть персонаж, туловище которого представляет собой анимиро-
ванный уровень, состоящий из нескольких рисунков изгиба туловища: при продолжении анимации
туловища конечности, связанные с ним, не будут следовать за движением туловища (поскольку туло-
вище не двигается или вращается с точки зрения его значений преобразования).

Используя крюки, вы можете указать, рисуя на чертеже, где должны быть расположены точки поворо-
та: таким образом, модель будет сохранять свою согласованность даже при использовании различных
рисунков с уровня анимации в ходе действия (см. Использование крюков).

Например, путем размещения крючков на рисунках туловища и конечностей (где они должны быть со-
единены) и определения связей с использованием крюков вместо центров, конечности будут следовать
за туловищем, даже если оно изгибается.

Инструмент Скелет ( ) позволяет вам одновременно установить крюк в качестве точки поворота
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для раздела и связать его с конкретным крюком другого раздела, видимого в окне просмотра.

Крюки должны быть размещены для каждого раздела модели персонажа, где вы хотите, чтобы были
суставы. Например, туловище может иметь пять крючков, один для головы, два для рук и два для
ног; предплечье может иметь два крючка, один для локтя и один для запястья.

При использовании инструмента Крюк ( ) для определения крюков для разделов модели можно
активировать опцию Привязка (см. Использование крюков). Таким образом, можно размещать крюки
точно в том же положении, что и крюки, уже определенные для других уровней анимации, видимых в
окне просмотра, или, если уровень является векторным уровнем Toonz, в центре закрытых фигур (та-
ких как прямоугольники, круги или одиночные векторные фигуры, замкнутые с помощью инструмента
Скотч).

Это означает, что если разделы модели нарисованы в нужном месте, вы можете определить идеально
перекрывающиеся крюки, чтобы конечности сохраняли свое положение, когда крюки связаны; или
вы можете использовать обычные фигуры на векторных рисунках Toonz (например, круги), чтобы
определить перекрывающиеся области конечностей модели, и, следовательно, поместить крюки точно
в их центр, чтобы достичь идеального соответствия, когда крюки связаны.

Примечание: Номер крюка - просто метка для идентификации крюков, и она не имеет значения при
выполнении ссылок.

Обычно проще начать работу с родительского раздела, а затем связать другие разделы один за другим,
следуя по одной конечности за раз.

Когда начинается сборка скелета с крюками, могут иметь место два разных случая: разделы модели
изображены не в нужном месте, один по отношению к другому; или они нарисованы в нужном месте
один по отношению к другому.

В первом случае соответствующий крюк сначала должен быть установлен в качестве точки поворота
для раздела модели, затем может быть создана ссылка. Обратите внимание, что при установке крюка
в качестве новой точки поворота крюк и, следовательно, раздел смещаются к центру рабочей области;
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как только вы связываете этот раздел с крюком другого раздела, он попадает в нужное место, причем
два крюка полностью перекрываются.

Во втором случае крюк выбранной секции и крюк другой секции перекрываются (например, крючок
на запястье секции руки перекрывает крючок на запястье секции предплечья) и специальная кнопка,
отображающая информацию о перекрытии крючки могут быть использованы для автоматического
связывания двух разделов одним щелчком мыши.

Совет: Чтобы выбрать раздел модели:

Выберите инструмент Скелет ( ), установите режим Создать скелет и щелкните раздел в окне
просмотра.

Совет: Чтобы установить крюк в качестве точки поворота выбранного раздела:

Нажмите на метку крюка, отображаемую рядом с крюком.

Совет: Чтобы связать выбранный раздел с крюком другого раздела:

1. Нажмите и перетащите квадрат вверху маркера до раздела, родитель которого вы хотите.
Отображаются все крюки, а участок, на который вы перетаскиваете, выделяется с помощью
ограничивающего прямоугольника.

2. Перетащите в сторону крючка, с которым вы хотите связать раздел: отображается метка крючка,
а другой ярлык отображает информацию о ссылке, которую вы собираетесь создать.

3. Отпустите, чтобы установить ссылку.

Совет: Чтобы связать два пересекающихся крюка:
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Нажмите на ярлык рядом с перекрывающимися крюками, отображающими информацию о ссылке,
которую вы собираетесь создать.

Совет: Чтобы разорвать связь между выделенным разделом и его родителем:

Нажмите и перетащите квадрат в середине графической ссылки между связанными разделами от
родительского.

Совет: Для визуализации только скелета от текущего раздела до родительского раздела:

Активируйте параметр Показывать только активный скелет на панели параметров инструмента.

17.5 Анимирование моделей

Когда режим инструмента Скелет ( ) установлен на Анимировать, можно задавать позиции для
разделов модели в различных кадрах, тем самым определяя анимацию.

В окне просмотра можно выбрать раздел модели и выполнить следующие задачи:

• Щелкните в любом месте, чтобы повернуть текущий раздел.

• Нажмите и перетащите зеленый квадрат с четырьмя стрелками, чтобы переместить текущий
раздел.

Примечание: При наведении курсора указатель курсор меняет форму, указывая на те операции,
которые вы можете выполнить.

Каждый раз, когда устанавливается позиция для раздела, ключевой кадр автоматически создается для
столбца Xsheet (или слоя Timeline), где этот раздел отображается, в текущем кадре. Ключи создаются
только для преобразования, которое вы изменяете: вращение, смещение или оба.

Также возможно активировать опцию Глобальный ключ, чтобы установить ключевой кадр для всех
преобразований раздела, включая масштабирование и сдвиг, как только будет установлен ключевой
кадр для одного преобразования. Это может оказаться полезным, если вы хотите сначала анимировать
модель, а затем уточнить анимацию, добавив преобразования растяжения и сжатия.

Если вы хотите создать ключевой кадр без работы с указателями, чтобы оставить положение раздела

и вращение такими, какие они есть, вы можете использовать кнопку Установить ключ ( ), до-
ступную в нижней панели окна просмотра. В этом случае ключи создаются для всех преобразований
объектов (см. Анимирование объектов). Также можно управлять ключами для нескольких разделов
модели одновременно, вставляя или удаляя ключи, влияющие на Xsheet/Timeline в целом, или на
выбор столбцов Xsheet (или слоев Timeline) (см. Работа с несколькими ключами столбцов).

Ключи и интерполяции, которые вы определяете таким образом, отображаются в столбцах Xsheet (или
слоях Timeline), где ими можно напрямую управлять (см. Использование ключей столбцов).

Поскольку ключевые кадры могут быть определены в определенных кадрах только для определенных
определенных разделов, вы можете откалибровать анимацию и скорость движения вашей модели так,
как вы предпочитаете.
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Примечание: Столбцы/слои также можно анимировать, работая в редакторе функций (см. Редак-
тирование с использованием электронных таблиц и кривых)

Если раздел модели представляет собой уровень анимации, состоящий из нескольких рисунков, а не
одного (например, если рука персонажа является уровнем анимации, состоящим из рисунков руки в

разных положениях), инструмент Скелет ( ) позволяет также пролистывать рисунки, чтобы вы-
брать тот, который вам нужен.

Совет: Чтобы выбрать раздел модели:

Выберите инструмент Скелет ( ), установите режим на Анимировать и щелкните раздел в окне
просмотра.

Совет: Поворот выбранного раздела:

Нажмите и перетащите куда-либо в окне просмотра.

Совет: Чтобы переместить выбранный раздел:

Нажмите и перетащите зеленый квадрат с четырьмя стрелками, доступными справа от текущей точки
поворота сечения.

Совет: Для визуализации только точек разворота текущего раздела до родительского
раздела:

Активируйте параметр Показать только активный скелет на панели параметров инструмента
«Скелет».

Совет: Чтобы просмотреть рисунки, относящиеся к уровню анимации:

Нажмите метку с именем уровня справа от точки поворота текущего раздела и пролистайте следую-
щие и предыдущие кадры, выполнив одно из следующих действий:

• Перетащите вверх или вниз.

• Нажмите стрелки вверх или вниз.

17.6 Использование обратной кинематики

Когда режим инструмента Скелет ( ) установлен на Обратная кинематика, можно перемещать
модель, учитывая артикуляцию всех секций, из которых сделан ее скелет. Это означает, что если вы
хотите переместить конец конечности модели в определенную позицию, все остальные секции, принад-
лежащие этой конечности, будут перемещаться, следовательно, без необходимости перемещать каждую
секцию отдельно.
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Например, если вы хотите, чтобы рука персонажа достигла определенной точки, вам не нужно отдельно
анимировать руку и предплечье, но вместо этого вы можете переместить руку в конечное положение,
автоматически настраивая участки руки и предплечья.

Когда активирован режим Обратная кинематика, отображается полный скелет с точками поворота
и ссылками.

При перемещении модели ключевой кадр поворота автоматически определяется для всех секций, участ-
вующих в движении, если только не активирована опция Глобальный ключ, в результате чего со-
здается ключевой кадр для всех преобразований раздела.

Примечание: При использовании обратной кинематики движения родительского участка скелета ав-
томатически рассчитываются, чтобы обеспечить правильную конфигурацию скелета; это означает, что
их нельзя редактировать больше с помощью стандартных инструментов редактирования движения,
таких как инструмент Анимирования или Редактора функций. Чтобы вернуться в стандартный
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режим редактирования движения, необходимо сбросить информацию о закрепленных центрах.

17.6.1 Закрепленный центр

Один единственный центр (по умолчанию расположенный в разделе, которая является родителем ске-
лета), отображается в виде синего квадрата: это означает, что он закреплен, и его положение не
изменится на протяжении всей анимации, когда разделы персонажа анимированы.

Закрепленный центр можно перемещать от соединения к другому вдоль анимации, чтобы центр
был закреплен только для определенного диапазона кадров. Когда закрепленный центр изменяется в
конкретном кадре, все предыдущие кадры сохранят ранее закрепленный центр; все последующие
кадры будут иметь новый закрепленный центр до кадра, где заранее определено другое закреп-
ленное центральное положение, если оно есть.

Изменение закрепленного центра позволяет создать более сложную анимацию, в которой фиксирован-
ные точки должны меняться во время движения модели, например, движение, когда одна лодыжка
закреплена, пока персонаж делает первый шаг, а другая лодыжка закреплена во время второго шага.

Примечание: После определения закрепленного центра он останется активным при анимации участ-

ков скелета как с помощью инструмента Скелет ( ), так и с помощью инструмента Анимирования

( ). Чтобы снова свободно анимировать любую часть скелета, сбросьте информацию о закрепленном
центре (см. ниже).

17.6.2 Временно закрепленные центры

Несколько дополнительных центров могут быть временно закреплены в любом кадре, чтобы огра-
ничить дополнительные соединения определенным положением. В отличие от закрепленного центра
временно закрепленные центры не сохраняются при изменении текущего кадра, так как они ис-
пользуются только для определения положения секций в определенном кадре.

Использование временно закрепленных центров позволяет определять конкретные позы в опре-
деленных кадрах, например, подъем руки путем закрепления плечевого сустава.

В соответствии с закрепленным центром и временно закрепленными центрами можно щелкнуть лю-
бую точку любого раздела и перетащить ее, чтобы переместить модель: все родительские секции вплоть
до первого закрепленного центра вдоль скелета будут двигаться в то время как все связанные секции
до свободного конца конечности будут жестко двигаться с выбранной секцией. Участки, затронутые
движением, выделяются, отображая линии связи красным.

Информация и координаты закрепленных центров сохраняются вместе со сценой; в случае, если вы
хотите удалить его или запустить анимацию, используя обратную кинематику с нуля, эта информация
может быть сброшена до значения по умолчанию, где закреплен только центр родительской части
скелета.

Совет: Для анимации модели с помощью обратной кинематики:

1. Выберите инструмент Скелет ( ) и установите режим Обратная кинематика.

2. Щелкните любую точку любой секции модели и перетащите ее в нужное место.
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Совет: Чтобы установить закрепленный скелет в центре:

Щелкните по центру: он превращается из оранжевого круга в синий квадрат, чтобы указать, что
он закреплен.

Совет: Чтобы изменить закрепленный центр скелета в центре:

1. Выберите кадр, в котором вы хотите установить новый центр.

2. Щелкните по центру: все предыдущие кадры сохранят ранее закрепленный центр; все по-
следующие кадры будут иметь новый закрепленный центр вплоть до кадра, где другое заранее
закрепленное положение могло быть определено заранее.

Совет: Чтобы установить временно закрепленный центр:

Удерживая нажатой клавишу Shift, щелкните центр: он превращается из оранжевого круга в
голубой квадрат, чтобы указать, что он временно закреплен.

Совет: Чтобы удалить временно закрепленный центр:

Удерживая нажатой клавишу Shift, щелкните временно закрепленный центр: он превра-
щается из светло-синего квадрата в оранжевый круг, чтобы указать, что он больше не закреплен
временно.

Совет: Для сброса информации о закрепленных центрах:

1. Выберите инструмент Скелет ( ).

2. Щелкните правой кнопкой мыши в средстве просмотра и выберите Сбросить закрепленнн
центр в открывшемся меню.
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Глава 18

Создание анимации с помощью Plastic Tool

Plastic tool - это мощный инструмент ( ), который можно использовать в качестве дополнения в
контексте перекладной анимации, а также самостоятельный инструмент анимации, способный ожи-
вить персонажа, начиная с одного рисунка. Используя референсный скелет и деформируемую сетку,
Plastic tool позволяет изгибать и деформировать каждый элемент, к которому он применяется, созда-
вая плавные анимации.
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18.1 Применение Plastic Tool

Инструмент Plastic Tool требует в качестве начального ввода по крайней мере один столбец Xsheet
(или слой Timeline), где отображается один или несколько рисунков; с этого момента это будет назы-
ваться texture-column (или TC). Используя контуры экспонированных рисунков в качестве референсов,
Plastic tool создает сетку из треугольников, содержащуюся в новом типе столбца/слоя: столбец/слой
Полисетка. Каждый вновь созданный столбец/слой полисетки автоматически подключается к соот-
ветствующему TC. Эта ссылка является основной точкой в работе Plastic: каждый столбец/слой, свя-
занный с сеткой, будет деформироваться им и отображаться в пределах границ сетки при рендеринге.

Для анимации/деформации уровня сетки, Plastic позволяет создать определенную структуру скеле-
та, активную на сетке. Каркас представляет собой набор связанных вершин, и для каждой вершины
можно указать различные параметры: Положение, Угол привязки, Жесткость и Порядок пе-
реркрытия линий. Таким образом, можно легко создать большой спектр анимаций и эффектов.

Примечание: Инструмент Plastic tooll применяется к столбцу Xsheet (или слою Timeline), и его
содержимое может быть анимированным уровнем.
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18.2 Построение полисетки используя Plastic Tool

Первым шагом для использования Plastic tool является создание сетки для столбца Xsheet (или слоя
Timeline), которую мы собираемся анимировать с помощью инструмента Plastic. Сетка - это особый
уровень, который можно сохранить как любой другой уровень.

Уровень сетки можно увидеть как фиолетовый столбец/слой, созданный при нажатии кнопки Со-
здать полисетку инструмента Plastic.

Полисетка - это реальный объект, который инструмент Plastic изменяет, когда анимируется пластико-
вый скелет. По этой причине все элементы, которые будут анимированы инструментом Plastic, нуж-
даются в сетке.

Совет: Чтобы создать полисетку:

1. Выберите столбец/слой, который будет анимирован, используя инструмент Plastic. Это будет
текстура-столбец (TC) полисетки, который будет создан.

2. Выберите инструмент Plastic ( )

3. Нажмите кнопку Создать полисетку на панели параметров инструмента.

4. Проверьте, в открывшемся диалоговом окне, плотность сетки в области предварительного про-
смотра. При необходимости отрегулируйте плотность с помощью ползунка Длина кромки по-
лисетки.
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Примечание: Плотность полисетки имеет решающее значение для получения гладких
кривых при вращении вершины скелета. Чем ниже значение Длина кромки полисетки,
тем выше будет плотность сетки, поэтому будет обеспечено лучшее качество анимации, но
потребуется больше вычислительных ресурсов.

Примечание: Предварительный просмотр покажет вам только один уровень за раз, даже
если вы выбрали несколько столбцов/слоев, чтобы проверить предварительный просмотр
каждого столбца/слоя, вы должны выбрать их один за другим, в то время как Plastic tool
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активен. Каждый раз, когда вы меняете выбор столбца/слоя, предварительный просмотр
будет обновляться для нового содержимого.

5. При необходимости измените значение параметра Растеризация DPI. Это значение представ-
ляет DPI, используемый, когда TC отображается как текстура для полисетки. Рекомендуется
использовать значение, соответствующее разрешению камеры. Слишком высокое значение DPI
по сравнению с разрешением камеры может привести к тому, что контуры TC будут не очень
мягкими.

Примечание: Параметр Растеризация DPI доступен только при создании сетки из
уровней Toonz Vector.

6. Настройте значение Край полисетки. Этот параметр выражается в пикселах, поскольку он ис-
пользуется, когда текстура проецируется на полисетку, для сохранения псевдонимов изображения
потребуется соответствующее количество полей.

7. Если вы создаете сетку из Sub-Xsheet, вы можете выбрать, какие элементы Sub-Xsheet будут
использоваться инструментом Plastic для вычисления сетки: просто отключите видимость для
элементов, которые не будут внести свой вклад в контур полисетки.

8. Нажмите кнопку Применить, чтобы создать сетку. Теперь вы можете видеть сетку, нарисо-
ванную зеленым цветом в окне просмотра, и новый фиолетовый столбец в Xsheet (или слое на
Timeline) рядом с TC.

Примечание: В Stage Schematic вы можете видеть, что узел TC теперь подключен к
только что созданному узлу Полисетка, его узел имеет фиолетовый заголовок для облег-
чения распознавания.

Если действие Создать сетку применяется к столбцу/слою, который уже изменен инструментом
Plastic (затем уже связан с уровнем сетки), диалоговое окно предложит запросить, как управлять
новыми и старыми файлами сетки, и пользователь может выбрать один из трех вариантов:
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• Полностью удалить старый уровень: исходный файл сетки заменяется новым с
данными последней сгенерированной полисетки; новый столбец для новой полисетки
создается, так как старый столбец сохраняет старую структуру, но предоставляет до-
ступ только к новой созданной полисетке.

• Сохранить старый уровень и перезаписать обработанные кадры: исходный
файл полисетки заменяется новым с данными последней сгенерированной полисетки;
новый столбец для новой полисетки создается, так как старый столбец сохраняет ста-
рую структуру, но предоставляет доступ только к новой созданной полисетки.

• Выберите другой путь (то же имя, что и у исходного уровня плюс _X, где X - по-
рядковый номер копии): создается совершенно новый файл полисетки, и новый столбец
представляет новое содержимое, а старый столбец - старые.

Примечание: Все вышеперечисленные параметры вызывают создание нового столбца
политки и построение цепочки, связывая столбцы texture-column и полисеткок в Stage
Schematic. В этой цепочке старая сетка связана с младшей, а самая младшая - с текстурным
столбцом. Переупорядочение связей в схеме сцены может быть необходимо для избежания
нежелательных результатов при анимации.

18.3 Модификация Plastic полисетки

Не всегда легко оценить правильную плотность для полисетки. Иногда может потребоваться более
высокая плотность, чтобы избежать «прямых линий» на изгибающихся элементах, или более низкая
плотность может использоваться для экономии вычислительных ресурсов в сложной сцене, или, про-
сто, рисунки элемента изменяются. Во всех этих случаях изменение полисетки может решить проблему.

Совет: Чтобы обновить Plastic полисетку для отражения изменений в Level Strip:

1. Выберите столбец/слой полисетки, который необходимо изменить.

2. Нажмите кнопку Создать полисетку.

3. В открывшемся диалоговом окне при необходимости измените значение ползунка Длина кром-
ки полисетки, проверив результат в области предварительного просмотра.

4. Нажмите кнопку Применить, чтобы создать полисетку. Новая полисетка заменяет старую, и
теперь она видна нарисованной зеленым цветом в главном окне просмотра.

Совет: Чтобы добавить новые кадры полисетки к существующему уровню полисетки:

1. Выберите столбец/слой полисетки, который необходимо изменить.

2. Создайте новые кадры (вставьте или добавьте их), как это обычно делается для любого стан-
дартного уровня Toonz, соответствующего новым кадрам, созданным для Texture Column.

3. Активируйте инструмент Plastic.

4. Нажмите кнопку Создать полисетку и отрегулируйте ползунок Длина кромки полисетки.

5. Нажмите кнопку Применить.
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18.4 Изменение полисетки

Полисетка, созданная с помощью кнопки Создать полисетку, может быть отредактирована несколь-
кими способами. Можно переместить точку полисетки, поменять местами, свернуть, разделить и об-
резать полисетку по ее краям.

Переставить ребро, если вы хотите изменить форму треугольника сетки; Убрать ребро, если вы
хотите соединить концы ребра; Разделить ребро, если вы хотите увеличить плотность полисетки в
любой заданной точке; Резать полисетку, если вы хотите дублировать ребро, чтобы иметь возмож-
ность, например, создать отверстие в полисетке и иметь возможность его анимировать.

Примечание: Команда Резать полисетку видна, только если выбранные ребра могут быть обре-
заны.

Совет: Чтобы войти в режим редактирования Plastic полисетки:

1. Выберите столбец/слой полисетки, который вы хотите изменить.

2. Если инструмент еще не активен, выберите инструмент Plastic tool ( )

3. На панели параметров инструмента установите для Режима: значение Редактировать поли-
сетку.

Совет: Чтобы переместить выбранные точки полисетки:

1. Выберите точки полисетки, которые вы хотите изменить. Используйте клавишу Ctrl, чтобы вы-
брать несколько точек. Выбранные точки сетки становятся красными.

2. Перетащите, чтобы переместить точку в новое положение.

Совет: Чтобы поменять ребро полисетки:

1. Выберите ребро полисетки.

2. Щелкните правой кнопкой мыши, чтобы открыть контекстное меню.

3. Выберите команду Переставить ребро.
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Совет: Чтобы убрать ребро полисетки:

1. Выберите ребро полисетки.

2. Щелкните правой кнопкой мыши, чтобы открыть контекстное меню.

3. Выберите команду Убрать ребро.

Совет: Чтобы разделить ребро полисетки:

1. Выберите ребро полисетки.

2. Щелкните правой кнопкой мыши, чтобы открыть контекстное меню.

3. Выберите команду Разделить ребро.

Совет: Чтобы разрезать ребро полисетки:

1. Выберите несколько ребер полисетки.

2. Щелкните правой кнопкой мыши, чтобы открыть контекстное меню.

3. Выберите команду Резать полисетку.
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18.5 Построение скелета

Скелет Plastic - это управляющая структура, связанная с уровнем полисетки, которая обеспечивает
указатели для деформации/анимации выбранных элементов Xsheet/Timeline.

Совет: Чтобы создать Plastic скелет:

1. Выберите в столбце полисетки слой, для которого вы хотите построить скелет.

2. Если инструмент еще не активен, выберите инструмент Plastic tool ( )

3. На панели параметров инструмента установите для Режима: значение Создать скелет.

4. Переместите курсор мыши на окно просмотра. Маленький красный квадрат теперь виден около
кончика курсора.
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5. В окне просмотра щелкните (чтобы установить на место) или щелкните и перетащите (чтобы
настроить его положение), чтобы разместить первую вершину. Фиолетовый квадрат теперь виден
в окне просмотра.

Примечание: При первом отпускании кнопки мыши вы устанавливаете положение ро-
дителя всей иерархии, корневой вершины. Эта вершина визуально отличается от других
вершин: ее квадрат сплошной, а остальные полые посередине, что дает визуальный намек
для определения правильного иерархического порядка в цепях скелета. Корневая верши-
на будет статической в режиме Анимировать, но ее все равно можно будет перемещать
в режиме Создать скелет, выбрав ее и перетащив.

6. Переместите в положение, в которое вы хотите добавить вторую вершину, и щелкните или щелк-
ните и перетащите, чтобы разместить ее. Оранжевая линия с черной рамкой соединит две вер-
шины.

7. Продолжайте нажимать или перетаскивать, пока все вершины не окажутся в нужных местах и
скелет не будет завершен.

18.6 Использование нескольких скелетов на уровне полисетки

Каждый уровень полисетки использует по крайней мере один скелет для анимации, но это просто
более простая конфигурация для работы: уровень сетки может иметь несколько активных скелетов в
разных кадрах для создания более сложной анимации: например, разворот персонажа или для ани-
мации уровня с несколькими рисунками разных форм. Каждый раз, когда рисунки меняют форму,
можно создать новую специальную для этого случая структуру скелета с количеством необходимых
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вершин и расположить их в правильных положениях.

Совет: Чтобы добавить новый скелет на уровень полисетки

1. В Xsheet/Timeline выберите уровень полисетки и кадр, где нужен новый скелет.

2. На панели параметров инструмента нажмите кнопку + справа от меню параметров, помеченного
Скелет:. Новая числовая запись добавляется в список, и ключевой кадр создается в выбранном
кадре.

3. Начните строить новый скелет как обычно.

Совет: Чтобы связать доступный скелет с выбранным кадром уровня полисетки

1. В Xsheet/Timeline выберите кадр уровня полисетки, где скелет должен измениться.

2. На панели параметров инструмента откройте меню параметров с надписью Скелет:, откроется
список идентификационных номеров уже созданных скелетов.

3. Выберите идентификационный номер, соответствующий нужному скелету.

4. Выбранный скелет теперь виден в главном окне просмотра, и ключевой кадр создается в выбран-
ном кадре.

Совет: Чтобы удалить скелет из списка скелетов

1. В Xsheet/Timeline выберите уровень полисетки, которому принадлежит скелет, который необхо-
димо удалить.

2. Выберите из выпадающего списке Скелет: идентификационный номер, соответствующий
скелету, который хотите удалить.

3. Нажмите кнопку -.

18.7 Модификация скелета

При рисовании скелета или после завершения его создания могут потребоваться некоторые корректи-
ровки расположения или количества вершин:

Совет: Чтобы выбрать вершину:

1. В режиме Создать скелет переместите указатель мыши на уже размещенную вершину.

2. Нажмите, когда появится имя вершины и пунктирный квадрат окружает положение вершины.

Совет: Чтобы удалить вершину:

1. В режиме Создать скелет выберите вершину, которую необходимо удалить.

2. Нажмите кнопку Del.
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Совет: Чтобы вставить вершину:

1. Находясь в режиме Создать скелет, наведите указатель мыши на линию, соединяющую две
вершины, которым необходима вершина между ними.

2. Нажмите, чтобы установить новую вершину на месте, или нажмите и перетащите, чтобы отре-
гулировать положение новой вершины.

Совет: Чтобы переместить вершину:

Нажмите на вершину, чтобы выбрать ее, и перетащите для настройки ее положения.

Совет: Чтобы не дать вершине растянуть полисетку:

1. Выберите вершину, которую вы хотите изменить.

2. Снимите флажок Разрешить растягивание на панели параметров инструмента.

Примечание: Квадрат, обозначающий положение вершины, становится желтым, и с этого момента
вершина не будет растягивать полисетку, пока вы ее перемещаете.

Совет: Чтобы привязать вершину к полисетке

1. В режиме Создать скелет активируйте параметр Привязка к полисетке.

2. Выберите вершину, которую вы хотите привязать.

3. Перетащите его рядом с точкой сетки, в которой вы хотите его привязать.

Совет: Чтобы разветвить скелет:

1. Находясь в режиме Создать скелет, выберите вершину, с которой начнется новая ветвь.

2. Переместите в расположение, где будет расположена первая вершина новой ветви.

3. Нажмите, чтобы создать ее.

Совет: Чтобы скопировать скелет:

1. Находясь в режиме Создать скелет, выберите корневую вершину и щелкните правой кноп-
кой мыши.

2. В открывшемся контекстном меню выберите параметр Копировать скелет.
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Совет: Чтобы вставить скелет:

1. Выберите столбец полисетки на Xsheet/Timeline.

2. При необходимости нажмите кнопку +, чтобы создать новый пустой скелет.

3. Щелкните правой кнопкой мыши и выберите параметр Вставить скелет.

Примечание: Вставка скелета в уже существующий приведет к удалению старой структуры и всей
ее анимации. Это можно вернуть в предыдущее состояние с помощью команды Отменить.

18.8 Анимирование Plastic элементов

Создание анимации в Plastic - довольно простая задача: просто выберите вершины и переместите их в
нужные позиции в определенных кадрах, и ключевые кадры анимации будут созданы автоматически.
Воспроизведите последовательность кадров, чтобы проверить результаты.

Совет: Для анимации элементов:

1. Выберите столбец/слой полисетки, который вы хотите анимировать.

2. Выберите инструмент Plastic и установите Режим: на Анимировать. Теперь в окне просмотра
вы можете увидеть скелет и сетку выбранного столбца/слоя.

3. Выберите первый кадр анимации в Xsheet/Timeline.

4. Выберите вершины скелета и переместите их в желаемые позиции, чтобы установить соответ-
ствующие ключевые кадры, или запишите нужные значения в текстовые поля панели параметров
инструмента.

5. Перейдите к следующему ключевому кадру анимации и измените положения вершин, чтобы опре-
делить новую позу.

6. Повторяйте шаг 5 до конца анимации.

Совет: Чтобы установить ключ покоя для одной вершины:
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В первый раз, когда вы рисуете скелет, вы также создаете положение покоя этой структуры. Эта поза
автоматически сохраняется, и вы можете вызвать ее в любой вершине.

1. Выберите вершину и щелкните правой кнопкой мыши.

2. В открывшемся контекстном меню выберите Установить ключ покоя.

3. Новый ключевой кадр в текущем кадре создается для вершины, используя его значения покоя.

Совет: Чтобы установить глобальную позицию покоя для всего скелета:

В первый раз, когда вы рисуете скелет, вы также создаете положение покоя этой структуры. Эта поза
автоматически сохраняется, и вы можете вернуться к всем ее вершинам.

1. Выберите вершину и щелкните правой кнопкой мыши.

2. В открывшемся контекстном меню выберите Установить глобальный ключ покоя.

3. Новый ключевой кадр в текущем кадре создается для всех вершин, используя их значения покоя.

Совет: Чтобы сохранить расстояние между вершинами при анимации:

Если требуется, чтобы расстояние между двумя соединениями оставалось постоянным во время ани-
мации, установите флажок Держать расстояние на панели параметров инструмента.

Совет: Чтобы установить ключевые кадры на всех вершинах одновременно:

По умолчанию, когда вы перемещаете вершину в режиме Анимировать, вы устанавливаете ключевой
кадр только для этой выбранной вершины. Чтобы установить ключевой кадр одновременно для всех
вершин скелета, при перемещении одной из них установите флажок Глобальный ключ.

Совет: Чтобы установить ключевой кадр для вершины, которая не изменила положение:

1. Выберите вершину, для которой вы хотите создать ключевой кадр.

2. Нажмите правую кнопку мыши.

3. Выберите опцию Установить ключ в открывшемся контекстном меню.
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Совет: Чтобы установить ключевой кадр для всех вершин скелета, которые не изменили
положение:

1. Выберите вершину скелета.

2. Нажмите правую кнопку мыши.

3. Выберите параметр Установить глобальный ключ в открывшемся контекстном меню.

Совет: Для анимации порядка переркрытия вершин:

Используя Plastic, вы можете имитировать эффект перекрывающихся конечностей, определяя порядок
наложения для вершин, участвующих в анимации.

1. Выберите вершину, которую вы хотите анимировать.

2. Введите значение Порядок переркрытия, которое вы хотите присвоить вершине, в текстовое
поле Порядок на панели параметров инструмента.

Примечание: Порядок переркрытия Plastic является характеристикой для каждой вершины, вы
должны определить желаемое значение для каждой требуемой вершины. Значение по умолчанию 0 для
всех вершин и может быть свободно изменено с использованием положительных или отрицательных
значений по мере необходимости.

Совет: Чтобы определить углы привязки для вершины:

1. Выберите нужную вершину.

2. Установите минимальное и максимальное значения Углы привязки для вращения вершины.

18.9 Определение жесткости для полисетки

Во многих случаях может потребоваться, чтобы определенные части сетки, анимированные с помощью
инструмента Plastic, сохраняли свою форму, даже если они следуют за общими преобразованиями всего
элемента, имитируя более «жесткую структуру» или ее часть. Чтобы достичь такого эффекта, значение
Жесткость может быть нарисовано непосредственно на полисетке.

При активации режима Покрасить жесткость на панели параметров инструмента Plastic стано-
вится доступным определенный инструмент рисования. В окне просмотра красный круг виден около
кончика указателя мыши, размер круга - это размер кисти, которую вы будете использовать для ри-
сования жесткости на полисетке.

Совет: Чтобы нарисовать жесткость на полисетке:

1. Выберите столбец/слой полисетки в Xsheet/Timeline.
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2. Выберите инструмент Plastic ( )

3. Установите для Режима: значение Покрасить жесткость.

4. Установите размер кисти, перемещая ползунок Толщина или введя значение в текстовое поле.

5. Выберите Жесткий в меню параметров справа от ползунка Толщина (Жесткий - это значение
по умолчанию).

6. Переместите курсор на окно просмотра и начните рисовать на выбранной полисетке. Цвет сетки
изменится на красный там, где нарисован. Теперь красные области ведут себя как жесткие части
полисетки.

Совет: Чтобы изменить, подправить, стереть жесткость полисетки:

1. Выберите столбец/слой полисетки в Xsheet/Timeline.

2. Выберите инструмент Plastic ( )

3. Установите для Режима: значение Покрасить жесткость.

4. Установите размер кисти, перемещая ползунок Толщина или введя значение в текстовое поле.

5. Выберите Гибкий в меню параметров справа от ползунка Толщина.

6. Переместите курсор в окно просмотра и начните рисовать на выбранной полисетке. Цвет поли-
сетки изменится на зеленый там, где нарисован. Теперь зеленые области ведут себя как гибкие
части полисетки.

Примечание: Цвет полисетки по умолчанию зеленый; это означает, что вся полисетка является
гибкой. Красный цвет используется для указания жестких областей полисетки (если они есть). Но
если вся полисетка окрашена в красный цвет, она тоже будет гибкой.

18.10 Отображение элементов и свойств

При работе с инструментом Plastic можно легко настроить, какая информация должна отображаться
в окне просмотра. Щелчок правой кнопкой мыши в окне просмотра когда инструмент Plastic активен,
вызывает контекстное меню. Существует четыре флажка, которые устанавливают свойства отображе-
ния полисетки, это Жесткость, Порядок (порядок наложения) и Калька скелета.
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Если Показать полисетку включено, полисетка будет видна в виде треугольной проволочной формы.

Если Показать жесткость включен, непрерывные зеленые области будут показывать гибкость, в то
время как красные области будут показывать жесткость.
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Если Показать порядок включен, то серая заливка показывает значения порядка наложения вершин,
где более светлые области будут сверху, а более темные сзади.
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Если Показать кальку скелета включен, призраки скелета в выбранных кадрах будут отображаться
с добавочными уровнями прозрачности.
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Вся эта информация может отображаться сразу (путем включения всех параметров), давая общее
описание состояния вершин.

18.11 Родительские Plastic уровни с применением вершин и крю-
ков

Для создания интересных и сложных анимаций может быть полезно и экономить время на создание
иерархических отношений между стандартными уровнями и уровнями, измененными для Plastic, или
между самими уровнями, измененными для Plastic, чтобы дочерние уровни автоматически наследовали
преобразования родительского уровня. Всегда можно связать уровни, используя центр столбца/слоя в
качестве цели, но что, если требуется что-то более тонкое, например Крюки? Мы уже описывали анало-
гичные методы для стандартных элементов OpenToonz (см. Связывание объектов или Использование
крюков), но модифицированные уровни Plastic работают немного иначе, потому что инструмент Крюк
не включен на уровнях такого типа. Измененные Plastic уровни используют свои вершины скелета
вместо точек крюка.

Совет: Чтобы связать стандартный уровень с Plastic измененным уровнем

1. Выберите в Xsheet/Timeline уровень, который должен быть связан.

2. Используйте инструмент Крюк в окне просмотра, чтобы создать точку на месте, которая будет
использоваться в качестве разворота для уровня.

3. Перейдите к Stage Schematic и выберите узел столбца/слоя, который должен быть связан. На-
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жмите на маленький квадрат с левой стороны и перетащите его на один из маленьких квадратов
с правой стороны целевого элемента, модифицированного Plastic, ссылки. Теперь эти два уров-
ня связаны, но контрольные точки для ссылки, вероятно, неверны (по умолчанию используются
центры столбцов/слоев).

4. Наведите указатель мыши на маленький квадрат слева от узла стандартного уровня, пока не
появятся две маленькие стрелки (вверх и вниз).

5. Нажмите на стрелки и перетащите, чтобы изменить значение в маленьком квадрате. Останови-
тесь, когда номер крючка, который должен использоваться в качестве точки разворота, до-
стигнут. В окне просмотра уровень перемещается с использованием выбранной точки в качестве
нового центра.

6. Проделайте ту же процедуру, что и в пункте 5, на небольшом квадрате справа от модифици-
рованного Plastic узла, который использовался в качестве цели для ссылки. Выберите номер
вершины скелета, который должен использоваться в качестве целевой контрольной точки для
ссылки. В окне просмотра стандартный уровень перемещается так, чтобы перекрывать положе-
ние точки крючка, выбранной в качестве ссылки на положение вершины скелета, выбранного на
уровне, измененном Plastic tool.

Примечание: Зеркальная процедура может использоваться для привязки уровня, модифицирован-
ного Plastic, к стандартному уровню.

Совет: Чтобы связать модифицированные Plastic уровни

Процедура требует, чтобы все задействованные уровни и которые должны были быть связаны с ис-
пользованием определенных позиций, имели по крайней мере один скелет и одну из его вершин нужно
расположить в желаемом месте для связи. Как уже говорилось, инструмент Крюк не работает на
уровнях, измененных в Plastic, поэтому для точного позиционирования вершины скелета необходимы
в качестве опорных точек как на источнике, так и на цели ссылки.

1. Перейдите к Stage Schematic и выберите узел столбца/слоя, который должен быть связан. На-
жмите на маленький квадрат с левой стороны и перетащите на один из маленьких квадратов
с правой стороны от цели ссылки. Теперь эти два уровня связаны, но контрольные точки для
ссылки, вероятно, неверны (по умолчанию используются центры столбцов/слоев).

2. Наведите указатель мыши на маленький квадрат слева от узла первого узла, пока не появятся
две маленькие стрелки.

3. Нажмите на стрелки и перетащите, чтобы изменить значение в маленьком квадрате. Останови-
тесь, когда номер точки вершины скелета, которая должна использоваться в качестве точки
разворота, достигнута. В окне просмотра уровень регулирует свою позицию относительно нового
выбранного центра.

4. Выполните ту же процедуру, что и в пункте 3, на небольшом квадрате справа от модифици-
рованного Plastic узла, который использовался в качестве цели для ссылки. Выберите номер
вершины скелета, который должен использоваться в качестве целевой контрольной точки для
ссылки. В окне просмотра перемещается первый уровень, чтобы перекрыть положение выбранной
вершины скелета с позицией выбранной вершины скелета цели.

18.11. Родительские Plastic уровни с применением вершин и крюков 379



OpenToonz Documentation, Выпуск 1.7.1

18.12 Представление данных Plastic в редакторе функций

При анимации элементов Plastic ключевые кадры создаются для вершин скелета. Вы можете видеть
их как стандартные ключевые кадры в Xsheet/Timeline или работать со значениями каждой вершины
в Редакторе функций.

Ключевые кадры Xsheet/Timeline помечают ключевые кадры для скелета Plastic в указанном кадре,
но не дают никакой информации о количестве задействованных вершин или их фактических свойствах
ключевых кадров; они могут быть непосредственны, один, несколько или все. Перемещая эти ключевые
кадры, вы можете легко изменить время анимации.

Ключевые кадры в редакторе функций более подробны, что дает вам возможность для тонкой на-
стройки и изменения анимации каждого параметра вершины.

Когда в дереве редактора функций вы открываете папку столбца/слоя, к которой применен инстру-
мент Plastic, вы видите папку Plastic Skeleton. Эта папка содержит канал Skeleton Id, подпапку
Root и одну подпапку для каждой вершины Plastic скелета, помеченную названием соответствующей
вершины.
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Канал Skeleton Id содержит данные, связанные с тем, какой скелет активен в определенном кадре.
Если уровень использует несколько скелетов, вы можете увидеть переключение с одного скелета на
другой, как в виде числовых значений, так и в графическом формате.

В подпапке Root отображаются все каналы параметров, но только параметр Порядок (порядок раз-
мещения) можно анимировать, когда эта вершина фактически используется в качестве корня скелета

Подпапки Vertex (по одной на каждую вершину каркаса) содержат три параметра: Angle, Distance и
SO, которые используются для определения положения вершины в каждый кадр во время анимации.

Значения этих параметров можно визуализировать в редакторе функций в виде электронной таблицы
или в виде кривых и при необходимости изменять.

Примечание: Вершины нескольких скелетов отображаются в виде единого списка и не группируются
для каждого скелета. Таким образом, кривая анимации Vertex_1 строится с использованием значений
анимации вершин с именем Vertex_1 всех скелетов полисетки, поэтому можно изменить только одну
кривую, чтобы настроить анимацию связанных вершин на разных скелетах.

18.13 Используйте математические выражения в анимации
Plastic

Чтобы использовать математические выражения OpenToonz в Plastic анимации, вы можете связать
вершины скелета друг с другом или со столбцом/слоем, штифтами или камерой.

Это позволяет настроить некоторые автоматические действия скелета, например, вы можете связать
основные вершины плеч, так что перемещение только одного плеча автоматически перемещает другое.

Предположим, что главные вершины плеч названы Левое_плечо и Правое_плечо, а полисетка находит-
ся в столбце 2 Xsheet (или в слое 2 Timeline). Вы можете установить вращение вершины Левое_плечо
равным вращению вершины Правое_плечо, установив в редакторе функций следующее выражение в
параметре Angle Левое_плечо:

vertex(2, "Правое_плечо").angle

Если вы предпочитаете, чтобы вращение левого плеча реагировало против вращения правого плеча,
вы можете добавить умножение следующим образом:

vertex(2, "Правое_плечо").angle*-1

Общий синтаксис таков:

vertex(column_number, «vertex_name»).parameter

Для получения дополнительной информации об использовании математических выражений см. Ис-
пользование интерполяций на основе выражений).

18.14 Plastic и Sub-Xsheets

Sub-Xsheet является допустимым объектом для инструмента Plastic, и все или некоторые из его столб-
цов могут иметь сетку для анимации. Если в качестве начального элемента выбран Sub-Xsheet, все
столбцы вспомогательного листа, видимые при нажатии кнопки Создать полисетку, учитываются
при создании полисетки. Эти уровни будут видны при рендере и будут деформированы преобразова-
ниями полисетки. Если после создания полисетки скрытые уровни становятся видимыми, они будут
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вести себя немного по-другому: они будут деформированы преобразованиями полисетки, но они бу-
дут отображаться при рендере только внутри границ полисетки (то есть действия сетки) как маска,
которая определяет то, что видно на визуализированном изображении, даже если вновь показанные
уровни помещаются во вложенный Sub-Xsheet с собственной полисеткой и скелетом).
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Глава 19

Применение эффектов

Эффекты можно применять к уровням анимации, изображениям и клипам, отображаемым в столбцах
Xsheet (или слоях Timeline) в FX Schematic, где каждый элемент представлен в виде узла.

Связь между содержимым столбцов/слоев и эффектами может управляться путем соединения или
разъединения связей между узлами.

19.1 Использование FX Schematic

В FX Schematic все столбцы/слои отображаются как узлы, имеющие выходной порт, подключенный к
узлу Xsheet: это означает, что их содержимое является частью сцены и отображается как есть.

Когда эффекты добавляются, они также отображаются как узлы с портами для создания ссылок,
которые позволяют вам задавать способ изменения содержимого сцены.

Узлы столбца/слоя имеют переключатели Переключатель видимости камеры ( ) и Переклю-

чение видимости ( ) в правом верхнем углу: эти переключатели совпадают с переключателями,
доступными в столбце Xsheet (или заголовке слоя Timeline) (см. Работа со столбцами Xsheet). Узлы

эффектов имеют только переключатель Видимости ( ), позволяющий вам включать или временно
исключать эффект при рендере.
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Узлы могут быть легко выбраны и расположены. Когда выделены, узлы подсвечиваются белым цветом;
текущий узел имеет свое название в желтом.

Совет: Для доступа к FX Схеме:

Нажимайте кнопку Переключения Схемы Fx ( ) в правой части нижней панели окна Stage Schematic,
пока в строке заголовка не отобразится FX Schematic.

Совет: Для навигации по FX Schematic:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте кнопку По размеру окна ( ) в нижней панели окна Schematic, чтобы отобразить
все узлы в текущем окне.

• Используйте кнопку Фокус на текущем ( ) в нижней панели окна схемы, чтобы центрировать
схему на текущем узле.

• Используйте кнопку Изменение порядка узлов ( ) в нижней панели окна Schematic, чтобы
изменить порядок всех узлов.

• Используйте кнопку Сбросить размер ( ) в нижней панели окна Schematic или используйте
комбинацию Вид по умолчанию (по умолчанию клавиши Alt + 0), чтобы отобразить все узлы
в размере по умолчанию.

Совет: Чтобы переименовать узел:

Дважды кликните по имени узла с нажатой клавишей Ctrl и введите новое имя.

Совет: Чтобы минимизировать или развернуть столбец/слой и узлы эффектов:

Выполните одно из следующих действий:

• Нажмите стрелку слева от имени узла, чтобы выборочно свернуть/развернуть столбцы.

• Нажмите кнопку Минимизировать/Максимизировать узлы ( / ) в нижней панели окна
Schematic, чтобы свернуть/развернуть все узлы столбцов.

Совет: Чтобы выделить узлы:

Выполните одно из следующих действий:

• Нажмите, чтобы выделить узел.

• Нажмите и перетащите, чтобы выбрать группу узлов.
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• Кликните по узлу с нажатой клавишей Ctrl (PC) или Cmd (macOS), чтобы добавить узел или
удалить его из выделения.

Примечание: Links могут быть выбраны вместе с узлами (см. Редактирование схемы FX ).

Совет: Чтобы переместить выделение:

Нажмите и перетащите любой выделенный узел.

Совет: Чтобы включить или временно исключить эффект из рендера:

Нажмите на переключатель Видимости ( ) в правом верхнем углу узла эффекта.

19.1.1 Группировка узлов

Можно сгруппировать несколько узлов в один узел, чтобы лучше управлять всей схемой FX. Группы
можно открывать для просмотра и редактирования, а их компоненты можно выбирать для дальнейших
операций, таких как редактирование настроек эффектов или создание новых групп.

Совет: Для группировки выделенных узлов:

Выполните одно из следующих действий:

• Щелкните правой кнопкой мыши любой выбранный узел и выберите Сгруппировать в открыв-
шемся меню.

• Нажмите сочетание клавиш Ctrl-G (PC) или Cmd-G (macOS).

Совет: Чтобы открыть группу:

Щелкните правой кнопкой мыши группу и выберите Открыть группу в открывшемся меню: узлы
группы отображаются в окне, показывая ссылки между узлами группы и ссылки с узлами вне группы.

Примечание: В FX схеме, когда отображается содержимое группы, можно редактировать ссылки
между узлами группы и ссылки с узлами вне группы.

Совет: Чтобы закрыть группу:

Нажмите кнопку Закрыть справа от строки заголовка группы.

Совет: Чтобы разгруппировать группу:

Щелкните правой кнопкой мыши группу и выберите Разгруппировать в открывшемся меню или
нажмите сочетание клавиш Ctrl-Shift-G (PC) или Cmd-Shift-G (macOS).
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19.1.2 Добавление эффектов

Вы можете Вставить эффекты к выбранным узлам, Добавить эффекты к Схеме или Заменить
ранее добавленные узлы эффектов. Это можно сделать из окна Браузер FX или с помощью рас-
крывающегося меню, которое открывается при щелчке правой кнопкой мыши по узлам или в пустой
области схемы эффектов. Оба организованы в папки/подменю, содержащие наборы эффектов; если
для эффекта определены некоторые Предустановки, доступна дополнительная папка/подменю (см.
Создание предустановок).

При вставке эффектов они будут размещены вдоль ссылки, которая начинается с выходного порта
выбранного узла; при добавлении эффектов они будут помещены в конец новой ссылки, которая будет
начинаться с выходного порта выбранного узла.

Если выбрано несколько узлов, эффект будет добавлен/вставлен для каждого выбранного узла, но все
добавленные/вставленные эффекты будут Связаны и связаны визуально зеленой линией. Это означает,
что каждый раз, когда редактируется эффект, также будут редактироваться все связанные узлы, если
только вы не разорвете ссылку, чтобы начать редактировать их отдельно.

Для глобального применения эффектов можно использовать узел Xsheet, как если бы это был стан-
дартный узел столбца (представляющий все содержимое сцены), и вставлять эффекты оттуда.
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В схеме могут использоваться три различных типа эффектов, каждый с различным типом узла:

• Основные эффекты, такие как эффект размытия, которые просто изменяют содержимое столб-
ца; они отображаются в виде желтого узла с портом ввода слева, помеченным Source, и портом
вывода справа.

Чтобы повлиять на столбец/слой, их необходимо вставить в ссылку от узла столбца/слоя к узлу Xsheet,
чтобы узел столбца/слоя был подключен к входному порту эффекта, а выходной порт узла эффекта
- к узлу Xsheet.

Если в цепочке применяется несколько эффектов, они будут применяться один за другим, следуя
порядку от узла столбца/слоя к узлу Xsheet.

• Комбинированные эффекты, такие как эффект Matte In, которые изменяют содержимое
столбца/слоя в соответствии с содержимым других столбцов/слоев; они отображаются с желтым
узлом с двумя или более входными портами слева и одним выходным портом справа.

Чтобы повлиять на столбец/слой, их необходимо вставить в ссылку от узла столбца/слоя к узлу Xsheet,
чтобы узел столбца/слоя был подключен к первому входному порту эффекта, помеченному Source,
тогда как другие столбцы/слои подключены к другим входным портам, чьи метки зависят от эффекта;
порт вывода узла эффекта должен быть подключен к узлу Xsheet.
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Например, в случае эффекта Matte In столбец, который нужно объединить, должен быть связан с
входным портом Source, столбец matte должен быть связан с входным портом Matte, а выходной порт
должен быть подключен к узлу Xsheet.

• Эффекты, которые создают сгенерированные компьютером изображения, такие как
радиальный градиент, которые отображаются в столбцах Xsheet (и слоях Timeline) и, следова-
тельно, аналогичны столбцам; они отображаются с оранжевым узлом только с выходным портом
справа. Эти узлы эффектов должны быть связаны с узлом Xsheet для визуализации или могут
быть связаны с другими узлами эффектов.
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Совет: Чтобы открыть Браузер FX:

Выполните одно из следующих действий:

• Выберите Xsheet → Новый FX. . .

• Нажмите кнопку Новый FX ( ) в нижней панели окна схемы FX.

Совет: Чтобы вставить эффект:

Выполните одно из следующих действий:

• Выберите узлы, для которых вы хотите вставить новый эффект, выберите эффект, который вы
хотите вставить в Браузер FX, и нажмите кнопку Вставить.

• Выберите узлы, для которых вы хотите вставить новый эффект, щелкните правой кнопкой мыши
любой из них и выберите Вставить FX в открывшемся меню, затем выберите эффект, который
вы хотите вставить, из доступных подменю.

• Выберите ссылки, куда вы хотите вставить новый эффект, щелкните правой кнопкой мыши по
любой из них и выберите **Вставить FX ** в открывшемся меню, затем выберите эффект, ко-
торый вы хотите вставить, из доступных подменю (см. Редактирование схемы FX ).
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Совет: Чтобы добавить эффект:

1. Выберите узлы, для которых вы хотите добавить новый эффект в конце новой ссылки.

2. Выполните одно из следующих действий:

• Выберите эффект, который вы хотите добавить, в Браузере FX и нажмите кнопку Добавить.

• Щелкните правой кнопкой мыши любой из выбранных узлов и выберите Добавить FX в от-
крывшемся меню, затем выберите эффект, который вы хотите добавить, из доступных подменю.

Совет: Чтобы заменить эффект:

1. Выберите узлы эффекта, которые вы хотите заменить новым эффектом.

2. Выполните одно из следующих действий:

• Выберите эффект, который вы хотите добавить, в Браузер FX и нажмите кнопку Заменить.

• Щелкните правой кнопкой мыши любой из выбранных узлов и выберите Заменить FX в от-
крывшемся меню, затем выберите новый эффект из доступных подменю.

Совет: Чтобы вставить/добавить эффекты глобально:

1. Выделите узел Xsheet.

2. Выполните одно из следующих действий:

• Выберите эффект, который вы хотите вставить/добавить, в Браузере FX и нажмите кнопки
Вставить или Добавить.

• Щелкните правой кнопкой мыши любой из выбранных узлов и выберите Вставить FX или До-
бавить FX в открывшемся меню, затем выберите эффект, который вы хотите вставить/добавить,
из доступных подменю.

Совет: Чтобы переименовать узел:

Кликните два раза с зажатой клавишей Ctrl (PC) или Cmd (macOS) по имени узла и введите новое
имя.

19.1.3 Редактирование схемы FX

Связи между узлами следует рассматривать как потоки, идущие направо, от узлов столбца/слоя к
узлу Вывод через узел Xsheet. Если по пути есть один или несколько эффектов, содержимое столбца
будет соответственно обработано, прежде чем станет частью вывода.

С выходного порта узлов может одновременно запускаться несколько ссылок, что позволяет, напри-
мер, визуализировать столбец/слой как есть, а также использовать в качестве маски для другого
столбца/слоя. Также можно постоянно определять, будут ли отображаться столбцы/слои, оставив или
удалив ссылку на узел Xsheet.

Редактируя связи между узлами или создавая новые, вы можете управлять тем, как узлы столб-
цов/слоев будут взаимодействовать друг с другом и с эффектами перед их визуализацией.
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Примечание: В эффектах, которые принимают несколько входных узлов, можно изменить порядок
наложения входных узлов, щелкнув и перетащив в область портов.

Узлы эффектов и ссылки могут быть выбраны для того, чтобы их можно было вырезать, скопировать,
вставить или удалить. Когда выбрано, узлы и ссылки выделены белым; текущий узел имеет свою метку
желтого цвета; когда выбран хотя бы один объект, связанные ссылки отображаются синим цветом.

При вставке скопированного/вырезанного выделения доступно несколько параметров:

• Используйте Вставить, чтобы вставить скопированное/вырезанное выделение в схему FX.

• Используйте Вставить вставку, чтобы вставить выделенное в выбранные ссылки.

• Используйте Вставить Добавить, чтобы добавить вставленный выбор из выбранных узлов в
конце новых ссылок.

• Используйте Вставить Заменить, чтобы заменить выбранные узлы эффектов вставленным вы-
делением.

Примечание: Ссылки должны выбираться вместе с узлами при копировании/вырезании выделения,
если вы хотите сохранить ссылки между ними при вставке.

Совет: Чтобы создать ссылки между узлами:

Нажмите и перетащите выходной порт узла на входной порт узла эффекта.

Совет: Чтобы выделить узлы и ссылки:

Выполните одно из следующих действий:

• Нажмите, чтобы выделить узел или ссылку.

• Нажмите и перетащите, чтобы выбрать группу узлов и ссылок.

• Кликните с зажатой клавишей Ctrl (PC) или Cmd (macOS), чтобы добавить узел или ссылку,
или удалить его из выбора.

Совет: Чтобы удалить ссылки между узлами:

Выберите ссылки, которые вы хотите удалить, и выполните одно из следующих действий:

• Выберите пункт меню Правка → Удалить.

• Щелкните правой кнопкой мыши любую выбранную ссылку и выберите Удалить в открывшемся
меню.

Совет: Чтобы подключить узел к узлу Xsheet:

Выполните одно из следующих действий:

• Щелкните и перетащите порт вывода узла на порт ввода узла Xsheet.

• Щелкните правой кнопкой мыши узел, который вы хотите подключить к узлу Xsheet, и выберите
Присоединить к Xsheet в открывшемся меню.
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Совет: Чтобы отключить поток от узла Xsheet:

Выполните одно из следующих действий:

• Удалить ссылку с узла на узел Xsheet.

• Щелкните правой кнопкой мыши узел, который вы хотите отключить от узла Xsheet, и выберите
Отсоединить от Xsheet в открывшемся меню.

Совет: Чтобы вставить узел эффекта в ссылку:

Кликните, удерживая клавишу Alt и перенесите на ссылку.

Совет: Чтобы извлечь узел эффекта из ссылки:

Кликните, с зажатой клавишей Alt и перетащите его из ссылки.

Совет: Чтобы отредактировать выделение узлов эффекта:

Выполните одно из следующих действий:

• Используйте команду Копировать, чтобы сохранить выбор в памяти для дальнейших операций.

• Используйте команду Вырезать, чтобы исключить выделение из схемы и сохранить его в памяти
для дальнейших операций.

• Используйте команду Вставить, чтобы вставить выделение, сохраненный в памяти в схеме FX.

• Щелкните правой кнопкой мыши ссылку и используйте команду Вставить вставку, чтобы
вставить выделенный в памяти выбор в выбранную ссылку.

• Щелкните правой кнопкой мыши любой узел и используйте команду Вставить Добавить, чтобы
добавить выделение, сохраненное в памяти, из выбранных узлов в конце новых ссылок.

• Щелкните правой кнопкой мыши узел эффекта и используйте команду Вставить Заменить,
чтобы заменить выбранные узлы эффекта выделением, сохраненным в памяти.

• Используйте команду Удалить, чтобы удалить выделеное.

Примечание: Все эти команды доступны в меню, которое открывается при щелчке правой кнопкой
мыши узлов и ссылок.

Совет: Чтобы создать связанный эффект:

1. Выберите узлы эффектов, которые вы хотите дублировать.

2. Щелкните правой кнопкой мыши любой из выбранных узлов и выберите Создать связанный
FX в открывшемся меню.

Совет: Чтобы сломать связанные эффекты:
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1. Выберите узлы эффектов, которые вы хотите разъединить.

2. Щелкните правой кнопкой мыши любой из выбранных узлов и выберите Разъединить в от-
крывшемся меню.

19.1.4 Использование нескольких выходных узлов

В схеме FX по умолчанию узел Xsheet подключен к узлу Output: это означает, что все узлы, под-
ключенные к узлу Xsheet, будут отображаться как в режиме предварительного просмотра, так и при
окончательном отображении.

Рендеринг сцены может быть ограничен конкретным узлом схемы путем создания дополнительных
выходных узлов, связанных с узлом, где вы хотите ограничить рендер.

Когда определено более одного выходного узла, вы можете установить, какой из них активный (тот,
который будет рассматриваться для предварительного просмотра или рендера сцены); активный вы-
ходной узел отображается синим, а остальные серым.

Совет: Чтобы ограничить вывод определенным узлом:

1. Выберите узел, для которого вы хотите ограничить вывод.

2. Выполните одно из следующих действий:

• Нажмите кнопку Новый вывод ( ) в нижней панели окна схемы.

• Щелкните правой кнопкой мыши узел и выберите Новый вывод в открывшемся меню.

Совет: Чтобы добавить выходной узел:

Выполните одно из следующих действий:

• Нажмите кнопку Новый вывод ( ) в нижней панели окна схемы.

• Щелкните правой кнопкой мыши по схеме и выберите Новый вывод в открывшемся меню.

Совет: Чтобы подключить узел к выходному узлу:

Нажмите и перетащите выходной порт узла на входной порт выходного узла.

Совет: Чтобы установить текущий узел вывода:

Щелкните правой кнопкой мыши по выводному узлу, который вы хотите установить в качестве теку-
щего, и выберите Активировать в открывшемся меню.

Совет: Чтобы удалить узел вывода:

Выполните одно из следующих действий:

• Выделите его и выберите пункт меню Правка → Удалить.

• Щелкните правой кнопкой мыши и выберите Удалить в открывшемся меню.
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Примечание: Последний оставшийся узел вывода не может быть удален из схемы.

19.2 Изменение настроек эффектов

Параметрами эффектов и их анимацией можно управлять в окне Настройки эффектов. В соответ-
ствии с выбранным эффектом, он отображает различные макеты ползунков, флажков, полей ввода
текста и т.д.

В нижней части окна доступна область предварительного просмотра, чтобы проверить результат
примененного эффекта: вы можете расширить его или свернуть его, активировать или деактивировать,
перемещаться по его содержимому, устанавливать его размер, цвет фона или ограничить его снимком
камеры. Область предварительного просмотра может быть расширена или сокращена нажатием на
символ +/- слева от надписи Просмотр образцов, в левом нижнем углу окна настроек эффектов.

Параметры могут быть анимированы путем установки ключевых кадров в определенных кадрах. Кноп-

ка Установить ключ ( ) доступна в области предварительного просмотра в нижней панели окна,
чтобы установить ключевые кадры для всех параметров. Для каждого из параметров, которые можно

анимировать, есть также специальная кнопка Установить ключ ( ) справа от имени параметра,
чтобы установить ключевые кадры для каждого параметра независимо.

Кнопка Установить ключ ( ) может иметь следующие цвета:

• Cерый, когда для текущего параметра не определены ключевые кадры для какого-либо пара-
метра.

• В синюю полосу, когда ключевые кадры определены хотя бы для одного параметра.

• Синий, когда ключевые кадры определены для всех параметров.

Кнопка конкретного параметра Установить ключ ( ) может иметь следующие цвета:

• Серый, если для параметра в текущем кадре не определено значение ключа.

• Оранжевый, когда значение ключа определено для параметра в текущем кадре.

• Светло-желтый, если параметр анимирован, но значение ключа в текущем кадре не определено.

• Желтый, если вы изменили значение параметра, и у текущего кадра нет ключа для параметра.

Кадры и ключевые кадры можно перемещать с помощью соответствующих кнопок в нижней панели

окна. Кнопки Следущий ключ ( ) и Предыдущий ключ ( ) доступны, только если определено
более одного ключевого кадра.
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Если ключевые кадры не определены, установленные вами параметры будут использоваться по всей
сцене.
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Совет: Чтобы открыть окно настроек эффектов:

Выполните одно из следующих действий:

• Щелкните правой кнопкой мыши узел эффекта и выберите Редактировать . . . в открывшемся
меню.

• Дважды щелкните узел эффекта.

Совет: Чтобы определить значения для эффекта:

Используйте доступные ползунки, флажки, текстовые поля и т.д., чтобы настроить эффект так, как
вы предпочитаете.

Совет: Чтобы установить текущий кадр:

Выполните одно из следующих действий:

• Введите номер кадра или используйте кнопки Следующий кадр и Предыдущий кадр, до-
ступные в нижней панели окна.

• Переместите курсор текущего кадра в Xsheet/Timeline или в редакторе функций.

• Используйте панель кадров или кнопки воспроизведения в нижней панели просмотра.

Совет: Чтобы установить ключевые кадры для всех параметров эффекта в текущем
кадре:

1. Выполните одно из следующих действий:

• Если текущий кадр не является ключом, нажмите кнопку Установить ключ ( ) в нижней
панели окна: цвет изменится с серого на синий и текущие значения станут ключевыми кадрами
для всех параметров в текущем кадре.

• Если текущий кадр является ключевым кадром только для некоторых параметров, нажмите

кнопку Установить ключ ( ): цвет изменится с полосатого на синий, а текущие значения
станут ключевыми кадрами для всех параметров текущего кадра.

2. Определите значения для параметров.

Совет: Чтобы установить ключевые кадры для определенного параметра в текущем кад-
ре:

1. Если в текущем кадре нет ключевого кадра для параметра, нажмите квадратную кнопку Уста-

новить ключ ( ) справа от параметра: цвет изменится с серого на оранжевый, и текущее
значение становится ключевым кадром для параметра в текущем кадре.

2. Задайте значение для параметра.

Примечание: Если текущий кадр не является ключевым кадром для параметра, и вы изменили его,
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кнопка Установить ключ ( ) справа от параметра становится желтой. Нажмите на нее, чтобы
установить ключ.

Совет: Чтобы удалить все ключевые кадры для параметров эффекта в текущем кадре:

Выполните одно из следующих действий:

• Если ключевые кадры установлены для всех параметров, нажмите кнопку Установить ключ

( в нижней панели окна: цвет сменится с синего на серый.

• Если ключевые кадры установлены только для некоторых параметров, дважды нажмите кнопку

Установить ключ ( ) в нижней панели окна: при первом щелчке она меняется с в синюю
полоску на синюю (так как вы устанавливаете ключи для всех параметров); со вторым щелчком
он превращается из синего в серый.

Совет: Чтобы удалить ключевой кадр для определенного параметра в текущем кадре:

Нажмите кнопку Установить ключ ( ) справа от параметра: цвет сменится с серого на оранжевый.

Совет: Для навигации по кадрам, в которых определены ключевые кадры:

Используйте кнопки Следующий ключ ( ) и Предыдущий ключ ( ), расположенные по
бокам от кнопки Установить ключ Set Key.

Совет: Чтобы активировать/деактивировать предварительный просмотр:

Выполните любое из следующих действий:

• Нажмите кнопку Вид с камеры ( ) в нижней панели окна настроек эффектов, чтобы ограни-
чить предварительный просмотр видом с камеры.

• Нажмите кнопку Предпросмотр ( ) в нижней панели окна настроек эффектов, чтобы про-
смотреть результаты независимо от снимка камеры.

Совет: Чтобы изменить размер области предварительного просмотра:

Выполните любое из следующих действий:

• Нажмите и перетащите горизонтальный разделитель.

• Нажмите и перетащите разделитель к границе окна, чтобы скрыть область предварительного
просмотра.

• Нажмите и перетащите разделитель, свернутый к границе окна, к центру окна, чтобы снова
отобразить область предварительного просмотра.

Примечание: Соотношения сторон области предварительного просмотра зависит от соотношений
сторон текущей камеры.
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Совет: Чтобы изменить цвет фона области предварительного просмотра:

Используйте кнопки в нижней панели окна настроек эффектов, чтобы выбрать Белый ( ), Черный

( ) или Клетчатый ( ) фон.

Совет: Для навигации по области предварительного просмотра:

Выполните одно из следующих действий:

• Используйте колесико мыши или сочетания клавиш увеличения (по умолчанию клавиши + и -)
для увеличения или уменьшения масштаба.

• Нажмите среднюю кнопку мыши и перетащите, чтобы прокрутить в любом направлении.

• Используйте сочетание клавиш Вид по умолчанию (по умолчанию клавиша Alt + 0) чтобы
отобразить предварительный просмотр в его реальном размере.

19.2.1 Использование гаджетов эффектов

Некоторые параметры эффектов, связанные с позициями или размерами, имеют некоторые гаджеты,
доступные в окне просмотра, чтобы их можно было установить, используя поле камеры и элементы
сцены в качестве ссылки. Например, эффект Radial Gradient имеет два круговых гаджета, которые
можно редактировать, чтобы установить внутренний размер и внешний размер градиента.

Как только узел эффекта выбран на схеме, инструмент Анимирования становится текущим инстру-
ментом, и отображаются связанные гаджеты эффектов, если они доступны. Настройки инструмента
Анимирования будут ссылаться на столбец, к которому применяется эффект, но в случае, если эффект
создает изображение, сгенерированное компьютером (например, радиальный градиент или пятно све-
та), настройки будут ссылаться на сам столбец эффекта (см. Анимирование объектов).

Совет: Для визуализации гаджетов эффектов в окне просмотра:

Выберите узел эффекта в схеме эффектов.

Совет: Для редактирования гаджетов эффектов:

Нажмите и перетащите гаджеты эффектов, видимые в средстве просмотра. При наведении курсора
на гаджет и связанные с ним маркеры курсор меняет форму, указывая на то, что вы редактируете
гаджет эффекта.

Примечание: Некоторые гаджеты имеют указатели для справки; однако любую точку вдоль формы
гаджета можно щелкнуть и перетащить.

19.2.2 Определение цветов и цветовых спектров

Некоторые эффекты могут потребовать определения цвета или цветового спектра.
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Цвета могут быть определены путем редактирования соответствующих значений красного, зеленого,
синего и альфа-канала или с помощью редактора стилей.

Цветовые спектры, то есть серия цветов, определяющих непрерывный градиент, могут быть определе-
ны путем добавления любого нужного цвета и редактирования каждого цвета отдельно. Цвет в спектре
может быть перемещен, чтобы установить расстояние между двумя цветами и соответствующим гра-
диентом.

Совет: Чтобы определить цвет:
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Выполните одно из следующих действий:

• Установите значения красного, зеленого, синего и альфа каналов.

• Нажмите на миниатюру цвета и используйте Редактор стилей, чтобы отредактировать его (см.
Простые цвета).

Совет: Чтобы установить цвет спектра:

Перемещайте стрелку под спектром, определяющую цвет, и отредактируйте связанный цвет.

Совет: Чтобы добавить цвет к спектру:

Нажмите на спектр, где вы хотите добавить новый цвет.

Совет: Чтобы переместить цвет в спектре:

Нажмите и перетащите стрелку, обозначающую цвет, на новую позицию.

Совет: Чтобы удалить цвет из спектра:

Нажмите и перетащите стрелку, обозначающую цвет вниз.

19.3 Создание предустановок

Конкретную конфигурацию и анимацию параметров эффекта можно сохранить в виде Пресета, ко-
торый будет доступен позже, как в обозревателе эффектов, так и в раскрывающихся меню, которые
открываются при щелчке правой кнопкой мыши по узлам или в области схемы.

При сохранении пресета для определенного эффекта в браузере эффектов значок эффекта превраща-
ется в папку, содержащую сохраненный пресет, при этом значок папки по-прежнему можно выбрать
для вставки эффекта со значениями по умолчанию; в раскрывающихся меню эффект имеет дополни-
тельное раскрывающееся меню, в котором можно выбрать первый элемент, чтобы вставить эффект со
значениями по умолчанию.
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Пресеты сохраняются в папке <projectroot>\fxs\preset. Это позволяет пресетам быть доступными
на всех компьютерах, использующих один и тот же Projectroot (см. Настройка Projectroot).

Примечание: В настоящее время приведенное выше утверждение не соответствует действи-
тельности так как по умолчанию пресеты сохраняются в OpenToonz stuff\fxs\presets. В
Windows его можно изменить на любой другой путь, перейдя в реестр и изменив значение
System\HKEY_LOCAL_MACHINE\SOFTWARE\OpenToonz\OpenToonz\TOONZFXPRESETS на нужное место.

После применения пресета связь между сохраненным пресетом и применяемым пресетом отсутствует:
примененный пресет можно редактировать, не затрагивая сохраненный.

Примечание: Когда вы сохраняете пресет с уже использованным именем, откроется диалоговое окно
подтверждения, в котором вас спросят, хотите ли вы перезаписать ранее сохраненный пресет.

Совет: Чтобы сохранить пресет:
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1. Щелкните правой кнопкой мыши узел эффекта, который вы хотите сохранить в качестве пресета,
и выберите Сохранить как пресет в открывшемся меню.

2. Присвойте имя пресету и нажмите кнопку Сохранить.

Совет: Чтобы извлечь сохраненный пресет:

Выполните любое из следующих действий:

• Откройте Браузер FX и откройте папку, относящуюся к эффекту, для которого вы сохранили
пресет.

• В меню правой кнопки мыши Вставить FX, Добавить FX или Заменить FX выберите под-
меню, относящееся к эффекту, для которого вы сохранили пресет.

Совет: Чтобы удалить пресет из браузера FX:

Щелкните правой кнопкой мыши по пресету в Браузере FX и выберите Удалить пресет в открыв-
шемся меню.

19.4 Создание Macro FX

Эффекты можно комбинировать для создания макроэффекта, который можно сохранять и извлекать
при необходимости.

Когда определен макроэффект, вы можете редактировать его настройки либо стандартным способом
в окне настроек FX, содержащем вкладку для каждого эффекта, объединенного для определения
макроэффекта, либо открывая его и редактируя один эффект за раз.

Макроэффект может быть открыт также для проверки того, как узлы эффекта связаны, и может быть
распущен, а его узлы эффектов вернутся обратно в схему.

После сохранения макроэффект будет доступен в Браузере FX и в раскрывающихся меню, которые
открываются при щелчке правой кнопкой мыши по узлам или в области схемы внутри папки Macro
в нижней части списка.

Примечание: Macro effects can’t contain zerary effect nodes in them (i.e. any effects in the Background
or Render categories). If any zerary effect node is selected when trying to use the Make Macro FX command,
no macro effect will be created.

Совет: Для создания макроэффекта:

1. Выберите узлы эффекта, которые вы хотите объединить для создания макроэффекта.

2. Щелкните правой кнопкой мыши на выделении и выберите Cделать Macro FX в открывшемся
меню.

Совет: Чтобы открыть макроэффект:
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Щелкните правой кнопкой мыши узел макроэффекта и выберите Открыть Makro FX в открывшемся
меню: узлы макроэффекта отображаются в поле с правыми ссылками на остальную часть схемы.

Примечание: Когда отображается содержимое макроэффекта невозможно редактировать ссылки
между узлами макроэффекта и ссылки с узлами вне макроэффекта.

Совет: Чтобы закрыть макроэффект:

Нажмите кнопку Закрыть справа от панели макроэффекта.

Совет: Чтобы распустить макроэффект:

Щелкните правой кнопкой мыши узел макроэффекта и выберите Разбить Makro FX в открывшемся
меню.

Совет: Чтобы отредактировать макроэффект:

Выполните одно из следующих действий:

• Щелкните правой кнопкой мыши узел макроэффекта и выберите Редактировать FX. . . в от-
крывшемся меню.

• Щелкните правой кнопкой мыши узел макроэффекта и выберите Открыть Makro FX в от-
крывшемся меню, затем отредактируйте узлы макроэффекта.

Совет: Чтобы сохранить макроэффект:

1. Щелкните правой кнопкой мыши узел эффекта макроэффета, который вы хотите сохранить, и
выберите Сохранить как пресет. . . в открывшемся меню.

2. Присвойте имя макроэффекту и нажмите кнопку Сохранить.

Совет: Чтобы удалить макроэффект из Браузера FX:

Щелкните правой кнопкой мыши макроэффект в Браузере FX и выберите Удалить Macro FX в
открывшемся меню.

19.5 Список эффектов

19.5.1 Background
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Checkerboard

Создает новый столбец/слой, содержащий шахматную доску, заданную двумя цветами (Color) , и
размером (Size) сетки.

Примечание: Размер сетки также можно установить с помощью квадратного указателя в окне про-
смотра (см. Использование FX Gadgets).
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Color Card

Создает новый столбец/слой, содержащий заданный цвет (Color). Его можно использовать, например, в
качестве цвета фона или для создания эффекта раскрашивания, применяя его в сочетании с эффектом
умножения.
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Kaleido (Калейдоскоп)

Повторяет источник, генерирующий калейдоскопический эффект.

Центр эффекта можно определить интерактивно, перемещая маленький виджет красного креста в
области предварительного просмотра или записывая нужные значения в текстовые поля X и Y.

Угол отражения и количество итераций можно задать в соответствующих полях ввода текста (Angle
и Count).
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Tile

Эффект повторяет исходное изображение для создания большего изображения: режим Tile форми-
рует шаблон, который полностью заполняет снимок с камеры, Tile Horizontally повторяет исходное
содержимое по горизонтали; Tile Vertically повторяет исходное содержимое по вертикали.

Параметры Mirror Horizontally и Mirror Vertically повторяют плитки, переворачивая их соответственно
в горизонтальном и вертикальном направлениях; если обе опции активированы, плитки будут отра-
жаться в обоих направлениях.

Значение Margin устанавливает размер поля вокруг каждой плитки, при этом положительные значения
добавляют пространство вокруг плиток, а отрицательные значения сжимают их.

19.5.2 Blur (Размытие)
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Blur (Размытие)

Смягчает содержимое источника, создавая эффект расфокусировки, в соответствии с определенной
интенсивностью.

Directional Blur
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Размытие исходного содержимого в соответствии с определенной интенсивностью (Intensity) в опреде-
ленном направлении, определенном углом (Angle).

Параметр Bidirectional применяет размытие также на другой стороне направления.

Примечание: Интенсивность и угол можно также установить с помощью гаджета со стрелкой с
ручкой в окне просмотра (см. Использование FX Gadgets).

Примечание: Направленное размытие не зависит от движения и скорости столбца, к которому оно
применяется.

Local Blur

Размытие исходного содержимого в соответствии со значением яркости содержимого узла, подключен-
ного к референсному вводу с другого узла. Значение интенсивности (Intensity) равномерно усиливает
размытие, данное содержание опорного узла.

Motion Blur (Размытие в движении)

Создает эффект размытия движения в соответствии с движением исходного содержимого в преды-
дущем и текущем кадре. Движение должно определяться анимированным столбцом, штифтами или
таблицей: чем выше скорость, тем более заметен эффект.

Если движение между последовательными кадрами является постоянным, вы можете увеличить или
уменьшить интенсивность (Intensity), чтобы получить более или менее видимый эффект. Если нет
движения между предыдущим и текущим кадрами, размытие движения не будет видно, даже если вы
установили высокую интенсивность.

Примечание: Никакого результата не будет видно, если размытие в движении применяется к столбцу,
который всегда находится в одной и той же позиции, в то время как содержимое является уровнем, на
котором нарисовано движение.
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Radial Blur

Размытие вдоль радиальных линий, источником которых является заданный центр (Center), определя-
емый горизонтальными (X) и вертикальными (Y) координатами, начиная с незатронутой внутренней
области, определенной радиусом (Radius).

Примечание: Центр и радиус также можно установить с помощью точечного и кругового гаджета
с указателем в окне просмотра (см. Использование FX Gadgets); центр также можно установить в
предварительном просмотре настроек FX.
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Spin Blur

Размытие по концентрическим круговым линиям, как будто содержимое источника поворачивается
вокруг установленного центра (Center), определенного горизонтальными (X) и вертикальными (Y)
координатами, начиная с незатронутой внутренней области, определенной радиусом (Radius).

Примечание: Центр и радиус также можно установить с помощью точечного и кругового гаджета
с указателем в окне просмотра (см. Использование FX Gadgets); центр также можно установить в
предварительном просмотре настроек FX.

19.5.3 Distort
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Free Distort

Искажает исходный контент в соответствии с положением четырех точек, определенных горизонталь-
ными (X) и вертикальными (Y) координатами. Для каждой точки вы можете установить фактическую
позицию и ее происхождение, чтобы определить, какая особенность изображения будет искажена в но-
вой позиции.

Параметр Режим (Mode) позволяет вам установить способ применения искажения: Bilinear искажа-
ет изображения в соответствии с конечными положениями четырех точек, и Perspective заставляет
искажение соответствовать плоскости проекции перспективы.

Чтобы лучше установить исходную позицию для каждой точки, вы можете использовать опцию Деак-
тивировать (Deactivate), которая позволяет вам видеть изображение без искажений.

Примечание: Положение четырех точек и их начало также можно задать с помощью гаджетов со
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стрелками с ручками на концах в окне просмотра (см. Использование FX Gadgets) и в предварительном
просмотре настроек FX также.

Linear Wave

Искажает исходный контент, создавая волновой эффект, который использует автоматически сгенери-
рованное изображение карты смещения. Значение Количество (Quantity) устанавливает количество
волн; Период (Period) устанавливает расстояние между волнами; Фаза (Phase) сдвигает искажения в
направлении волны.

Вы также можете добавить поперечную волну к основным линейным волнам: амплитуда (Amplitude)
устанавливает интенсивность искажения; Частота (Frequency) устанавливает количество волн, созда-
ющих искажение; Цикл (Cycle) сдвигает искажающие волны.

Вращение для всего волнового эффекта может быть установлено с помощью значения угла (Angle).
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Количество искажений контролируется значением интенсивности (Intensity); детали искажения, пара-
метром чувствительности (Sensitivity); Параметр Резкость (Sharpen) позволяет уменьшить размытость
конечного результата.

Perlin Noise

Искажает исходный контент, используя сгенерированное компьютером изображение карты смещения,
тип которого можно выбрать между Clouds и Marble/Wood.

Количество искажений контролируется значением интенсивности (Intensity); размер сетки карты сме-
щения - параметром Размер (Size) . Также можно управлять горизонтальным (Horizontal Offset) и
вертикальным (Vertical Offset) смещением и стадией эволюции (Evolurion) изображения карты сме-
щения; установив изменение этих значений между двумя ключами, вы можете установить, насколько
карта смещения перемещается и изменяется во время анимации.

Параметр Альфа (Alpha) также добавляет смещение прозрачности к полностью непрозрачным изоб-
ражениям.

Примечание: Горизонтальное и вертикальное смещение также можно установить с помощью точеч-
ного гаджета в окне просмотра (см. Использование FX Gadgets).
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Random Wave

Искажает исходный контент, создавая эффект случайной волны, который использует автоматически
сгенерированное изображение карты смещения. Его можно использовать, например, для создания от-
ражения на поверхности воды или вида под водой.

Этап изображения карты смещения можно контролировать с помощью значения Evolution; устанав-
ливая изменение этого значения между двумя клавишами, вы устанавливаете, насколько изображение
карты смещения изменяется во время анимации.

Положение изображения карты смещения может быть смещено по горизонтальной X и вертикальной
Y осям. Устанавливая изменение этого значения между двумя клавишами, эффект искажения можно
анимировать в любом направлении.

Количество искажений контролируется значением интенсивности (Intensity); детали искажения, пара-
метром чувствительности (Sensitivity); Параметр Резкость (Sharpen) позволяет уменьшить размытость
конечного результата.

Примечание: Положение вдоль горизонтальной и вертикальной оси также можно задать с помощью
точечного гаджета в окне просмотра (см. Использование FX Gadgets).
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Ripple

Искажает исходный контент, создавая эффект круговой волны, который использует автоматически
сгенерированное изображение карты смещения. Значение Количество (Quantity) устанавливает ко-
личество пульсаций; значение Период (Period) устанавливает расстояние между пульсациями; Цикл
(Cycle) смещает искажение пульсации, с увеличением значений, расширяющим пульсации, и уменьше-
нием значений, сжимающих их.

Центр (Center) круговых волн может быть установлен с горизонтальным X и вертикальным Y значе-
нием; круговые волны можно масштабировать (Scale) в горизонтальном и вертикальном направлениях
и поворачивать в соответствии с заданным углом (Angle).

Количество искажений контролируется значением интенсивности (Intensity); детали искажения, пара-
метром чувствительности (Sensitivity); Параметр Резкость (Sharpen) позволяет уменьшить размытость
конечного результата.

Примечание: Центр и период также можно установить с помощью точечного и кругового гаджета
с ручкой в окне просмотра (см. Использование FX Gadgets); центр также может быть установлен в
предварительном просмотре настроек FX.
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Warp

Искажает содержимое источника в соответствии с изменением яркости содержимого узла, подклю-
ченного к дескриптору ввода Warper, которое используется в качестве изображения карты смещения,
влияющего на содержимое источника.

Количество искажений контролируется значением интенсивности (Intensity); детали деформации по
размеру (Size) сетки карты смещения; параметр Резкость (Sharpen) позволяет уменьшить размытость
конечного результата.

19.5.4 Градиенты (Gradients)
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Diamond Gradient

Создает новый столбец/слой, содержащий градиент, который проходит гиперболически от центра к
четырем углам, определяемым цветовым спектром (см. Определение цветов и цветовых спектров) и
значением размера (Size).

Примечание: Размер также можно установить с помощью кругового гаджета с ручкой в окне про-
смотра (см. Использование FX Gadgets).
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Four Points Gradient

Создает новый столбец/слой, содержащий градиент, определяемый четырьмя цветами (Color), опре-
деляемыми значениями красного R, зеленого G, синего B и альфа-канала A, исходные точки которых
можно размещать, где это необходимо, определяя горизонтальные (X) и вертикальные (Y) координаты.

Примечание: Исходные точки также можно установить с помощью точечных гаджетов в окне про-
смотра (см. Использование FX Gadgets), а также в предварительном просмотре настроек FX.
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Линейный градиент (Linear Gradient)

Создает новый столбец / слой, содержащий постепенное смешение двух цветов (Color), определяемых
значениями красного (R), зеленого (G), синего (B) и альфа (A) каналов. Размер (Size) контролирует
область градиента между двумя цветами.

Вы также можете добавить Distortion Wave на линейный градиент: амплитуда (Amplitude) устанавли-
вает интенсивность искажения; частота (Frequency) устанавливает количество волн, создающих иска-
жение; фаза (Phase) сдвигает искажающие волны.

Примечание: Размер также можно установить с помощью гаджета с двумя ручками на концах в
окне просмотра (см. Использование FX Gadgets).

420 Глава 19. Применение эффектов



OpenToonz Documentation, Выпуск 1.7.1

Multi Linear Gradient

Создает новый столбец/слой, содержащий мультилинейный градиент, определенный цветовым спек-
тром (см. Определение цветов и цветовых спектров). Значение Period устанавливает размер градиента
спектра; Количество (Quantity) - это количество повторений спектра; Фаза (Phase) сдвигает градиент
цветов.

Вы также можете добавить Wave distortion к мультилинейному градиенту: амплитуда (Amplitude) уста-
навливает интенсивность искажения; частота (Frequency) устанавливает количество волн, создающих
искажение; фаза (Phase) сдвигает искажающие волны.

Примечание: Период также можно установить с помощью гаджета с двумя ручками на концах в
окне просмотра (см. Использование FX Gadgets)
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Multi Radial Gradient

Создает новый столбец/слой, содержащий многорадиальный градиент, определенный цветовым спек-
тром (см. Определение цветов и цветовых спектров). Значение Period устанавливает размер градиента
спектра; Количество (Quantity) - это количество повторений спектра; Фаза (Phase) сдвигает градиент
цветов.

Примечание: Период также можно установить с помощью кругового гаджета с ручкой в окне про-
смотра (см. Использование FX Gadgets).
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Радиальный градиент (Radial Gradient)

Создает новый столбец/слой, содержащий постепенное смешение двух цветов (Color), определяемых
значениями красного R, зеленого G, синего B и альфа-канала A, затеняя их по кругу. Inner Size кон-
тролирует область, где начинается градиент между двумя цветами; Outer Size, где это заканчивается.

Примечание: Inner size и outer size также можно установить с помощью круговых гаджетов с ручкой
в окне просмотра (см. Использование FX Gadgets).
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Спиральный градиент (Spiral)

Создает новый столбец/слой, содержащий градиент спиральной структуры, определенный цветовым
спектром (см. Определение цветов и цветовых спектров). Частота (Frequency) устанавливает размер
и количество витков; Фаза (Phase) сдвигает градиент цветов.

Square Gradient
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Создает новый столбец/слой, содержащий квадратный градиент, который идет линейно от центра к
четырем углам, определяемым цветовым спектром (см. Определение цветов и цветовых спектров) и
значением размера (Size).

Примечание: Размер также можно установить с помощью повернутого квадратного гаджета с руч-
ками в окне просмотра (см. Использование FX Gadgets).

19.5.5 Image Adjust

Adjust Levels
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Регулирует блики и тени содержимого источника путем переназначения интенсивности пикселей в
соответствии со значениями уровней входного (Input) и выходного (Output) сигналов для каналов
RGB, красный (Red), зеленый (Green), синий (Blue) и альфа (Alpha); он также контролирует значение
гаммы для каждого канала отдельно.

Для каждого канала входные значения повторно отображают интенсивность пикселей, значение ко-
торой равно или ниже, чем Минимальное значение, до 0, а те, чье значение равно или превышает
Максимальное значение, до 255. Это может быть полезно для повышения контрастности изображения.

Для каждого канала выходные значения преобразуют интенсивность пикселей, значение которой мень-
ше минимального значения, в минимальное значение, а значения, значение которых выше максималь-
ного значения, - в максимальное значение. Это может быть полезно для уменьшения контрастности
изображения.

Яркость и контраст (Brightness & Contrast)

Увеличивает или уменьшает яркость (Brightness) и контрастность (Contrast) содержимого источника.
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Channel Mixer

Меняет местами каналы исходного контента. Для каждого канала вы можете установить, останется
ли он как есть, или хотите, чтобы другой канал был смешанным. Например, чтобы оставить красный
канал как есть, красный на красный равен 1, остальные каналы на красный равны 0; установив Green
на Red на 0.5, вы добавите половину интенсивности зеленого канала к красному.
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Его можно использовать, например, для создания черно-белой клавиши для изображения с альфа-
каналом, установив для всех значений значение 0, а для альфы - красный, зеленый, синий и альфа
1.

Curves

Регулирует тональный диапазон источника, переназначая интенсивность пикселей в соответствии с
тональной кривой для каналов RGB, Red, Green, Blue и Alpha.

Горизонтальная ось графика представляет исходные уровни яркости пикселей (входной Input уровень);
вертикальная ось представляет новые уровни яркости (выходной Output уровень).

Диагональная линия по умолчанию указывает, что ни один пиксель не сопоставлен с новыми значени-
ями, поэтому все пиксели имеют одинаковые входные и выходные значения.

Для корректировки кривой можно использовать множество точек регулировки: чтобы добавить точку,
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щелкните по кривой; чтобы изменить кривизну, используйте ручки касательной к точке; чтобы уда-
лить точку, выберите ее и используйте сочетание клавиш удаления (по умолчанию клавиша Delete).

Параметр Linear ограничивает кривую серией прямых сегментов.

Despeckle

Устраняет мелкие дефекты (грязь, царапины, пятна и т.п.) рисунка. Размер в пикселях деталей, кото-
рые будут отретушированы, можно определить в текстовом поле ввода Размер (Size). Фон изображений
может быть прозрачным или белым, выбор доступен в меню (Detect On).

В области предварительного просмотра можно проверить результаты, чтобы избежать стирания дета-
лей, относящихся к рисунку.
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Гамма (Gamma)

Изменяет значение гаммы исходного контента.
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HSV Scale

Изменяет значение тона (Hue), насыщенности (Saturation) и значения (Value) исходного контента. Тон
меняется от -180 до 180; насыщенность и значение от -100 до 100. Все три параметра сохраняют свое
первоначальное значение на 0.
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Invert

Инвертирует цветовые значения исходного контента, например, делает позитивное черно-белое изоб-
ражение негативным или позитивное из отсканированного черно-белого негатива.
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Multitone

Применяет к исходному содержимому цвета, определенные цветовым спектром (см. Определение цве-
тов и цветовых спектров) в соответствии с яркостью изображения. Исходное изображение превраща-
ется в черно-белое, и цвет в дальнем левом углу спектра будет использоваться для черных пикселей,
цвет в крайнем правом углу для белых пикселей и промежуточные цвета для промежуточных серых
пикселей.
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RGBA Cut

Разграничивает минимальные и максимальные значения красного (Red), зеленого (Green), синего
(Blue) и альфа (Alpha) компонентов исходного содержимого. Максимум может быть уменьшен с 255
(исходное значение) до 0, когда красный, зеленый, синий или альфа-компонент не будут видны. Ми-
нимум может быть увеличен с 0, первоначальное значение, до 255, когда красный, зеленый, синий
компоненты будут насыщены, а альфа будет полностью непрозрачным.
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RGB Fade

Затухает содержимое источника до цвета, определяемого значениями красного (Red), зеленого (Green)
и синего (Blue). Интенсивность (Intensity), выраженная в процентах, колеблется от 0 (без затухания)
до 100 (от затухания до полного цвета).
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RGBA Scale

Изменяет процентное содержание красного (Red), зеленого (Green), синего (Blue) и альфа (Alpha)
компонентов исходного содержимого. На 0 нет красного, зеленого, синего или альфа-компонента; на
100 компоненты имеют свое первоначальное значение.
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Резкость (Sharpen)

Увеличивает резкость (Sharpness) исходного контента в соответствии с определенной интенсивностью
(Intensity).

19.5.6 Layer Blending
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Add

Добавляет красное, зеленое и синее значения содержимого узла Source1 к значению Source2, пиксель
за пикселем.

Если нисходящий узел не определен, операция добавления применяется ко всем изображениям, лежа-
щим в основе содержимого восходящего узла, в соответствии с порядком слоев в Xsheet/Timeline.

Интенсивность (Intensity) выражает процент значений, используемых в добавлении; отрицательное
значение определяет вычитание вместо добавления.
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Color Burn

Затемняет цвета пикселей содержимого ниже подключенного узла чтобы отразить цвет содержимого
верхнего узла. Белый цвет в содержимом верхне подключенного узла не влияет на результат.

Если ниже подключенный узел не определен, операция затемнения цвета применяется ко всем изоб-
ражениям, лежащим в основе содержимого выше подключенного узла в соответствии с порядком пе-
рекрытия слоев в Xsheet/Timeline.

Color Dodge
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Увеличивает яркость цвета пикселов содержимого нижерасположенного узла чтобы отобразить цвет
содержимого выше подключенного. Черный цвет в верхнем содержимом узла не влияет на результат.

Если ниже подключенный узел не задан, операция осветления применяется ко всем изображениям, рас-
положенным ниже содержимого выше подключенного узла в соответствии с порядком расположения
слоев Xsheet/Timeline.

Cross Dissolve

Создает перекрестное растворение между содержимым выше и ниже подключенных узлов. Когда зна-
чение Intensity (Интенсивность) равно 0, отображается только содержимое верхнего узла; когда это
100 только нижнего.
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Darken

Сравнивает цвета пикселей содержимого подключенных узлов и выбирает более темный в качестве
цвета результата. Белый цвет в содержимом выше подключенного узла не влияет на результат; черный
дает черный результат.

Если определен только один узел, операция затемнения применяется ко всем изображениям, лежащим
в основе его содержимого, в соответствии с порядком слоев Xsheet/Timeline.
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Lighten

Сравнивает цвет пикселей содержимого подключенных узлов и выбирает более светлый в качестве
цвета результата. Черный цвет в содержимом вышерасположенного узла не влияет на результат; белый
дает белый результат.

Если подключен только один узел операция осветления применяется ко всем изображениям, лежащим
в основе подключенного узла в соответствии с порядком наложения Xsheet/Timeline.
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Local Transparency

Применяет прозрачность к содержимого источника (Source) в соответствии со значением яркости со-
держимого узла, подключенного к эталонному входному порту (Reference).

Значение интенсивности (Intensity) равномерно усиливает прозрачность, данное содержание эталонно-
го узла.
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Multiply

Умножает красные, зеленые, синие и значения альфа-канала контента подключенного узла.

Значение интенсивности (Intensity) выражает процент значений, используемых при умножении. При
активации опции Alpha также учитывается информация о альфа-канале.

Если определен только один узел, операция умножения применяется ко всем изображениям, лежащим
в основе содержимого верхнего узла в соответствии с порядком слоев Xsheet/Timeline.
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Over

Размещает подключенные узлы один над другим. Каждый раз, когда подключается узел, добавляет-
ся новый порт, таким образом, перекрытие столбцов может быть определено независимо от порядка
столбцов Xsheet (или слоев Timeline). Порядок содержимого сверху вниз, где узел, подключенный
к верхнему порту, будет поверх остальных. Это можно использовать, когда вам нужно объединить
несколько узлов в один, например, чтобы замаскировать несколько столбцов с одинаковой маской.

Premultiply

Умножает альфа-канал содержимого узла источника.

Полноцветные изображения, которые имеют значимый альфа-канал, бывают двух типов: предвари-
тельно умноженные или нет. Не предварительно умноженное изображение может быть распознано,
когда оно загружено в OpenToonz, потому что его край, где имеется полная прозрачность с одной сто-
роны и непрозрачность с другой, не является гладким, но отображает сплошной ореол. С эффектом
предварительного умножения можно преобразовать альфа-канал изображения, чтобы он был правиль-
но прочитан OpenToonz.

Примечание: Полноцветные изображения также можно умножить с помощью параметра Умножения
в окне Уровень -> Параметры уровня или обработать в обозревателе на постоянной основе, так что
нет необходимости применять эффект в схеме (см. Редактирование настроек уровня и Использование
браузера файлов ).
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Screen

Комбинируется путем умножения цвета, обратного пикселям, для содержимого узлов Source1 и Source2,
в результате чего результирующий цвет светлее, чем пиксели узлов Source1 и Source2 за исключением
случаев, когда один из них равен 0. Черный цвет в содержимом узла Source1 не влияет результат;
белый дает белый результат.

Если Source2 не задан, , операция экранирования применяется ко всем изображениям, лежащим в
основе содержимого Source1, в соответствии с порядком наслоения Xsheet/Timeline.
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Subtract

Вычитает значения красного, зеленого и синего каналов содержимого узла Source1 из значения Source2,
пиксел за пикселoм. При активации опции Аlpha также учитывается информация о альфа-канале.

Если подключен только один узел, операция вычитания применяется ко всем изображениям, лежащим
в основе содержимого подключенного узла, в соответствии с порядком слоев Xsheet/Timeline.
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Transparency

Устанавливает прозрачность исходного контента. Интенсивность прозрачности (Intensity), выраженная
в процентах, варьируется от 0, полностью непрозрачная, до 100, полностью прозрачная.

19.5.7 Light (Свет)
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Backlit

Создает эффект подсветки, используя содержимое узла Light в качестве источника света, влияющего
на содержимое узла Source с помощью установленной интенсивности (Intensity). Содержимое узла Light
также может быть затенено до цвета, определяемого значениями каналов красного Red, зеленого Green
и синего Blue, в соответствии с установленным затуханием Fade.
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Body Highlight

Создает выделенную область для содержимого узла Source в соответствии с его альфа-каналом. Вы
можете установить цвет подсветки Color, а также значения прозрачности Transparensy и размытия
Blur, которые будут применяться.

Смещение выделенной области определяется значениями смещения по горизонтали (X) и по вертикали
(Y), которые также можно установить в интерактивном режиме в окне предварительного просмотра
окна настроек эффектов, где центр смещения отображается с крестиком.

Включив опцию Invert, затронутые области будут переключаться.

Эффект также можно использовать для создания тени тела, определив черный цвет для подсветки.
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Превращает исходный контент в тень, которая может быть искажена и затемнена до цвета с
переменной прозрачностью и размытостью.

Превращает исходный контент узла Source в тень, которая может быть искажена и затемнена до цвета
с переменной прозрачностью и размытостью.

Искажение (Distortion) может быть сделано как в эффекте Free Distort (см. Free Distort). Цвет за-
тухания может быть определен значениями красного Red, зеленого Green и синего Blue каналов, а
также может быть установлена интенсивность затухания Fade. Для более реалистичной тени можно
установить другое значение размытия Blur и прозрачности Transparency для верхней и нижней части
исходного содержимого.
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Glow

Создает эффект свечения, используя содержимое узла Light в качестве источника света, который све-
тится на содержимом узла Source, подключенного к входному порту Source. Размытие Blur и Яркость
Brightness светящегося можно настроить; содержимое узла Light также может быть затемнено до цве-
та, определенного значениями красного Red, зеленого Green и синего Blue каналов, в соответствии с
установленной интенсивностью Intensity.

Если узел источника не определен, свечение применяется ко всем изображениям, лежащим в основе
содержимого узла Light, в соответствии с порядком слоев Xsheet/Timeline.
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Light Spot

Создает новый столбец/слой, содержащий световое пятно, размер и цвет которого можно установить
соответственно с помощью значений ширины и высоты, а также значений красного Red, зеленого Green,
синего Blue и альфа Alpha каналов. Softness устанавливает рассеивание света в области за пределами
пятна.

Примечание: Ширина и высота также могут быть заданы с помощью гаджета-бокса с ручками в
окне просмотра (see Использование гаджетов эффектов ).
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Raylit

Размещает источник света за содержимым узла Source, отбрасывая лучи света снаружи или внутри
контура изображения.

Положение источника света определяется горизонтальными (X) и вертикальными (Y) координатами.
Изменяя положение источника света, вы изменяете способ направления лучей вдоль контура изобра-
жения; изменяя значение расстояния, вы можете сделать так, чтобы источник света приближался или
удалялся от изображения.

Свойства света могут быть установлены путем определения интенсивности Intensity, цвета Color, ко-
торый устанавливается значениями красного Red, зеленого Green, синего Blue и альфа Alpha каналов,
затухания Decay, то есть уменьшения интенсивности света в зависимости от его расстояния от изобра-
жения, и гладкости Smoothness, который определяет, насколько четкими являются лучи вдоль контура
изображения.

Опция Invert переключает излучение световых лучей с внешней стороны изображения на внутреннюю.

Флажок Keep image определяет, отображается ли исходный рисунок на выходе или нет.

Примечание: Центр также можно установить с помощью точечного гаджета в окне просмотра (см.
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Использование гаджетов эффектов) и в предварительном просмотре настроек эффектов.

Примечание: Содержимое узла Source должно иметь значительный альфа-канал, чтобы иметь эф-
фективный результат.

Color Raylit

Размещает источник света за содержимым узла Source, отбрасывая лучи света за пределы контура
изображения.

Положение источника света определяется горизонтальными (X) и вертикальными (Y) координатами.
Изменяя положение источника света, вы изменяете способ направления лучей вдоль контура изобра-
жения; изменяя значение расстояния, вы можете сделать так, чтобы источник света приближался или
удалялся от изображения.

Цвета лучей рассчитываются по оригинальным цветам рисунка.

Свойства света можно установить, задав интенсивность Intensity, затухание Decay, то есть уменьше-
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ние интенсивности света в соответствии с его расстоянием от изображения, и плавность Smoothness,
которая определяет, насколько резкими будут лучи по контуру изображения.

Флажок Keep image определяет, отображается ли исходный рисунок на выходе или нет.

Target Spot

Создает новый столбец / слой, содержащий световое пятно, размер и цвет которого можно установить
соответственно с помощью значений ширины и высоты, а также значений красного, зеленого, синего
и альфа-канала. Направление пятна может быть установлено путем определения расстояния света от
стола и угла между направлением пятна света и столом. Распад, то есть уменьшение интенсивности
света в соответствии с расстоянием от стола, также можно контролировать.

19.5.8 Matte
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Erode/Dilate

Морфологически размывает или расширяет альфа-канал подключенного узла на указанное значение,
где положительные значения соответствуют расширениям, а отрицательные - эрозии.

Параметр Type определяет форму углов рамки, применяемых вокруг изображения, когда значение
радиуса Radius положительное.
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HSV Key

Определяет хромакей содержимого Source с использованием установленных значений Hue, Saturation и
Value. Вы можете установить диапазон для каждого значения с помощью соответствующего ползунка
Range. Выбор можно инвертировать с помощью кнопки Invert.
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Matte In

Делает контент узла Source видимым только внутри непрозрачных областей содержимого узла, под-
ключенного к входному порту Matte.

Matte Out
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Делает контент узла Source видимым только за пределами непрозрачных областей содержимого узла,
подключенного к входному порту Matte.

RGB Key

Определяет хромакей для содержимого узла Source с использованием установленных значений красно-
го R, зеленого G и синего B цветов. Вы можете установить диапазон для каждого значения с помощью
соответствующего ползунка Range. Выделение можно инвертировать с помощью кнопки Invert.
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Visible Matte In

Делает содержимое узла Up видимым только внутри непрозрачных областей содержимого узла, под-
ключенного к входному порту Down, оставляя узел Down все еще видимым.

19.5.9 Шум (Noise)

Dissolve
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Устраняет случайным образом пикселы из контента узла Source в соответствии с установленной ин-
тенсивностью Intensity.

Шум (Noise)

Добавляет эффект шума к содержимому узла Source в соответствии с установленной интенсивностью
Intensity. Вы можете решить, какой компонент шума из красного Red, зеленого Green и синего Blue вы
хотите активировать, и если результат должен быть черно-белым (Black & White).
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Salt & Pepper Noise

Добавляет эффект черно-белого шума к содержимому узла Source в соответствии с установленной
интенсивностью Intensity.

19.5.10 Render
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Clouds

Создает новый столбец/слой, содержащий фрактальное изображение, тип которого можно выбрать
между Clouds (Облака) и Marble (Мрамор)/Wood(Дерево). Размер влияет на сетку, используемую для
генерации фрактального изображения; цветовой спектр определяет используемые цвета (см. Опреде-
ление цветов и цветовых спектров).

При увеличении минимального значения цветовой спектр сдвигается вправо, и, следовательно, боль-
шее количество пикселей будет окрашено в цвет, определенный в дальнем левом углу спектра. При
уменьшении максимального значения цветовой спектр сдвигается влево, и, следовательно, большее
количество пикселей будет окрашено в цвет, определенный в дальнем правом углу спектра.

Значение Evolution фрактального изображения также может контролироваться; устанавливая измене-
ние этого значения между двумя ключевыми кадрами вы устанавливаете насколько сильно изменяется
изображение фрактала во течении анимации.
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Particles (Частицы)

Эффект Particles создает новый уровень в выбранном столбце/слое, содержащем частицы.

Он позволяет моделировать широкий спектр явлений, таких как дождь, снег, искры, дым и случайные
сочетания элементов, например, поле сияющих звезд, начиная с одной сияющей звезды, или колеблю-
щуюся траву на лугу, начиная с одной анимированной травинки.

См. Применения эффекта частиц .
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Text Iwa

Создает новый столбец/слой, содержащий редактируемый и анимируемый текст, используя следующие
параметры:

• Источник (Источник), указывает источник текста. Вы можете выбрать один из:

– Nearby Note Column (Ближайший столбец заметки) : получает текст из столбца Note
Level, помещенный непосредственно в левую часть столбца эффекта Text Iwa, в Xsheet (в
представлении таймлайна используется слой Note Level непосредственно под слоем эффек-
та). Если соответствующий столбец/слой не содержит уровень заметки или ячейка пуста,
текст не будет отображаться.

– Specified Note Column: аналогичен параметру Nearby Note Column, но номер исполь-
зуемого столбца уровня заметок можно указать в помощью поле Column Index ниже.

– Input Text: будет использоваться текст, введенный в поле Text ниже (как показано на
рисунке выше).

• Column Index указывает номер столбца исходного уровня заметок для использования. Исполь-
зуется только Specified Note Column в режиме Source.

• Text, указывает исходный текст. Используется только в режиме Input Text в режиме Source.

• Horizontal Align, указывает выравнивание текста. Возможные варианты: Left (Слева), Right
(Справа), Center (По центру) и Justify (По ширине).

• Center X:, Y: задает положение текста.

• Width, Height определяет размер текстового поля. Как и в параметрах Text функции Хлопушка-
нумератор, размер шрифта будет автоматически изменяться, чтобы соответствовать размеру по-
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ля (см. Использование хлопушки-нумератора).

• Font, указывает семейство шрифтов для использования.

• Style:, указывает начертание используемого шрифта.

• Size:, указывает максимальный размер шрифта для использования.

Примечание: Значение Size вступит в силу только в том случае, если автоматически
рассчитанный размер шрифта (для размещения в указанном текстовом поле) больше зна-
чения, указанного для этого параметра.

• Text Color указывает цвет текста. Этот цвет также будет использоваться для ограничительной
линии.

• Box Color, определяет цвет фона текстового поля.

• Опция Show Border, когда активирована, линия границы будет отображаться вокруг текстовой
рамки. Обратите внимание, что текстовое поле (заданное пользователем) и текстовое ограни-
чивающее поле (автоматически вычисляемое из визуализированного текста) могут различаться,
особенно если для параметра максимальный размер шрифта Size установлено небольшое значе-
ние.

Примечание: Известная проблема: когда вы используете столбец уровня заметок для исходного
текста, изменение текста не будет автоматически запускать регенерацию предварительного просмотра.
Вам нужно будет вручную перезапускать предварительный просмотр, используя контекстное меню
окна просмотра.

19.5.11 Stylize
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Color Emboss

Обводка краев исходного содержимого с помощью комбинации бликов и теней. Вы можете установить
интенсивность (Intensity) эффекта, а также расстояние (Distance) и направление (Direction) света,
которые создают эффект тиснения. Радиус (Radius) устанавливает глубину тиснения.

При подключении узла к порту Controller содержимое Source будет выдавлено в соответствии с содер-
жимым узла Controller.
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Emboss

Превращает содержимое узла Source в серые области и обрисовывает его края с помощью комбина-
ции бликов и теней. Вы можете установить интенсивность (Intensity) эффекта, а также расстояние
(Distance) и направление света (Direction), которые создают эффект тиснения. Радиус (Radius) уста-
навливает глубину тиснения.
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Mosaic (Мозаика)

Превращает содержимое узла Source в серии плиток в соответствии с указанными размером (Size) и
расстоянием (Distance). Цвет и прозрачность плиток берутся из исходного содержимого.

Цвет фона (Background Color) может быть установлен, и он будет виден вокруг плиток. Форму плитки
можно выбрать между квадратной и круглой.
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Posterize (Постеризация)

Преобразует исходный контент (Source) в несколько оттенков в соответствии с заданным количеством
уровней. Оттенки зависят от значений яркости исходного содержимого, и уровни предназначены для
каждого канала; например, два уровня дают шесть цветов: два для красный, два для зеленого и два
для синего.
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Solarize

Смешивает негативную и позитивную версии содержимого Source, как если бы фотографический от-
печаток ненадолго подвергался воздействию света во время проявки. Вы можете установить интенсив-
ность эффекта (Intensity) и контролировать Peak Edge, то есть количество используемых позитивных
и негативных изображений в производном изображении.

19.5.12 Toonz Level

Эффекты типа Toonz Level могут применяться только к Toonz Vector и Toonz Raster (файлы PLI
и TLV). Обычно они влияют на рисунки, к которым они применяются, в соответствии с индексами
стилей. Индексы стилей можно узнать в Палитре после символа # в Подсказка стиля или в нижнем
правом углу стиля в любом из режимов Просмотра в виде иконок.

Номера индексов можно указать в соответствующем текстовом поле через запятую. Чтобы определить
диапазон индексов, вы должны ввести первый и последний индексы, разделенные тире (например, 4-7
будут ссылаться на индексы 4, 5, 6 и 7. Чтобы выбрать все индексы, введите all; чтобы не выбирать
индексы, введите none.

Эффекты типа Toonz Level должны всегда применяться первыми, когда серия эффектов применяется к
уровню анимации, поскольку они работают только на уровнях Toonz Vector или Toonz Raster, которые
не были преобразованы другими типами эффектов. Однако два или более эффекта типа Toonz Level
могут быть применены к одному и тому же уровню анимации.
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Art Contour

Создает в содержимом узла Source узор, повторяя содержимое узла Controller, вдоль линий, окра-
шенных стилями, индексы которых указаны в текстовом поле Color Indexes. Его можно использовать,
например, для создания рассеянной кисти или эффектов волос и меха вдоль линий рисования.

Параметр Keep Color назначает цвет линии применяемому узору; параметр Keep Contour сохраняет
линию рисования, которая будет видна под узором.

То, как содержимое узла Controller создает шаблон, зависит от настроек Pattern.

Density устанавливает количество рисунка, который будет применяться вдоль линии. Установив для
параметра Density значение 0, вы можете указать минимальное и максимальное расстояние между
двумя последующими изображениями, применяемыми в качестве рисунка на линии.

Size устанавливает минимальный и максимальный процент изменения размера, применяемый к изоб-
ражениям, используемым в качестве шаблона; значение 100 - это исходный размер изображений.

Orientation устанавливает минимальный и максимальный угол поворота для изображений, используе-
мых в качестве шаблона, в соответствии с направлением линии; значение 0 отображает изображения

19.5. Список эффектов 473



OpenToonz Documentation, Выпуск 1.7.1

перпендикулярно направлению линии. Если используется параметр абсолютной ориентации, значения
ориентации не зависят от направления линий: значение 0 - это исходная ориентация изображений.

Calligraphic Line

Changes in the Source content the thickness of the drawing lines painted with styles whose indexes are
specified in the Color Indexes text field.

Вы можете указать увеличение толщины Thickness и то, как оно будет применяться в процентах к
различным направлениям линий по горизонтали Horizontal, вертикали Vertical, вверх по диагонали Up
Diagonal, вниз по диагонали Down Diagonal.

Smoothness устанавливает плавность перехода между участками линий, на которые воздействует эф-
фект, и теми, на которые не влияет; в то время как Noise устанавливает регулярность края линии.
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Color Blending

Смешивает строки исходного содержимого Source и области, окрашенные стилями, индексы которых
заданы в текстовом поле Color Indexes. Его можно использовать, например, для смешивания теней и
выделения областей с обычной цветной областью или для создания градиентов цветов.

Intensity определяет, насколько широкой будет область смешивания между выбранными цветами; в то
время как Smoothness определяет, насколько плавным будет колебание между смешанными цветами.

Параметр No Blending over Other Colors останавливает смешивание, как только обнаруживается линия
или область, индекс которой не включен в выделение; если он отключен, смешивание между выбран-
ными цветами продолжается в разделе исключенные линии и области.
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External Palette

Применяется к содержимому узла Source палитры, подключенного к входному порту Palette; если
узел столбца подключен к входному порту Palette, то будет рассматриваться палитра, связанная с его
содержимым.

Исходные стили уровней Toonz, содержащихся в исходном узле, заменяются стилями уровней, содер-
жащихся в узле палитры, в соответствии с их индексами стилей.

476 Глава 19. Применение эффектов



OpenToonz Documentation, Выпуск 1.7.1

Outline

Изменение толщины внешнего контура рисунка, подключенного к Source.

Вы можете указать увеличение толщины Thickness и то, как оно будет применяться в процентах к
различным направлениям линий по горизонтали Horizontal, вертикали Vertical, вверх по диагонали Up
Diagonal, вниз по диагонали Down Diagonal.

Smoothness задает плавность прохождения между участками линий, затронутых эффектом, и теми,
которые не затронуты; в то время как Noise задает регулярность края контура.
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Palette Filter

Фильтрует стили палитры содержимого Source в соответствии с индексами, указанными в текстовом
поле Color Indexes.

Меню параметров Apply To позволяет вам выбрать, хотите ли вы повлиять на линии и области (Lines
& Area), только на линии (Lines) или только на области (Areas), даже если они нарисованы одними и
теми же стилями; меню параметров Action позволяет вам выбрать, хотите ли вы оставить (Keep) или
удалить (Delete) указанные стили.
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Pinned Texture

Искажает содержимое узла Texture и применяет его к областям узла Source, окрашенным стилями,
индексы которых указаны в текстовом поле Color Indexes.

Искажение может быть сделано как в эффекте Free Distort (см. Free Distort), а текстура может быть
применена как в эффекте Texture (см. ниже).
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Texture

Применяет содержимое узла Texture к линиям и областям узла Source, окрашенным стилями, индексы
которых указаны в текстовом поле Color Indexes.

Поскольку содержимое узла Texture можно анимировать по своему усмотрению, этот эффект также
позволяет создавать анимированную текстуру.

Меню параметров Action позволяет вам выбрать, хотите ли вы применить текстуру к указанным сти-
лям (Keep) или применить ее ко всем стилям, кроме указанных (Delete).

Меню параметров Mode позволяет вам установить, как будет применяться содержимое узла тексту-
ры: Texture использует текстуру для замены выбранных стилей; Pattern сохраняет исходные цвета,
но изменяет их в соответствии с яркостью текстуры; Add (Добавить), Subtract (Вычесть), Multiply
(Умножить), Lighten (Осветлить) и Darken (Затемнить) определить способ применения текстуры к ис-
ходным цветам (см. Layer Blending). Если выбран режим Add, Subtract или Multiply, вы также можете
установить значение (Value) эффекта.

Примечание: Чтобы повторить изображение текстуры и создать мозаику для создания более крупной
текстуры, вы можете применить эффект Tile к столбцу текстуры перед тем, как связать его с узлом

480 Глава 19. Применение эффектов



OpenToonz Documentation, Выпуск 1.7.1

текстуры (см. Tile).

19.5.13 Shaders

OpenToonz обеспечивает поддержку эффектов, визуализируемых с помощью пиксельных шейдеров с
аппаратным ускорением. Шейдеры - это простые программы, скомпилированные графическим процес-
сором, использующие массивно-параллельную архитектуру современных графических устройств для
выполнения с экстремальной скоростью. Эффекты шейдеров OpenToonz написаны на языке шейдеров
OpenGL (GLSL) и находятся в папке OpenToonz stuff/library/shaders. Дополнительные сведения о
редактировании или создании новых эффектов шейдеров см. в файле readme.txt.

Caustic

Создает новый столбец/слой, содержащий моделирование отражения света от поверхности воды. Мож-
но задать Water Color (цвет воды), выражаемый значениями RGBA.

Этап изображения карты смещения можно контролировать с помощью значения Evolution; устанав-
ливая изменение этого значения между двумя клавишами, вы устанавливаете, насколько изображение
карты смещения изменяется во время анимации.
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Fireball

Создает новый столбец/слой, содержащий огненный шар, вырывающийся из точки.

Диапазон цветов может быть определен установкой значений RGBA для цветов Color 1 и Color 2.
Стадия изображения карты смещения может контролироваться с помощью значения Evolution; уста-
навливая вариацию этого значения между двумя ключами, вы устанавливаете, как во время анимации
изображение карты смещения меняется.
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Glitter

Добавляет крестообразные световые лучи, выходящие из самой яркой части изображения.

Используйте Threshold (порог), чтобы указать вырез в самой яркой части входного изображения. Бо-
лее высокие значения заставят эффект добавлять свет также к более темным частям изображения,
производя больше света. Brightness указывает яркость добавленных световых лучей; Radius указывает,
сколько световые лучи будут выходить из ярких входных пикселей; Angle указывает угол пересечения
света. Значение 0 означает, что создаваемые световые кресты будут выровнены по оси. Halo - это коли-
чество световой дисперсии, перпендикулярной направлению световых лучей. Более высокие значения
будут производить более широкие лучи.
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Star Sky

Создает новый столбец/слой, содержащий простое звездное небо с регулируемой яркостью Brightness
с наложенными облаками. Можно установить цвет наложенных облаков Cloud Color задав значения
RGBA.

Стадию движения звезд можно контролировать с помощью значения Evolution; задав изменение этого
значения между двумя ключевыми кадрами, вы устанавливаете, насколько изображение карты сме-
щения изменяется во время анимации.

Используйте параметр Brightness, чтобы регулировать яркость звезд.
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Sun Flare

Создает новый столбец/слой, содержащий лучи цветного света, выходящие из радиального градиента
в центре. Устанавливает цвет солнечных лучей, определяемых значениями RGBA параметра Color. Ко-
личество лучей определяется параметром Rays, а их яркость задается параметром Intensity. Параметр
Angle отвечает за направление лучей, а параметр Bias определяет размер лучей. Параметр Sharpness
позволяет сделать лучи более резкими или плавными.
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Wavy

Создает новый столбец/слой, содержащий простой градиент с цветным «волнистым» узором. Цвет волн
определяется путем установки значений RGBA для параметров Color 1 и Color 2. Стадия изображе-
ния карты смещения может контролироваться с помощью используя значение Evolution; устанавливая
вариацию этого значения между двумя ключами, вы устанавливаете, насколько изображение карты
смещения изменяется во время анимации.
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GPU Radial Blur

Размытие по радиальным линиям, начало которых находится в центре, определяемом горизонтальны-
ми (X) и вертикальными (Y) координатами, начиная с незатронутой внутренней области, определенной
безопасным радиусом Safe Radius. Параметр Blur Factor устанавливает степень размытия.
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GPU Spin Blur

Размывает по концентрическим круговым линиям, как если бы исходный контент вращался вокруг
установленного центра, определяемого горизонтальными (X) и вертикальными (Y) координатами, на-
чиная с незатронутой внутренней области, определенной безопасным радиусом Safe Radius. Параметр
Blur устанавливает степень размытия.
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Глава 20

Using the Particles Effect

The Particles effect creates a new level in the selected column/layer containing particles.

It allows you to simulate a wide range of phenomena, such as rain, snow, sparkles, smoke, and a random
configuration of elements, for example a field of shining stars starting from one shining star or the waving
grass in a meadow starting from one animated blade of grass.

Using a wide variety of parameters available, the Particles effect can be completely customized. A series of
Presets, simulating some basic events, are also available. You can look at these Presets to better understand
how to set the parameters; or you can use them as the starting point to create your own effects.

Particles are defined by parameters organized in different folders: Source, Birth Params, Environment,
Animation and Colors.

Примечание: Particles effect may have unexpected results when the Stretch option in Output Settings
is used to set a higher FPS value, as this effect requires the original timing information (see Choosing the
Output Settings ).

20.1 Defining Particle Images

Any column/layer content can be used as a particle: its animated content and its animation will be reflected
by the particle animation, using the transformations and the drawings exposed in the column/layer cells at
the related frame in each point of the particle life.

For example if a level is exposed in the column/layer at step two, the particle Texture will be animated at
step two as well; or if you have a drawing that’s spinning because the column/layer is animated, the particle
will be spinning as well.

To use a column/layer content as a particle, the column/layer node has to be linked to the Texture port of
the particles effect node. As soon as a column/layer is linked to the texture input port, a new texture port
is available: in this way it is possible to use the content of several columns/layers as particles.
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Примечание: Image formats containing DPI information are loaded using that image DPI; in this case
the particles level will be camera resolution independent.

20.2 Defining Control Images

A column/layer contents can also be used to control some parameters of the particles effect: its animated
content and its animation will affect the particles parameter according to specific image properties, such as
brightness or transparency.

For example if the level exposed in the column/layer is animated, and the column/layer is used to control
the particles Source, the particles Source will follow the animation of the level; or if the column/layer is
moving and it’s used to control the Gravity field, the Gravity field will move as well.

To use a column/layer contents as a Control Image, connect the column/layer node to a Control input port
of the Particles effect node. As soon as the column/layer is linked to the Control input port, a new Control
port is available: in this way it’s possible to use the contents of several columns/layers to control the Particles
effect.

To apply the control image to a parameter, use the related field available in the FX Settings pane: to specify
a Control Image, type the number related to the control image port; to use no control image, type the
number 0.

Примечание: When the control images brightness is used to affect a particles parameter, transparent
areas are considered as being completely black.

20.3 Source
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The particles Source is the area where the particles are generated. It can be defined in the Source page, by
specifying its size and position, or a control image. The way particles are generated, for example their birth
rate, can be controlled as well.

20.3.1 Source

Control Image

Sets if and which control image has to be used for the particles source (see Defining Control Images).

If used, particles are generated only inside the opaque areas of the Control Image.

Рис. 1: Particles generated according to an image-controlled source.

Threshold

This value defines which pixels of the Control Image are to be used for placing the paricles, defining a range
based on the opacity value of its pixels. Lower the value and more opaque the pixels have to be for being
used as particles generators.

Multiple Generators in Control Image

When activated, each defined opaque area of the Control Image will have the same number of generated
particles, totalling the Birth Rate. For example if the Birth Rate is 20, and the Control Image has 4 defined
opaque areas, 5 particles will be generated in each area.
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Use Control Image Gradation

When activated, the intensity of the opacity in the Control Image defines the generation density of the
particles. This option cannot be used at the same time as Multiple Generators in Control Image.

Center

Sets the source Center position, defined by horizontal (X) and vertical (Y) coordinates; it can also be
interactively set in the preview of the FX Settings pane, where the Center point is displayed as a cross.

If you want to animate the Source to create a trail of particles, you can do it either by animating the Center
coordinates, or by animating a column/layer, containing the source area, that has to be used as the Control
Image for the Source (see above).

Примечание: The Center can be also set by using a point gadget in the viewer (see Using FX Gadgets ).

Примечание: The Center is not considered in case a Control Image is used.

Width and Height

Sets the size of the Source area.

Примечание: The Width and Height can be also set by using a box gadget with handles in the viewer
(see Using FX Gadgets ).

Примечание: These values are not considered in case a Control Image is used.

Рис. 2: Particles generated according to a small square source at the center of the camera, and according to
a wide box placed at the top of the camera.
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20.3.2 Particle Generation

Starting Frame

Sets the frame at which the particles generation starts.

When you need a particles event to start before frame 1, you can set a negative Starting Frame value. For
example if you need at frame 1 a snowfall, you cannot make the event start at frame 1, otherwise you will
see only the first generated snowflakes; in this case you can set a negative value, for example -20, so that the
snowfall has already evolved for 20 frames before being displayed at frame 1.

As the Starting Frame is an effect parameter, moving the Particles effect level up or down in the Xsheet (or
left or right in the Timeline) will not change the actual starting frame: the parameter itself has to be edited.

Примечание: If the Starting Frame is higher than the first frame where a Birth Rate is set, the former
value is used as the starting point of the event. For example if the Starting Frame is 20 and first frame with
a positive Birth Rate is frame 15, from frame 15 to 20 no particles will be generated.

Birth Rate

Sets the number of particles to be generated in each frame. When the value is constant, in each frame the
same number of particles will be generated. For example if the Birth Rate at frame 1 is 20, the first frame
will contain 20 particles, the second 40, the third 60, and so on.

The Birth Rate value considers also decimal numbers. For example, if you set the birth rate to 0.2, a particle
each five frames will be generated (0.2 multiplied by 5 is equal to 1 particle).

By animating the Birth Rate, you can control the quantity of particles in the effect. For example if you want
only 20 particles starting from frame 1, you need to set a key at frame 1 with the Birth Rate set to 20, and
another key at frame 2 with the Birth Rate set to 0.

Animation Step

Sets the step of the whole particles animation. This allows you to match the animation of the particle effect
with the animation in the scene, in case the scene uses an animation step different from 1.

Random Seed

Creates a different particles configuration. With the same parameters values and the same Random Seed
the particles configuration is always the same; changing the Random Seed allows you to retain all the set
parameters but to change the particles configuration. Only integer numbers are considered.

20.3.3 Particle

Animation

The particle animation follows the source node content, but you can decide how that content is used,
especially in case the Particles effect is longer than the Texture columns/layers content. The following
options are available:

• Hold Frame randomly assigns a frame from the Texture node content to each generated particle; that
frame is kept throughout the life of the particle.
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• Random Frame randomly assigns a frame from the Texture node content to each generated particle,
changing it randomly at each frame of the particle lifetime.

• Column assigns the first frame from the Texture node content to each particle when it is generated;
the animation cycles following the Texture node content order throughout the life of the particle.

• Column - Random Start randomly assigns a frame from the Texture node content to each particle
when it is generated; the animation cycles following the Texture content order throughout the life of
the particle starting from the assigned frame.

• Column Swing - Random Start randomly assigns a frame from the Texture node content to each
particle when it is generated; the animation moves from the assigned frame to the last or to the first,
then keeps on swinging back and forth along the frames sequence, throughout the life of the particle.

20.4 Birth Parameters

Each particle, when generated at the current frame, has some parameters that are assigned and retained
throughout its life. Those attributes can be set in the Birth Params page.
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20.4.1 Speed

Assigns a speed and a direction for each generated particle.

Speed

Assigns randomly a speed to each particle, according to the minimum and maximum values.

The speed value makes the particle move constantly as frames increase, and is expressed in the chosen unit
of measure per frame. A negative value makes the particle move in the opposite direction of the one set by
the angle.

Control Image

Sets if and which control image has to be used to control the particles speed (see Defining Control Images ).

If used, the speed value range defined above will be distributed according to the brightness value of the
control image pixel where the particle is generated: particles will be faster where the image is brighter.

Linked to Scale

Assigns to each particle a speed value, taken between the minimum and maximum speed, according to the
Size value applied to the particle. This causes the largest particles to be the fastest, emphasizing a depth of
field effect.

Speed Angle

Assigns randomly to each particle an angle value defining the speed direction, according to the minimum
and maximum values.

The value 0 is for an upward direction; higher values turn the direction clockwise.

Рис. 3: A particle animation with different random speed, and with different random speed and direction
angle.
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Use Gradient Angle

When activated, adjusts the initial velocity to the gradient vector of the Control Image Speed Angle.

20.4.2 Size, Mass and Orientation

Size

Assigns randomly a size to each particle, according to the minimum and maximum values. The size is
expressed as a percentage, where 100 is the original size.

Рис. 4: Particles generated with a fixed size and with a random one.

Perspective Distribution

When activated, and if a Control Image for Size is conected, particles size will be inversely proportional to
their density. It can be used for placement of depth particles, as in a sea waves level. When this option is
active, the Use Control Image Gradation option will be ignored.

Control Image

Sets if and which control image has to be used to control particles size (see Defining Control Images ).

If used, the size value range defined above will be distributed according to the brightness value of the control
image pixel where the particle is generated: particles will be larger where the image is brighter.

Use Control Image for the Whole Lifetime

If activated, the defined control image is used to set the particles size for each frame of the particles life,
ignoring any Size Increase value.

If deactivated the control image is used only at the birth of the particles, and any size variation depends
only on the Size Increase value (see Size Increase ).
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Mass

Assigns randomly a mass to each particle, according to the minimum and maximum values. The mass is
taken into account when gravity affects the particles behavior.

Orientation

Assigns randomly an orientation to each particle, according to the minimum and maximum angle values.

The value 0 leaves the image as is; increasing values turn the particle clockwise.

Control Image

Sets if and which control image has to be used to control particles orientation (see Defining Control Images
).

If used, the orientation value range defined above will be distributed according to the brightness value of the
control image pixel where the particle is generated.

Рис. 5: Different random orientation assigned to same-size and to different-sized particles.

20.4.3 Trail

Trail

Allows you to define a trail according to the particle motion by specifying how many previous frames positions
have to be used to generate the trail. The number of frames the trail lasts is randomly assigned according
to the minimum and maximum values.

Step

Sets how many particles will be visible in the trail. For example, if the trail value is 10 and the step is set to
2, the trail will be 10 frames long, but only five particles, one every two frames, will be visible.
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20.4.4 Lifetime

Lifetime

Assigns randomly a lifetime to each particle, according to the minimum and maximum values. The lifetime
is the number of frames the particle will last before disappearing.

For example if a particle is generated at frame 15 with an assigned lifetime value of 20, it will last till frame
35, disappearing at frame 36.

Control Image

Sets if and which control image has to be used to control particles lifetime (see Defining Control Images ).

If used, the lifetime value range defined above will be distributed according to the brightness value of the
control image pixel where the particle is generated: particles will live longer where the image is brighter.

Use Column Duration for Lifetime

Limits the particles lifetime to the number of frames the column/layer content used as particles source lasts.

The particle animation remains the one defined in the Animation parameters (see Animation ).

20.4.5 Top Layer

Top Layer

Defines the layering order of the generated particles. Options are the following:

• Younger places the latest generated particles on top of all the others.

• Older places the latest generated particles behind the previously generated ones.

• Smaller places smaller particles on top of the bigger ones.

• Bigger places bigger particles on top of the smaller ones.

• Random places each particle randomly in-between the previously generated particles.
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20.5 Environment

Particles behavior defined by their birth parameters can be affected by external events, such as gravity and
wind, that can be defined in the Environment page.

20.5.1 Gravity

Simulates a single direction force that accelerates the particles, as gravity does.

Gravity

Sets the acceleration of gravity acting upon the particles: the motion generated by the intensity of the gravity
increases as frames increase.

A negative value makes the particle accelerate in the opposite direction of the one set by the angle.

Gravity Angle

Defines the gravity direction. The value 0 is for a downward direction; higher values turn the direction
clockwise.

Control Image

Sets if and which control image has to be used to define a gravity field affecting the particles motion (see
Defining Control Images ).
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Рис. 6: A particle animation without and with gravity.

If used, the particles will be attracted by the brighter areas of the image, ignoring the set Gravity Angle
value: the brightest areas of the image will have the Gravity value you set. For best results, the dark and
light areas should be smoothly blended.

Рис. 7: A single particle movement without and with an image-controlled gravity.

20.5.2 Friction

Friction

Simulates a force which has a direction opposite to the motion of the particles, in order to slow them down,
or to stop them.

A negative value makes the particles accelerate in the direction of their own motion.

Control Image

Sets if and which control image has to be used to define a friction field affecting the particles speed (see
Defining Control Images ).
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If used, the particles motion will be affected by the brighter areas of the image: the brightest areas of the
image will have the Friction value you set. For best results, the dark and light areas should be smoothly
blended. If you want the particles to stop suddenly, use a high intensity value.

Рис. 8: A particle animation with an image-controlled friction.

20.5.3 Wind

Simulates a speed that is added to the particles speed. The speed is constant, this means that there is no
acceleration in the motion of the particles.

Wind Intensity

Sets the wind speed. A negative value makes the particle move in the opposite direction of the one set by
the angle.

Wind Angle

Sets the angle value defining the wind speed direction.The value 0 is for an upward direction; higher values
turn the direction clockwise.

For example if a particle is standing still, and at frame 10 a wind starts with an intensity of 50 and an angle
of 90, the particle will move constantly rightward at each frame.
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20.5.4 Scattering

Sets a random horizontal and vertical displacement that is added to the movement of the particles.

Horizontal

Sets the minimum and maximum displacement that can be generated and randomly added to the horizontal
component of the particle movement. Positive values shifts the particle to the right; negative ones to the left.

Vertical

Sets the minimum and maximum displacement that can be generated and randomly added to the vertical
component of the particle movement. Positive values shifts the particle to the top; negative ones to the
bottom.

H Control Image

Sets if and which control image has to be used to control the horizontal scattering value (see Defining Control
Images ).

If used, the horizontal scattering value range defined above will be distributed according to the brightness
value of the control image: the horizontal scattering will be higher where the image is brighter.

V Control Image

Sets if and which control image has to be used to control the vertical scattering value (see Defining Control
Images ).

If used, the vertical scattering value range defined above will be distributed according to the brightness value
of the control image: the vertical scattering will be higher where the image is brighter.

Swing Mode

Sets the way the scattering values are used; options are the following:

• Random adds the horizontal and vertical scattering values to the particle movement at each frame.

• Smooth reaches the horizontal and vertical scattering values by interpolating values, in order to create
a smooth movement. The interpolation lasts as many frames as set by the swing value set below; when
the scattering values are reached, new values for each parameter are generated.

Swing

Sets the minimum and maximum number of frames throughout which the horizontal and vertical scattering
values will vary, while remaining either positive or negative. This allows you to set a swinging movement
where each swing lasts a random number of frames, still having a random scattering at each frame.

For example with a horizontal scattering between 1 and 8, and a Swing value with the minimum and
maximum set to 10, the particle will be shifted with a random value of between 1 and 8 to the right for 10
frames; then at frame 11 the scattering changes, so that the random value between 1 and 8 will shift the
particle to the left for the following 10 frames.
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20.6 Animation

Particles birth properties can be transformed during their lifetime, for example particles can rotate, or change
size, by using additional settings available in the Animation page.

20.6.1 Rotation

Controls the way each particle rotates around its center throughout its life.

Rotation Speed

Makes the particles rotate constantly as frames increase, and is expressed in degree per frame. Positive values
makes the particle spin clockwise.

Unlike the directional Speed parameter, this parameter is not a birth attribute. This means that if in a
20 frames animation you animate the Rotation Speed value from -30 to 30, during the animation all the
particles will rotate together, counterclockwise for the first 10 frames, then clockwise for the next 10 frames.

Extra Speed

Sets the minimum and maximum value that is randomly added to the rotational speed, thus creating a more
chaotic rotation.

Swing Mode

Sets the way the spinning is performed; options are the following:
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Рис. 9: A particle animation with a fixed rotation speed, and with extra speed including smooth swing.

• Random, adds the extra speed values to the rotation of the particles at each frame.

• Smooth, reaches the rotational extra speed value by interpolating values, in order to create a smooth
movement. The interpolation lasts as many frames as set by the swing value; when the extra speed
value is reached, new values for each parameter are generated.

Rotation Swing

Sets the minimum and maximum number of frames throughout which the extra speed values will vary, while
remaining either positive or negative. This allows you to set a swinging movement where each swing lasts a
random number of frames, having a random extra speed at each frame.

Follow Particles Movement

Rotates the particles according to their movement direction. The particle preserves its original orientation
when the movement is horizontal to the right.

Рис. 10: A particle animation without and with the Follow Particles Movement option.
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20.6.2 Opacity

Sets a fade-in process at the beginning of particles life, and a fade-out process at the end, according to the
set minimum and maximum opacity values.

Opacity

Sets the minimum and maximum opacity values for the fade-in and fade-out processes. Values are expressed
as a percentage, where 100 is the original opacity.

The fade-in process begins from the minimum value and reaches the maximum value at the end; the fade-out
process begins from the maximum value and reaches the minimum value at the end.

Fade-in Frames

Sets the number of frames the fade-in process lasts, starting from the first frame of the particle life.

Fade-out Frames

Sets the number of frames the fade-out process lasts, starting from the last frame of the particle life and
counting backward.

Trail

Sets the opacity of the images used for the trail: the minimum value is the opacity of the oldest particle in
the trail; the maximum value is the opacity of the youngest one (see Trail ).

20.6.3 Size Increase

Size Intensity

Sets the minimum and maximum scaling factor to be applied to the particle in each frame. Positive values are
for increasing the size of the particles, negative ones for decreasing it. Values are expressed as a percentage.

Control Image

Sets if and which control image has to be used to control particles size increase (see Defining Control Images
).

If used, the size increase value range defined above will be distributed according to the brightness value of
the control image: particles will increase in size faster where the image is brighter.
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20.7 Colors

Particles can fade to specific colors at their birth, during their life and just before their death, by specifying
settings in the Color page. The color parameters are birth attributes, i.e. they are assigned to the particles
when they are generated.

20.7.1 Birth Color

Birth Color

Sets the range of colors to which particles fade at their birth, by defining a color spectrum (see Defining
Colors and Color Spectrums ).

Control Image

Sets if and which control image has to be used to define the particles birth colors (see Defining Control
Images ).
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If used, particles will pick their birth color from the control image pixels according to their birth position.

Рис. 11: A control image used to assign color to the generated particles.

Birth Spread

Sets a spread value that will be added to the red, green and blue values of the color to which particles fade
at their birth.

In this way particles will fade to a range of colors spreading from the colors defined in the spectrum or in
the control image.

Birth Intensity

Sets the intensity of the birth color-fading.

Pick Control Image’s Color for Every Frame

When activated, at every frame the Control Image pixels will be sampled in the current position of the
particles, changing their color.

20.7.2 Fade-in Color

Fade-in Color

Sets the range of colors to which particles fade at a certain number of frames after their birth, by defining a
color spectrum (see Defining Colors and Color Spectrums ).

Control Image

Sets if and which control image has to be used to define the particles fade-in colors (see Defining Control
Images ).

If used, particles will pick their fade-in color from the control image pixels according to their position.
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Fade-in Spread

Sets a spread value that will be added to the red, green and blue values of the color to which particles fade
in.

In this way particles will fade to a range of colors spreading from the colors defined in the spectrum or in
the control image.

Frame Range

Sets the number of frames the fade-in process lasts, starting from the first frame of the particle life.

Fade-in Intensity

Sets the intensity of the fade-in process.

20.7.3 Fade-out Color

Fade-out Color

Sets the range of colors to which particles fade starting from a certain number of frames before their death,
by defining a color spectrum (see Defining Colors and Color Spectrums ).

Control Image

Sets if and which control image has to be used to define the particles fade-out colors (see Defining Control
Images ).

If used, particles will pick their fade-out color from the control image pixels according to their position.

Fade-out Spread

Sets a spread value that will be added to the red, green and blue values of the color to which particles fade
out.

In this way particles will fade to a range of colors spreading from the colors defined in the spectrum or in
the control image.

Frame Range

Sets the number of frames the fade-out process lasts, starting from the last frame of the particle life and
counting backward.

Fade-out Intensity

Sets the intensity of the fade-out process.
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Глава 21

Previewing and Rendering

In order to generate the final animation, including all the transformations and effects applied to the scene
elements, the scene has to be rendered.

It is also possible to preview the animation for performing checks and tune-ups before the full rendering
process.

21.1 Previewing the Animation

Animations can be previewed directly in the OpenToonz Viewer, including in the Preview mode all the
Flipbook features, or by rendering a preview and visualizing it in a separate Flipbook window.

In both cases the Flipbook window tools can be used, and its appearance can be customized (see Using the
Flipbook ).

Примечание: If the computer performance worsens during the preview process of raster animation levels,
try activating the Minimize Raster Memory Fragmentation option in the Preferences. . . → General
dialog section (see Optimizing the Memory Usage ).

21.1.1 Previewing Frames in the Viewer

In the Viewer it is possible to activate the Preview mode to render the current frame according to the current
camera (see Using the Stage Schematic for s).

When changing the current frame, for example by using the playback buttons, it is possible to render other
frames of the scene as well. The framebar displays already rendered frames in dark grey, frames that have
yet to be rendered in light red, and the current frame, while being rendered in light green and when already
rendered in light grey.
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For the current camera it is also possible to define a Sub-camera, having an area smaller than the camera
frame, inside which the preview will be rendered, and outside which the scene elements will be displayed as
they are.

Примечание: To optimize the preview time, only the area visible in the Viewer will be rendered: if you
zoom out the viewer the preview will resume to render the new visualized area.

When the Preview mode is activated, every change made in the scene will cause the preview of frames
affected by the changes to be recomputed. If, for some reason, the preview fails during the update process,
you can regenerate the preview, which will automatically delete previously previewed frames, and compute
them again.

Once the frames are previewed, the results can be saved to disk.

The background colors of the preview window, including the colors of the camera background, the window
background and the checkerboard visible when transparent images are rendered, are those defined for the
Flipbook (see Using the Flipbook ).

Примечание: When previewing frames in the Viewer it is possible to display blank frames after each
preview playback, when looping (see Using the Flipbook ), and to limit the range of frames to be considered
when playing back the animation by using the Playback Markers (see Using the Playback Markers ).

Примечание: The Camera Box, the Field Guide, the Safe Area and the Guides can be shown or hidden
in the Viewer during Preview as well (see Customizing the Viewer ).

Примечание: If the Apply Shrink to Main Viewer option is activated in the Preview Settings dialog,
the previewed frames may have a reduced resolution (see Using the Preview Window ).

Совет: To activate and deactivate the preview:

Click the Preview button ( ) in the viewer title bar to activate or deactivate the Preview mode.

Совет: To define a preview Sub-camera for the current camera:

1. Activate the Define Sub-camera button ( ) in the viewer bottom bar.

2. Click and drag in the Viewer to define the box for the Sub-camera area; once the box is defined you
can resize it by clicking and dragging its sides and corners, and move it by clicking and dragging inside
of it.

Совет: To hide the Sub-camera box:

Deactivate the Define Sub-camera button ( ) in the Viewer bottom bar.

Совет: To activate and deactivate the Sub-camera preview:
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Click the Sub-camera Preview button ( ) in the Viewer title bar to activate or deactivate the Sub-camera
Preview mode.

Совет: To regenerate the preview:

Right-click in the viewer in Preview mode and choose from the menu that opens one of the following:

• Regenerate Frame Preview to delete and recompute the current frame only.

• Regenerate Preview to delete and recompute the whole previewed frame range.

Совет: To save previewed frames:

1. Do one of the following:

• Click the Save Images button ( ) in the Viewer bottom bar.

• Right-click in the Viewer, and choose Save Previewed Frames from the menu that opens.

2. Use the Browser to choose a name and location for the file to be saved.

Примечание: The saved files format will be the one currently defined in the Output Settings dialog,
and the format options used at save time will also be the ones defined by using the Options button there
(see Choosing the Output Settings ).

Примечание: The saved files color depth will always be 8 bit, regardless of the options chosen in the
Output Settings or Preview Settings dialogs.

21.1.2 Using the Preview Window

The animation can be previewed in a separate window according to specific Preview Settings, that can be
different from the Output Settings. In this way the preview can be configured so that it is faster to compute
then the final output, for example because it uses a camera with a smaller resolution.

It is possible to define the range of previewed frames both in the Preview Settings and by using the Playback
Markers in the Xsheet/Timeline: any change made in one mode is reflected in the other one as well (see
Using the Playback Markers ). It is also possible to display blank frames after each preview playback, when
looping.

It is possible to activate the Preferences. . . → Preview → Fit to Flipbook option to ensure that the
previewed images fit the size of the preview window, regardless their resolution.

It is possible to clone the Preview window, or to automatically open as many Preview windows as needed by
activating the Preferences. . . → Preview → Display in a New Flipbook Window option, for example
to examine or compare specific frames by using the Flipbook tools (see Using the Flipbook ).
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Примечание: As when changes are made in the scene all the preview windows automatically update, it
is possible to check the animation before and after some editing by freezing any of the Previews.

The Preview window framebar displays rendered frames in grey, frames that have yet to be rendered in light
red, and the current frame that is being rendered in light green.

Примечание: To optimize the preview time, only the area visible in the Preview window will be rendered:
if you zoom out the Viewer the preview will resume to render the new visualized area.

The Preview Settings dialog lets you define the resolution, range, step and shrink of the preview frames.
Settings are the following:

• Output Camera: sets which camera, among the ones defined in the scene, has to be used to set the
resolution and preview the animation.

• Frame Start: and End: set the frame range of the scene to preview; by default these values refer to
the whole scene length.

• Step: sets the step for the rendered sequence; for example if it is two, one frame each two will be
rendered.

• Shrink: sets the reduction value for the previewed sequence resolution; for example if it is 2, one pixel
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each two will be rendered, thus resulting in previewed frames having half of the original output camera
resolution.

• Apply Shrink to Main Viewer if activated uses the shrink value set in the preview settings to the
preview mode of the viewer as well (see Previewing Frames in the Viewer ).

• Resample Balance: controls the resample that is used when images are scaled or rotated. In scenes
where images are strongly resampled, for instance when their size changes dramatically, the final
rendering may appear slightly out of focus. By balancing the resample you can give some sharpness
back to the rendered frames.

There are several options to choose from. Originally Toonz provided three options: Standard,
Improved, High. The higher the balance chosen, the longer the time needed for rendering the output.
Additionally, OpenToonz provides several other standard resampling filters that could help improve
the final results in a wider range of situations.

• Channel Width: sets the color depth for rendered images; choices are 8 bit or 16 bit per color channel.

• Dedicated CPUs: sets, in case your computer has multiple CPUs, how many processors will be
assigned to the previewing process. Setting the value to All will generate a number of rendering threads
equal to the number of processors, thus speeding up the previewing process. However it is suggested to
use the Half or Single values if the scene to preview is very complex, because the higher the dedicated
CPUs, the more the memory required to perform the preview.

• Render Tile: allows the preview of very complex scenes whose frames will be computed in tiles that
are automatically stitched to create the final preview: the smaller the size of the tile, the longer the
preview process. Setting the value to Medium or Small will allow the preview of very high resolution
outputs of very complex scenes, that otherwise may fail to be previewed; setting the value to None
may prevent some artifacts that the tile stitching may generate. In most of the cases the Large value
will do the work, because it is not slower than the None option, and yet is able to preview complex
scenes.

• Use Sub-camera, when activated, uses the sub-camera defined for the selected camera in the preview
frames (see Previewing Frames in the Viewer ).

Совет: To set the scene preview settings:

1. Choose Render → Preview Settings. . . .

2. Set the options you want to use for the preview.

Совет: To open the preview window:

Choose Render → Preview.

Совет: To clone the preview window:

Right-click in the Flipbook window and choose Clone Preview from the menu that opens.

Совет: To freeze the preview rendering:

Right-click in the Flipbook window and choose Freeze Preview from the menu that opens.
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Совет: To open a new Flipbook window every time you run a preview:

1. In File → Preferences. . . → Preview.

2. Activate the Display in a New Flipbook Window option.

Совет: To rewind the preview content automatically after playback:

1. In File → Preferences. . . → Preview.

2. Activate the Rewind After Playback option.

Совет: To display blank frames after each preview playback when looping:

1. In File → Preferences. . . → Preview.

2. Do any of the following:

• Use Blank Frames option to set how many blank frames you want to be displayed after each preview
playback, when looping.

• Use Blank Frames Color option to set the color for the blank frames.

Previewing and Caching Effect Nodes in the Schematic

The Preview window can also be opened from the FX Schematic, to check the compositing result up to a
specific node. The behaviour of the FX Schematic Preview window is the same as the standard one (see
Using the Preview Window ).

Примечание: In case the Sub-camera is used, the Preview window will fit the Sub-camera area (see Using
the Preview Window ).

It is also possible to cache the preview up to a specific node, so that the result of the compositing up to that
node is stored in the computer memory and will be reused with no need to recompute it the next time the
preview is run.

Of course if something changes in the flow up to the cached node (for example if an object transformation
or an effect parameter is changed), the cached preview will be discarded and will be stored again the next
time the Preview is run.

Совет: To open a Preview window referring to an FX Schematic node:

Right-click the node and choose Preview from the menu that opens.

Совет: To cache an effect node:

Right-click the node and choose Cache FX from the menu that opens: the effect node will be displayed
with a fold at the bottom right corner to highlight that it has been cached.
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Совет: To uncache an effect node:

Right-click the node and choose Cache FX from the menu that opens: the cached preview images will be
discarded.

21.1.3 Using the Flipbook

The Flipbook is an image viewer where animation levels, images, clips and rendered frames can be displayed.
In OpenToonz it is used to display the scene contents in the Viewer, including the Preview mode, and to
display the previewed or rendered animations. It is also used to view files and levels from the browser or the
Xsheet/Timeline, and to display the loaded Color Model.

Примечание: The Safe Area is the only element that can be shown or hidden in the Flipbook when
previewing the animation (see Customizing the Viewer ).

The Flipbook title bar displays the information about the content on the left, and the zoom percentage on
the right.

At the bottom a customizable set of buttons is available:

• The Option button ( ) sets which buttons and elements have to be displayed in the bottom bar.

• The Save Images button ( ) opens a browser to save the flipbook content.

• The Snapshot ( ) and Compare to Snapshot ( ) buttons allow the comparison between
different frames of the flipbook content.

• The Define Sub-camera button ( ) allows the definition of a region, smaller than the size of the
loaded image sequence, that will limit the portion of the images that will be displayed in the Flipbook.
It may prove useful to speed up the loading time and increase the playback speed, when you are only
interested in a certain region of the full camera image.

• The Sub-camera Preview button ( ) lets you activate or deactivate the defined sub-camera region
(see above).

• The Background color buttons sets a White ( ), Black ( ) or Checkered ( ) background
for transparent images.

• The framerate slider sets the number of frames per second to be displayed during playback.

• The playback buttons can be used to play the Flipbook content back and set the current frame.

• The Channel buttons display the Red, Green, Blue and Alpha channels of the Flipbook content, both
in colors and grey-scale.

• The Histogram button ( ) opens a window displaying histograms mapping the amount of the
darkest and lightest pixels in each channel.

Примечание: If the bottom bar is too short to display all the options, it can be scrolled by using arrow
buttons available at its ends.
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In an opened Flipbook it is possible to load new contents both replacing the previous animation, or appending
the new contents to it. When several Flipbooks are opened, their playback can be linked, so that moving
the current frame or playing the contents back in one of them, automatically moves the current frames and
plays the contents back in all the other Flipbooks as well.

The colors displayed as background in the flipbook can also be customized so that they can better fit the
color scheme of the production.

Совет: To open a Flipbook:

Choose Windows → Flipbook.

Совет: To load some contents into a Flipbook:

Do one of the following:

• Right-click in the Flipbook and choose Load Images from the menu that opens, then use the Browser
to retrieve the file you want to load.

• Drag and drop the file you want to load from the OpenToonz file browser to the Flipbook.

Совет: To append some content to the Flipbook content:

Right-click in the Flipbook and choose Append Images from the menu that opens, then use the Browser
to retrieve the file you want to append to the current content.

Совет: To navigate the Flipbook content:

Do one of the following:

• Use the zoom shortcut keys (by default + and - keys) to zoom in and zoom out at specific steps (e.g.
50%, 100%, 200%, etc.).

• Use the mouse wheel to zoom in and zoom out.

• Click and drag to define an area you want to zoom to.

• Use the Reset View shortcut (by default the Alt + 0 key), or right-click in the Viewer and choose
Reset View from the menu that opens, to display the Flipbook content at its actual size, and centered
on the image center.

• Middle-click and drag to scroll in any direction.

Совет: To fit the size of the Flipbook window to its content:

Double-click the Flipbook title bar.

Совет: Windows only - to enter/exit the Flipbook full screen mode:

Right-click the Flipbook and choose Full Screen Mode / Exit Full Screen Mode from the menu that
opens.
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Совет: To customize the Flipbook bottom bar:

Use the Option button ( ) to choose which buttons and elements have to be displayed: only selected items
will be displayed.

Совет: To play the Flipbook content back:

Do one of the following:

• Use the Play button.

• Drag the frame bar cursor.

Совет: To rewind the Flipbook content automatically after playback:

1. In File → Preferences. . . → Preview.

2. Activate the Rewind after Playback option.

Совет: To set the current frame:

Do one of the following:

• Use the playback buttons.

• Drag the frame bar cursor.

• Type in the frame bar field the number of the frame you want to view.

Совет: To link the playback of all the open Flipbook windows:

Choose Play → Link Flipbooks to activate or deactivate the linked playback mode.

Совет: To set the playback frame rate:

Use the frame rate slider; by default the framerate is the one set in the Scene Settings dialog (see Setting
the Frame Rate ).

Совет: To save the Flipbook content:

1. Do one of the following:

• Right-click in the Flipbook and choose Save Images from the menu that opens.

• Click the Save Images button ( ) in the Flipbook bottom bar.

2. Use the Browser to choose a name, a format and a location for the file to be saved.

Совет: To take a snapshot of a frame and compare it to another frame:
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1. Select the frame you want to store and click the Snapshot button ( ) in the Flipbook bottom bar.

2. Move to a different frame, or load some different content, and click the Compare to Snapshot button

( ).

3. Click and drag the vertical or horizontal marker to display the taken snapshot under the current frame.

4. Click again the Compare to Snapshot button ( ) to exit the compare mode.

Совет: To Define the Loading Box:

1. Load in the Flipbook the sequence of images you want to visualize.

2. Activate the Define Loading Box button ( ) in the Flipbook bottom bar.

3. Click and drag in the image to Define the Loading Box; once the box is defined you can resize it by
clicking and dragging its sides and corners, and move it by clicking and dragging inside it.

Совет: To activate and deactivate the Loading Box:

Click the Use Loading Box button ( ) in the Flipbook bottombar to activate or deactivate the loading
box.

Совет: To set the Flipbook background color for transparent images:

Click the White Background ( ), Black Background ( ) or Checkered Background ( ) buttons
in the Flipbook bottom bar to activate/deactivate the desired background color.

Примечание: In the Preview window and when the Viewer is in Preview mode the background color will
be visible behind the Camera BG Color (see below ).

Совет: To set the image channels to be displayed:

Do one of the following:

• Click the top section of the Red, Green and Blue buttons in the Flipbook bottom bar to display, or
hide, the related image channel in colors.

• Click the bottom section of the Red, Green and Blue buttons in the Flipbook bottom bar to display,
or hide, the related image channel in grey-scale.

• Click the Alpha Channel button in the Flipbook bottom bar to display, or hide, the image alpha
channel.

Примечание: When no channel button is activated the full image is displayed.

Совет: To display the Histograms of the Flipbook content:
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1. Do one of the following:

• Click the Histogram button ( ) in the Flipbook bottom bar.

• Right-click the Flipbook content and choose Show Histogram from the menu that opens.

2. Choose the channel for which you want to see the histogram.

Совет: To define the previewed images background color:

1. Choose Xsheet → Scene Settings. . .

2. Set the Camera BG Color by doing one of the following:

• Set the Red, Green and Blue values.

• Click the color thumbnail and use the Style Editor to edit it (see Plain Colors ).

Примечание: This color is relevant only in the Preview window and when the Viewer is in Preview mode.

Совет: To define the Flipbook checkerboard colors:

1. Choose Xsheet → Scene Settings. . .

2. Set the Checkerboard Color 1 and Color 2 by doing one of the following:

• Set the Red, Green and Blue values.

• Click the color thumbnail and use the Style Editor to edit it (see Plain Colors ).

21.1.4 Using the Playback Markers

Two markers, Playback Start Marker and Playback End Marker, are available in the frame column of
the Xsheet (and the frame row of the Timeline) to define the playback range.

The user can manually set the playback markers to define the starting and ending frames to be considered
when playing back the animation, or leave them unset, so OpenToonz automatically defines a playback range
that includes all of the Xsheet/Timeline contents.

Примечание: When the playback markers are activated, the frame range in the Preview Settings. . .
dialog changes accordingly (see Using the Preview Window ).

Совет: To set a playback range:

1. Set the starting frame by doing one of the following:

• Drag the Playback Start Marker to the desired frame.

• Right-click on the desired frame in the frame column/bar and select Set Start Marker from the menu
that shows.

2. Set the ending frame by doing one of the following:
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• Drag the Playback End Marker to the desired frame.

• Right-click on the desired frame in the frame column and select Set Stop Marker from the menu
that shows.

Совет: To set the playback range to match the duration of a block of contiguous exposed cells:

1. In the Xsheet/Timeline, select an exposed cell from the desired column/layer.

2. Right-click on the desired frame in the frame column and select Set Auto Markers from the menu
that shows.

Примечание: There must be an exposed cell in that column/layer at that frame for the Set Auto
Markers option to be available.

Примечание: No matter to what block of contiguous exposed cells the selected cell belongs to, this function
will take into account the frame in which the user performed the right click operation to set the markers.

Совет: To set a single-frame playback range:

Right-click on the desired frame in the frame column/bar and select Preview This from the menu that
shows.

Совет: To unset the playback markers:

Right click on the frame column and select Remove Markers from the menu that shows.

Примечание: When deactivated, playback markers turn grey.

21.2 Rendering the Animation

Final animations can be rendered directly by loading the related scene, or in batch mode. In both cases the
rendering properties are defined in the Output Settings dialog.

Примечание: Information about the scene name and frame number can be included when needed in
rendered frames by activating the Show Info in Rendered Frames option in the Preferences. . . →
General dialog section.

21.2.1 Choosing the Output Settings

The Output Settings dialog lets you define the file format, location and properties for the final rendering.
Settings are the following:
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Camera Settings

• Output Camera: sets which camera, among the ones defined in the scene, has to be used to render
the animation.

• Frame Size sets the frame size of the current camera, also available in the Xsheet → Camera
Settings. . . dialog (see Defining Camera Settings ).

• Frame Start: and End: set the frame range of the scene to render; by default these values refer to
the whole scene length.

• Step: sets the step for the rendered sequence; for example if it is 2, one frame each two will be rendered.

• Shrink: sets a reduction value for the defined render resolution; for example if it is 2, one pixel each
two will be rendered, thus resulting in frames having half of the original output camera resolution.

File Settings

• Save in: is for setting the location where the output is saved; the location can be set by typing or by
using the Browser button.

Примечание: If in the Browser you choose any default folder of the active project, in the path field
the full path will be replaced by the related default folder alias (see Project Default Folders ).

• Name: is the name you want to assign to the output file; by default it’s the name of the scene.

In case the chosen file format produces image sequences, the base name will be assigned to all rendered
frames, that will be identified by a progressive four-digits number written between the base name and
the file extension, e.g. animation.0001.tif , animation.0002.tif , etc. These file sequences will be
displayed in the OpenToonz File Browser with a double dot before the file extension, e.g. animation.
.tif , and treated as a single animation level when loaded back into OpenToonz.

• File Format is the format for the output; natively supported formats are the following: 3GP, AVI,
BMP, GIF, JPG, MOV, NOL, PNG, RGB, SGI, Spritesheet, TGA, TIF and TIFF.

Примечание: OpenToonz supports the 3GP and MOV formats by using the 32-bit version of
QuickTime.

To save in other popular video formats, like MP4 and WebM, OpenToonz uses FFmpeg (a free software
project that produces libraries and programs for handling multimedia data). Once FFmpeg is installed
in the system, and configured to work with OpenToonz, MP4 and WebM will be listed along the other
standard output file formats. For detailed instructions on how to install and configure FFmpeg, please
see Using FFmpeg with OpenToonz .

Примечание: Apart from 3GP, AVI, GIF, MOV, MP4 and WebM, all other formats will output
image sequences.

• Options button, opens a dialog to set specific properties related to the chosen file format, such as
codecs for video files, color depth for TIF images, etc.

• Resample Balance: controls the resample that is used when images are scaled or rotated. In scenes
where images are strongly resampled, for instance when their size changes dramatically, the final
rendering may appear slightly out of focus. By chosing a different resampling algorithm you can give
some sharpness back to the rendered frames.
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There are several options to choose from. Originally Toonz provided only three options: Standard,
Improved, and High. The higher the balance chosen, the longer the time needed for rendering the
output. Currently OpenToonz also provides several other standard resampling options that could help
improve the final results in a wider range of situations. These include: Triange filter, Mitchell-
Netravali filter, Cubic convolution, Hann window, Hamming window, Lanczos window,
Gaussian convolution, Closest Pixel and Bilinear.

• Channel Width: sets the color depth for rendered images; choices are 8 bit and 16 bit per color
channel. If using the 16 bit channel width, be sure to select an output file format supporting it, for
example the TIF format with the 64(RGBA) option activated.

• Dedicated CPUs: sets, in case your computer has multiple CPUs, how many processor threads will
be assigned to the rendering process. Setting the value to All will generate a number of rendering
threads equal to the number of processors, thus speeding up the rendering process. However in systems
with limited RAM resources, it’s suggested to use the Half or Single options if the scene to render is
very complex, because the higher the dedicated CPUs, the more RAM will be required to perform the
rendering, leading to potentially longer rendering times or system instability.

• Render Tile: allows the rendering of complex scenes, by dividing each frame in a certain number of
tiles, which are individually rendered and finally stitched together to create the final output frame: the
smaller the size of the tiles, the longer the rendering will take but the less RAM will require. Setting the
value to Medium or Small will allow the rendering of very high resolution outputs of very complex
scenes, that otherwise may fail to be rendered; setting the value to None may prevent some artifacts
that the tile stitching may generate. In most cases the Large value will do the work, because it’s not
slower than the None option, and yet is able to render complex scenes.

Other Settings

• Add Clapperboard allows to add a Clapperboard. A clapperboard is a static image intended to
display information of the scene. It will be added before the rendered frames, in order to record and
convey information to subsequent phases of the pipeline.

Примечание: For this option to be enabled you must first choose any video file format from the
File Format dropdown menu (i.e. 3GP, AVI, MOV, MP4 or WebM).

• Edit Clapperboard. . . button, opens a dialog for designing the clapperboard and setting its
properties. For detailed information on using the Clapperboard feature, please see the Using The
Clapperboard section.

• Gamma: performs a gamma correction on rendered images before writing them to a file; the value
you specify can include decimal fractions.

• Dominant Field: allows you to render two images per frame, then keeping only odd lines from one
image, and even lines from the other to compose a final frame. This process is called interlacing.

Interlaced images are useful when experiencing a strobe effect due to a fast camera or object movement,
as all movement interpolation will be effectively doubled (having one odd-lines image and one even-lines
image, instead of just one full progresive frame), thus becoming smoother.

Field rendering is only relevant for scenes that are intended for video output. Options are None (for
rendering progresive frames), Even (PAL) and Odd (NTSC) (for chosing which of the rendered
interlaced fields is to be shown in first place). Usually you should choose it according to the video
standard you are outputting to.

• Frame Rate: is the frame rate of the scene, also available in the Xsheet → Scene Settings. . . dialog
(see Setting the Frame Rate ).
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• Stretch from FPS: To: changes the timing of the Xsheet when outputting files; in this way you can
output a number of frames that is independent from the frame rate set in the scene settings.

For example, if you are working at 25 fps, a 150 frames Xsheet will produce 6 seconds of animation. If
you need to transfer the frame rate to 30 fps using the same Xsheet, the animation will last 5 seconds
(150 frames divided by 30 fps is equal to 5 seconds), and consequently it will be a little bit faster.
Stretching from 25 to 30 fps, the output will include an increased number of frames to retain the
original time length, and the rendered frames will be 180 (6 seconds multiplied by 30 fps is equal to
180 frames).

When going from a higher frame rate to a lower one, some level drawings will not be used because the
number of output frames decreases. When doing the contrary, some level drawings will be repeated
because the number of output frames is higher. Interpolations for object movements and special effects
variations will be re-computed according to the final frame rate, in order to keep all the interpolations
as smooth as possible.

Примечание: When the field rendering is used (by using the Dominant Field option) and the
Stretch feature is set for passing from a lower frame rate to a higher one, drawings and images will
be interlaced as well, to create newly added frames.

Примечание: The Particles effect may have unexpected results when the scene is stretched to a
higher FPS value, as the effect requires the original timing information.

• Multiple Rendering: creates automatically for a single scene several output files based on the Xsheet
columns (or Timeline layers) content, and according to the FX Schematic. Options are None, FX
Schematic Flows and FX Schematic Terminal Nodes (see Creating Multiple Renderings ).

• Do stereoscopy activates the stereoscopic 3D output of the scenes. Each frame will be rendered from
two different camera view creating two sequences of files, one for each view. The suffixes _l (left) and
_r (right) will be used to identify sequences.

• Camera Shift: sets the distance between the two camera views.

Примечание: For working properly at least some elements of the scene must have Z-Depth values
other than 0 in their positioning. OpenToonz uses these values and the Camera Shift parameter for
rendering the stereoscopic effect.

• Render button, starts rendering the scene using the current render settings.

Совет: To set the scene output settings:

1. Choose Render → *Output Settings. . .

2. Set the options you want to use for the final rendering.

Using The Clapperboard

A clapperboard is a static image intended to display information of the scene. It will be added before the
rendered frames, in order to record and convey information to subsequent phases of the pipeline.
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The clapperboard consists of board items. At the bottom-right of the Clapperboard Settings dialog there is
a list of all the clapperboard items, which can be layered by moving them Up or Down in the list by using
the appropriate buttons. Items can also be created or deleted by using the Add or Remove buttons.

Settings for the currently selected item are displayed above the items list, at the top-right of the Clapperboard
Settings dialog. Each item has an information Type:. Most of them will automatically retrieve the
correspondent data from the current scene or the system, such as: scene Duration, Scene location,
Current date, etc. Other types, such as Text or Image allow to input user defined data to be displayed
in the Clapperboard.

The settings can be saved as a Preset in order to be reused later, using the Save as Preset and Load
Preset buttons. They can also be stored in the project’s default settings by using the File → Save Default
Settings command.

Примечание: WARNING: Adding the Clapperboard will make the scene file to lose compatibility with
older versions of OpenToonz. Setting the Duration: back to 0 will remove the clapperboard data from the
scene, so that compatibility can be restored.

Совет: To Add a Clapperboard:

1. Open the Render → Output Settings. . . dialog.

2. Select any movie type file format (3GP, AVI, MOV, MP4 or WebM).

3. In the More Settings section, enable the Add Clapperboard option.

4. Click Edit Clapperboard. . . button. The Clapperboard Settings dialog opens.

5. Set the Duration (frames): option to any value greater than 0.

Примечание: Setting the duration to 0 frames will remove the clapperboard data from the scene when
it’s saved.
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Совет: To temporarily deactivate the Clapperboard:

1. Open the Render → Output Settings. . . → More dialog section.

2. Disable the Add Clapperboard option.

Совет: To Delete the Clapperboard:

1. Open the Render → Output Settings. . . → More dialog section.

2. Click Edit Clapperboard. . . button. The Clapperboard Settings dialog opens.

3. Set the Duration (frames): option value to 0.

4. Save the scene.

Creating Multiple Renderings

With Multiple Rendering: it’s possible to render automatically, from a single scene, several output files
based on the Xsheet columns (or Timeline layers) content and according to the FX Schematic. Options are
None, FX Schematic Flows and FX Schematic Terminal Nodes.

Flows: creates as many outputs as the flows connecting the column nodes to the Xsheet node. Any
effect nodes with multiple input ports met along the flow (such as Matte effects) will be ignored.

Terminal Nodes: creates as many outputs as the number of nodes linked to the Xsheet node; all
the columns and effects linked to each of these nodes will be taken into account for the rendering.

The names of the different output files are automatically generated in order to avoid any name conflict
between file names. In particular they are built by appending to the output file name: the column name,
then the column ID (as can be read in the node tooltip), then the effect name, then the effect ID (as
can be read in the node tooltip) in case the effect node was renamed. For example scene01_B(Col3)_My
Blur(Blur1)..tif is one of the output files of the scene scene01 , related to the flow going from column B
(whose ID is Col3 ) to the effect node My Blur (whose ID is Blur1 ).

Примечание: No output will be displayed after the rendering, regardless of Open Flipbook after
Rendering being activated in Preferences. . . → Preview dialog section.

Примечание: If you need more control on the way scene elements are rendered, you may consider using
Sub-Xsheets and the Over effect (see Using Sub-Xsheets and Over ). For example if you want a single
output for a set of columns/layers, you may collapse them in a Sub-Xsheet (in case of Flows type multiple
rendering) or connect them to several Over nodes (in case of Terminal Nodes type multiple rendering).

21.2.2 Rendering Animations with Alpha Channel Information

It’s possible to render a scene with a transparent background color in order to export it to editing systems
supporting alpha channel information.
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In this case no image has to be used as background, and the output file format has to support alpha channel
information, e.g. TIF at 32 or 64 bits per pixel, TGA at 32 bits per pixel, or MOV with codecs supporting
alpha (i.e. Animation).

Совет: To render animation with alpha channel information:

1. Choose Xsheet → Scene Settings. . . .

2. Set the alpha channel of the Camera BG Color to 0 (i.e. transparent).

3. Choose an output file format supporting alpha channel information.

21.2.3 Rendering A Loaded Scene

The current scene can be rendered directly while being loaded in OpenToonz according to the defined Output
Settings.

By choosing the appropriate range in the Output Settings it’s possible to render the scene in chunks, for
example by rendering a section first, and then another one. In this case the animation available in the Output
location will always include all frames rendered up to that point, both if the format is a multiple-files output
(e.g. TIF or TGA), and a single-file one (e.g. MP4 or MOV). The same applies if a section of the scene has
to be rendered again because some corrections were needed.

If the scene contains some audio files and is rendered in a file format supporting audio (for example MP4),
all the audio files will be merged to form the soundtrack of the movie (see Creating a Soundtrack ).

Примечание: Audio files loaded in Sub-Xsheets will not be included in the output soundtrack (see Using
Sub-Xsheets ).

As soon as the rendering is over, the rendered animation can be automatically displayed in a OpenToonz
Flipbook by activating the Open Flipbook after Rendering option in the Preferences. . . → Preview
dialog section; it’s also possible to display blank frames after each rendering playback when looping. If a
soundtrack is available for the rendered scene, it’s also possible to listen to it.

When displayed in the Flipbook, the rendering can be checked by using the Flipbook tools (see Using the
Flipbook ).

You can also activate the Use Default Viewer for Movie Formats option in the Preferences. . . →
General dialog section, in order to play back the output with its own default viewer, e.g. QuickTime Player
for the MOV format.

Совет: To render the currently loaded scene:

Choose Render → Render.

Совет: To display blank frames after each rendering playback when looping:

1. Choose File → Preferences. . . → Preview.

2. Do any of the following:

• In Blank Frames: set how many blank frames you want to be displayed after each preview playback,
when looping.

• In Blank Frames Color: set the color for the blank frames.
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21.2.4 Rendering Scenes in Batch Mode

The rendering of a scene can be added to a task list and performed in batch mode, in order to run it in the
background while you perform other work on your computer.

Render tasks can be submitted from the OpenToonz Browser and can be managed and executed in the Tasks
pane, together with Cleanup tasks (see Cleaning up Drawings in Batch Mode ).

The Tasks pane is divided into two sections: on the left there is the Task tree where all of the Render
tasks are displayed with a clapboard icon and all the Cleanup tasks with a brush icon; on the right there is
Information about the task selected in the Task tree.

The Task list can be saved as TNZBAT files and loaded back later, in case you want to manage it through
different working sessions.
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Совет: To Save a Task list:

1. Do one of the following:

• Click the Save ( ) or the Save As ( ) buttons in the top bar of the Tasks pane.

• Right-click the Tasks item at the top of the list and choose Save Task List or the Save Task List
As from the menu that opens.

2. Use the Browser that opens to save the list.

Совет: To Load a Task list:

1. Do one of the following:

• Click the Load ( ) button in the top bar of the Tasks pane.

• Right-click the Tasks item at the top of the list and choose Load Task List from the menu that
opens.

2. Use the Browser that opens to retrieve and load a previously saved list.

Совет: To resize the Tasks pane sections:

Do any of the following:

• Click and drag the separator to resize sections.

• Click and drag the separator toward the window border to hide a section.

• Click and drag the separator collapsed to the window border toward the window center to display again
the hidden section.

21.2.5 Managing and Executing Render Tasks

When a Render task is selected in the tree, in the section on the right of the Tasks pane task-related properties
are displayed, some of which can be edited to configure the task. Properties are the following:

• Name displays the task name; it can be edited to better identify the task.

• Status shows if the task is: Waiting, Running, Completed or Failed.

• Command Line displays the command line related to the task execution with arguments and
qualifiers.

• Server displays the computer that is running, or will run, the task.

• Submitted By displays the user that submitted the task.

• Submitted On displays the computer from where the task was submitted.

• Submission Date displays when the task was submitted.

• Start Date displays when the task execution started.

• Completion Date displays when the task execution was completed.

• Duration displays how long the execution lasted.
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• Step Count displays the number of frames rendered.

• Failed Steps displays the number of frames that failed to be rendered.

• Successful Steps displays the number of frames successfully rendered.

• Priority sets the importance or urgency of the task: tasks with a higher priority will be executed first.
It can be edited to change the task priority.

• Output displays the location, name and extension of the rendered output; this information comes
from the scene output settings but can be edited here before the rendering.

• Frames Per Chunk sets how the task is divided into sub-tasks in order to distribute the rendering
job in the render farm, one sub-task for each computer. It can be edited to change the chunk size (see
Using Chunks when Rendering Tasks ).

• From and To set the scene frame range to render; this information comes from the scene output
settings but can be edited here before the rendering (see Choosing the Output Settings ).

• Step sets the step for the rendered sequence; this information comes from the scene output settings
but can be edited here before the rendering (see Choosing the Output Settings ).

• Shrink sets the reduction value of the rendered sequence resolution; this information comes from the
scene output settings but can be edited here before the rendering (see Choosing the Output Settings ).

• Dedicated CPUs sets how many processors are assigned to the rendering process; this information
comes from the scene output settings but can be edited here before the rendering (see Choosing the
Output Settings ).

• Render Tile sets if the rendering has to be computed in tiles; this information comes from the scene
output settings but can be edited here before the rendering (see Choosing the Output Settings ).

• Dependencies lets you set which of the other submitted tasks have to be successfully completed
before starting the current task execution: these tasks can be added from the box on the right where
all submitted tasks are displayed.

Task execution can be started and stopped from the task list.

When the tasks are executed, the icon color tells the status of the task according to the following color code:

• Grey, when the task is waiting or is not executed yet.

• Yellow, when the task is being executed.

• Green, when the task is successfully executed.

• Orange, when the task is executed with some errors.

• Red, when the task execution has failed.

Совет: To Add scenes to render in the task list:

Do one of the following:

• Click the Add Render button ( ) in the top bar of the Tasks pane and use the Browser to select
a scene file.

• Select the scenes in the OpenToonz Browser, then right-click any of them and choose Add As Render
Task from the menu that opens.

Совет: To Configure the render task in the task list:
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1. Select a render task in the task list.

2. Configure it by using the options available on the right of the list.

Совет: To select tasks in the task list:

Do any of the following:

• Click a task to select it.

• Shift-click a task to extend the selection up to that task.

• Ctrl-click (PC) or Cmd-click (Mac) a task to add it to, or remove it from the selection.

Совет: To Execute selected tasks:

Do one of the following:

• Click the Start ( ) button in the top bar of the Tasks pane.

• Right-click any selected task icon and choose Start from the menu that opens.

Совет: To Stop the execution of selected tasks:

Do one of the following:

• Click the Stop ( ) button in the top bar of the Tasks pane.

• Right-click any selected task icon and choose Stop from the menu that opens.

Совет: To Remove selected tasks from the list:

Do one of the following:

• Click the Remove ( ) button in the top bar of the Tasks pane.

• Right-click any selected task in the list and choose Remove from the menu that opens.

Совет: To Add or Remove tasks from the Dependencies list:

Do one of the following:

• To Add a task to the dependencies list, select a task in the task list on the right and click the <<
Add button.

• To Remove a task from the dependencies list, select a task in the dependencies list on the left, and
click the Remove >> button.

Using Chunks when Rendering Tasks

If you are using the OpenToonz render farm, it’s possible to divide a task into chunks so that each computer
of the farm will render a section of the same render task (see Using the Toonz Farm ).
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The default value for the chunk size (expressed in number of frames) can be set using the Render Task
Chunk Size in the Preferences. . . → General dialog section. If the default value is higher than the duration
(in frames) of the submitted scene, the value will be automatically adjusted to be equal to the duration of
the scene.

Once a task is submitted, it’s possible to change the chunk size by editing the related value in the task
properties.

When a task is divided into chunks, each chunk of the task is represented in the task tree as a sub-task.

Render tasks and sub-tasks will be distributed on the farm, one for each computer, so that several tasks can
be executed at the same time (see Using the Toonz Farm ).

If you are not using the OpenToonz render farm, dividing the task into chunks is not only useless, but it
slows down the rendering process as well. For this reason it’s suggested to use a high Render Task Chunk
Size value (e.g. 1000) in the Preferences. . . → General dialog section.

Примечание: Chunk size is relevant only when animations are rendered as image sequences (for example
in TIF or TGA formats).
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Using the Toonz Farm

The Toonz Farm allows you to process OpenToonz scenes submitted as cleanup tasks or render tasks in
the task list by using a series of computers connected on the same network using TCP/IP (see Cleaning up
Drawings in Batch Mode and Rendering Scenes in Batch Mode ).

When tasks are executed, they are automatically assigned to the computers belonging to the farm in order
to balance the workload. When all computers are busy, remaining tasks are not assigned until a machine is
ready to process them.

Примечание: If you have divided a render task into chunks, each chunk will be assigned to a different
computer of the farm, thus speeding up the rendering of a single render task (see Using Chunks when
Rendering Tasks ).

The Toonz Farm is composed by the following:

• Controller node: is the computer that dispatches the tasks to server (rendering) nodes. This computer
runs the controller program, named tfarmcontroller.exe on Windows and tfarmcontrollerd on
Macintosh. One controller node is needed for defining a farm.

Примечание: The controller node can also be used as a server (rendering) node.

• Server (rendering) nodes: are the computers that execute tasks dispatched by the controller. Each
of these computers runs a server program, named tfarmserver.exe on Windows and tfarmserverd on
Macintosh, that is in charge of running tasks, notifying the controller when a task has been completed,
etc.

• Root folder named FARMROOT: is a shared folder where a number of configuration files are
stored. The controller node and all the rendering nodes must be able to access this shared folder
(see Configuring the Toonz Farm ).

• Client program: is the program run by the user to queue new tasks and to monitor the Toonz Farm.
OpenToonz itself is the client program of the Toonz Farm, and can be run on any computer on the
network, not necessarily on a controller node or a sever (rendering) node.
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Примечание: In order to render the scenes successfully all the computers involved in the Toonz Farm,
controller, servers and clients have to share the same projectroot folders (see Setting the Projectroot ).

22.1 Installing the Toonz Farm on Windows

To install the Toonz Farm, you have to install the Farm Controller component on the controller node, and
the Farm Server component on the server (rendering) nodes.

Примечание: If you want to use a computer both as controller and as server (rendering) node, you have
to install both the components.

During the installation of any of the components you must specify the full-path of the FARMROOT folder.
This path must be expressed using the UNC format, like the following:

\\HostName\ShareName\FolderName

The drive where the FARMROOT folder is located has to be shared on the network, giving full control to
any user by setting the right permissions.

When you choose to install the Farm Controller component, the installation program will create for the
controller program a Windows Service, named Toonz Farm Controller.

When you choose to install the Farm Server component, the installation program will create for the server
program a Windows Service, named Toonz Farm Server.

Примечание: As the Toonz Farm requires exchanges of data between computers in the network by using
TCP/IP protocol, any firewall system that may block access on computer ports has to be disabled.

22.1.1 Setting the Controller Node

On the controller node the controller component is installed as a Windows service, named Toonz Farm
Controller. By default a Windows Service runs under the security credentials of the Local System account.
By default this account is not granted the right to access folders shared by remote hosts.

Since the Toonz Farm Controller needs to access the FARMROOT folder, typically shared by a remote
host, please run this service as a user with the proper rights.

Примечание: It is possible to start the service from a DOS shell by navigating to the folder where the
binaries of OpenToonz are installed, and then using the following command line:tfarmcontroller -console

Совет: To run the Toonz Farm Controller as a user with the proper rights:

1. Choose Control Panel → Administrative Tools → Services, and right-click the Toonz Farm
Controller service to open the Properties panel.

2. Select the Log On page, check the This Account: option.

3. Choose the network where the Toonz Farm is going to work and set an account that has administrator
rights on that network. Insert and confirm the related password.
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4. Click the OK button.

22.1.2 Setting the Server Nodes

On the server (rendering) nodes, the server component is installed as a Windows service, named Toonz Farm
Server. By default a Windows Service runs under the security credentials of the Local System account. By
default this account is not granted the right to access folders shared by remote hosts.

Since the Toonz Farm Server, for rendering purposes, needs to access one or more folders shared by remote
hosts, please run this service as an user with the proper rights.

Примечание: It is possible to start the service from a DOS shell by navigating to the folder where the
binaries of OpenToonz are installed, and then using the following command line:tfarmserver -console

Совет: To run the Toonz Farm Controller as an user with the proper rights:

1. Choose Control Panel → Administrative Tools → Services, and right-click the Toonz Farm Server
service to open the Properties panel.

2. Select the Log On page, check the This Account: option.

3. Choose the network where the Toonz Farm is going to work and set an account that has administrator
rights on that network. Insert and confirm the related password.

4. Click the OK button.

22.2 Installing the Toonz Farm on Macintosh

To install the Toonz Farm, you have to install the Farm Controller component on the controller node, and
the Farm Server component on the server (rendering) nodes.

Примечание: If you want to use a computer both as controller and as server (rendering) node, you have
to install both the components.

After the installation of the toonz farm components, a FARMROOT folder has to be defined, and on all the
computers belonging to the farm, both controller and servers, the full-path of the FARMROOT folder has
to be specified.

To define the FARMROOT folder you can take as model the toonzfarm folder stored in OpenToonz stuff.
You can take the toonzfarm folder from any computer where OpenToonz in installed, choose the location
you prefer, and share it on the network, giving full control to any user by setting the right permissions.

To specify the path to the FARMROOT on the computers, both controller and servers, belonging to the
farm, you have to edit the configfarmroot.txt file by typing in it the full path to the FARMROOT folder.

To retrieve this file open the Applications/OpenToonz folder, right-click the OpenToonz icon and choose
Show Package Contents from the menu that opens; in the folder that opens browse to the Contents/
Resources folder and retrieve the configfarmroot.txt file.
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Примечание: As the Toonz farm requires exchanges of data between computers in the network by using
TCP/IP protocol, any firewall system that may block access on computer ports has to be disabled.

22.3 Configuring the Toonz Farm

Once the installation has been completed, you have to configure the Toonz Farm by editing some configuration
files stored in the FARMROOT folder.

The FARMROOT folder must be accessible by all the nodes that compose the Toonz Farm: the controller
node, the server (rendering) nodes and the computers running OpenToonz. This means that the drive where
the FARMROOT folder is located has to be shared on the network, and the permissions for users have to
be maximum, in order to give full control to any users.

For the same reason the computer where the FARMROOT is located has to be started before all the other
computers involved in the farm.

The FARMROOT folder contains the following:

• the config folder containing the servers.txt , the controller.txt and the id.txt .

• the logs folder.

The controller.txt and the servers.txt configuration files must be edited to define the controller node
and the server (rendering) nodes before using the Render Farm.

22.3.1 Defining the Controller Node

The controller node is defined in the controller.txt configuration file placed in the FARMROOT\config
folder.

The file must contain a single text line that describes the node you want to use as a controller.

For the controller node you must specify the following:

• Computer name.

• IP address.

• The port number you intend to use for the controller service.

Примечание: Be sure that the port you set is not blocked by any firewall system, and is open for all the
computers belonging to the Toonz farm.

Each of the above information must be separated by a single space. Here is an example of a controller.txt
file:

render1 10.10.0.130 10000

In the above example, render1 is the controller node, its IP address is 10.10.0.166 and the controller
program runs on the 10000 port.
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22.3.2 Defining the Server Nodes

The server (rendering) nodes are defined in the servers.txt configuration file placed in the
FARMROOT\config directory.

The file must contain a text line for every computer you want to use as a server (rendering) node.

For each sever (rendering) node you must specify the following:

• Computer name.

• IP address.

• The port number you intend to use for the server service.

Примечание: Be sure that the port you set is not blocked by any firewall system, and is open for all the
computers belonging to the Toonz Farm.

The above information must be separated by a single space. Here is an example of a servers.txt file:

render1 10.10.0.166 8002
render2 10.10.0.195 8002
render3 10.10.0.111 8002
render4 10.10.0.180 8002

In the above example, render1 is a server node whose IP address is 10.10.0.166 and the server program
runs on the 8002 port; render2 is a server node whose IP address is 10.10.0.195 and the server program
runs on the 8002 port; etc.

If you want to add or remove a server (rendering) node from the servers.txt file, you have to restart the
controller node in order to make the changes effective.

22.3.3 Defining the Toonz Farm in OpenToonz

OpenToonz is the Toonz Farm client program: it allows you to submit new tasks and monitor the status of
the farm.

If the computer where you run OpenToonz is a controller or a server (rendering) node for the Toonz Farm,
no further settings are required.

If the computer is neither a controller nor a server (rendering) node for the Toonz Farm, the FARMROOT
has to be defined.

Совет: To define the FARMROOT in OpenToonz:

1. Run OpenToonz and go to the Farm room.

2. In the Batch Servers pane, set the Process with: option menu to Render Farm.

3. In the dialog that opens specify the full path to the FARMROOT folder.

4. Click the OK button.

22.3. Configuring the Toonz Farm 537



OpenToonz Documentation, Выпуск 1.7.1

22.4 Using the Toonz Farm

In OpenToonz you can find the Farm room that allows you to monitor the farm processes. This room
contains two main windows: the Tasks window and the Batch Servers window.

The render farm can be monitored by using both the Tasks pane, where the list of tasks can be managed
and executed, and the Servers pane, where the computers executing the tasks can be managed.

Примечание: All shared disks involved in the task processing, i.e. disks where files resulting from the task
execution have to be written, must be shared granting full permissions to any user, otherwise tasks execution
will not succeed. For Windows, disks must have a Share Permission set to Full Control for Everyone; for
Macintosh, the sharing settings must allow any user to read from and write to disks.

22.4.1 Monitoring the Server Nodes

The Batch Servers pane is divided in three areas: at the top there’s an option menu to set whether the tasks
execution has to be performed with the Local computer or with the Render Farm; then there is the list
of server (rendering) nodes in the farm; at the bottom you can see information about the server currently
selected in the list.

The server (rendering) nodes included in the list are those defined in the server.txt configuration file (see
Defining the Server Nodes ). If a server node is down at the controller startup, it will not be available in the
farm: this means that all the server nodes must be up before starting up the controller node. For the same
reason if you want to restart or shut down a server (rendering) node, you have to restart the controller node
in order to make the changes effective.

If the Process with: option menu is set to Local, all the tasks you run will be executed by the local
computer; if it’s set to Render Farm, the tasks will be executed by the Toonz Farm.

Примечание: When you select Render Farm you could be prompted to define the FARMROOT (see
Defining the Toonz Farm in Toonz ).

When a server is selected in the list, the following related information are displayed in the area at the bottom
of the window:

• Name: displays the name of the server (rendering) node.

• IP Address: displays its IP address.

• Port Number: displays the port number used to exchange data with the farm.

• Tasks: displays the task being executed.

• State: displays if the server is Ready, Busy or Down.

Примечание: A server node state may be down if the server port you set is blocked by a
firewall system, and is not open for all the computers belonging to the Toonz Farm (see Defining
the Server Nodes ).

• Number of CPU: displays the number of CPUs available on the server.

• Physical Memory: displays the amount of physical memory available on the server.
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Совет: To use the Local computer to execute tasks:

Set the Process with: option menu to Local.

Совет: To use the Toonz Farm to execute tasks:

Set the Process with: option menu to Render Farm.

22.4.2 Checking the Toonz Farm Processing

When the Toonz Farm is used, any problem that may be experienced during the processing is recorded in
LOG files, that can be opened and used to diagnose problems.

The LOG files are saved in the OpenToonz stuff\toonzfarm folder of the computer experiencing the
problem; each LOG refers to the processing performed by that computer only.

The LOG files that may be generated by the Toonz Farm processing are the following:

• server.log logs all the operations concerning the server computer activity.

• controller.log logs all the operations concerning the controller computer activity.

• tcomposer.log logs all the operations concerning the render activity performed by the server
computers.

• tcleanup.log logs all the operations concerning the cleanup activity performed by the server
computers.
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Использование системы контроля версий

Система контроля версий хранит в центральном хранилище всю историю изменений для каждого
файла в базе данных производства.

The central repository must be located in a shared resource (that can be a computer in your local network
or an internet-based repository), while the local copy of files, called working copy, at a specific time or
revision, should be located on the computer you use.

Когда вам нужно работать над файлом, вы можете get (взять) его из центрального хранилища (реп-
позитория) в вашу рабочую копию, и edit (редактировать) его; по окончании редактирования файла,
решив что вы хотите предоставить изменения, вы можете put (положить) его назад из вашей рабочей
копии в центральное хранилище.

файл который вы put будет сохранен в качестве последнего изменения (ревизии) файла, предыдущие
изменения будут сохранены в истории файла, и все пользователи того же реппозитория смогут get
этот файл. В случае когда предыдущая версия файла потребуется, вы всегда можете извлечь ее из
центрального реппозитория.

OpenToonz поддерживает систему контроля версий Subversion , это одна из самых систем управления
популярной версии, используется во многих масштабных проектов с открытым исходным кодом (куда
более популярна система GIT (прим. перев.)).

Примечание: Установка центрального реппозитория для вашей системы контроля версий подобно
на корневую папку проекта (projectroot) OpenToonz, поэтому управление проектом в рамках системы
контроля версий такое же, только ссылается на центральный реппозиторий а не на projectroot (см.
Managing Projects ).

23.1 Установка системы контроля версий

Система контроля версий работает как клиент/серверн инструмент: сервер хранит все файлы в цен-
тральном хранилище, и клиент используется чтобы get файлы в вашу рабочую копию и put изменения
файлов на сервер.
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23.1.1 Установка сервера контроля версий

Можно настроить компьютер в той же локальной сети, что и сервер управления версиями, установив
Subversion 1.6 или более поздней версии, или можно использовать онлайн-сервис (например Assembla
(или, вероятно, github (прим. переводчика))).

Вы можете перейти к Subversion starting page чтобы загрузить её.

Обратитесь к системному администратору для настройки сервера управления версиями.

23.1.2 Установка клиента контроля версий на Windows,

On Windows the setup of a version control client requires the download and installation of the Subversion
client 1.6 or later.

You can go to the Subversion download page for downloading it. There you should look for the available
binary packages and download a version control client for Windows. We suggest the use of CollabNet
Subversion Command-Line Client.

Примечание: If an older Subversion release is used some version control features might not work.

23.1.3 Installing the Version Control Client on Macintosh

On Macintosh the setup of a version control client depends on the OS version.

If the OS is Snow Leopard (version 10.6) or later, the setup requires no installation as the version control
client is included in the operating system.

If the OS is older than Snow Leopard, the setup requires the download and installation of the Subversion
client 1.6 or later.

You can go to the Subversion download page for downloading it. There you should look for the available
binary packages and download a version control client for Macintosh.

After the installation is very important to check where Subversion is installed, as this information is needed
to configure the version control in OpenToonz: this information is displayed in the last page of the installation
process and by default is usually /opt/subversion/bin .

Примечание: If a Subversion release older than v1.6 is used, some version control features might not
work.

23.1.4 Configuring the Version Control in OpenToonz

Once the version control server is configured and the version control client is installed it’s possible to configure
OpenToonz in order to use the version control.

In OpenToonz the version control information is stored in the versioncontrol.xml file located in the
OpenToonz stuff\config folder. By default the file has the following content:
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<?xml version="1.0" encoding="UTF-8"?>
<Repositories>

<!-- REMOVE ENTIRELY THIS LINE TO ENABLE SVN
<repository>

<name>PutYourRepositoryName</name>
<localPath>putYourWorkingCopyPath</localPath>
<repoPath>putYourRepositoryPath</repoPath>

</repository>
REMOVE ENTIRELY THIS LINE TO ENABLE SVN -->

<svnPath></svnPath>
</Repositories>

By editing the file with a text editor it’s possible to set the information for the central repository and the
working copy location.

Together with the configuration file, version control users must be defined by editing the permissions.xml
file located in the OpenToonz stuff\config folder.

Примечание: The versioncontrol.xml and permissions.xml file have to be well-formed, and so cannot
contain an opening tag without its related closing tag, otherwise OpenToonz will not run. If you decide to
edit the files, make a backup copy first in case you need to revert the file to the original version.

Совет: To configure the version control in OpenToonz:

1. Open the versioncontrol.xml file located in the OpenToonz stuff\config folder with a text editor.

2. Delete the line

<!-- REMOVE ENTIRELY THIS LINE TO ENABLE SVN

and the line

REMOVE ENTIRELY THIS LINE TO ENABLE SVN -->

3. In the line

<name>PutYourRepositoryName</name>

type between the tags the name you want the repository to have in the OpenToonz browser.

4. In the line

<localPath>putYourWorkingCopyPath</localPath>

type between the tags the path to where you want the working copy to be located on the local
computer (e.g. C:\myworkingcopy\ for Windows or /myworkingcopy for Macintosh).

5. In the line

<repoPath>putYourRepositoryPath</repoPath>

type between the tags the URL of the central repository according to how it was defined on
the version control server (e.g. http://10.0.0.1/mySVNrepository/ for a repository located
in the local network; file:///C:/mySVNrepository for a repository located in the local
Windows computer or file:///mySVNrepository for a repository located in the local Macintosh
computer; and https://subversion.assembla.com/svn/mySVNrepository for an internet-
based repository).

For Macintosh only, if the OS is older than Snow Leopard and you installed the Subversion
client 1.6 or later, in the line
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<svnPath></svnPath>

type between the tags the path to the folder where Subversion is installed (this information is
displayed in the last page of the installation process and by default is /opt/subversion/bin ).

6. Save the versioncontrol.xml file.

Совет: To define the version control users:

1. Open the permissions.xml file located in the OpenToonz stuff\config folder with a text editor.

2. In the user section define a user and assign him the version control user name and password as
configured on the server. For example to assign to the user JohnDoe the user johnd whose password is
johndpassword, add the following user:

<user name="JohnDoe">
<roles>toonzer</roles>
<svn name="johnd" password="johndpassword" />

</user>

3. Save the permissions.xml file.

Совет: To define several version control repositories:

1. Open the versioncontrol.xml file located in the OpenToonz stuff\config folder with a text editor.

2. Add after the lines defining a repository the following lines:

<repository>
<name>PutYourRepositoryName</name>
<localPath>putYourWorkingCopyPath</localPath>
<repoPath>putYourRepositoryPath</repoPath>

</repository>

and set the related information.

3. Save the versioncontrol.xml file.

Совет: To define users for different repositories:

1. Open the permissions.xml file located in the OpenToonz stuff\config folder with a text editor.

2. In the user section assign to a user the version control user name and password as configured on the
server of the second repository. For example to assign to the user JohnDoe the user johnd2 whose
password is johndpassword2 defined for the second repository, add a svn name line so that the user
name section in the permissions.xml file will look like the following:

<user name="JohnDoe">
<roles>toonzer</roles>
<svn name="johnd" password="johndpassword" />
<svn name="johnd2" password="johndpassword2" />

</user>

3. Save the permissions.xml file.
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23.1.5 Initializing the Version Control in OpenToonz

Before starting to use the version control system, it has to be initialized by setting an option in the
Preferences dialog and restarting OpenToonz.

At this point the repository will be displayed in the OpenToonz browser, and you will be able to start using
it.

Совет: To initialize the version control system:

1. In OpenToonz open the Preferences. . . → Version Control dialog section and activate the Enable
Version Control option.

Примечание: If the version control is not correctly installed or the configuration file is not
correctly defined, activating the option will prompt a warning message.

2. Quit and restart OpenToonz.

3. In the OpenToonz browser look for the repository at the end of the folder tree, named as you defined
it in the configuration file; right-click it and choose Get from the menu that opens to establish the
connection between the central repository and the local working copy.

23.2 Использование системы контроля версий

The central repository and the local working copy are displayed in the OpenToonz browser at the end of the
folder tree as one single folder. By navigating the contents of this folder it’s possible to retrieve the folders
and files.

When a folder is selected in the folder tree a refresh operation occurs automatically, to check the status of
the folder and its content. As this operations may require some time according to the connection speed on
the local network or in the Internet, the automatic refresh operation can be disabled.

Примечание: If several repositories are defined, each of them will be displayed with the name previously
assigned.

Совет: To disable the automatic refresh for folder content:

1. Choose File → Preferences. . . → Version Control.

2. Deactivate the Automatically Refresh Folder Contents option.

Совет: To manually refresh a folder content visualization:

Right-click the folder icon in the folder tree and choose Refresh from the menu that opens.
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Рис. 1: One online repository defined (svn_test) hosting the active project (mySVNproject).
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23.2.1 Getting and Putting Folders and Files

The basic operations in the version control system involves getting files from the central repository to the
local working copy; and then putting the modified files back from the local working copy to the central
repository.

In case you are putting folders, in the dialog that opens you can check which files and folders contained in
the selected folder have to be put in the central repository. Every time files and folders are put, it is also
possible to type a comment to let the other users know about s of the performed modifications.
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In case you are getting or putting scene files (TNZ format), in the dialog that opens it’s possible to check
the Get Scene Contents or the Put Scene Contents option to include with the request, or return back,
the materials used in the scene as well.

Примечание: The first time you get a folder not previously available in the working copy (folder with
grey icon), you get the files contained in the folder, but not the sub-folders. The next time you get the folder
(folder with a colored icon), you get the entire contents of the folder, including sub-folders and the related
contents.

Совет: To get the latest version of a folder or a file from the central repository to the local
working copy:

1. Right-click the folder icon in the folder tree, or the file icon in the browser, and choose Get from the
menu that opens.

2. In the dialog that opens if you are getting a scene file (TNZ format) activate the Get Scene Contents
if you want to get the files used in the scene as well.

3. Click the Update button.

Совет: To put your modified version of a folder or a file from the local working copy to the
central repository:

1. Right-click the folder icon in the folder tree, or the file icon in the browser, and choose Put from the
menu that opens.

2. In the dialog that opens do any of the following:

• If you are putting a folder, check which files and folders contained by the selected folder have to be
put in the central repository.

• If you are putting a scene file (TNZ format) activate the Put Scene Contents if you want to put the
files used in the scene as well.

3. Type a comment if required and click the Put button.
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23.2.2 Editing Files

When using the version control system, in order to modify files you have to put them in Edit mode before
loading them into OpenToonz; if not, they will be loaded as read-only.

The Edit operation «locks» the file, so only the user running the command will be able to modify it
(preventing other users using the same central repository from unlocking it and being able to modify it).
At the moment a file is about to be edited, it’s possible to type in a Comment, to let the other users know
about your editing operation.

When editing a scene file (TNZ format), in the dialog that opens it’s possible to check the Edit Scene
Contents option, in order to be able to edit the materials used in the scene as well. If you choose to edit
only the scene file, or if some material used in the scene is currently being edited by other users sharing the
same central repository, the locked frames of that levels will be displayed with a forbidden icon in the Level
Strip.
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The Edit Frame Range command is available as well, to let a user edit only the needed frames of any Toonz
Vector or Toonz Raster animation level. This way, different users can work at the same time on different
frame ranges of the same animation level.

When you want to release files from the editing mode, so that others can work on them, you can use the
Unlock command.

Примечание: Files are in read-only mode (or in locked mode) in case a user is editing them, by setting the
file system read-only attribute. For this reason, manually using the OS (instead of the appropriate version
control commands) to change this status, may cause serious inconsistencies in the version control system.

Совет: To edit an updated file:

1. Right-click the file and choose Edit from the menu that opens.

2. In the dialog that opens if you are editing a scene file (TNZ format) activate the Edit Scene Contents
if you want to edit the files used in the scene as well.

3. Type a comment if required and click the Edit button.
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Совет: To edit a file that is older than the version available in the central repository:

1. Right-click the file and choose Edit from the menu that opens.

2. In the dialog that opens if you are editing a scene file (TNZ format) activate the Edit Scene Contents
if you want to edit the files used in the scene as well.

3. Type a comment if required and do one of the following:

• Click the Get and Edit button to get the latest version of the files and edit them.

• Click the Edit button to edit the version of the files that is currently in your local working copy.

Совет: To edit only the needed frames of a Toonz level file:

1. Right-click the file and choose Edit Frame Range from the menu that opens.

2. In the dialog that opens set the frame range you want to edit.

3. Type a comment if required and click the Edit button.

Совет: To release a file from the editing mode:

Right-click the file and choose Unlock from the menu that opens.

Совет: To check the editing state of a locked file:

Right-click the file and choose Edit Info from the menu that opens.

23.2.3 Retrieving File Revisions

One of the main advantages of using a version control system is that the history of the revisions for every file
in the production database is always available. This means that it’s possible to very easily retrieve previous
versions of any file.

To retrieve older file versions it’s possible to use the Get Revision command. When used on a single file it
displays a timeline with all the file versions; in the timeline you can check the different file versions with the
related icons and information, and select which version to get in order to edit it.
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When getting a revision of a scene file (TNZ format), in the dialog that opens it’s possible to check the Get
Scene Contents option in order to get the revisions of the materials used in the scene as well.
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When used on a multiple files selection it opens a dialog that allows you to specify the time, day, week or
date of the files version you want to retrieve.

Совет: To retrieve an older revision of a file:

1. Right-click the file and choose Get Revision from the menu that opens.

2. In the dialog that opens look for the file version you are interested in and select it; if you are editing a
scene file (TNZ format) activate the Edit Scene Contents if you want to get the revision of the files
used in the scene as well.

3. Do one of the following:

• Click the Get Selected Revision button to get the selected file version.

• Click the Get Last Revision button to get the latest file version.

Совет: To retrieve an older revision of a selection of multiple files:

1. Right-click any of the selected files and choose Get Revision from the menu that opens.

2. In the dialog that opens specify how much older the version of the files you want to retrieve has to be,
by doing one of the following:

• Specify a time in hours and minutes.

• Specify a number of days.

• Specify a number of weeks.

• Specify and exact date and time.

3. Click the Update button.
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23.2.4 Understanding the Folder and File Icons

According to the folder and file icons you can tell if the folder or the file in the working copy is updated or
not to the latest version available in the central repository, and if files are edited by other users and locked.

Примечание: If the File Browser displays files as a List, the information about the version control status
is displayed in the column labeled Version Control.

For folders the following icons are used:

• A grey folder icon is used for folders available only in the repository. You can use the Get command
to copy them to the local working copy.

• A colored folder icon with a yellow mark is used when the folder contents in the working copy is
not up to date and does not match to the folder contents in the repository : this is the case when there
are modified or new files in the working copy or there are modified or new files in the repository. You
can use the Get command to copy them to the local working copy.

• A colored folder icon with a green mark is used when the folder contents in the working copy is
up to date and matches to the folder contents in the repository.

• A colored folder with a plus mark is used for folders available only in the working copy. You can
use the Put command to copy them to the central repository.

For files the following icons are used:

• A generic grey icon is used for files available only in the repository. You can use the Get command to
copy them to the local working copy.

• The file icon with a grey check mark is used when files in the working copy are up to date and
match to the latest version available in the repository. The files are in read-only mode, and they have
to be in edit mode in order to be modified.

• The file icon with a green check mark is used when files in the working copy are in edit mode.

• The file icon with a green check mark on a grey and white background is used when files in the
working copy are partially in edit mode.

• The file icon with a red exclamation mark is used when files in the working copy are newer than the
latest version available in the repository, because you modified them. You can use the Put command
to copy them to the central repository.

• The file icon with a red exclamation mark on a grey and white background is used when files in
the working copy are partially newer than to the latest version available in the repository, because you
modified them. You can use the Put command to copy them to the central repository.

• The file icon with an orange exclamation mark is used when files in the working copy are older
than the latest version available in the repository, because someone modified them. You can use the
Get command to copy them to the local working copy.

• The file icon with an lock mark is used when files are in edit mode by other users. For these files
it is only possible to check the information about the user editing the file.
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• The file icon with a lock mark on a grey and white background is used when files are partially in
edit mode by other users.

• The file icon with the plus mark is used for files available only in the working copy. You can use
the Put command to copy them to the central repository.
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Глава 24

ToonzScript

ToonzScript is the scripting language used in OpenToonz. Using ToonzScript allows users to create sequences
of commands, thus avoiding the need to perform repetitive tasks manually. ToonzScript is based on QtScript
and is built on the ECMAScript standard. A reference guide for the ECMAScript standard can be found at
the following URL:

ECMAScript Reference

Примечание: Several well known scripting languages are based on the ECMAScript standard such as
JavaScript, JScript, and ActionScript. The ToonzScript syntax is similar to that of JavaScript, for this
reason, a good introduction to JavaScript can be very useful to better understand ToonzScript’s basics.

The original ToonzScript page with some (rather old) examples is available at the following URL:

ToonzScript page

Scripts can be run using the File → Script → Run Script... command. Alternatively, commands can
be typed and executed directly in the Script Console, which can be opened using the File → Script →
Open Script Console... command.

Примечание: When a script is running, the Script Console will open automatically to show the commands
contained within the script.
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24.1 File management

The ToonzScript file extension is .js, scripts need to be in the OpenToonz stuff/library/script folder, to
be automatically retrieved by opening the Run Script command browser.
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24.2 Using the Script Console

The Script Console allows the user to directly enter commands, additionally, dragging & dropping external
text files into the console will automatically insert the path of the file(s).

Start a series of lengthy operations from the console does not block the interface.

24.2.1 Console use conventions

The following conventions are implemented in the use of the Script Console:

• Only the text of the last paragraph can be edited.

• The Up and Down arrow keys allow the navigation of the command history.

• The execution of time consuming commands doesn’t prevent interaction with the software interface.

• The ctrl+y shortcut interrupts the execution of time consuming commands.

• When entering a path in a string, any and all backslashes must be doubled. Following this rule the
path: C:\tmp\test.jpg becomes C:\\tmp\\test.jpg .

• Even if working on a Windows family OS the slash and the backslash can be used in the same way,
thus the path C:\tmp\test.jpg is equivalent to the path C:/tmp/test.jpg .

• The drag & drop of an external file into the console generates a string containing the file’s path and
the backslashes are doubled automatically.

• While you can copy multiple lines of text from the console is allowed only one line paste.

24.3 ToonzScript specifications

Built on the foundaments of ECMAScript, ToonzScript retains a degree of similarity to the JavaScript syntax
but, at the same time, implements some functions and several classes specifically built to make easier the
interaction with the OpenToonz software architecture. Here follows the list of the ToonzScript specifications:

24.3.1 Commands

• print(arg1, arg2, . . . ): writes a message on console.
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The print command doesn’t return the undefined value.

Example:

print(“result=”,12*3);

• run(filename): runs the script saved in filename.
The relative path are referred to the folder «<opentoonz library>/scripts/»

Examples:

run(“test.js”)
run(“C:\\Users\\Username\\Tests\\another_test.js”)

• view(image): allows to view an image.
The view command can be legally used in the following context: view(new Image(filename))

• view(level): allows to view a level.

Example:

view(new Level(“C:\\OpenToonz stuff\\sandbox\\drawings\\A.pli”))

• The variable ToonzVersion can be used to check the current version of OpenToonz.

24.3.2 Classes

For each class, the related constructor, methods and attibutes are listed.

File path

contains the path of an object.

Constructor:

• new FilePath(path)

Methods:

• path2 = path.withExtension(e)

• path2 = path.withName(name)

• path2 = path.withParentDirectory(d)

• path2 = path.concat(f) - where f can be a FilePath or a string

• files = path.files() - if path is a folder then this method returns the files inside the folder.

Attributes:

• path.extension - read and write attribute

• path.name - read and write attribute

• path.parentDirectory - read and write attribute

• path.lastModified - read only attribute

• path.exists - read only attribute

• path.isDirectory - read only attribute
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Examples:

myRoot = new FilePath(“C:\\Users\\username\\”);

f = myRoot.concat(“tests”).concat(“name.0001.tif”);

print(f.extension); // => “tif”

print(f.name); // => “name”

print(f.parentDirectory); // => “C:\Users\username\tests”

if(f.exists) print(“the file “,f,”exists”); else print(“the file “,f,”does not exist”);

d = new Date().getTime() - f.lastModified.getTime();

d.setDate(d.getDate()-1);

if(f.lastModified>=d) print(“file modified in the last 24 hours);

files = myRoot.files();

for(k in files) print(files[k]); // print all files in myRoot

Image

contains an image, supported types are: tlv, pli or fullcolor.

Constructor:

• new Image() or new Image(filename)

Methods:

• img.save(filename) - the file extension has to be compatible with the kind of used level

• img.load(filename)

Attributes:

• img.width - has value 0 if the image is a pli

• img.height - has value 0 if the image is a pli

• img.dpi - has value 0 if the image is a pli

• img.type - accepted values (“Empty”, “Raster”, “ToonzRaster”, “Vector”)

Examples:

img = new Image(“C:/images/basename.0003.tif”);

view(img);

print(img.width,img.height,img.dpi);

img = new Image(“C:/images/name.pli”); // reads only the first frame.

view(img);

img.save(“C:/images/name.pli”);
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Level

contains a level, the supported types are: tlv, pli or fullcolor.

Constructor:

• new Level() or new Level(filename)

Methods:

• level.load(filename)

• level.save(filename) - the file extension has to be compatible with the kind of usedlevel

• level.getFrameIds() - lists the names of all the frames

• level.getFrame(frameId) - retrive the image of the specified frame

• level.getFrameByIndex(index) - gets the frame specified by the index value (first value of index is 0)

• level.setFrame(frameId, image) - sets a frame (if the level is not empty its content and the type of
image has to be compatible)

Attributes:

• level.name - is a read and write attribute

• level.path - is a read and write attribute

• level.frameCount - is a read only value

• level.type (“Empty”, ”Raster”, ”ToonzRaster”, ”Vector”) - is a read only value

Examples:

// This example produces a "renumber"

inputLevel= new Image(“C:/images/name.pli”);

outputLevel = new Level();

for(i=0;i<inputLevel.frameCount;i++)
{

outputLevel.setFrame(i+1, inputLevel.getFrameByIndex(i));

outputLevel.save(“C:/images/name.pli”);
}

// instead this keeps the sequence of frames, but reverses the order

outputLevel = new Level();

fids = inputLevel.getFrameIds();

for(i=0;i<fids.length;i++)
{

img = inputLevel.getFrame(fids[fids.length-1-i]);
outputLevel.setFrame(fids[i], img);

}

view(outputLevel);
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Scene

contains a Toonz scene.

Constructor:

• new Scene() or new Scene(filename)

Methods:

• scene.load(filename)

Примечание: If the path is relative, scenes of the current project are used.

• scene.save(filename)

• scene.setCel(row, col, cell) , scene.setCell(row, col, level, frameId)

Примечание: cell is the kind of object returned by getCell() .

• The following syntax is allowed scene.setCell(1, 0, scene.getCell(0,0))

• To delete a cell: scene.setCell(row, col, undefined)

• cell is a standard JavaScript object that includes the attributes:level and fid , the following use is
allowed: scene.setCell(row, col, {level:a, fid:1})

• level can be a Level or a level name. The level has to be already in the scene.

• fid supports numeric values or string values as “2” or “2a”.

• cell = scene.getCell(row, col) - returns a JavaScript object with level and fid attributes

• scene.insertColumn(col)

• scene.deleteColumn(col)

• scene.getLevels() - returns an arrray that contains all the levels belonging to the scene

• scene.getLevel(name) - returns the level basing on its name. If a level using the name specified does
not exists the value undefined is returned.

• level = scene.newLevel(type, name) - Adds a layer to the scene. Type can be «Raster», «ToonzRaster»
or «Vector». Name must not be already „used in the scene.

• level = scene.loadLevel(name, path) - Load a level (mode „«links») in the scene. The path must exist
and be an absolute path.The name must not have been already used for another level of the scene.

Attributes:

• scene.frameCount - is a read only value

• scene.columnCount - is a read only value

Examples:

filename = “test.tnz”; // relative to “+scenes”

scene = new Scene(filename);

print(scene.frameCount, scene.columnCount);

(continues on next page)
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(продолжение с предыдущей страницы)

// Move the cells of the first column on the first frame of the other columns.

for(r=1;r<scene.frameCount;r++)
{

scene.setCell(0,r, scene.getCell(r,0));

scene.setCell(r,0,undefined); // delete the old cell.
}

scene.save(“name.tnz”);

//Create a new scene.

scene = new Scene();

level = scene.load(“A”,”C:/levels/name.pli”);

fids = level.getFrameIds();

for(i=0;i<fids.length;i++) scene.setCell(i,0,level,fids[i]);

scene.save(“name.tnz”);

// writes name, path and number of frames of each level in the scene.

scene = new Scene(“name.tnz”);

levels = scene.getLevels();

for(i=0;i<levels.length;i++)
{

level = levels[i];

print(level.name, level.path, level.frameCount);
}

Transform

represents a geometric tansformation (composed by rotation, translation and scale). Used by ImageBuilder.

Constructor:

• new Transform()

Methods:

• transform.translate(dx, dy)

• transform.rotate(degrees)

Примечание: Positive values correspond to a counterclockwise rotation.

• transform.scale(s)

• transform.scale(sx, sy)

Examples:
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transform = new Transform().rotate(45).translate(10,2);

print(transform);

ImageBuilder

allows to modify an image (rotate, scale, crop), or to make an over between two or more images.

Constructor:

• new ImageBuilder() or new ImageBuilder(xres, yres)

Methods:

• builder.add(img)

• builder.add(img, transform)

Примечание: The component of translation of the transform means expressed in pixels for Raster and
Toonz Raster levels, and in Camera Stand units for Vector levels.

• builder.fill(color)

Attributes:

• builder.image - returns the actual result.

Examples:

ib = new ImageBuilder(800,800);

img = new Image(“C:/levels/name.0001.tif”);

scale = 1;

phi = 0;

for(i=0;i<20;i++)
{

tr = new Transform().scale(scale).translate(0,-200).rotate(phi);

ib.add(img, tr);

phi -= scale*30;

scale *= 0.9;
}

view(ib.image);

OutlineVectorizer

vectorize raster images using an outline algorithm.

Constructor:

• new OutlineVectorizer()
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Methods:

• v.vectorize(level or image) - returns the new vectorized level (or image), supports as input: Raster or
Toonz Raster images and levels.

Attributes:

• v.accuracy

• v.despeckling

• v.preservePaintedAreas

• v.cornerAdherence

• v.cornerAngle

• v.cornerCurveRadius

• v.maxColors

• v.transparentColor

• v.toneThreshold

Examples:

v = new OutlineVectorizer();

v.preservePaintedAreas = true;

a = new Image("C:/Users/username/name.tif");

b = v.vectorize(a);

view(b);

CenterlineVectorizer

vectorize raster images using a centerline algorithm.

Constructor:

• new CenterlineVectorizer()

Methods:

• v.vectorize(level or image) - returns the new vectorized level (or image), supports as input: Raster or
Toonz Raster images and levels.

Attributes:

• v.threshold

• v.accuracy

• v.despeckling

• v.maxThickness

• v.thicknessCalibration

• v.preservePaintedAreas

• v.addBorder
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Examples:

v = new OutlineVectorizer();

v.preservePaintedAreas = true;

a = new Image("C:/Users/username/name.tif");

b = v.vectorize(a);

view(b);

Rasterizer

converts vector images into Raster or ToonzRaster images.

Constructor:

• new Rasterizer()

Methods:

• out = r.rasterize(vimg) - converts to raster an image or a level

Attributes:

• r.colorMapped - if its value is set to True the generated image is of ToonzRaster type

• r.xres

• r.yres

• r.dpi

Examples:

a = new Level("C:\\Users\\username\\PLI\\name.pli");

r= new Rasterizer();

r.xres=768; r.yres=576; r.dpi=40;

b = r.rasterize(a);

b.save(“C:\\Users\\username\\PLI\\name.tif”);

r.colorMapped = true

c = r.rasterize(new Level("C:\\Users\\username\\PLI\\name.pli"))

c.save(“C:\\Users\\username\\PLI\\bimba.tlv”);

Renderer

renders a whole scene or part of a scene, creating levels or images.

Constructor:

• new Renderer()
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Methods:

• level = c.renderScene(scene)

• image = c.renderFrame(scene, frameIndex)

Примечание: frameIndex starts from 0

Attributes:

• r.columns (list of indices of columns to render. e.g. r.columns = [0,3])

• r.frames (list of indices of frames to render. e.g. r.frames = [0,1,2,3])

Examples:

scene = new Scene("testscene.tnz”);

r= new Rasterizer();

view(r.renderScene(scene ,0));

r.columns = [0,2];

view(r.renderScene(a,0)); // frame 1; columns 1 and 3

r.frames = [0,2,4,6];

output = r.renderScene(scene ); // frames 1,3,5,7; columns 1 and 3

output.save(“C:\\Users\\username\\output\\name..tif”);

r.columns = [];

output = r.renderScene(scene ); // frames 1,3,5,7; all columns

output.save(““C:\\Users\\username\\output\\name..tif””);

24.4 Code examples

Following there are some examples of scripting code:

24.4.1 Outline vectorization

This brief script is an example of using the OutlineVectorizer on a single image. The script is commented,
explaining what each section does:

//Define the input and output folders

dir = "C:\\OpenToonz stuff\\SCRIPT IMAGES IN\\";

dir2 = "C:\\OpenToonz stuff\\SCRIPT IMAGES OUT\\";

(continues on next page)
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(продолжение с предыдущей страницы)

//Load image toad3.0001.tif from disk

a = new Image(dir+"toad3.0001.tif");

print("loaded",a);

//Initialize a vectorizer and specify any relevant options

v = new OutlineVectorizer();

v.maxThickness = 1;

v.preservePaintedAreas = false;

v.accuracy = 10;

v.maxColors = 10;

//Run the vectorization process and save the result

v.vectorize(a).save(dir2 + "vec.pli");

print("vectorized");

24.4.2 Rotating an image

This example explains how to load an image and then create an animation in a level, rotating the loaded
frame:

\\Define the input and output folders

dir = "C:\\OpenToonz stuff\\SCRIPT IMAGES IN\\";

dir2 = "C:\\OpenToonz stuff\\SCRIPT IMAGES OUT\\";

//Load the toad3.tif image

a = new Level(dir+"toad3..tif");

print("loaded\n",a);

//Initialization of the new objects and creation of a list containing the IDs of all the frames

t = new Transform();

b=new Level();

ll=a.getFrameIds();

//For loop that builds the new level. At each step a new frame is added to the level b using the
(continues on next page)
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(продолжение с предыдущей страницы)

setFrame method that adds the myimage frame rotated of a step degrees value using the ib␣
→˓ImageBuilder

for(i=0; i<a.frameCount;i++)
{

ib = new ImageBuilder();

step=360/a.frameCount;

myimage=a.getFrame(ll[i]);

b.setFrame(ll[i], ib.add(myimage, t.rotate(step)).image);

print("building frame " + ll[i] + "\n");
}

//Save the result prompting a status message

b.save(dir2+"rottoad3..tif")

print("saved\n",b);

//Shows the resulting level in a flipbook window

view(b);
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Глава 25

Keyboard Shortcuts

25.1 Configuring Shortcuts
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Predefined shortcuts are available for OpenToonz tools, modifiers and menu commands. They can be
customized, and new shortcuts can be added for undefined items.

Shortcuts are specific to each user, meaning that each user in the system can have a different set of shortcuts.

Совет: To configure a shortcut:

1. Choose File → Configure Shortcuts. . .

2. Search for the command or tool you want to configure the shortcut for in the appropriate folder, or by
using the Search field at the top of the window.

3. Select the command or tool name in the list.

4. Press the keyboard key, or combination of keys, you want to assign as shortcut.

Совет: To remove a configured shortcut:

1. Choose File → Configure Shortcuts. . .

2. Search for the command or tool you want to configure the shortcut for in the appropriate folder, or by
using the Search field at the top of the window.

3. Select the command or tool name in the list.

4. Click the Remove button.

25.2 Predefined Keyboard Shortcuts

The following are some of the predefined shortcuts available in OpenToonz.
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Tools

Animate A

Selection S

Brush B

Geometric G

Type Y

Fill F

Eraser E

Tape T

Style Picker K

RGB Picker R

Control Point Editor C

Pinch M

Skeleton V

Hook O

Plastic X

Zoom Shift + Space

Rotate Ctrl/ Cmd + Space

Hand Space

Примечание: If you press and hold a tool keyboard shortcut, you perform a temporary tool selection:
when you release the key you will return to the previously selected tool.

Tool Modifiers
Brush Size - Decrease max U
Brush Size - Increase max I
Brush Size - Decrease min H
Brush Size - Increase min J
Rectangular/Normal type F5
Frame Range F6
Selective F7
Segment F8
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Visualization
Actual Pixel Size N
Fit to Window Alt/ Option + 9
Reset View Alt/ Option + 0
Zoom in +
Zoom out -
Onion Skin Toggle /
Maximize Panel ‘
Full Screen Mode Alt/ Option + F
Main Window Full Screen Mode Ctrl/ Cmd + ‘

Playback Controls
Play P
Loop L
Previous Drawing ,
Next Drawing .
Previous Frame Shift + ,
Next Frame Shift + .
Previous Keyframe Ctrl/ Cmd + ,
Next Keyframe Ctrl/ Cmd + .

File Menu
New Scene Ctrl/ Cmd + N
Load Scene. . . Ctrl/ Cmd + L
Save All Ctrl/ Cmd + S
Save Scene Ctrl/ Cmd + Shift + S
Preferences. . . Ctrl/ Cmd + U
Quit Ctrl/ Cmd + Q

Edit Menu
Undo Ctrl/ Cmd + Z
Redo Ctrl/ Cmd + Y
Cut Ctrl/ Cmd + X
Copy Ctrl/ Cmd + C
Paste Insert Ctrl/ Cmd + V
Paste Insert Above/After Ctrl/ Cmd + Shift + V
Delete Del
Insert Ins
Insert Above/After Shift + Ins
Select All Ctrl/ Cmd + A
Group Ctrl/ Cmd + G
Ungroup Ctrl/ Cmd + Shift + G
Bring to Front Ctrl/ Cmd + ]
Bring Forward ]
Send Backward [
Send to Back Ctrl/ Cmd + [
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Level Menu
New Level. . . Alt/ Option + N

Xsheet Menu
Set Key Z
New FX. . . Ctrl/ Cmd + F
Edit FX. . . Ctrl/ Cmd + K
Apply Lip Sync Data to Column Alt/ Option + L

Cells Menu
Duplicate Drawing D
Increase Step „
Decrease Step ;
Drawing Substitution Backward Q
Drawing Substitution Forward W
Similar Drawing Substitution Backward Alt/ Option + Q
Similar Drawing Substitution Forward Alt/ Option + W

Play Menu
Play P
Loop L
First Frame Alt/ Option + ,
Last Frame Alt/ Option + .
Previous Frame Shift + ,
Next Frame Shift + .
Previous Keyframe Ctrl/ Cmd + ,
Next Keyframe Ctrl/ Cmd + .
Previous Drawing ,
Next Drawing .

Render Menu
Preview Ctrl/ Cmd + R
Output Settings. . . Ctrl/ Cmd + O
Render Ctrl/ Cmd + Shift + R
Fast Render to MP4 Alt/ Option + R

Windows Menu
History Ctrl/ Cmd + H
Record Audio Alt/ Option + A
Startup Popup. . . Alt/ Option + S
Maximize Panel ‘
Main Window Full Screen Mode Ctrl/ Cmd + ‘

Help Menu
Online Manual. . . F1
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Глава 26

FX Reference

Примечание: The FX Reference is not complete at this time

26.1 Layer Blending

26.1.1 Local Transparency

Inputs:

Source, The image that will be affected.

Reference, The luminance of the Reference image will control the opacity of the Source.
The Source will be made transparent where the Reference is light, and opaque where the Reference is dark.

Parameters:

Intensity, Controls the overall strength of the effect.
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A value of 50 will produce a result halfway between the Source image and the full effect.

Usage Example:

We can use a checker pattern to control the opacity of a circle

This is how the two levels are connected in the FX Schematic; by connecting the checker level to the Reference
input, we will use its luminance to mask portions of the circle

Here is the result; the red circle is visible within the black areas of the checker pattern and not in the white
areas
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26.1.2 Transparency

Inputs:

Source, The image that will be affected.

Parameters:

Intensity, Controls the overall strength of the effect.
A value of 50 will produce a result halfway between the Source image and the full effect.

Usage Example:

We will see the transparency of a yellow circle on top of a black rectangle background
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This is how the image levels are connected in the FX schematic; by connecting the circle level to the source
input we can control the circle’s transparency

Here is the result; the first image is with zero percent transparency, the second image is with fifty percent
transparency, and the third image is with seventy five percent transparency
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